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Preface

With the release of IBM® Lotus® Sametime® Connect 7.5, IBM provides an 
application platform upon which enhancements and application plug-ins can be 
built to best meet your organization's needs. Sametime Connect 7.5 is the first 
release of new instant messaging technology built on the Eclipse-based IBM 
WebSphere® Everyplace® Deployment platform. This new release leverages the 
Eclipse plug-in framework to provide developers with extensibility features that go 
far beyond those available in previous releases.

Lotus Sametime Connect 7.5 offers more than simple instant messaging and 
presence features. Because it is built on Eclipse, a variety of plug-ins that expand 
the functionality of Lotus Sametime Connect are shipped with the product, and 
third parties can build additional plug-ins. 

The objective of this IBM Redbook is to show you how to develop Eclipse based 
plug-ins to customize and personalize the real-time, collaborative capabilities of 
Sametime within your organization. The book serves as a thorough guide on how 
to build plug-ins, beginning with how to install the Eclipse development 
environment, and then leading the reader through numerous examples ranging 
from a basic introduction on branding your Sametime environment, to showing 
how to integrate with a back-end system, retrieve information, and then 
manipulate the data presentation within the context of a Sametime window. For 
each example, we provide the audience with a step-by-step guide on how to build 
the plug-in. 

Finally, this capability for custom development represents a primary value point 
for Sametime 7.5. The ability to create plug-ins allows organizations to meet the 
growing needs of the instant messaging community. This flexibility, combined 
with Sametime’s already proven security model and numerous user interface 
enhancements, makes Lotus Sametime Connect a powerful tool to help 
companies harness the potential of their employees.

The team that wrote this redbook
This IBM Redbook was produced by a team of specialists from around the world 
working at the International Technical Support Organization, Cambridge, MA, 
USA Center.
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Chapter 1. Introduction to Sametime 7.5

With the release of IBM Lotus Sametime Connect 7.5, IBM provides an 
application platform upon which enhancements and application plug-ins can be 
built to best meet your organization's needs. Sametime Connect 7.5 is the first 
release of new instant messaging technology built on the Eclipse-based IBM 
WebSphere Everyplace Deployment platform. This new release leverages the 
Eclipse plug-in framework to provide developers with extensibility features that go 
far beyond those available in previous releases.

Lotus Sametime Connect 7.5 offers more than simple instant messaging and 
presence features. Because it is built on Eclipse, a variety of plug-ins that expand 
the functionality of Lotus Sametime Connect are shipped with the product, and 
third parties can build additional plug-ins. 

The objective of this IBM Redbook is to show you how to develop Eclipse based 
plug-ins to customize and personalize the real-time, collaborative capabilities of 
Sametime within your organization. This IBM Redbook serves as a thorough 
guide on how to build plug-ins, beginning with how to install the Eclipse 
development environment, and then leading the reader through numerous 
examples ranging from an introduction on branding your Sametime environment, 
to eventually showing how to integrate with a back-end system, retrieve 
information, and then manipulate the data presentation within the context of a 
Sametime window. For each example, we provide the audience with a step by 
step guide on how to build the plug-in. 

1
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In this chapter, we introduce the new features of Lotus Sametime 7.5. You will 
learn about the advantages of extending the Sametime Connect client and 
review some of the sample plug-ins that are included in the SDK. You can deploy 
these plug-ins to your own Lotus Sametime environment. You can also reuse the 
code in these samples to create your own extended functionality.

The following topics are presented in this chapter:

� About Lotus Sametime 7.5

� Extending the Sametime Connect Client

� Sametime toolkits

� Using plug-ins

� Sample plug-ins included in the Sametime SDK

� Plug-in integration points
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1.1  About Lotus Sametime 7.5

Millions of people worldwide use IBM Lotus Sametime 7.5 capabilities every day 
to gain instant access to people and information, bring together geographically 
dispersed teams, and improve individual and team productivity. Lotus Sametime 
7.5 provides instant, anytime access to people and information through three on 
demand concepts: 

� Presence awareness

� Business instant messaging

� Web conferencing 

Lotus Sametime now uses audio integration from leading teleconferencing and 
telecommunications providers to offer a single interface to both audio and Web 
conferencing, as well as click-to-call functionality directly from the Lotus 
Sametime Connect Client. 

Additionally, Lotus Sametime 7.5: 

� Provides easy-to-use, intuitive technology that provides a rapid way to resolve 
problems and settle questions through clear, high quality communications. 

� Allows quick access global teams. 

� Provides a cost-effective, consistent approach to real-time collaboration within 
an encrypted, authenticated, and managed environment. 

� Offers integration with Microsoft® Office and Microsoft Outlook® applications. 

� Includes a mobile client that can be deployed on multiple mobile platforms 
and devices. 

1.1.1  New in Sametime 7.5

Lotus Sametime 7.5 includes over 150 new features, including rich text, chat 
history, integrated Voice over IP (VoIP), managed interoperability with public IM 
networks, and new options for telephony and video integration. 

With Lotus Sametime 7.5, users get:

� Improved instant message features, such as spell check, automatic time 
stamps, integrated chat histories, built-in Voice over IP (VoIP), and more. 

� Streamlined Web conferences that are easier to schedule and join and offer 
higher quality, bandwidth efficient presentation sharing and automatic 
reconnection. 
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� Managed interoperability options with public IM networks, such as AOL and 
Yahoo. 

� Ability to create and embed applications into the real-time environment via 
Sametime 7.5's Eclipse-based framework. 

� Integration with applications such as Microsoft Office and Outlook.

� Ability for mobile clients to run on multiple operating systems and devices. 

1.1.2  New Sametime Connect client

Lotus Sametime 7.5 runs on Microsoft Windows® 2000 and XP, Linux®, and 
Apple's Mac OS X Version 10.4 and also serves as the instant messaging client 
for a future release of IBM Workplace Collaboration Services. It provides an 
extensive list of new out-of-the-box functionality that ultimately leads to a much 
richer user experience. Some of these features include: 

� New status settings 

� Click to call

� Click to dial

� Location awareness

� Rich text 

� Ability to send links, graphics, and screen captures to chat partners

� Time stamps

� Emoticons 

� Spell-check 

� Type-ahead name searching 

� Area for virtual business cards 

� Corporate branding

� Tools to maintain and view Chat history 

� Support for multiple Sametime communities

For more information about the new client features, read Taking a tour of the new 
features and technology in IBM Lotus Sametime 7.5 on developerWorks® at:

http://www-128.ibm.com/developerworks/lotus/library/sametime75/
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1.1.3  Improved Web conferencing

Improvements to Sametime 7.5 Web conferencing include:

� Streamlined meeting creation 

� Improved error and information messages when joining a Web meeting

� Improved connectivity to meeting server and client

� New meeting room client designed for easier navigation and preference 
selections

� Improved UI for easier hand off between moderators

� Third party integrated telephony and video solutions

� Lotus Sametime policy engine that allows administrators to regulate specific 
functionality that people are allowed to use.

1.1.4  Real-Time Collaboration (RTC) Gateway

With previous releases of Lotus Sametime, the challenge was to provide secure 
presence and instant messaging to a company’s internal users, while also 
providing that same functionality to external private and public IM networks. In 
addition, interoperability was suppose to occur in an environment that lacked 
standards and where IM providers used proprietary protocols. 

The Real-time Collaboration (RTC) Gateway provides conversion services for 
various protocols, thus allowing full interoperability across domain boundaries. 

The RTC Gateway is a next generation product that is designed to provide 
server-side aggregation, thus allowing server-to-server awareness between 
multiple communities. This is a fundamental difference from prior Lotus 
Sametime functionality and provides much greater administrative control through 
policy-managed access to public and other company IM networks.

Note: The initial release of the RTC Gateway is scheduled for Q3 2006 and 
will be free of charge with a Lotus Sametime server. This Gateway also 
provides free integration with public IM communities. IBM will release four 
protocol connectors with the initial ship of the RTC Gateway. These protocol 
connectors include translators for Lotus Sametime (VP protocol), SIP (100% 
IETF), and the dialects of SIP used for the Sametime SIP Gateway and AOL. 
The initial release will allow connectivity with other RTC Gateways, existing 
Sametime SIP Gateways, AOL, and Yahoo.
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1.1.5  Extendable platform

The new unified Sametime Connect client is built on the Eclipse open source 
platform. By building Lotus Sametime on top of Eclipse, it becomes easier for 
third-party tool providers to build plug-ins, applications, or extensions that 
integrate seamlessly into Lotus Sametime. 

1.2  Extending the Sametime Connect Client

Previous releases of the Lotus Sametime instant messaging client did not allow 
for extensions. Release 7.0 of the Lotus Sametime Java Toolkit allowed for reuse 
of Sametime-aware widgets and gave API access to server data, but today’s 
Lotus Sametime Connect goes further, providing a platform on which third-party 
developers can build plug-ins, applications, and extensions and integrate them 
into the Sametime Connect client.

1.2.1  Benefits of extending client functionality

The Sametime extensible client is more flexible than traditional applications. 
Administrators can provide automatic upgrades to clients and plug-ins. For 
example, your company may begin by using Lotus Sametime’s out-of-the-box 
click-to-voice-chat function. At some future point, however, you can integrate 
Lotus Sametime with your company’s internal PBX phone system for click-to-call 
functionality, using a plug-in that you develop or purchase from a third-party 
vendor. The new functionality can be quickly deployed to users automatically or 
users can install the new functionality as needed.

In addition, and perhaps most importantly, the instant messaging and presence 
components in Lotus Sametime Connect 7.5 can be used by other IBM managed 
client products, including the next release of IBM Lotus Notes®, code-named 
Hannover, and future releases of the IBM Workplace Managed Client™.

1.2.2  Eclipse platform for extending functionality

IBM Lotus Sametime Connect 7.5 is based on the Eclipse platform. 
Consequently, if you are familiar with Java and Eclipse plug-in development, you 
can extend the Lotus Sametime client. Because these plug-ins are integrated 
into the Sametime Connect client UI via extension points, users will not be able to 
easily distinguish the plug-in features from features that are native to the product.

Eclipse is an open source, Java-based, and extensible development platform. By 
itself, it is simply a framework and a set of services for building a development 
8 Extending Sametime 7.5: Building Plug-ins for Sametime



environment from plug-in components. Eclipse comes with a standard set of 
plug-ins, including the Java Development Tools (JDT). 

In addition to providing a Java Integrated Development Environment (IDE), 
Eclipse also includes the Plug-in Development Environment (PDE), which is 
mainly of interest to software developers who want to extend Eclipse, since it 
allows them to build tools that integrate seamlessly with the Eclipse environment. 
Because everything in Eclipse is a plug-in, all tool developers have a level playing 
field for offering extensions to Eclipse and providing a consistent, unified 
integrated development environment for users. 

For more information, read Getting started with the Eclipse Platform at:

http://www-128.ibm.com/developerworks/opensource/library/os-ecov/

1.3  Sametime toolkits

Lotus Sametime includes comprehensive application development toolkits. You 
can use the toolkits to embed real-time capabilities, such as chat and real-time 
help features, into e-business applications. The toolkits can also be used to 
expand Sametime’s native functionality, for example, building plug-ins to 
incorporate your company’s internal directory with Lotus Sametime. You can use 
one or a combination of the toolkits to develop customized real-time applications.

The Lotus Sametime SDK includes both the Connect client and server toolkits. 
The client toolkits are intended to be used by client or browser-based 
applications and include the Lotus Sametime Connect toolkit, the Lotus 
Sametime Links toolkit, and the Lotus Sametime Java toolkit. See Chapter 3, 
“Setting up the Integrated Development Environment” on page 37 for a complete 
list of Lotus Sametime 7.5 SDK toolkits.

1.3.1  Sametime Connect toolkit (Sametime Connect SDK)

The Lotus Sametime Connect toolkit (sometimes referred to as the Lotus 
Sametime Connect SDK) is a collection of APIs built on top of WebSphere 
Everyplace Deployment and Eclipse and can be used to build plug-ins to 
enhance the usability of Lotus Sametime Connect.

The Lotus Sametime Connect toolkit provides an integration guide, Javadoc™, 
J9 Java Class Libraries (JCL) Desktop run time, and sample plug-ins.

You can use the Lotus Sametime Connect toolkit to develop plug-ins that 
customize the Lotus Sametime Connect client. Sample plug-ins are shipped with 
the toolkit and provide some key functionality within Lotus Sametime Connect.
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For more information about the sample plug-ins that ship with Lotus Sametime 
Connect 7.5, see the developerWorks Lotus article, “Extending IBM Lotus 
Sametime Connect 7.5.”

For more information about the Sametime toolkits, read A tour of the IBM Lotus 
Sametime 7.5 toolkits, available at:

http://www-128.ibm.com/developerworks/lotus/library/sametime75-toolkits
/

Downloading the SDK and setting up the IDE
The SDK is a new feature in Sametime 7.5 and is downloaded from IBM 
developerWorks at http://www.ibm.com/developerworks/. For instructions on 
downloading the toolkit and setting up the development environment, see 
Chapter 3, “Setting up the Integrated Development Environment” on page 37.

1.4  Using plug-ins

A plug-in is a computer program that provides a feature or an extension to a 
feature in an existing application.

1.4.1  About plug-ins

Users can manually add plug-ins to their Sametime Connect client. These 
plug-ins may be accessed from an Eclipse update site or from a local source, 
e-mail, file server, and so on and then manually enabled.

Plug-ins can be automatically provisioned to users’ clients through administrative 
controls. See Chapter 12, “Deploying plug-ins for Sametime 7.5” on page 525 for 
more information about deploying plug-ins.

1.4.2  Manually install a plug-in

Users can install new plug-ins and updates to existing ones. Follow these 
instructions to manually install a plug-in.

1. Select File → Manage updates → Download plug-ins.

2. Click Search for new features to install and then click Next. 

Note: The system administrator determines whether plug-ins are available to 
users. The system administrator may also automatically update or provision 
plug-ins to the users’ Lotus Sametime Connect client. 
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3. Click New Remote Site....

4. Enter the name and address for the new site, and then click OK.

5. Click the Ignore features not applicable to this environment check box. 

6. Click Finish. 

The Updates window displays, and includes the plug-ins available for 
downloading. Expand the lists to view all plug-ins available from the site.

7. Expand the list and click the check box next to each plug-in you wish to 
download, and then click Next. 

8. Click I accept the terms of the license agreement, and then click Next.

9. Click Finish to start downloading the plug-in(s).

10.Restart the Sametime Connect client, if prompted to do so.

1.4.3  Managing plug-in updates

The system administrator determines whether plug-ins are available to users and 
whether new plug-in updates are automatically installed to the users’ Sametime 
Connect client. If automatic updates are available, users can specify an update 
schedule and download options. 

Specify automatic updates
Follow these instructions to modify the preference settings so that the plug-ins 
are automatically updated.

1. Select File → Preferences.

2. Expand Install/Update in the navigator and select Automatic Updates. 

3. Select Automatically find new updates and notify me to automatically 
install updates to plug-ins.

4. Select how often you want to look for updates and download options for new 
updates. 

5. Click Apply.

Note: The plug-in site can be a local or a remote Eclipse update site.

Note: The directions here are intended to provide an introduction for 
managing updates of plug-ins. For detailed information about deploying 
plug-ins throughout the enterprise, please refer to Chapter 12, “Deploying 
plug-ins for Sametime 7.5” on page 525. 
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6. Click OK. 

1.4.4  Manually remove a plug-in

Administrators can automatically update, add, and remove plug-ins from the 
Sametime Connect client. Users can also manually uninstall some plug-in 
features. Follow these instruction to remove a plug-in from the Sametime 
Connect client.

1. Start the Sametime Connect client.

2. Select File → Properties → Manage Updates → Configure....

3. In the Product Configuration dialog box, expand the list of Sametime features.

4. Select and right-click the plug-in you wish to remove. 

5. Select Uninstall from the context menu.

6. Respond Yes when you are prompted to restart Sametime Connect client.

1.5  Sample plug-ins included in the Sametime SDK

The IBM Lotus Sametime Software Developers Kit (SDK) includes the following 
sample plug-ins:

� BuddyNote

� Recent Buddies

� Acronym Expander

� Quick Response

� Snippets

� Branding

You can deploy and use these plug-ins and reuse the extensions and code to 
create new plug-ins.

1.5.1  BuddyNote

The BuddyNote feature enables you to annotate your buddy list by adding notes 
about your contacts. 

Note: Some features cannot be uninstalled by the user, the Uninstall option 
will be grayed out in those instances.
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Use the Buddy Note to record information about your contact, including:

� The person's work schedule.

� Home address and alternate phone numbers. 

� The person's areas of expertise. 

� Where you met this person (for example, at a conference, training course, 
meeting, and so on).

� Personal information, such as their birthday or spouse's first name.

When you select a contact from your buddy list, the notes area displays, as 
shown in Figure 1-1. You can add, modify, and delete notes from this area.

Figure 1-1   BuddyNote plug-in user interface

1.5.2  Recent buddies

Recent Buddies is a buddy list that displays the people you chat with the most. 
The list is populated as you use Sametime Connect to chat with others. You use 
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Recent Buddies to quickly locate those people you have chatted with most 
recently. Figure 1-2 shows the user interface for the Recent Buddies plug-in.

Figure 1-2   Recent Buddies plug-in interface

You can sort the Recent Buddies list by clicking the column headers.

Modifying the Recent Buddies list 
To modify the Recent Buddies list, right-click a name and select one of the 
following:

� Primary: Maintains the name in the list, regardless of how often you chat with 
this person. 

� Remove: Deletes the name from the list.

� Exclude: Disables the name so it will not be included in the Recent Buddy list, 
regardless of how often or how recently you have chatted with this person. 
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1.5.3  Acronym Expander

Acronym Expander is a type of private library to which you can add acronyms 
and their definitions. When you participate in a chat, and another person sends 
you a message that contains the acronym, Acronym Expander detects the use of 
acronyms and replaces the text with the expanded definition.

Example 1-1 shows a sample chat transcript that contains the acronym “OTP.”

Example 1-1   Chat message without Acronym Expander

Robin Hi, have you got a minute to chat?
Chris No, OTP. 

Example 1-2 shows how the chat would look with Acronym Expander installed. In 
place of “OTP”, the plug-in replaces the words “Sorry, I’m on the phone right 
now.”

Example 1-2   Chat message with Acronym Expander

Robin Hi, have you got a minute to chat?
Chris No, Sorry I'm on the phone right now. 
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Users can add their own acronyms using the plug-in interface, which is accessed 
through the Preferences menu. Figure 1-3 shows the Acronym Expander 
interface. 

Figure 1-3   Acronym Expander plug-in user interface

1.5.4  Quick Response

Quick Response is a collection of information and phrases you use most often. 
You use this feature to quickly send standard greetings, information, phone 
numbers, and other messages.

Some examples of useful Quick Response phrases include: 

� I see that you are away. Would you reply to this message upon your return? I 
have a question. 

� Sorry, I am in a meeting. I will respond to you soon. 

� Please ping me when you return. 
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� Would you call me? My phone number is 301-555-1212 

Send a Quick Response
You send a Quick Response from the chat window. Figure 1-4 shows how to 
send a Quick Response using the Quick Response icon on the toolbar. 

Figure 1-4   Quick Response plug-in user interface

To enter a Quick Response:

1. Click the Quick Response icon on the tool bar.

2. Select a response from the list.

3. Optionally, you can click <add new response> to add phrases to the Quick 
Response list.

1.5.5  Snippets

The Snippets plug-in provides several small code examples. The code can be 
used in building new plug-ins, which include user interface extensions such as 
menu items, toolbar buttons, and n-way chat.
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1.5.6  Branding

The Branding plug-in is installed with the SDK and includes the extensions used 
to modify the Sametime Connect client and login dialog interface. Using the 
extensions provided in the Branding plug-in, developers can add logos and 
graphics, change the color palette, launch a Web page, and enable controls. 

For more information about the sample plug-ins that ship with Lotus Sametime 
Connect 7.5, see the Lotus developerWorks article, Extending IBM Lotus 
Sametime Connect 7.5 at:

http://www-128.ibm.com/developerworks/lotus/library/sametime-sdk/

1.6  Plug-in integration points

Users access plug-in functionality using the same UI features that activate the 
standard Lotus Sametime features. These integration points include:

� Adding an action to the Lotus Sametime Connect system tray icon

� Adding right-mouse click actions to a selected person or group

� Adding a toolbar action to the contact list window

� Adding a toolbar action to the chat window

� Drop-down menu choices

� Branding
18 Extending Sametime 7.5: Building Plug-ins for Sametime
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Figure 1-5 highlights some of the features that can be extended from the Lotus 
Sametime Connect client. 

Figure 1-5   Lotus Sametime Connect client extension points
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Figure 1-6 highlights UI features that can be extended in the chat window.

Figure 1-6   Chat window extension points

While Figure 1-5 on page 19 and Figure 1-6 illustrate the extension points from 
an user graphical user interface perspective, Chapter 4, “Extension points” on 
page 61 provides and in-depth look at the underlying code framework, explaining 
how and where Sametime can be extended. 

1.7  Overview of the samples provided in this IBM 
Redbook

This IBM Redbook serves as a thorough guide on how to build plug-ins, 
beginning with how to install the Eclipse development environment, and then 
leading the reader through numerous examples ranging from an introduction on 
branding your Sametime environment, to eventually showing how to integrate 
with a back-end system, retrieve information, and then manipulate the data 
presentation within the context of a Sametime window. The following samples are 
provided:

� Chapter 2, “Overview of Lotus Sametime 7.5 architecture” on page 23 
describes the IBM Lotus Sametime Connect client architecture, focusing on 
how Sametime 7.5 is now built on the Eclipse platform. 

� Chapter 3, “Setting up the Integrated Development Environment” on page 37 
provides a detailed guide for the tasks that are completed to set up the 
integrated development environment (IDE) for IBM Lotus Sametime 7.5. It 
shows you how to install and configure the development environment used to 
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extend the Sametime connect client. This development environment includes 
Eclipse and the software development kit (SDK). 

� Chapter 4, “Extension points” on page 61 discusses how the Sametime 
Connect client exposes a number of extension points through which a 
developer can add new functionality via the creation of custom plug-ins. This 
chapter details the available extension points, giving simple examples of the 
steps necessary to implement each one. 

� Chapter 5, “Introduction to building a plug-in: modifying the UI” on page 161 
provides a method and instructions to create a UI plug-in used to brand the 
IBM Lotus Sametime 7.5 Connect Client with your own corporate logos or 
images. For this example, we use a specific scenario for the RiverBend Tea 
and Coffee Company. 

� Chapter 6, “Leveraging Web services and building a calendar lookup plug-in 
for Sametime Connect” on page 215 discusses the use of Web services 
within a plug-in, and shows an example of a calendar lookup Web service 
integrated into a IBM Lotus Sametime Connect plug-in, enabling users to look 
up the calendar details for someone in their contact list from within the 
Sametime Connect client.

� Chapter 7, “Advanced plug-in example: The Sametime Server Statistics 
Plug-in” on page 249 examines the development of a Sametime plug-in that 
allows a Sametime administrator to monitor several Sametime servers in real 
time. The plug-in makes use of the new Sametime Monitoring and Statistics 
toolkit and allows the user to view and sort on a variety of useful statistics. 
The data is displayed in graph format to showcase the possibilities for 
creating a professional and useful user interface for your back-end data.

� Chapter 8, “Advanced plug-in example: SAP integration” on page 297 
examines how to create a plug-in that integrates with a back-end system, 
such as SAP, to extract data for several different scenarios. There are three 
examples within the plug-in. They are:

– Human Resources Integration

– Inventory Status

– Order Status
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� Part 4, “Advanced example: building a framework for structured content” on 
page 389 provides an in-depth, advanced example of how to build a 
framework for structured content. In the case of this example, the content is 
specific to online learning. The details of how to build this plug-in are detailed 
within the following chapters. 

– Chapter 9, “Introducing My Lotus Learning Education framework plug-in 
for Sametime Connect” on page 391

– Chapter 10, “Building the education framework plug-in” on page 405

– Chapter 11, “Refining and implementing the education framework plug-in 
for Sametime Connect” on page 485

� Chapter 12, “Deploying plug-ins for Sametime 7.5” on page 525 presents how 
to deploy IBM Lotus Sametime Connect client plug-ins, including how to 
manually install plug-ins, and how to set up administrative provisioning to 
automatically distribute plug-ins for a distributed environment.
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Chapter 2. Overview of Lotus Sametime 
7.5 architecture

This chapter describes the IBM Lotus Sametime Connect client architecture.

One of the most dramatic changes to Lotus Sametime Connect 7.5 is that it is 
now built on top of Eclipse. In essence, Lotus Sametime Connect is a package of 
Eclipse plug-ins. Although some may think of Eclipse as only a Java IDE, it is 
also an open platform for rich client development. In this chapter, we provide an 
overview of the architecture to reinforce the benefits of having the Sametime 7.5 
Connect client now built on the Eclipse platform.

The following topics are presented in this chapter:

� Brief overview of Eclipse

� Overview of the Sametime architecture

– Overview of the Lotus Sametime Connect architecture

– Lotus Sametime Server architecture

2
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2.1  Brief overview of Eclipse

Eclipse is an open source community whose projects are focused on providing 
an extensible development platform and application frameworks for building 
software. There is a large consortium of software vendors, solution providers, 
corporations, educational and research institutions, and individuals working 
cohesively to create an ecosystem that enhances and cultivates the Eclipse 
Platform with complementary products, capabilities, and services.

The URL for the Eclipse web site is:

http://www.eclipse.org 

Users of Eclipse-based offerings benefit from:

� Access to research and knowledge from the entire Eclipse ecosystem. 

� Higher-quality software that comes under scrutiny from the eyes of the open 
source community. 

� The ability to reuse skills because of the consistent Eclipse interface. 

Java technology developers using Eclipse benefit from:

� A world-class Java IDE

� Native look and feel across platform

� Easy extensions to Java tooling 

Developers of Eclipse tools benefit from:

� A portable and customizable platform 

� Seamless tool integration 

� An end-to-end solution 

The Eclipse Platform builds confidence and trust by providing the source code for 
the platform. Software developers are tired of integrating tools and trying to 
deconstruct how to make tools work together in an environment. Making the 
Eclipse Platform an open source initiative enables tool developers to do the same 
and to not only contribute new plug-ins but to also help improve the existing 
platform. 

IBM is the originator of the Eclipse Platform. The platform began development by 
Object Technology International in 1998 (a subsidiary of IBM purchased in 1996, 
now known as the IBM Ottawa Lab) to address the problems raised by clients 
that dealt with the cohesiveness of IBM software tooling. Clients complained that 
IBM tooling looked like it came from different companies and did not work 
together. 
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In 2001, IBM established the Eclipse consortium and gave the gift of Eclipse to 
the open source community. The goal was to let the open source community 
control the code and let the consortium deal with commercial relations. There 
were nine initial members of the consortium, which included IBM partners and 
competitors. IBM continued to nurture the evolution of the platform by funding 
various programs like Eclipse innovation grants and sponsoring Eclipse code 
camps. The platform was developed using an open source model through an 
open source license where anyone is welcome to participate.

IBM wanted more serious commitment from vendors, but vendors perceived the 
Eclipse consortium as IBM-controlled and were reluctant to make a strategic 
commitment while IBM was in control. To resolve these problems, IBM 
relinquished control. With the support of many companies, the Eclipse 
Foundation was formed in 2004 as a not-for-profit organization with a dedicated 
professional staff.

Today, IBM is committed to Eclipse more than ever and takes an active part in the 
Eclipse Foundation as a strategic member. Furthermore, IBM has more 
developers contributing to Eclipse than any other vendor.

Essential to the success of the Eclipse Platform are three intertwined 
communities:

� Committers: An open, active, inclusive community of committers responsible 
for developing official Eclipse tooling. An example group of committers is the 
Eclipse Web Tools Platform project team. 

� Plug-in developers: A community that exists outside the committer community 
that extends the platform to create useful tooling. Eclipse Plug-in Central 
contains a large sampling of plug-in developers. 

� Users: A community composed of people who use the tooling developed by 
committers and plug-in developers. 

2.2  Lotus Sametime platform

One of the most dramatic changes to Lotus Sametime Connect is that it is now 
built on top of Eclipse. In essence, Lotus Sametime Connect is a package of 
Eclipse plug-ins. 
 Chapter 2. Overview of Lotus Sametime 7.5 architecture 25



Figure 2-1 shows a high-level outline of the Eclipse architecture as Lotus 
Sametime Connect uses it. 

Figure 2-1   Sametime Connect platform

At its simplest level, Eclipse is an open-source foundation on which you can 
develop applications. The building blocks of Eclipse are called plug-ins, which 
are the smallest unit of Eclipse functionality. 

Eclipse plug-ins are like a power strip: there is a part that plugs into the electricity 
source and parts that other plugs can plug-into. An Eclipse plug-in may define:

� Extensions, which are analogous to the plug part of the power strip

� Extension points, which are analogous to the sockets of the power strip

Just as any appliance with a plug can use a power strip, so can any application 
with a plug, or extension, that fits can use the extension points of a plug-in. In this 

Note: While Figure 2-1 illustrates how Eclipse serves as a foundation for the 
Sametime Connect Client, Figure 2-2 on page 30 provides greater detail on 
each of the plug-in components that make up the Sametime platform. 

Eclipse 3.2 RCP

SWT JFace Workbench Help Preferences

Platform Runtime

Sametime
Platform
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way, extension points can extend the original application in ways that grow with 
the needs of the user community.

The Lotus Sametime Connect extension points are documented in the IBM Lotus 
Sametime Connect 7.5 Integration Guide (found at 
http://www-128.ibm.com/developerworks/lotus/downloads/toolkits.html) 
and later in this IBM Redbook. You can extend Lotus Sametime Connect by 
creating plug-ins that contribute to, or extend, the Lotus Sametime Connect 
plug-in extension points. Your plug-ins can access any of the services that are 
exposed by Lotus Sametime or its underlying platforms like IBM WebSphere 
Everyplace Deployment.

The interconnections among plug-ins, extensions, and extension points are 
defined by the plug-in manifest. The Eclipse IDE includes specialized editors for 
creating and modifying plug-in artifacts in its plug-in development environment 
(PDE). These editors include wizards that lead the developer through creating a 
plug-in, declaring its dependencies, contributing to other plug-ins’ extension 
points, and declaring their own extension points.

2.2.1  Rich Client Platform

Eclipse offers the Rich Client Platform (RCP), which is used with applications 
that do not require a common resource model or some of the other features of 
the platform. The RCP FAQ is a great resource for understanding the capabilities 
of RCP and can be found at:

http://wiki.eclipse.org/index.php/RCP_FAQ
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2.2.2  Eclipse platform components

Table 2-1 lists and describes some of the Eclipse platform components that Lotus 
Sametime Connect uses.

Table 2-1   Eclipse platform components

For more information about Eclipse, refer to the following sources:

http://www.eclipse.org 

http://www.ibm.com/developerworks/opensource/top-projects/eclipse-start
here.html

2.2.3  Platform run time

The platform runtime handles the life cycle of plug-ins, their creation, declaration 
and interaction with other plug-ins. On top of this are the different components 
that provide the portable infrastructure for creating a business application. 

Component Description

Platform Runtime Provides the foundational support for plug-ins and for the 
plug-in registry, a mechanism for declaring extension points, 
and for extending objects dynamically. The Eclipse run time 
uses the standard OSGi framework to define how plug-ins are 
packaged.

Help Help provides a plug-in with HTML-based online help and 
search capabilities. Help content is contributed through 
plug-ins that are recognized at run time.

JFace UI framework, working in conjunction with the standard widget 
toolkit (SWT), for handling many common UI programming 
tasks.

Preferences An Eclipse-managed collection of indexed dialog boxes. 
Plug-ins can contribute new Preference pages using an 
extension. 

SWT The Standard Widget Toolkit (SWT) provides access to the 
user interface facilities of the operating systems on which it is 
implemented. SWT-built applications leverage the UI of the 
host system more than do other Java toolkits, such as Swing.

Workbench The Workbench provides a highly scalable, open-ended, and 
multi-window environment for managing views, editors, 
perspectives (task-oriented layouts), actions, wizards, 
preference pages, and more. 
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2.3  Overview of the Sametime architecture

Sametime services fall into three areas:

� Community services: These services include awareness, instant messaging, 
and chat. A buddy list makes Sametime users aware of users who are 
available (and users who are online but unavailable) to receive an instant 
message or participate in a chat with one or more people. The instant 
messaging traffic is encrypted.

� Online Meeting services: These services include a shared whiteboard and the 
ability to share programs and documents online. Sametime also offers a 
server-based Meeting Center where users can schedule online meetings in 
advance and store agendas and other meeting materials.

� Customization and Integration services: Sametime also provides a 
comprehensive API that enables clients to easily integrate real-time 
collaborative capabilities into other applications, such as e-commerce sites, 
help desks, and training/information delivery applications like Sales Force 
Automation.

There are two distinct Sametime architectures a developer might need to work 
with; the Connect Client architecture and the Server architecture. The following 
sections will cover both.

2.4  Overview of the Lotus Sametime Connect 
architecture

The Eclipse Rich Client Platform (RCP) and IBM WebSphere Everyplace 
Deployment serve as the foundation of Lotus Sametime Connect. A key benefit 
of this choice of platform is that it can integrate seamlessly with other application 
components, namely other plug-ins. The contributions of these plug-ins can be 
as simple as a new menu choice that displays information in a dialog box or as 
complex as a wholly integrated mini-application. The overarching goal of the 
Lotus Sametime Connect architecture is to provide three benefits: extensibility, 
integration, and reuse.

The benefit of using Eclipse as an integration platform to the user is its ability to 
add new functionality into the environment. A flexible yet consistent user 
experience is a strong selling point, but the advantage for Eclipse programmers 
is the leveraging of their existing skills in developing standard Eclipse RCP 
line-of-business applications. 

Most of the principles of Eclipse application development are directly applicable 
to creating extensions to Lotus Sametime Connect. Even users without previous 
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Eclipse application development experience will recognize in these principles the 
common object-oriented programming patterns. For example, Eclipse follows the 
classic separation of model (Workbench) and view (ViewParts and their 
lower-level graphical components in the JFace framework). Thus, the clear 
separation of component responsibility reduces the need to learn each individual 
piece in order to be productive. The Lotus Sametime architecture embraces this 
same principle.

Figure 2-2 shows major Lotus Sametime Connect components. The Java run 
time, Eclipse RCP, and WebSphere Everyplace Deployment layers form the 
foundation common to IBM managed client products, which include the Lotus 
Notes Hannover release and future releases of the IBM Workplace Managed 
Client. The components enclosed by the box are specific to Lotus Sametime 
Connect and include public and implementation-specific plug-ins.

Figure 2-2   Sametime Connect Architecture

Most of the rectangles shown above the Eclipse 3.2 RCP layer correspond to one 
or more plug-ins. Some, like the Sametime Java Toolkit, represent libraries that 
may be referred to by plug-ins above them, but are not plug-ins themselves. That 
is, not all code is plug-in aware, either because it pre-dated the Eclipse plug-in 
model, or because it does not require the extensibility that Eclipse provides. The 
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rest of this chapter will introduce some of the key component layers, plug-ins, 
extension points, and classes and interfaces that will be part of your extensions 
to Lotus Sametime Connect.

2.5  Component layers

This section briefly describes some of the key component layers depicted in 
Figure 2-2 on page 30.

2.5.1  WebSphere Everyplace Deployment

The IBM WebSphere Everyplace Deployment (WED) platform provides services 
used by Lotus Sametime 7.5. WebSphere Everyplace Deployment will also be 
used in IBM Lotus Notes 8 and future releases of the IBM Workplace Managed 
Client. WebSphere Everyplace Deployment includes the Eclipse RCP and Java 
run time environment (JRE™), as well as additional services used by managed 
client products.

WebSphere Everyplace Deployment provides a common services platform on a 
variety of devices, ranging from handheld devices to desktop computers. The full 
WebSphere Everyplace Deployment platform provides support for Java 2 
Enterprise Edition (J2EE) and Web applications. Lotus Sametime Connect 
includes a subset of the WebSphere Everyplace Deployment platform for those 
services required by Sametime.

WebSphere Everyplace Deployment is available as a stand-alone product and 
includes the WebSphere Everyplace Client Toolkit, which facilitates the 
development of applications for the WebSphere Everyplace Deployment 
platform. The latest shipping release of WebSphere Everyplace Deployment is 
6.0. Lotus Sametime Connect 7.5 is based on a pre-release version of 
WebSphere Everyplace Deployment V6.1. 

WebSphere Everyplace Deployment provides support for a number of different 
execution environments. Lotus Sametime Connect 7.5 for Windows and Linux 
platforms uses the J9 JCL Desktop custom run time environment, which provides 
a wide set of features from the Java 2 Platform API core libraries. Lotus 
Sametime Connect 7.5 for Mac OS X uses the native Java run time environment.

When WebSphere Everyplace Deployment V6.1 is released in late 2006, you will 
have access to the complete set of WebSphere Everyplace Deployment APIs 
and services, and you will be able to use the WebSphere Everyplace Client 
Toolkit to build plug-ins for Lotus Sametime Connect.
 Chapter 2. Overview of Lotus Sametime 7.5 architecture 31



2.5.2  Real-Time Collaboration (RTC) API

The Real-Time Collaboration (RTC) platform provides synchronous collaboration 
services used by Lotus Sametime Connect 7.5 and other IBM offerings. Some of 
the services provided by the RTC platform include:

� Login services
� Real-time session management
� Presence features
� Event notification
� Instant messaging and file transfer meeting tools

The major release of Lotus Sametime after version 7.5 will provide an RTC API 
that you can use to leverage these services in your own applications. The RTC 
API is a protocol-agnostic API, so that applications do not need information about 
the transport protocol being used to deliver messages. The RTC API will support 
both the Sametime Virtual Places (VP) protocol and SIP. Third parties can extend 
the RTC API to support additional protocols and add meeting tools.

2.5.3  Lotus Sametime Java Toolkit

The Sametime Java Toolkit provides Java APIs to access many of the services 
provided by the Lotus Sametime client and server products. The Sametime Java 
Toolkit is a widely-used API that has been available for many years. The 
Sametime Java Toolkit is used by the RTC platform to access Sametime-specific 
services. When you build plug-ins for Lotus Sametime Connect 7.5, you can use 
the Sametime Java Toolkit to access Sametime services that are not provided by 
other Lotus Sametime Connect APIs.

The Sametime Java Toolkit has been updated to provide access to new features 
in the Lotus Sametime 7.5 release, and is included in the Sametime SDK. See 
the readme.txt file in the st75sdk directory of the Lotus Sametime 7.5 SDK for 
more information.

2.6  J9 JCL Desktop

Lotus Sametime Connect 7.5 for Windows and Linux platforms uses a 
compacted, custom Java Runtime Environment known as the J9 Java Class 
Libraries (JCL) Desktop. While this pared down J9 Java Runtime Environment 
enables a smaller footprint for the Sametime Connect Client, the J9 does not 
contain the full number of Java classes included in the standard 1.4.2 or 1.5 
Sun™ JVM™. For example, some of the classes not contained in the J9 JVM are 
AWT and Swing classes, which are used for graphical user interface (GUI) 
objects in Java applications. These packages are not part of the J9 JVM because 
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SWT is the default Eclipse platform GUI, SWT uses the operating system to 
create native graphics, and SWT is lighter (that is, less resource intensive) than 
either AWT or Swing. Accordingly, developers may encounter issues when 
utilizing a toolkit that references a class or package (such as AWT or Swing) that 
is not included in the J9 VM. 

Considerations around possible limitations for the J9 JCL 
Desktop 
Although the J9 JCL Desktop custom run time environment provides access to 
most core API features of the J2SE™ 1.4.2 Java Runtime Environment, it does 
not support all of those features. For the purposes of this IBM Redbook, the 
instructions to set up the development environment, and the examples provided, 
focus primarily on creating plug-ins that use core Java classes supported by the 
J9 JCL Desktop. However, if your plug-in uses Java code that was not developed 
using the J9 JCL Desktop run time environment, that code may not run with J9 
JCL Desktop. Accordingly, when using Java code that was not created in a 
development environment configured for the J9 JCL Desktop, be sure to test your 
plug-in thoroughly to catch any run time errors caused by incompatible code. 
This means that compiled code will not necessarily show errors when you 
develop your plug-in, but will not execute or not execute properly when it runs. 

For more information about the Java APIs supported by J9 JCL Desktop, see the 
J9 JCL Desktop Javadoc in the st75sdk\client\connect\javadoc\j9 directory of the 
Sametime SDK.

Finally, when WebSphere Everyplace Deployment V6.1 (Lotus Expeditor) is 
released (scheduled for late 2006), developers will have access to the complete 
set of WebSphere Everyplace Deployment APIs and services, and will be able to 
use additional JREs provided with Expeditor. 

2.7  Lotus Sametime Server architecture

Lotus Sametime includes many server applications, which collectively provide 
the capabilities of the Sametime server. All client-to-client communication, such 
as instant messaging, passes through the Sametime server. 

Users who log onto the Sametime server from different clients can communicate, 
as long as the users use clients that support Sametime's functionality. For 
example, a user who logs on through a Sametime-enabled word processed 
document can chat with a user who logs on through Sametime Connect, or 
through the company portal. 
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Once the client is logged into the Sametime server, it has access to all Lotus 
Sametime services and can communicate with any other Sametime client logged 
in to the Sametime server, based on the:

� Capabilities of the various clients

� Privacy rules that the users defined

� Policy rules defined by the administrator and enforced by some of the server 
applications

The Sametime server consists of three servers that interact with one another:

� Community server: Provides all Sametime community services, such as login, 
instant messaging, and awareness.

� Meeting server: Provides all Sametime meeting services, such as screen 
sharing and IP audio and video. Note that IP audio and video require 
installation of the Sametime Multimedia Services package. 

� Domino DNA: Provides core Sametime services, such as directory access, 
authentication, and the HTTP server.
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Chapter 3. Setting up the Integrated 
Development Environment

This chapter presents the tasks that are completed to set up the Integrated 
Development Environment (IDE) for IBM Lotus Sametime 7.5. 

In this chapter, we show you how to install and configure the development 
environment used to extend the Sametime connect client. This development 
environment includes Eclipse and the software development kit (SDK), which 
includes sample plug-ins.

The following topics are presented in this chapter:

� About the Integrated Development Environment

� Sametime Connect IDE requirements

� Installing the Sametime IDE

� Installing sample plug-ins

3
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3.1  About the Integrated Development Environment

One of the key values of IBM Lotus Sametime Connect 7.5 is the ability for 
third-party developers to use Eclipse-based plug-ins to extend the product’s 
functionality. 

Developers install and configure the Sametime Integrated Development 
Environment (IDE), which includes the tools and platforms needed to create and 
modify plug-ins. 

3.1.1  Sametime Software Development Kit (SDK)

Lotus Sametime includes comprehensive application development toolkits. You 
can use the toolkits to embed real-time capabilities, such as chat and real-time 
help features, into e-business applications. The toolkits can also be used to 
expand Sametime’s native functionality, for example, building plug-ins to 
incorporate your company’s internal directory with Lotus Sametime. You can use 
one or a combination of the toolkits to develop customized, real-time 
applications.

The SDK is a new feature in Sametime 7.5 and is downloaded from IBM 
developerWorks at:

http://www.ibm.com/developerworks/

3.1.2  SDK toolkits

The IBM Lotus Sametime 7.5 SDK includes the following toolkits:

� Sametime Connect Toolkit (new for 7.5): Used to build Eclipse plug-ins that 
integrate with or extend the Sametime Connect client.

� Sametime Java Toolkit: Used to add Sametime features to Java applications.

� Sametime Links Toolkit: Used to add Sametime features to Web pages using 
JavaScript™ and HTML.

� Sametime Community Server Toolkit: Used to build Java components that 
add or extend services on the Sametime server.

� Sametime Directory and Database Access Toolkit: Used to build C++ or Java 
components for the Sametime server that provide directory integration, chat 
logging, or virus scanning services.

� Sametime Online Meeting Toolkit (new for 7.5): Used to schedule and 
manage Web conferences via HTTP.
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� Sametime Monitoring and Statistics Toolkit (new for 7.5): Used to access 
Sametime server statistics in XML format via HTTP.

� Sametime Telephony Conferencing Service Provider Interface (TCSPI) 
Toolkit: Used to provide click-to-call telephony services for Sametime 
Connect, Sametime Web conferencing, and Lotus Notes.

For more information about the Lotus Sametime toolkits, see A tour of the IBM 
Lotus Sametime 7.5 toolkits, at:

http://www-128.ibm.com/developerworks/lotus/library/sametime75-toolkits

3.1.3  The Sametime Connect Toolkit

The Sametime Connect Toolkit is a collection of APIs built on top of IBM 
WebSphere Everyplace Deployment and Eclipse that can be used to build 
plug-ins that enhance the usability of the Sametime Connect client. 

The Sametime Connect Toolkit contains the following components:

� Integration Guide: This guide documents the APIs needed to extend the client 
and explains the implementation of several sample plug-ins, which can serve 
as starting points for creating more complex plug-ins.

� Javadoc: These documents provide information about the plug in samples, 
the J9 JCL Desktop Custom Runtime Environment, and toolkits.

� J9 JCL Desktop run time environment: A scaled-down run time environment 
used with the SDK.

� Sample plug-ins: Developers can examine and modify the source code of 
these plug-ins, using a basic Integrated Development Environment (IDE) like 
Eclipse or a more sophisticated IDE, such as IBM Rational® Application 
Developer.

3.1.4  Lotus Expeditor toolkit

In 2006, IBM plans to release the Lotus Expeditor Toolkit V6.1. This IDE, formerly 
the WebSphere Everyplace Client Toolkit, is used to develop plug-ins for several 
Eclipse-based platforms, including Lotus Sametime, IBM Lotus Notes, and 
Workplace Managed Client for WebSphere. 

The Expeditor toolkit automatically configures the IDE and uses product profiles 
to define the target components that can be modified or extended.
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3.2  Sametime Connect IDE requirements

In order create your own plug-ins for Lotus Sametime Connect 7.5, you will install 
and configure the following:

� Sametime SDK.

� Eclipse IDE Version 3.2. 

� The J9 JCL Desktop custom run time environment provided with the Lotus 
Sametime 7.5 SDK for Windows and Linux platforms. Note that the samples 
in the SDK will not run with the J2SE 1.4.2 JRE from Sun Microsystems™. 
For Mac OS X, Lotus Sametime Connect uses the native JRE.

� The Eclipse J9 JDT launching plug-in for the Windows and Linux platforms. 
This plug-in enables you to use the J9 JCL Desktop custom run time 
environment to develop your plug-ins. This plug-in is not needed for Mac OS 
X.

� A standard JRE, 1.4.2 or higher, to run the Eclipse IDE. Eclipse does not 
include its own JRE, and will not run on the J9 JCL Desktop custom run time 
environment included with the SDK. Note that the JRE used to run the Eclipse 
IDE is not the same one you will use to compile and run your plug-ins; Eclipse 
allows you to specify a different run time environment to use for compiling and 
running your code. We recommend that you use a J2SE 5.0 JRE to run the 
Eclipse IDE. For information about downloading the IBM J2SE 5.0 JRE, see 
the following site:

http://www.ibm.com/developerworks/java/jdk

� A Microsoft Windows XP, Linux, or Mac OS X platform supported by the Lotus 
Sametime Connect 7.5 release. See the release notes on your Lotus 
Sametime 7.5 server for a list of supported client platforms. 

3.3  Installing the Sametime IDE

To install the Sametime IDE, complete the following tasks. Detailed instructions 
for each task are included on the following pages:

Task 1: Install the IBM Lotus Sametime 7.5 SDK.

Task 2: Install Eclipse V3.2 SDK.

Task 3: Install the J9 JDT launching plug-in for Eclipse.

Task 4: Configure the run time environment.

Note: The samples documented in this guide were only tested with 
Microsoft Windows XP. 
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Task 5: Configure the target platform.

Task 6: Create a launch configuration.

3.3.1  Task 1: Install the IBM Lotus Sametime 7.5 SDK

The Software Development Kit (SDK) is a collection of all Lotus Sametime 7.5 
client and server toolkits in one consolidated package. The kit replaces the 
separate toolkits available for previous Sametime releases. The kit includes 
documentation. 

Follow these instructions to install the Lotus Sametime SDK:

1. Download the SDK from the IBM developerWorks Lotus toolkit download site 
at the following URL:

http://www.ibm.com/developerworks/lotus/downloads/toolkits.html

2. Extract the contents of the downloaded zip file to c:\st75sdk.

3.3.2  Task 2: Install Eclipse V3.2 SDK

Eclipse is an open platform for rich client development. Although Eclipse is a 
Java-based platform, it can be used to build tools for other programming 
languages.

To create plug-ins, or work with some existing ones, you need Eclipse Version 
3.2. You can have multiple versions of Eclipse installed on your system. 

Follow these instructions to download and install Eclipse IDE Version 3.2:

1. Open this Web page: 

http://www.eclipse.org/

2. Select the Downloads tab.

3. Click the download or mirror site closest to you.

Note: You must have an IBM Registration ID to download materials from IBM 
developerWorks. You can create the ID from the download site or use your 
existing ID to sign in.

Important: Configuration instructions in this chapter assume that you have 
installed the SDK to c:/st75sdk. If you choose to extract the SDK to a different 
location, you must adapt these instructions to account for the different 
location.
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4. Click Save.

5. Extract the contents of the downloaded eclipse-SDK .zip file to a directory, for 
example, c:\eclipse32.

Eclipse installs to c:\eclipse32\eclipse. 

3.3.3  .Task 3: Install the J9 JDT launching plug-in for Eclipse 
(Windows and Linux platforms)

The J9 JDT (Java Development Tools) launching plug-in enables you to use the 
J9 JCL Desktop custom run time environment to compile, run, and test your 
plug-ins. This plug-in is required by Eclipse to recognize and launch the J9 JCL 
Desktop run time environment used by Sametime.

Follow these instructions to install the J9 JDT plug-in:

1. If Eclipse is running, exit it.

2. Download the J9 JDT launching plug-in .zip file from the following URL:

http://dev.eclipse.org/viewcvs/index.cgi/org.eclipse.ercp/org.eclips
e.jdt.launching.j9/org.eclipse.jdt.launching.j9-plugin.zip?cvsroot=D
SDP_Project  

Tip: Download the Eclipse 3.2 documentation from 
http://www.eclipse.org/documentation/. This file contains useful 
information, tutorials, and samples for using Eclipse, including:

� Workbench User Guide

� Java Development User Guide

� Plug-in Development Environment Guide

Important: Without this plug-in, you cannot use J9 JCL Desktop to compile, 
run, or debug your code. Even with the J9 JDT launching plug-in, you must 
use the J9 JCL Desktop run time environment on the Sametime SDK to 
develop plug-ins, rather than the J9 DCL Desktop run time environment 
included with Lotus Sametime Connect 7.5.
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3. Extract the contents of the downloaded J9 JDT launching plug-in .zip file to 
the Eclipse subdirectory in the directory where you installed Eclipse, for 
example, c:\eclipse32\eclipse.

About the J9 JCL desktop custom run time environment
Although the J9 JCL Desktop custom run time environment provides access to 
most core API features of the J2SE 1.4.2 Java Runtime Environment, it does not 
support all of those features. After configuring the development environment as 
instructed in this chapter, you will not be able to create plug-in code that is not 
supported by J9 JCL Desktop. This means that you will not be able to 
unintentionally use Java APIs that will not work with Lotus Sametime Connect. 
However, if your plug-in uses Java code that was not developed using the J9 JCL 
Desktop run time environment, that code may not run with J9 JCL Desktop. 

When using Java code that was not created in a development environment 
configured for J9 JCL Desktop, be sure to test your plug-in thoroughly to find and 
fix any run time errors caused by incompatible code. 

For more information about the Java APIs supported by J9 JCL Desktop, see the 
J9 JCL Desktop Javadoc in the st75sdk\client\connect\javadoc\j9 directory of the 
Sametime SDK.

3.3.4  Task 4: Configure the run time environment 

The run time environment contains specific information for running and testing 
your Eclipse application with a specific JRE. The Sametime Connect client uses 
the J9 JCL Desktop JRE from WebSphere Everyplace Deployment. However, 
this JRE does not have debugging enabled, which is useful when developing 
applications. The Sametime SDK contains the same JRE with debugging 
enabled. So, you will need to configure Eclipse to point to the JRE included with 
the SDK.

Note: The J9 JDT plug-in is updated from time to time. You should check the 
URL above to see if a newer version is available, and if so, install the newest 
version. (At press time, the version available was Revision 1.6.) If you have 
started Eclipse previously, you must specify the -clean command-line option 
one time so the new plug-in will be recognized. We recommend that you 
remove any existing version of the J9 JDT launcher plug-in when installing a 
new version

Note: You need to re-install the J9 JDT plug-in if you re-install the Eclipse IDE.
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Creating the Workspace
In a Windows or Linux environment, after you have installed Eclipse and the J9 
JDT launching plug-in, you will need to create a workspace for your plug-in 
development and configure it to use the J9 JCL Desktop run time environment 
included with the Lotus Sametime 7.5 SDK. 

You can associate development profiles, called workspaces, to run inside the 
workbench. In this section, you will create a new workspace configured for 
Sametime 7.5 Connect Client plug-in development. This new workspace can be 
reused in the future for any Sametime plug-in projects.

Follow these instructions to configure the run time environment:

1. Start Eclipse by launching the eclipse.exe executable located in your Eclipse 
installation directory. Assuming that you followed the example directory 
structure for installing Eclipse, you would find this in C:\eclipse32\eclipse. 

2. After you have launched Eclipse, you are prompted to type a workspace 
directory. Create a new workspace called 
c:\eclipse32\eclipse\sametime_workspace. 

If the directory you specify does not exist, Eclipse creates a new workspace 
directory with that name.

Add Installed JRE
3. Select Window → Preferences to display the Preferences dialog box. 

4. Expand Java and select Installed JREs, and then click Add.

Note: If you have not yet installed a JRE (Java Runtime Environment), you will 
be notified that Eclipse is not finding an installed JRE. 

You will first need to download and install the Java Runtime Environment 
(JRE). This can be downloaded from the following URL:

http://www.java.com/en/download/index.jsp 
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5. Click the JRE type list and select J9 VM.

6. In the JRE name field, enter a name, for example, JCL Desktop.

7. Next to the JRE home directory field, click Browse and select the j9-runtime 
subdirectory for either Win32® or Linux, for example, 
c:\st75sdk\client\connect\j9-runtime\win32, and then click OK.

8. In the Default VM Arguments field, enter -jcl:max.

9. Verify that the Add JRE dialog box looks like Figure 3-1, and then click OK to 
save the new configuration.

Figure 3-1   Add JRE dialog box

Add additional libraries to the JRE
Sametime Connect uses additional libraries not included in the core J9 JCL 
Desktop JRE. Follow these instructions to add the ext and endorsed libraries to 
the JRE.

10.In the Installed JREs dialog box, click JCL Desktop and click Edit….

11.Click Add External JARs… and browse to 
C:\st75sdk\client\connect\j9-runtime\win32\lib\jclmax\ext.

Note: If you do not see the J9 VM in the JRE type list, restart Eclipse.
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12.Select all the files, and then click Open.

13.In the Edit JRE dialog box, click Add External JARs…. 

14.Browse to C:\st75sdk\client\connect\j9-runtime\win32\lib\endorsed.

15.Select all JAR files listed in the dialog, and then click Open.

16.In the JRE system libraries list, Ctrl-click to select the files string.jar, 
harmony_regex.jar, nio.jar, and sound.jar, (these are the files that you 
added in step 11), and click Up until those files are at the top of the list.

Tip: If you make a mistake, click Restore Default to remove JAR files and 
return the JRE to the state it is in after you completed step 8.
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17.Verify that the Add JRE dialog box looks like Figure 3-2, then click OK to save 
the new run time environment.

Figure 3-2   Adding JAR files to the JRE

Set the default run time environment
18.In the Installed JREs dialog box, click the check box next to the new JCL 

Desktop run time environment to make it the default, as shown in Figure 3-3.

Figure 3-3   Selecting the default JRE 
 Chapter 3. Setting up the Integrated Development Environment 47



Define compiler settings
19.In the Preferences navigator, select Java → Compiler.

20.Uncheck Use default compliance settings. The compliance settings should 
look like Figure 3-4.

Figure 3-4   Java Compiler Preference settings

21.Click OK to close the Preferences dialog box. 

22.If prompted to perform a rebuild, select Yes.

3.3.5  Task 5: Configure the target platform

The target platform is the application that will launch during testing and will 
contain your plug-in. The target platform also gives you access to the available 
extension points contained in the target platform. When searching the target 
location for plug-ins, Eclipse assumes plug-ins are in a /plugins subdirectory of 
the target location (for example, c:\Program Files\IBM\Sametime Connect 
7.5\plugins). 
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Configure target platform to Sametime Connect
By default, Eclipse configures the target platform to Eclipse. You modify the 
target platform to gain access to the plug-ins associated with Sametime Connect. 
This will cause Lotus Sametime Connect to start whenever you run or debug 
plug-ins in the Eclipse IDE. This will also expose the available Sametime 
extension points that you will later extend with code.

Follow these instructions to configure the target platform:

1. Start Eclipse. When prompted to select a workplace, choose the workplace 
directory you created in 3.3.4, “Task 4: Configure the run time environment” 
on page 43.

2. Select Window → Preferences to display the Preferences dialog box.

3. Expand Plug-in Development and select Target Platform.

4. Click the Browse button next to the Location field, and navigate to the 
Sametime subdirectory where you installed Lotus Sametime Connect 7.5, for 
example, c:\Program Files\IBM\Sametime Connect 7.5, and then click OK.

Note: Do not select the plugins subdirectory.
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The target platform preferences page now contains a list of the plug-ins 
associated with the Sametime 7.5 Connect application, as shown in Figure 3-5.

5. Verify that the Preferences dialog box looks similar to Figure 3-5.

.

Figure 3-5   Specifying plug-in target location

Optional: Copy the development-time plug-in to the Sametime
Connect plug-ins directory
The com.ibm.collaboration.realtime.doc.isv folder contains a development-time 
plug-in that will be read by the Eclipse IDE to provide context assist. It must be 
located in the same directory as the target platform (for example, c:\Program 
Files\IBM\Sametime Connect 75\plugins).

1. Copy the 
C:\st75sdk\client\connect\javadoc-plugin\com.ibm.collaboration.realtime.doc.i
sv folder, to the \Sametime Connect 7.5\plugins directory (for example, 
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c:\Program Files\IBM\Sametime Connect 7.5\plugins), as shown in 
Figure 3-6.

Figure 3-6   Copying com.ibm.collaboration.realtime.doc.isv folder

Optional: Associate Eclipse source code to plug-ins
The Eclipse plug-ins included in the Lotus Sametime Connect installation do not 
include source code. Having the source code available is useful for when you 
want to debug plug-ins that use this code (skipping this task will result in “source 
code not found” being shown in the editor when stepping through your plug-in 
using the Eclipse debugger).

Follow these instructions to associate source code with these plug-ins:

1. Select Window → Preferences → Plug-in Development → Target 
Platform.

2. Select the Source Code Locations tab. 

3. Click Add… . 

4. Browse to the plugins directory of the Eclipse 3.2 IDE installation and expand 
org.eclipse.platform.source.win32.win32.x86_3.2.0.v20060609m-AgOex
n6hlEUsvBO.

5. Select the \src subdirectory and click OK.
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6. Repeat steps 8 through 10 to select the \src directories shown in Figure 3-7.

Figure 3-7   Selecting source code locations

After selecting each of the src directories, the target platform preferences window 
should look like Figure 3-8.

Figure 3-8   Target platform preferences selected
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7. Click OK to save your changes.

3.3.6  Task 6: Create a launch configuration

The launch configuration is used to run or debug the plug-ins using the Lotus 
Sametime Connect target platform you created in 3.3.5, “Task 5: Configure the 
target platform” on page 48.

The launch configuration contains configuration information for launching your 
application. By creating a new launch configuration, you can control different 
things, such as the JRE to use, VM arguments, projects to include, tracing, 
environment variables, and so on.

Follow these instructions to create a new launch configuration.

1. Start Eclipse. Select the workspace. 

2. In the plug-in perspective, select Run → Run… in order to configure the run 
time environment.

3. Double-click Eclipse Application on the navigator list. 

The new configuration window displays.

4. In the Name field, enter the launch configuration name, for example, ST 7.5.

5. In the Location field, enter the name of the workplace, for example, 
C:\sametime75Dev\workspace.

6. Use the Clear workspace data before launching check box to determine 
whether or not the application starts new each time or with previous 
configuration changes. Checking the check box will clear your Sametime 

Important: Choose the same workplace directory you created in 3.3.4, “Task 
4: Configure the run time environment” on page 43.

Note: The workspace you specify here is the one that Lotus Sametime 
Connect will use to store product settings when you launch it from Eclipse. 
This is not the same workspace that Lotus Sametime Connect uses when 
you launch it outside of the Eclipse IDE. 

Restriction: You should not select the same workspace directory that you 
are using for Eclipse configuration settings (the one you selected in 
previous steps). 
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Connect and plug-in preferences each time you start the application from 
Eclipse.

7. In the Program to Run section, click Run an Application.

8. If necessary, in the Run an Application field, click the drop-down arrow and 
select com.ibm.collaboration.realtime.application.RTCApplication. 

9. If necessary, click the drop-down arrow next to the Runtime JRE field and 
select the J9 JCL Desktop runtime configuration (JCL Desktop) you created 
in “.Task 3: Install the J9 JDT launching plug-in for Eclipse (Windows and 
Linux platforms)” on page 42.

Your window should look like the window shown in Figure 3-9.

Figure 3-9   Create a new launch configuration

10.Select the Arguments tab and enter the following in the VM arguments field:

-Xint -Xtrace:none -Xgcpolicy:gencon -Djava.home=<JRE_HOME>
-Dcom.ibm.pvc.webcontainer.port=7777
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11.Click the Plug-ins tab and make sure Launch with all workspace and 
enabled external plug-ins is selected.

12.Click Apply to save your changes.

13.Click Run to launch the configuration.

Lotus Sametime Connect is launched from the plug-in development environment 
of Eclipse.

3.4  Installing sample plug-ins

Here we discuss installing some sample plug-ins.

3.4.1  About sample plug-ins

The IBM Lotus Sametime Software Development Kit includes sample plug-ins. 
You can view and reuse some the extensions used to create these plug-ins, or 
you may choose to modify a sample-plug-in to add your own functionality. For 
more information about the sample plug-ins, see Chapter 1, “Introduction to 
Sametime 7.5” on page 3.

Note: <JRE_HOME> is the location of the J9 JCL Desktop run time 
environment on the Lotus Sametime 7.5 SDK. This is the environment where 
you configured the JRE in 3.3.4, “Task 4: Configure the run time environment” 
on page 43.

If you installed the SDK to c:/st75sdk in a windows environment, then you 
would enter the following (with no spaces or linebreaks):

-Xint -Xtrace:none -Xgcpolicy:gencon 
-Djava.home=C:\st75sdk\client\connect\j9-runtime\win32 
-Dcom.ibm.pvc.webcontainer.port=7777

Linux only: Select the Environment tab and create a new environment 
variable called MOZILLA_FIVE_HOME. The value of the variable should be 
the path where Mozilla is installed on your machine, for example, 
/usr/lib/mozilla-1.7.13.
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3.4.2  Sample plug-in extensions

Table 3-1 lists the sample plug ins that are included in the Sametime SDK; the 
table also lists the extensions used in each.

Table 3-1   Sametime SDK Plug-in extensions

3.4.3  Procedure to install sample plug-ins

Follow these instructions to install the Sametime SDK sample plug-ins.

1. Start Eclipse and select the workspace. 

Plug-in Extensions used:
com.ibm.realtime.collaboration...

Recent Buddies � *imhub.miniApps

� *messages.MessageHandlerListener

� org.eclipse.ui.popupMenus (object 
contributions)

BuddyNote � *imhub.miniApps

� *messages.MessageHandlerListener

Quick Response � *chatwindow.popupAddOn

� *chatwindow.chatAction

� org.eclipse.ui.preferencePages

Acronym Expander � *messages.MessageHandlerListener

� org.eclipse.ui.preferencePages

St Branding � *.ui.stbranding

Snippets � *chatwindow.chatAction

� *chatWindow.chatArea

� *chatwindow.nwayListExtension

� *chatwindow.popupAddOn

� *messages.MessageHandlerListener

� org.eclipse.ui.popupMenus (object 
contributions)

� org.eclipse.ui.actionSets

Important: Choose the same workplace directory you created in 3.3.4, “Task 
4: Configure the run time environment” on page 43.
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2. Select Window → Open Perspective → Other → Plug-in Development to 
open the plug-in development perspective.

3. Select File → Import... → Plug-in Development > Plug-ins and Fragments 
to import the sample plug-ins from the Lotus Sametime 7.5 SDK to your 
development environment.

4. Click Next.

5. In the Import From section, deselect The target platform (as specified in 
the Preferences).

6. Click Browse... and search for the samples subdirectory of the st75sdk 
directory, for example, C:\st75sdk\client\connect\samples, and then click OK.

7. In the Import As section, select Projects with source folders, as shown in 
Figure 3-10.

.

Figure 3-10   Import Plug-in and Fragments

8. Click Next.

9. In the Selection dialog box, click Add All. 

10.Click Finish.
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The Lotus Sametime SDK plug-ins are added to your Package Explorer, as 
shown in Figure 3-11.

Figure 3-11   Sametime SDK plug-ins added to Eclipse environment.

To run the plug-ins in debug mode, select Run → Debug… to launch the 
configuration from the Eclipse main menu.

To run the plug-in in a Sametime Connect client:

1. Select Run → Run... and select the name of the plug-in. 

Congratulations, you are now ready to start creating plug-ins for your Sametime 
Connect client. 

For additional information, see the IBM Lotus Sametime Connect 7.5 Integration 
Guide, found at:

http://www-128.ibm.com/developerworks/lotus/downloads/toolkits.html

3.5  Terminology for working in Eclipse

An explanation of the following terms will be useful as you begin working in the 
Eclipse development environment. 

� Workbench

� Workspace

� Perspective
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The Eclipse development environment (and Eclipse applications) runs inside an 
environment called a workbench. The workbench is a collection of toolbars, 
menus, and one or more perspectives. Essentially, you can think of the 
workbench as the Eclipse IDE. When starting a new project, you can create a 
specific profile for a development project, known as a workspace. 

In the Eclipse IDE, you can associate development profiles (workspaces) to run 
inside the workbench. In the process of configuring the IDE, we have already 
created a new workspace configured for Sametime 7.5 Connect Client plug-in 
development. (See “Creating the Workspace” on page 44.) This new workspace 
can be reused in the future for any Sametime plug-in projects.

Note: Please refer to Figure 3-12 on page 60 for a visual explanation of these 
terms.
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Figure 3-12 illustrates these terms within the context of the Eclipse IDE. 

Figure 3-12   Eclipse Workbench - explaining the terminology of perspectives within a project

Workbench is essentially the entire IDE, including toolbars and menus

A perspective represents different views into the project, including 
a list of packages, a class editor and an outline view of the classes in the 
plug-in. 
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Chapter 4. Extension points

The ability to extend the IBM Lotus Sametime 7.5 Connect Client is a virtue of its 
Eclipse-based architecture. The Connect Client exposes a number of extension 
points through which a developer can add new functionality via the creation of 
custom plug-ins. 

The majority of these extension points affect the client’s user interface, allowing 
the creation of new visual enhancements. For example, you can create a new 
action menu item in the Tools menu, or add a new choice to the context menu 
that appears when you right-click a buddy in your contact list. The branding of the 
Sametime Connect Client is also accomplished via extension points (see 
Chapter 5, “Introduction to building a plug-in: modifying the UI” on page 161 for a 
full description of branding the client).

Other extension points permit interaction with the Sametime Connect client’s 
internal messaging system, letting you react to important events, such as 
incoming or outgoing chats.

This chapter details the available extension points, giving simple examples of the 
steps necessary to implement each one:

� User interface extension points

� Adding to the contact list window

� Adding to the chat window

� Adding to the nway chat (multi person chat) window

4
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� Adding a preference page

� Adding a mini application

� Message Event Notification extension point

Attention: Much of the sample code used within this chapter’s examples can 
be downloaded from the IBM Redbooks FTP site. Please refer to Appendix A, 
“Additional material” on page 557 for detailed instructions on how to download 
and deploy the code sample: 

ftp://www.redbooks.ibm.com/redbooks/SG247346
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4.1  Introduction

Eclipse plug-ins can define extension points using an extension point schema. 
The schema defines how a plug-in, called an extender plug-in, can modify the 
host plug-in by declaring an extension. Extension points are defined on the host 
plug-ins, while extensions are declared by the extender plug-ins.

One way to think about this is to imagine a power-strip: the power strip is an 
extension point. The plugs that connect to the sockets are extensions. Sametime 
Connect consists of a base set of plug-ins that expose certain extension points. 
You can extend the functionality of Sametime Connect by creating plug-ins that 
contribute to (extend) these extension points. The interconnections among 
plug-ins, extensions, and extension points are defined by the plug-in’s manifest 
file.

In order to extend Sametime Connect, you need to perform the following tasks:

1. Create a plug-in and a plug-in project to house it during development.

2. Add any required dependencies.

3. Declare the extension point(s) you will be extending.

4. Create your extension(s).

5. Install, test, and deploy your plug-in (covered fully in Chapter 12, “Deploying 
plug-ins for Sametime 7.5” on page 525).
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4.1.1  Creating a plug-in project and plug-in

To extend the Sametime 7.5 Connect user interface, we first need to create a 
plug-in and a containing plug-in project.

1. Select File → New → Project, as shown in Figure 4-1. 

Figure 4-1   Eclipse New Project wizard

2. In the New Project dialog, select Plug-in Project and click Next. 

3. Enter a project Name and accept the rest of the defaults, as shown in 
Figure 4-1, and then click Next.
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Figure 4-2   New Plug-in Project wizard

The Plug-in Content dialog displays, as shown in Figure 4-3 on page 66.

4. Optionally, change the Plug-in Name and Plug-in Provider settings. 

5. In the Plug-in Options section, leave the defaults. 

The Activator class specifies the plug-in’s life cycle on your behalf. There is 
one Activator instance per plug-in. The This plug-in will make contributions 
to the UI option is left checked as in one of our examples, we will be adding a 
preference page that counts as a direct contribution to the Eclipse UI. The 
Sametime Connect API provides a means of extending the Connect UI. If we 
were just extending the Connect UI, making a contribution to the Eclipse UI 
would not be necessary. In our case, we are creating an Eclipse preference 
page that extends the Eclipse UI. By leaving this option checked, the wizard 
will make our Activator class extend org.eclipse.ui.plugin.AbstractUIPlugin. 

If we had deselected this option, the wizard would make our Activator class 
extend org.eclipse.core.runtime.Plugin. The AbstractUIPlugin class itself 
extends Plugin, but provides a few extra methods and gives direct access to 
the Eclipse UI. 

6. Click Finish.
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Figure 4-3   Plug-in Project details

Note that the org.eclipse.ui and org.eclipse.core.runtime plug-ins were added as 
dependencies by the wizard (Figure 4-4), and that an Activator.java file was 
created (Figure 4-5 on page 67).

Figure 4-4   Plug-ins added as dependencies by the Plug-in Project wizard
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Figure 4-5   Activator class created by the Plug-in Project wizard

4.2  User interface extension points

There are a number of extension points that allow you to integrate your 
functionality seamlessly into the user interface of the Sametime Connect client. 
These include: 

� Adding new capabilities into the chat window

� Adding an icon to the tool action bar

� Adding menu items to different views and objects, such as the n-way multi 
chat participant list
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Figure 4-6 highlights some of the features that can be extended from the Lotus 
Sametime Connect client. 

Figure 4-6   Lotus Sametime Connect client extension points
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Figure 4-7 highlights UI features that can be extended in the chat window.

Figure 4-7   Chat window extension points

4.3  Adding to the contact list window

There are a number of extension points that allow you to integrate your 
functionality seamlessly into the user interface of the Sametime Connect client. 
These include: 

� Adding an action to the Menu bar

� Adding an action to the Tool Bar

� Adding an action to the system tray menu

� Adding to the context (right-click) menu
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4.3.1  Adding an action to the Menu bar

Figure 4-8 shows a custom action that was added to the Connect client’s menu 
bar.

Figure 4-8   A custom action added to the Connect client’s menu bar

To add an action to the contact list’s Menu bar, we start by specifying the 
extension point that we are going to be extending. In this case, it is one of the 
core Eclipse extension points, org.eclipse.ui.actionSets.

1. Open the plug-in’s manifest file (if it is not already open) by double-clicking the 
MANIFEST.MF file. 
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2. Select the Extensions tab and click Add... (Figure 4-9).

Figure 4-9   The Extensions tab of the plug-in’s manifest file
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3. Select the org.eclipse.ui.actionSets extension point, and then click Finish 
(see Figure 4-10).

Figure 4-10   Extension point selection wizard

Note that a plugin.xml tab is created as soon as new extension is defined 
(Figure 4-11), and that XML is added to this plugin.xml file by the wizard 
(Figure 4-12 on page 73).

Figure 4-11   plugin.xml tab added by the wizard
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Figure 4-12   plugin.xml file after extension point specified

4. Right-click the extension point and select New → actionSet to create a new 
actionSet extension element (see Figure 4-13).

Figure 4-13   Adding a new actionSet extension element

5. In the label field, enter a value that is more meaningful (see Figure 4-14).

Figure 4-14   actionSet extension element details
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Figure 4-15 shows the XML added to the plugin.xml page by the wizard.

Figure 4-15   plugin.xml after addition of actionSet element

6. Right-click the actionSet extension element and select New → action to add 
a new action extension element (see Figure 4-16).

Figure 4-16   Adding a new action extension element

7. Confirm that the id field contains a unique value. 

8. Add a value for the label property.

9. In the menubarPath property, enter tools/toolsEnd (see Figure 4-17).

Figure 4-17   action extension element details
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The menubarPath property controls where the action appears in the Menu Bar. 
The value tools/toolsEnd puts it at the bottom of the Tools menu.

Add the action item to the Menu Bar
In order to get the action item into the Connect client’s Menu Bar, we need to 
extend another core extension point, org.eclipse.ui.actionSetPartAssociations. 
This extension point is used to define an action set that should be added to a 
particular Eclipse view or editor. In our case, we are trying the action set we 
created earlier to the Connect client’s Menu Bar via its id property, 
com.ibm.collaboration.realtime.imhub.

1. Add the org.eclipse.ui.actionSetPartAssociations extension point (see 
Figure 4-18).

Figure 4-18   Extension Point Selection dialog
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2. Right-click the extension point and select New → actionSetPartAssociation 
to create a new extension element (Figure 4-19). 

Figure 4-19   Adding a new actionSetPartAssociation extension element

3. In the targetID property field (see Figure 4-20), enter the same actionSet ID 
that was set earlier (see Figure 4-14 on page 73).

Figure 4-20   targetID property for the actionSetPartAssociation element

4. Right-click the actionSetPartAssociation element and select New → part 
(see Figure 4-21).

Figure 4-21   Creating a new part extension element

5. Change the id property to com.ibm.collaboration.realtime.imhub. This makes 
it display in the Menu Bar (see Figure 4-22 on page 77).

Note: The id property must be com.ibm.collaboration.realtime.imhub or the 
action will not appear in the Menu Bar.
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Figure 4-22   The ID of the part must be com.ibm.collaboration.realtime.imhub

Figure 4-23 shows the XML added to the plugin.xml file by the wizard.

Figure 4-23   plugin.xml after addition of part element

This is enough to get the new option to appear in the menu. 

Test the Menu Bar action item
1. Select Run → Run... from the menu.

2. Click No if prompted to clear run time workspace data. The clear workspace 
data option determines whether or not the application starts new each time or 
with previous configuration changes. For example, enabling this option clears 
the Connect preferences each time you start it from Eclipse. To be given the 
choice of whether to delete the workspace data for a given launch of this 
configuration, select Ask for confirmation before clearing and a 
confirmation dialog box will be displayed for each run of this configuration.

3. Login to the Sametime server when prompted to do so.
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4. Click the Tools menu to see a new menu option at the bottom of the list, as 
shown in Figure 4-24.

Figure 4-24   Custom action in the Tools menu

5. Click the menu item to launch a dialog box, which displays “The chosen 
option is not currently available.” (Figure 4-25) This is an example of Eclipse’s 
lazy-loading architecture. There is enough information in the plugin.xml file to 
add the menu option to the Tools menu without Eclipse actually having to load 
any code.

Figure 4-25   Error generated when clicking the action
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Create the action’s code
Now we need to create a class file and write some code to actually get 
something to happen when a menu option is clicked. 

1. Display the Extensions tab.

2. Select the action element and click the class link to create the extension class 
file (Figure 4-26).

Figure 4-26   Class link that launches New Class wizard

3. In the New Class dialog, click the Browse button to select the correct 
package.

Figure 4-27   Package selection dialog
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4. Enter a class Name, and confirm that it implements the 
org.eclipse.ui.IWorkbenchWindowActionDelegate interface (Figure 4-28). 

5. Accept the rest of the defaults and click Finish.

Figure 4-28   New Java Class wizard

6. We need to implement the interface’s run() method, which is the method 
called when the menu item is actually clicked. We will use a JFace 
MessageDialog object, so we need to import the 
org.eclipse.jface.dialogs.MessageDialog class. Example 4-1 on page 81 
shows the code to launch a dialog box and display a simple text message.
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Example 4-1   MenuBarAction’s run() method

public void run(IAction arg0) {
MessageDialog.openInformation(null, "Redbook Extension Points", 

"Menu Bar action");

}

7. If required, save the class file and the plugin.xml file.

Figure 4-29 shows the XML code added to the plugin.xml file by the wizard that 
generated the class file.

Figure 4-29   plugin.xml after class generation

8. Click Run → Run... to launch the run time workspace so we can see the 
plug-in in action.

9. When the Connect client has launched and you have logged in, click the new 
menu item. The run() method of the MenuBarAction class is called, and the 
dialog box displays (Figure 4-30).

Figure 4-30   Clicking the menu action displays the dialog box
 Chapter 4. Extension points 81



Table 4-1 summarizes the extension points we have extended in this example, 
and the dependency required by our plug-in.

Table 4-1   Summary of extension points and dependencies

4.3.2  Adding an action to the Tool Bar

Figure 4-31 shows a custom action added to the Tool Bar.

Figure 4-31   Custom action added to the Tool Bar

As in the previous example, we start by specifying the extension point we are 
going to extend. In this case, it is another of the core Eclipse extension points, 
org.eclipse.ui.viewActions.

1. After adding the viewActions extension point, add a new viewContribution 
extension element by right-clicking the extension point and selecting New → 
viewContribution.

Extension point(s) extended Required plug-in(s)

org.eclipse.ui.actionSets
org.eclipse.ui.actionSetPartAssociations

org.eclipse.ui
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2. Set the targetID property to com.ibm.collaboration.realtime.imhub as shown 
in Figure 4-32.

Figure 4-32   viewContribution extension element details

3. Right-click the viewContribution element and select New → action to add a 
new action extension element.

4. Confirm that the id is a unique value, and enter the label and toolbarPath 
properties. The location of the action in the Tool bar is controlled by the 
toolbarPath property. Figure 4-33 shows the valid values for the toolbarPath 
property.

Figure 4-33   Locations for adding an action to the Tool Bar.

The enablesFor property is a numerical value indicating the selection count that 
must be met to enable the action. If this attribute is specified and the condition is 
met, the action is enabled. If the condition is not met, the action is disabled. If no 
attribute is specified, the action is enabled for any number of items selected.

5. We also need to add an icon to the Tool bar, for the user to click. To add an 
icon image, we need to first add an image folder to the plug-in. 

Note: The targetID must be set to com.ibm.collaboration.realtime.imhub for 
the action to appear in the Tool Bar.
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Right-click the top-level project and select New → Folder (Figure 4-34).

Figure 4-34   Adding a new folder to the plug-in project

6. In the Folder name field, enter the folder name (images is a standard name).
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Figure 4-35   Specify the folder name

7. Right-click the folder and select File → Import to import the image you wish 
to copy into the image folder.

8. After you have imported your image from the plug-in manifest’s Extensions 
tab, click the Browse... button next to the icon field, and select your image. 

9. Repeat step 8 for the disabledIcon field if you want to show a different image 
while the action is not enabled.

10.Our class needs to extend the 
com.ibm.collaboration.realtime.imhub.actions.BuddyListAction class, so we 
need to add the com.ibm.collaboration.realtime.imhub plug-in as a 
dependency. 
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Select the Dependencies tab and click Add. Find the 
com.ibm.collaboration.realtime.imhub plug-in and click OK. (see Figure 4-36

Figure 4-36   Adding the com.ibm.collaboration.realtime.imhub plug-in as a dependency

11.Click the class link to create the class file. 

The New Java Class dialog displays (see Figure 4-37 on page 87).

12.Select the correct package.

13.Enter the class Name.

14.Remove the default interface and add the Superclass 
com.ibm.collaboration.realtime.imhub.actions.BuddyListAction. 

15.Deselect the option to implement Inherited abstract methods; we only need to 
override the superclass’ run() method (Figure 4-37 on page 87).
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Figure 4-37   Creating the action class

16.We use a JFace MessageDialog to open a pop-up window when the Tool Bar 
icon is clicked.

Example 4-2   JFace MessageDialog

public void run() {
MessageDialog.openInformation(null, "Redbook Extension Points", 

"Tool Bar action");

}
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Table 4-2 summarizes the extension point we have extended in this example, and 
the plug-in dependencies we needed.

Table 4-2   Summary of extension points and dependencies

4.3.3  Adding an action to the system tray menu

When the Sametime Connect client is minimized to the system tray, users can 
right-click the Sametime icon to launch a menu (see Figure 4-38). It is possible to 
add a custom action to this menu.

Figure 4-38   Custom action added to the system tray menu

1. On the Extensions tab, add the extension point org.eclipse.ui.actionSets.

2. Right-click the extension point and select New → actionSet to add a new 
actionSet extension element.

3. Set the id property to be something starting with 
com.ibm.collaboration.realtime, and add a label property, as shown in 
Figure 4-39.

Figure 4-39   actionSet extension element details

Extension point(s) extended Required plug-in(s)

org.eclipse.ui.viewActions org.eclipse.ui
com.ibm.collaboration.realtime.imhub
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4. Add a new action extension element by right-clicking the actionSet element 
and selecting New → action.

5. Enter values for the id, label, and menubarPath properties. 

The label property controls the menu action’s text label, while the 
menubarPath property controls its location within the menu. Figure 4-40 
shows valid values for the menubarPath property.

Figure 4-40   menubarPath property values for the system tray menu

6. Click the class link to create the action’s class. 

The class needs to implement the IWorkbenchWindowActionDelegate 
interface. The interface’s run(IAction) method is called when the user clicks on 
the menu item. Again, we use a JFace MessageDialog object to open a dialog 
box (see Example 4-3).

Example 4-3   SystemTrayAction’s run() method

public void run(IAction arg0) {
MessageDialog.openInformation(null, "Redbook Extension Points", 

"System Tray action");

}

Note: The id property must begin with com.ibm.collaboration.realtime; 
otherwise, the action will not show up in the system tray. 
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Table 4-3 summarizes the extension point we have extended in this example, and 
the plug-in dependency we needed.

Table 4-3   Summary of extension points and dependencies

4.3.4  Adding to the context (right-click) menu

The org.eclipse.ui plug-in provides the org.eclipse.ui.popupMenus extension 
point, which allows custom plug-ins to add new actions to the context menus 
owned by other plug-ins. Such action contributions can be made against a 
specific object type by using the objectContribution element. 

When using the objectContribution element, the action will appear in all context 
menus where objects of the specified type are selected. The Sametime Connect 
API exposes two interfaces in the com.ibm.collaboration.realtime.livenames 
package (PersonSelection and GroupSelection) in the 
com.ibm.collaboration.realtime.people plug-in to represent Person and Group 
objects whose context menus you can contribute.

Add an action to a person selection
Figure 4-41 on page 91 shows a custom action added to the person context 
menu.

Extension point(s) extended Required plug-in(s)

org.eclipse.ui.actionSets org.eclipse.ui
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Figure 4-41   Custom action added to person context menu

1. Add the plug-in dependency com.ibm.collaboration.realtime.people.

2. Add the required extension point, org.eclipse.ui.popupMenus. 

Right-click the extension point and select New → objectContribution. 

3. Ensure the id is a unique value. 
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4. For the objectClass, click Browse and select 
com.ibm.collaboration.realtime.livenames.PersonSelection 
(Figure 4-42).

Figure 4-42   Select the PersonSelection interface

This is how we specify that we want to apply the context menu of a selected 
person. Menu actions added via object contributions are added wherever an 
object fulfilling the specified objectClass interface appears (in this case, 
PersonSelection).

5. Right-click the objectContribution element and select New → action. 

6. Keep or modify the id, label, and class name. 

The label is the text that will appear in the context menu. Its position in the 
context menu is controlled by the menubarPath property. Figure 4-43 on 
page 93 shows the valid values for the menubarPath property.
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Figure 4-43   Valid values for the menubarPath property

The enablesFor property is a numerical value indicating the selection count 
which must be met to enable the action.

As defined in the schema for the org.eclipse.ui.popupMenus extension point, 
our class must implement the org.eclipse.ui.IObjectActionDelegate interface. 
We do this by extending the 
com.ibm.collaboration.realtime.livenames.LiveNameActionDelegate helper 
class, which implements the required interface. To do this, we first need to 
add another plug-in dependency. 
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7. Click the Dependencies tab in the plug-in manifest and add the 
com.ibm.rcp.realtime.livenames plug-in to the list of required plug-ins 
(Figure 4-44).

Figure 4-44   Adding the com.ibm.rcp.realtime.livenames plug-in as a dependency

8. Click the class link to create the class file. 

9. To extend the correct class, click the Browse... button next to the Superclass 
field and select LiveNameActionDelegate (Figure 4-45).

Figure 4-45   Extend the LiveNameActionDelegate class

10.Accept the defaults and click Finish. 
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You will see that the wizard has created a run() method that takes an IAction 
object as a parameter. The run() method is invoked when the context menu 
item is clicked, with Eclipse passing in the IAction object. 

To show that this works, add our familiar JFace MessageDialog code to the 
run() method (Example 4-4).

Example 4-4   Opening a MessageDialog when the menu item is clicked

public void run(IAction arg0) {
MessageDialog.openInformation(null, "Redbook: Context menu 

action", "Context menu bar action");

}

If we launch the run time workspace now (Run → Run...), we will see the action 
in the context menu when we right-click a name in the contact list. Clicking the 
menu item opens the dialog box shown in Figure 4-46.

Figure 4-46   Custom action in the person selection context menu
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A dialog box with a static message is enough to show that our code is working, 
but is not particularly useful. In the real world, it is more practical for our context 
menu action to want to work with the name of the person you have just clicked. 
We can find that information by using the getSelectedPersons() method inherited 
from the LiveNameActionDelegate class. This returns an array of Person objects. 
If we have clicked only one name, that will be the first and only name in the array 
(Example 4-5). For multiple selections, you would need to access each element 
of the array in turn.

Example 4-5   Accessing the display name of the selected contact

public void run(IAction arg0) {
Person[] persons = getSelectedPersons();
Person person = persons[0];

MessageDialog.openInformation(null, "Redbook: Context menu 
action", person.getDisplayName());

}

The enablement criteria for an action extension is initially defined by the 
enablesFor attribute, as discussed earlier. However, once the action class has 
been instantiated, it may control the action enablement state directly within its 
selectionChanged() method (inherited from LiveNameActionDelegate).

Table 4-4 summarizes the extension point we have extended in this example, and 
the plug-in dependencies for this plug-in.

Table 4-4   Summary of extension points and dependencies

Adding an action to a group selection
This is very similar to creating the person action, except this time we only want 
our action to be applicable to group objects. We do this by defining our object 
contribution to be GroupSelection rather than PersonSelection (see Figure 4-47 
on page 97). 

Extension point(s) extended Required plug-in(s)

org.eclipse.ui.popupMenus org.eclipse.ui
com.ibm.collaboration.realtime.people
com.ibm.rcp.realtime.livenames
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Figure 4-47   Adding an action to a group selection

1. Add the extension point org.eclipse.ui.popupMenus.

2. Create an objectContribution extension element by right-clicking the 
extension point.
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3. For the objectClass, click Browse... and select the 
com.ibm.collaboration.realtime.livenames.GroupSelection interface, as 
shown in Figure 4-48.

Figure 4-48   Select the GroupSelection interface as the object contribution

The position of the action in the menu is again controlled by the menubarPath 
variable. Figure 4-49 shows the valid values for the property.

Figure 4-49   Valid menubarPath property values

4. When creating our class, we also want to extend the 
com.ibm.collaboration.realtime.livenames.GroupActionDelegate helper class. 
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In the Superclass field, click Browse... and select GroupActionDelegate, as 
shown in Figure 4-50.

Figure 4-50   Extend the GroupActionDelegate class

Again, we could just implement a static message dialog, but that is not 
particularly useful. We would probably like to know the group name, the group 
type, who is in the group, and how many of them are online. The code for this 
is shown in Example 4-6.

Example 4-6   Obtaining the group name and contents from the menu action

public void run(IAction arg0) {
Group[] myGroups = getSelectedGroups();
Group myGroup = myGroups[0];

String groupName = myGroup.getName();
String groupType = myGroup.getType();
int i = myGroup.getNumberOnlineChildren();

Person[] groupMembers = myGroup.getPersons();
int j;
StringBuffer sb = new StringBuffer();
for (j=0; j<groupMembers.length; j++)
{

Person groupMember = (Person) groupMembers[j];
sb.append(groupMember.getDisplayName() + "\n");

}

MessageDialog.openInformation(null, "Redbook: Context menu 
action", "You clicked on the " + 
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groupName + " group, which is a " + groupType + " group, 
with " + i + " online member(s)..." + 

"\n\nThe members of the group are: \n\n" + sb.toString());
}

Clicking the context menu item will result in a dialog similar to the one shown in 
Figure 4-51.

Figure 4-51   Dialog generated by clicking the group context menu action

If we need to handle multiple group selections, we could iterate through the array 
returned by the getSelectedGroups() method and handle each Group object in 
turn.

Table 4-5 summarizes the extension point we have extended in this example, and 
the plug-in dependencies for this plug-in.

Table 4-5   Summary of extension points and dependencies

4.4  Adding to the chat window

There are a number of ways of contributing to the UI of the chat window:

� Adding an action to the Menu Bar

� Adding an action to the Tool Bar

� Adding an action to both the Menu and Tool Bars

� Adding an action to the Format Bar

Extension point(s) extended Required plug-in(s)

org.eclipse.ui.popupMenus org.eclipse.ui
com.ibm.collaboration.realtime.people
com.ibm.rcp.realtime.livenames
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� Adding a chat area extension

� Adding a pop-up message area

4.4.1  Adding an action to the Menu bar

Figure 4-52 shows a custom action added to the Menu bar of the chat window.

Figure 4-52   Custom action added to Menu bar of chat window

1. Adding an action to the menu bar of the chat window involves adding the 
required extension point, 
com.ibm.collaboration.realtime.chatwindow.chatAction. If you try to add this 
extension point, it does not appear in the list of available extension points, 
which means that it must depend on a plug-in that we have not yet added as a 
dependency. 
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2. Deselect the option Show only the extension points for the required 
plug-ins 

You should now be able to locate the chatAction extension point, as shown in 
Figure 4-53.

Figure 4-53   Deselect the required plug-ins option to find the required extension point

3. Click Finish.

Eclipse prompts you to add the plug-in 
com.ibm.collaboration.realtime.chatwindow to the list of plug-in 
dependencies, as shown in Figure 4-54 on page 103.
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Figure 4-54   Prompt to add to the list of plug-in dependencies

4. Click Yes.

If you select the Dependencies tab, you will see that the wizard has added 
the com.ibm.collaboration.realtime.chatwindow plug-in to the list, as shown in 
Figure 4-55.

Figure 4-55   Updated list of plug-in dependencies

5. Select the Extensions tab and right-click the newly added extension. Select 
New → chatAction.

Figure 4-56   Add a new chatAction extension element
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6. Modify or keep the plug-in and class name. 

7. Change the Type to be menu. This adds the action to the Menu bar of the 
chat window. 

8. Add the text for the menu item label in the displayName field.

9. The menubarPath property controls the location of the action in the Menu Bar. 
Table 4-6 lists valid values for the menubarPath property.

Table 4-6   Valid values for the menubarPath property

10.The showsFor attribute specifies whether the action is enabled for a 1-1 chat 
(single), multi-party chat (multi), or both.

11.Click the class link to create the class file for this extension. 

12.We want our class to extend the ChatWindowAction class.

Remove the interface suggested by the wizard and add 
com.ibm.collaboration.realtime.chat.actions.ChatWindowAction as the 
Superclass. 

13.Deselect the Inherited abstract methods option. We only need to implement 
one method for our example. 

14.Add a public run() method to call the JFace MessageDialog window, as shown 
in Example 4-7.

Example 4-7   ChatWindowMenuBarAction’s run() method

public void run(){
MessageDialog.openInformation(null, "Redbook: Chat Window Menu 

Bar action", "Chat window menu bar action");
}

Table 4-7 on page 105 summarizes the extension point we have extended in this 
example, and the plug-in dependency for this plug-in.

File Edit View Tools Help

file/open
file/save
file/print.group
file/preferences
file/additions
file/fileEnd

edit/editStart
edit/additions
edit/editEnd

view/viewStart
view/additions
view/viewEnd

tools/additionsTop
tools/additionsMiddle
tools/additions
tools/actions
tools/send/additions
tools/insertMenu
tools/insertTop
tools/insert/top
tools/toolsEnd

help/helpStart
help/helpEnd
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Table 4-7   Summary of extension points and dependencies

4.4.2  Adding an action to the Tool bar

Figure 4-57 shows adding an action to the Tool bar.

Figure 4-57   Adding an action to the Tool bar

We can add an action to the Tool bar in a very similar way to how we created the 
Menu bar action. 

1. Right-click the chatAction extension point and select New → chatAction. 

The important difference is the value of the type property, when set to buddy, 
the action appears in the Tool bar instead. 

2. Create the class file by clicking the class link; as with the Menu bar action, 
deselect the suggested interface class and instead extend the 
ChatWindowAction class. 

3. Implement the exact same run() method as you did in the 
ChatWindowMenuBarAction class, so a dialog box will be shown when a user 
clicks the action. 

Extension point(s) extended Required plug-in(s)

com.ibm.collaboration.realtime.chatwindo
w.chatAction

com.ibm.collaboration.realtime.chatwindo
w
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If you do nothing more and run the sample, your action will display as a nice 
little red square on the chat window tool bar, as shown in Figure 4-58. This is 
the default behavior when Eclipse cannot load an image, when it is either 
missing or incorrectly defined.

Figure 4-58   Tool bar action without an image defined

4. Click the action to launch a dialog box as expected. If you want to use a text 
label for the action, add it to the displayName property, as shown in 
Figure 4-59.

Figure 4-59   Example displayName property

Figure 4-60 on page 107 shows the tool bar action with the text label produced 
by the displayName property.
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Figure 4-60   Tool bar action with text label produced by displayName property

5. If you want to use an image instead of text, you can use the image property. 
You can optionally add tool tip help in the tooltipText property (see Figure 4-61 
and Figure 4-62 on page 108).

Figure 4-61   Example tooltipText and image properties
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Figure 4-62   Tool bar action represented by image with tool tip

6. The position of the text or image in the Tool bar is controlled by the path 
property. Figure 4-63 shows the valid values for the path property.

Figure 4-63   Valid values for the path property

Table 4-8 on page 109 summarizes the extension point we have extended in this 
example, and the plug-in dependency for this plug-in.

Note: If you have an image and a displayName specified, the image takes 
precedence and the text will not be displayed.
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Table 4-8   Summary of extension points and dependencies

4.4.3  Adding an action to both Menu and Tool bars

You can add your action to both the Menu bar and the Tool bar by setting the 
type to be buddy and including values for both the path and menubarPath 
properties, as shown in Figure 4-64 and Figure 4-65 on page 110.

Figure 4-64   Sample properties to add action to both Menu and Tool bars

Extension point(s) extended Required plug-in(s)

com.ibm.collaboration.realtime.chatwindo
w.chatAction

com.ibm.collaboration.realtime.chatwindo
w
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Figure 4-65   Chat window showing custom action in both Menu and Tool bars

4.4.4  Adding an action to the Format bar

Figure 4-66 shows a custom action added to the chat window Format bar.

Figure 4-66   Custom action added to chat window Format bar

The Format bar is the icon strip above the chat send area field. Adding an action 
to it is done in exactly the same way as the previous two, except the type value is 
set to format. Again, you can use text or an image by setting values for the 
displayName or image properties respectively. 
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1. Create the class file in exactly the same way as before, implementing the 
run() method to launch the dialog window. 

The location of the action text or image is again controlled by the path 
property. Figure 4-67 shows the valid values for the path property.

Figure 4-67   Valid path property values

Figure 4-68 shows sample values for the chatAction extension element.

Figure 4-68   Sample values for the chatAction extension element
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4.4.5  Adding a chat area extension

Figure 4-69 shows a chat window with the chat area extension.

Figure 4-69   Chat window with chat area extension

The chatArea is an optional UI expansion area that provides a tab folder in place 
of where the chat transcript widget displays, so you can add additional UI 
controls that rely on larger screen real estate.

1. We first need to add the required extension point, 
com.ibm.collaboration.realtime.chatwindow.chatArea. 

Right-click the extension point and select New → chatArea to create a new 
chatArea extension element. Keep or modify the id (ensuring that it is unique), 
and label, as shown in Figure 4-70 on page 113.
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Figure 4-70   Sample properties for chatArea extension element

2. Click the class link to create the class file. Keep the defaults and click Finish, 
as shown in Figure 4-71.

Figure 4-71   Creating the chatArea class

3. We implement the createPartControl() method from the 
com.ibm.collaboration.realtime.chatwindow.addon.ChatWindowExtension 
interface to produce the UI for the chatArea. In this example, we use an SWT 
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Browser object and set its URL to be the developerWorks Lotus web site, as 
shown in Example 4-8.

Example 4-8   ChatArea’s createPartControl() method

public void createPartControl(Composite arg0) {
Browser browser = new Browser(arg0, SWT.NONE);
browser.setUrl("http://www-128.ibm.com/developerworks/lotus");

}

4. Now that we have created the chatArea, we need to create an action to 
display it. 

Create a new tool bar action (or modify the existing one) and add code to the 
run() method to open the chatArea we just created. The chatArea is opened 
by calling the enableChatArea() method of the ChatWindowHandler class, 
passing in the id of the chatArea, as shown in Example 4-9.

Example 4-9   ChatWindowOpenChatArea’s run() method

public void run()
{

getChatWindowHandler().enableChatArea("com.ibm.redbooks.extensionpoints
.chatarea");

}

When this code is invoked, a second, tabbed area opens within the chat window. 
The original chat transcript area gains a tab with the heading Transcript, while the 
new chat area opens with a tab heading with the value of the label property from 
the chatArea extension, as shown in Figure 4-72 on page 115.
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Figure 4-72   Chat window showing newly opened chat area

5. The chat area can be closed from an action by calling the disableChatArea() 
method of the ChatWindowHandler class, again passing in the id of the 
chatArea, as shown in Example 4-10.

Example 4-10   Sample action code to close chat area

public void run()
{

getChatWindowHandler().disableChatArea("com.ibm.redbooks.extensionpoint
s.chatarea");

}
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Figure 4-73   Chat transcript area retains tabbed heading after closure of chat area

4.4.6  Adding a pop-up message area

Figure 4-74 on page 117 shows a chat window with a pop-up message area 
displayed.

Note: While this closes the new chatArea, it leaves the chat transcript area 
with its tab heading of Transcript, as shown in Figure 4-73
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Figure 4-74   Chat window with pop-up message area displayed

Adding a pop-up message area creates a pop-up area at the bottom of the chat 
window. It is created by extending the extension point 
com.ibm.collaboration.realtime.chatwindow.popupAddOn. 

1. Add the extension point and create a new popupAddOn extension element 

Right-click and select New → popupAddOn. Enter values for the element id, 
name, and class name. 
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2. Click the class link to create a new class. Add the interface 
com.ibm.collaboration.realtime.chatwindow.addon.PopupAddOn, as shown in 
Figure 4-75.

Figure 4-75   ChatWindowPopupAddOn class details

3. We need to implement the three methods from this interface (see 
Example 4-11 on page 119):

� createControl() produces the actual UI element.

� getInitialSize() returns the initial height (in pixels) of the popup.

� getName() returns the display name of the popup, which appears in the tab if 
there is more than one popup.
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Example 4-11   Sample implementations of createControl(), getInitialSize(), and 
getName()

public Composite createControl(ChatWindowHandler handler, Composite 
parent) {

Composite comp = new Composite(parent, SWT.BORDER);
comp.setLayout(new FillLayout());

Label label = new Label(comp, SWT.CENTER);
label.setText("Redbook: Chat window popupAddOn");

comp.layout();
return comp;

}

public int getInitialSize() {
return 100;

}

public String getName() {
return "Redbook: popupAddOn";

}

4. As with the chatArea, we need to create an action to launch our 
popupAddOn. Again, create a new Format bar action (or modify the existing 
one) and add code to the run() method to open the popupAddOn. 

The popupAddOn is opened by calling the createPopupMessageArea() 
method of the ChatWindowHandler class, passing in the id of the 
popupAddOn and a value (in pixels) for its initial height, as shown in 
Example 4-12.

Example 4-12   Sample action code to open the popupAddOn

public void run(){

getChatWindowHandler().createPopupMessageArea("com.ibm.redbooks.extensi
onpoints.chatwindowpopupaddon", 100);

}
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5. It is possible to determine if the pop-up message area is currently visible by 
using ChatWindowHandler.isPopupVisible(), and to close the message area 
with ChatWindowHandler.hidePopupMessageArea(), as shown in 
Example 4-13.

Example 4-13   Sample action code to toggle the popupAddOn

public void run(){
if (getChatWindowHandler().isPopupVisible())
{

getChatWindowHandler().hidePopupMessageArea();
}
else

getChatWindowHandler().createPopupMessageArea("com.ibm.redbooks.extensi
onpoints.chatwindowpopupaddon", 100);

}

4.5  Adding to the nway chat (multi person chat) window

The com.ibm.collaboration.realtime.chatwindow plug-in provides the 
com.ibm.collaboration.realtime.chatwindow.nwayListExtension extension point 
the ability to allow for nway (multi person) chat window customization. 
Contributions can made through the elements labelProvider, extraColumns, 
cellListener, and toolView (see Figure 4-76 on page 121).
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Figure 4-76   nway chat window

Set dependencies
For this example, several dependencies are required (although this may vary 
depending on choices you make for functionality). For the purposes of this 
example, add the following plug-in dependencies:

� com.ibm.collaboration.realtime.chatwindow (This dependency is required for 
any nway chat customization.)

� com.ibm.collaboration.realtime.ui

� com.ibm.collaboration.realtime.people

� com.ibm.collaboration.realtime.core

� com.ibm.rcp.realtime.livenames
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Figure 4-77 shows the dependencies for the example plug-in.

Figure 4-77   Dependencies for example plug-in

Import images
In addition to these dependencies, the example calls for three images (although 
this may vary, depending on the choices you make for functionality) to import 
images follow these steps.

1. Highlight the project (see Figure 4-78).

Figure 4-78   Highlight the project in the Package Explorer perspective

2. Select File → New → Folder.

3. Enter a Folder name for the folder (“images” was used in our example) (see 
Figure 4-79 on page 123).
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Figure 4-79   Create new folder called images

4. Highlight the images folder (or the name you gave the folder) in the Package 
Explorer perspective.

5. Select File → Import to launch the import wizard.

6. In the General folder, highlight File System and click Next.

7. Click the Browse button next to the From directory field and navigate to the 
folder where your images are located and click OK.

8. Select the images you require, and then click Finish.

Images will be imported to the images folder.

Set extensions
1. Click the Extensions tab in the manifest editor.

2. Add the required extension point 
com.ibm.collaboration.realtime.chatwindow.nwayListExtension. 
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3. Right-click the newly created extension in the all extensions window and 
select New → nwayListExtension (see Figure 4-80). 

Figure 4-80   Added nwayListExtension

4. Once it is created, the nwayListExtension properties will appear on the right 
side of the editor. Keep or change the id. 

5. In the Enabled field, select true as a default (see Figure 4-81). Selecting false 
will disable all elements below the extension point in the directory structure.

Figure 4-81   Adding an nwayListExtension
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4.5.1  Add extra column and new function

The extraColumns and cellListeners elements of nwayListExtension provide a 
way to add additional columns to the participant list table of the nway chat 
window. labelProvider allows for those columns to have graphics or text that can 
have additional functionality.

1. Right-click the newly added nwayListExtension in the All Extensions 
window. 

2. Select New → labelProvider. This will create a new entry titled labelProvider 
(you will come back to this in step 5).

Figure 4-82   Newly created labelProvider

3. Right-click the nwayListExtension in the All Extensions window. Select 
New → extraColumns.

4. Right-click the newly added extraColumns in the All Extensions window. 
Select New → column. Leave the default columnIndex and set the 
initialWidth value to 30.
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Figure 4-83   New column creation

5. Right-click nwayListExtension in the All Extensions window. Select New → 
cellListeners. 

6. Right-click the newly added cellListeners in the All Extensions window. 
Select New → cellListener. Leave the default value in the columnIndex field.

Figure 4-84   Create New cellListener.

7. Highlight the labelProvider entry in the All Extensions window (see 
Figure 4-85 on page 127).
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Figure 4-85   Highlight the labelProvider entry

8. Under the Extension Element Details for the new labelProvider, click the 
class hyperlink to create a new class for this labelProvider.

Figure 4-86   Click Class to create new labelProvider Class
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9. Set the Create Java Class window to match the Figure 4-87, then click OK.

Figure 4-87   Create first labelProvider Class

10.The labelProvider class code will now display in the class editor. Make 
additions to the code to identify the image. In Example 4-14, the image is 
defined in the Activator.java, which will be examined in the next step.

Example 4-14   Column Image code in the labelProvider class

package com.ibm.riverbend.enway;

import org.eclipse.jface.viewers.ILabelProviderListener;
import org.eclipse.swt.graphics.Image;

import 
com.ibm.collaboration.realtime.tableextension.NwayTableLabelProvider;

/**
 * Demonstrate column additions to the n-way chat participant
 * list.
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 * 
 */

public class NwayListImageLabelProvider extends NwayTableLabelProvider 
{

public Image getColumnImage(Object element, int columnIndex) {
if (columnIndex == 0)

return Activator.NWAY_LIST_COLUMN_IMAGE;
else

return null;
}

public String getColumnText(Object element, int columnIndex) {
return null;

}

public void addListener(ILabelProviderListener listener) {
}

public void dispose() {
}

public boolean isLabelProperty(Object element, String property) {
return false;

}

public void removeListener(ILabelProviderListener listener) {
}

}

11.From the Package Explorer perspective, double-click to open the 
Activator.java file.

12.Verify your Activator.java code is structured, as in Example 4-15.

Example 4-15   Example Activator.java 

package com.ibm.riverbend.enwaychat;

import org.eclipse.jface.resource.ImageDescriptor;
import org.eclipse.swt.graphics.Image;
import org.eclipse.ui.plugin.AbstractUIPlugin;
import org.osgi.framework.BundleContext;

/**
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 * The main plugin class to be used in the desktop.
 */
public class Activator extends AbstractUIPlugin {

private static Activator plugin;
public static Image NWAY_LIST_COLUMN_IMAGE;

/**
 * The constructor.
 */
public Activator() {

plugin = this;
}

public static Activator getDefault() {
return plugin;
}

/*
 *  (non-Javadoc)
 * @see 

org.osgi.framework.BundleActivator#start(org.osgi.framework.BundleConte
xt)

 */
public void start(BundleContext context) throws Exception {
NWAY_LIST_COLUMN_IMAGE = 

getImageDescriptor("images/biggrin.gif").createImage();
super.start(context);
}

/*
 *  (non-Javadoc)
 * @see 

org.osgi.framework.BundleActivator#stop(org.osgi.framework.BundleContex
t)

 */
public void stop(BundleContext context) throws Exception {
NWAY_LIST_COLUMN_IMAGE.dispose();
plugin = null;
super.stop(context);
}

/**
 * Returns an image descriptor for the image file at the given
130 Extending Sametime 7.5: Building Plug-ins for Sametime



 * plug-in relative path. Note that we dispose of the image 
 * as Garbage Collector will not collect an img
 * @param path the path
 * @return the image descriptor
 */
public static ImageDescriptor getImageDescriptor(String path) {
return 

AbstractUIPlugin.imageDescriptorFromPlugin("com.ibm.riverbend.enwaychat
", path);

}
}

13.Highlight the cellListener entry in the All extensions window (see 
Figure 4-88).

Figure 4-88   Highlight the cellListener entry

14.Right-click the nwayListExtension in the All Extensions window. Select 
New → cellListeners. 

15.Click the class hyperlink to create a new cellListener class. (see Figure 4-89)

Figure 4-89   Click class to create a new cellListener class
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16.Complete the New Java Class wizard so that it looks like Figure 4-90

Figure 4-90   Create a new cellListener Class

17.The cellListener class code will now display in the class editor. 

Make additions to the code to customize the function for the first column. In 
Example 4-16, the column is set to identify the chat partner, create a 
messagebox when the column is clicked next to the person’s name, and 
create a new chat window if the user answers yes to the messagebox.

Example 4-16   Example cellListener code

package com.ibm.riverbend.enway;

import org.eclipse.jface.dialogs.MessageDialog;
import org.eclipse.swt.widgets.Event;

import com.ibm.collaboration.realtime.chatwindow.ChatWindowPartner;
import com.ibm.collaboration.realtime.people.PeopleService;
import com.ibm.collaboration.realtime.people.Person;
import com.ibm.collaboration.realtime.servicehub.ServiceException;
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import com.ibm.collaboration.realtime.servicehub.ServiceHub;
import 
com.ibm.collaboration.realtime.tableextension.NwayTableCellSelectionLis
tener;

/**
 * Contribute "Hello" action to column of a n-way chat participant 
list. 
 * 
 * @see com.ibm.collaboration.realtime.chatwindow.nwayListExtension 
extension point
 */

public class NwayListCellListener extends 
NwayTableCellSelectionListener {

public void handleEvent(Event event) {
ChatWindowPartner cwp = (ChatWindowPartner) event.data;
final Person person = cwp.getPerson();
if (person != null) {

boolean yn = MessageDialog.openQuestion(null, 
"NwayListCellListener Example Area", 
"Say Hi to this person" + person.getContactId() + "?");

if (yn){
try {

PeopleService peopleSvc = (PeopleService) 
ServiceHub.getService(PeopleService.SERVICE_TYPE);

peopleSvc.createConversation(person);
} 
catch (ServiceException e) {

e.printStackTrace();
}

}
}

}
}
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4.5.2  Create a second column for new functionality

1. Right-click the 
com.ibm.collaboration.realtime.chatwindow.nwayListExtension 
extension in the All Extensions window and select New → 
nwayListExtension (see Figure 4-91). 

a. Change or keep the ID value.

Figure 4-91   Create a second nwayListExtension from 
com.ibm.collaboration.realtime.chatwindow.nwayListExtension

2. Right-click the second nwayListExtension in the All Extensions window. 
Select New → labelProvider to add a second column named labelProvider 
(see Figure 4-92). We will come back to this element in step 4.

Figure 4-92   Second labelProvider.

3. Right-click the second nwayListExtension in the All Extensions window. 
Select New → extraColumns to create the second column.

a. Right-click the second extraColumns in the All extensions window. Select 
New → column. Set the default columnIndex value to 0 and, the 
initialWidth value to 30 (see Figure 4-93 on page 135).
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Figure 4-93   Set values for second column.

4. Highlight the second nwayListExtension labelProvider to display the 
element properties.

5. Click the class hyperlink to create a new (second) labelProvider class. This 
class will be used to define the display and function of the second column in 
the n-way participants list.

6. Complete the New Java Class wizard so that it looks like Figure 4-94.

Figure 4-94   Class wizard the for the second labelProvider class
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7. The second labelProvider class code will now show in the class editor. 

Make additions to the code to customize the function for the second column. 
In Example 4-17, the column is set to identify the chat partner, obtain the chat 
partner status, and display a numeric representation of their status in the 
second column beside the participant’s name in the nway chat window.

Example 4-17   Second labelProvider Class code example

package com.ibm.riverbend.enway;

import org.eclipse.jface.viewers.ILabelProviderListener;
import org.eclipse.swt.graphics.Image;

import com.ibm.collaboration.realtime.chatwindow.ChatWindowPartner;
import com.ibm.collaboration.realtime.people.Person;
import 
com.ibm.collaboration.realtime.tableextension.NwayTableLabelProvider;

/**
 * Column additions to the n-way chat participant
 * list.
 * 
 * @see com.ibm.collaboration.realtime.chatwindow.nwayListExtension 
extension point.
 */

public class NwayListStatusLabelProvider extends NwayTableLabelProvider 
{

public Image getColumnImage(Object element, int columnIndex) {
return null;

}

public String getColumnText(Object element, int columnIndex) {
if (element instanceof ChatWindowPartner) {

Person person = ((ChatWindowPartner) element).getPerson();
if (person != null) {

return "[" + person.getStatus() + "]";
}

}
return "col" + columnIndex;

}

public void addListener(ILabelProviderListener listener) {
}
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public void dispose() {
}

public boolean isLabelProperty(Object element, String property) {
return false;

}

public void removeListener(ILabelProviderListener listener) {
}

}

The second column of the example displays a numeric representation of the 
participant’s status. Although it is not done in this example, this function can be 
further extended to display icons or colored symbols to show the participants 
status. To accomplish this, you will need to understand the meaning of each 
numeric representation. Table 4-9 demonstrates the possible values. For more 
information and options, see Constant Field Values in the 
com.ibm.rcp.realtime.livenames.LiveName.getStatus() method in the Sametime 
7.5 SDK.

Table 4-9   com.ibm.rcp.realtime.livenames.LiveName.getStatus() field values

At this point, you have created two columns in the participants list of the Nway 
chat window. The first column displays an image that, when clicked, will open a 
messagebox asking if the user wants to say “Hi” to the participant selected. If the 
answer is “yes,” then a new chat window, directly to the participant, will open. The 
second column will display a numeric representation of the selected participants’ 
online status.

public static final int STATUS_AWAY 2

public static final int STATUS_AWAY_MOBILE 7

public static final int STATUS_DND 3

public static final int STATUS_DND_MOBILE 8

public static final int STATUS_IN_MEETING 5

public static final int STATUS_IN_MEETING_MOBILE 10

public static final int STATUS_NOT_USING 4

public static final int STATUS_OFFLINE 0

public static final int STATUS_ONLINE 1

public static final int STATUS_ONLINE_MOBILE 6
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4.5.3  Create a toolView

The toolView element ofnwayListExtension defines the location of additional 
views within the nway chat window. The view com.ibm.riverbend.enway.toolview 
will set the additional view in the participants list. In the case of our example, a 
company brand logo will be inserted; however, mini apps or other functionality 
can also be added to this area.

1. Right-click the 
com.ibm.collaboration.realtime.chatwindow.nwayListExtension 
extension in the All Extensions window and select New → 
nwayListExtension. 

2. Right-click the third nwayListExtension in the All Extensions window. Select 
New → toolView.

a. In the toolView Element details, keep or change the id value.

b. Add or change the view to com.ibm.riverbend.enway.toolview (see 
Figure 4-95).

Figure 4-95   toolView element details

3. Add the org.eclipse.ui.views dependency, which is used to define additional 
views for the workbench.

4. Right-click the newly created extension org.eclipse.ui.views and select 
New → view (see Figure 4-96 on page 139).
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Figure 4-96   Create a new view from org.eclipse.ui.views.

5. In the newly created View Element Details window, change the id value to 
match the view name you provided the toolView view (in the case of this 
example, com.ibm.riverbend.enway.toolview) (see Figure 4-97). 

a. Provide a name that will appear at the top of your new view. 

b. An icon can also be added if you have imported an image.

Figure 4-97   View Properties for new org.eclipse.ui.views, view entry
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6. Click the class hyperlink to create a new view class. Set the fields of the new 
class wizard to match Figure 4-98, and then click Finish.

Figure 4-98   New class wizard

7. The new view class will open in the class editor. 

Modify the code to add an image or control or both to the view area. In the 
case of the example, the image will be created in the Activator.java code and 
called from the view class code to insure proper disposal of the image.

Example 4-18   View class code used in the example

package com.ibm.riverbend.enway;

import org.eclipse.swt.SWT;
import org.eclipse.swt.graphics.Image;
import org.eclipse.swt.widgets.Composite;
import org.eclipse.swt.widgets.Label;
import org.eclipse.ui.part.ViewPart;

/**
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 * Contributed view to the chat window for n-way chats.
 */

public class NwayListToolView extends ViewPart {
Image img = Activator.NWAY_BRAND;

public NwayListToolView() {
super();

}

public void createPartControl(Composite parent) {
Label lbl = new Label(parent, SWT.SHADOW_IN);
lbl.setImage(img);

    }

public void setFocus() {
}

}

8. The updated Activator.java code in our example looks like Example 4-19.

Example 4-19   Updated Activator.java code used in the example

package com.ibm.riverbend.enway;

import org.eclipse.jface.resource.ImageDescriptor;
import org.eclipse.swt.graphics.Image;
import org.eclipse.ui.plugin.AbstractUIPlugin;
import org.osgi.framework.BundleContext;

/**
 * The main plugin class to be used in the desktop.
 */
public class Activator extends AbstractUIPlugin {

private static Activator plugin;
public static Image NWAY_LIST_COLUMN_IMAGE;
public static Image NWAY_BRAND;

/**
 * The constructor.
 */
public Activator() {

plugin = this;
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}

public static Activator getDefault() {
return plugin;

}

/*
 *  (non-Javadoc)
 * @see 

org.osgi.framework.BundleActivator#start(org.osgi.framework.BundleConte
xt)

 */
public void start(BundleContext context) throws Exception {

NWAY_LIST_COLUMN_IMAGE = 
getImageDescriptor("images/biggrin.gif").createImage();

NWAY_BRAND = 
getImageDescriptor("images/rb_logo_192px.gif").createImage();

super.start(context);
}

/*
 *  (non-Javadoc)
 * @see 

org.osgi.framework.BundleActivator#stop(org.osgi.framework.BundleContex
t)

 */
public void stop(BundleContext context) throws Exception {

NWAY_LIST_COLUMN_IMAGE.dispose();
NWAY_BRAND.dispose();
plugin = null;
super.stop(context);

}

/**
 * Returns an image descriptor for the image file at the given
 * plug-in relative path.
 *
 * @param path the path
 * @return the image descriptor
 */
public static ImageDescriptor getImageDescriptor(String path) {

return 
AbstractUIPlugin.imageDescriptorFromPlugin("com.ibm.riverbend.enway", 
path);

}
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}

4.6  Adding a preference page

Figure 4-99 shows a sample custom preference page.

Figure 4-99   Sample custom preference page

Eclipse-based applications provide an extension point that allows you to add a 
preference page to the preferences of the application (in our case, Sametime 
Connect).

We can use the built-in Eclipse PDE extension wizard to create a preference 
page.

1. Open the Extensions tab in the plug-in manifest and click Add. 
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2. Click the Extension Wizards tab, select the Preference Page extension 
template, and click Next, as shown in Figure 4-100.

Figure 4-100   Preference Page extension wizard

A template for a preference page is created that we can modify as required. 

3. Change or leave as is the Java Package Name, Page Class Name, and 
Page Name, as shown in Figure 4-101 on page 145.
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Figure 4-101   Preference page properties

The page name will display as the preference page title. and in the list of 
preference pages when the user selects File → Preferences.
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If we look again at the Extensions tab, we can see that the wizard has added two 
new extension points to our plug-in: org.eclipse.ui.preferencePages and 
org.eclipse.core.runtime.preferences, as shown in Figure 4-102.

Figure 4-102   Extension points added to the Extensions list

The org.eclipse.ui.preferencePages extension point is used to add the actual 
Preference page to the Eclipse UI. The org.eclipse.core.runtime.preferences 
extension point is used to initialize default values for any fields in the Preference 
page.

The wizard also creates an extension element for each of the extension points. A 
page extension element is created under the preferencePages extension point, 
and an initializer element is created under the preferences extension point, as 
shown in Figure 4-103.

Figure 4-103   Page and initializer extension elements added by the wizard

Each extension element has an associated Java class as well that the wizard 
also created. The class associated with the page element defines the layout for 
our preference page. It extends the FieldEditorPreferencePage class and 
implements the IWorkbenchPreferencePage interface. The constructor of its 
parent class takes one argument, an integer representing the layout to be used. 
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The wizard chooses a GRID layout, which by default has one column. In the 
createFieldEditors() method (overridden from the parent 
FieldEditorPreferencePage), four fields of different types are added to the 
preference page, as shown in Example 4-20.

Example 4-20   RedbookPreferencePage class created by the wizard

public class RedbookPreferencePage
extends FieldEditorPreferencePage
implements IWorkbenchPreferencePage {

public RedbookPreferencePage() {
super(GRID);
setPreferenceStore(Activator.getDefault().getPreferenceStore());
setDescription("A demonstration of a preference page 

implementation");
}

/**
 * Creates the field editors. Field editors are abstractions of
 * the common GUI blocks needed to manipulate various types
 * of preferences. Each field editor knows how to save and
 * restore itself.
 */
public void createFieldEditors() {

addField(new DirectoryFieldEditor(PreferenceConstants.P_PATH, 
"&Directory preference:", getFieldEditorParent()));

addField(
new BooleanFieldEditor(

PreferenceConstants.P_BOOLEAN,
"&An example of a boolean preference",
getFieldEditorParent()));

addField(new RadioGroupFieldEditor(
PreferenceConstants.P_CHOICE,

"An example of a multiple-choice preference",
1,
new String[][] { { "&Choice 1", "choice1" }, {

"C&hoice 2", "choice2" }
}, getFieldEditorParent()));
addField(

new StringFieldEditor(PreferenceConstants.P_STRING, "A &text 
preference:", getFieldEditorParent()));

}
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The wizard created a third class, PreferenceConstants.java. This is a 
convenience class that can be used to store constant values used by the 
preference page, as shown in Example 4-21.

Example 4-21   PreferenceConstants class created by the wizard

public class PreferenceConstants {

public static final String P_PATH = "pathPreference";

public static final String P_BOOLEAN = "booleanPreference";

public static final String P_CHOICE = "choicePreference";

public static final String P_STRING = "stringPreference";

}

The autogenerated class associated with the initializer element extends the 
AbstractPreferenceInitializer class. In its initializeDefaultPreferences() method, it 
populates default values for the preference fields. It uses the constants defined in 
the PreferenceConstants class, as shown in Example 4-22.

Example 4-22   PreferenceInitializer class created by the wizard

public class PreferenceInitializer extends 
AbstractPreferenceInitializer {

/*
 * (non-Javadoc)
 * 
 * @see 

org.eclipse.core.runtime.preferences.AbstractPreferenceInitializer#init
ializeDefaultPreferences()

 */
public void initializeDefaultPreferences() {

IPreferenceStore store = Activator.getDefault()
.getPreferenceStore();

store.setDefault(PreferenceConstants.P_BOOLEAN, true);
store.setDefault(PreferenceConstants.P_CHOICE, "choice2");
store.setDefault(PreferenceConstants.P_STRING,

"Default value");

}
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}

Eclipse preferences represent a set of name-value pairs. Each name has two 
values, a default value and a user-specified value. If no user-specified value 
exists, the default value is used.

By nature of the fact that our plug-in subclassifies AbstractUIPlugin (see 4.1.1, 
“Creating a plug-in project and plug-in” on page 64), plug-in preferences are 
automatically saved when the plug-in shuts down. There are two APIs for 
accessing the preferences stored in our preference page:

� org.eclipse.core.runtime.Preferences

� org.eclipse.jface.preference.IPreferenceStore

The IPreferenceStore interface predates Eclipse 3.1 and the Preferences 
interface, and exists only for backwards compatibility. Therefore, to access our 
preferences from the plug-in, we use the Preferences interface and the code 
shown in Example 4-23.

Example 4-23   Code to retrieve preference values

Activator.getDefault().getPluginPreferences().getXXX(preferenceName)

If our plug-in extended Plugin rather than AbstractUIPlugin, there are some extra 
steps involved. The stop() method would need to be modified to always call 
savePluginPreferences() and saveDialogSettings() so that the preferences 
persisted across sessions.

The preference pages are displayed in the preference dialog alphabetically. A 
new preference page can be nested under an existing one using the category 
property of the page extension element. If we set the category to be the same 
value as the id of an existing preference page (as shown in Figure 4-104), the 
preference page will appear nested beneath it, as shown in Figure 4-105 on 
page 150.

Figure 4-104   Setting the category to an existing preference page id
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Figure 4-105   Preference page nested beneath existing one

Table 4-10 summarizes the extension points we have extended in this example, 
and the plug-in dependencies for this plug-in.

Table 4-10   Summary of extension points and dependencies

Extension point(s) extended Required plug-in(s)

org.eclipse.ui.preferencePages
org.eclipse.core.runtime.preferences

org.eclipse.ui org.eclipse.core.runtime
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4.7  Adding a mini application

Figure 4-106 shows a custom mini application added to the contacts list.

Figure 4-106   Custom mini application added to the contacts list

The mini-app area is the area at the bottom of the contacts list that plug-ins can 
take advantage of to display data.

We will be extending the extension point 
com.ibm.collaboration.realtime.imhub.miniApps. Using this extension point 
means we are dependent on the com.ibm.collaboration.realtime.imhub plug-in. 

Note: We already added this plug-in as a dependency in 4.3.2, “Adding an 
action to the Tool Bar” on page 82, so we do not need to do it again now, but 
you would need to add it if you had not already done so.
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1. Right-click the extension point and select New → miniApp to add a new 
miniApp extension element, as shown in Figure 4-107.

Figure 4-107   Adding a new miniApp extension element

2. Modify (if required) the id, displayName, and class properties. 

The value of the displayName property will appear in the menu bar of the 
miniApp. Add a value for the maxHeight property, otherwise we will not be 
able to see the miniApp even though it is there. Setting an icon property will 
cause the image to be displayed in the menu bar alongside the text from the 
displayName property.

3. Click the class link to create the class file for the miniApp. We want our class 
to extend the Sametime miniApp class, so we select the 
com.ibm.collaboration.realtime.miniapp.AbstractMiniApp class as the 
Superclass, as shown in Figure 4-108 on page 153.
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Figure 4-108   Creating the miniApp class

4. Accept the rest of the defaults and click Finish. 

This is enough to get the miniApp to display in the Connect client, but is, of 
course, not very useful without any functionality.

5. Two methods are inherited from AbstractMiniApp, init() and createControl(). 
The createControl() method builds the user interface for the miniApp. To 
illustrate this, we will add a simple SWT Label that displays a text string, as 
shown in Example 4-24.

Example 4-24   RedbookMiniApp’s createControl() method

public Control createControl(Composite parent) {

Composite comp = new Composite(parent, SWT.BORDER);
comp.setLayout(new FillLayout());

Label label = new Label(comp, SWT.CENTER);
label.setText("Redbook miniApp");
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comp.layout();
return comp;

}

When we launch the run time workspace, the miniApp appears at the bottom of 
the contact list.

The miniApp can initially be hidden from display by overriding the 
isInitiallyVisible() method from the AbstractMiniApp class. The default is true, so 
the miniApp is initially visible.

Table 4-11 summarizes the extension point we have extended in this example, 
and the plug-in dependency for this plug-in.

Table 4-11   Summary of extension points and dependencies

4.8  Message Event Notification extension point

Sametime Connect components communicate key events through a common 
messaging bus. The components that use this messaging framework are termed 
participants. As in a traditional publish - subscribe system, the sender of a 
system message does not need to know anything about the component 
responsible for processing that message; it deals only with the messaging bus. 
Tapping in to this messaging framework allows you to react to important events 
within the Sametime Connect client, for example, you can intercept an incoming 
chat message before it is displayed by the client, or modify an outgoing chat 
message before it is delivered to its intended recipient.

The com.ibm.collaboration.realtime.messages.Message class provides the base 
class that all the specific message types subclass. For each message type, there 
is a specific subclass of the base Message class that is specific to that type of 
message. For example, the 

Note: If this method returns false, the miniApp is hidden; the init() and 
createControl() methods are not called. This could be used to hide the 
miniApp if there was some problem with the generation of its content, or to 
show it again if some event has taken place since the last time it was 
displayed.

Extension point extended Required plug-in

com.ibm.collaboration.realtime.imhub.min
iApps

com.ibm.collaboration.realtime.imhub
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com.ibm.collaboration.realtime.messages.im.ImTextReceivedMessage 
represents the system message that is broadcast by the messaging bus when 
the user receives an incoming 1-to-1 chat message. Likewise, the 
ImTextSendMessage is broadcast by the bus as a 1-to-1 instant message is sent. 
We can use the class’ getText() method to get the actual content of the message.

The Message class and it’s subclasses are contained in the 
com.ibm.collaboration.realtime.messages plug-in, and comprise the 
com.ibm.collaboration.realtime.messages, 
com.ibm.collaboration.realtime.messages.im, and 
com.ibm.collaboration.realtime.messages.search packages.

4.8.1  The MessageHandlerListener extension point

In order to receive the various messages from the messaging bus, we need to 
follow this general pattern:

� Extend the 
com.ibm.collaboration.realtime.messages.MessageHandlerListener 
extension point and add either a messageHandler or 
messageHandlerCallback extension element.

� Create a subclass of the DefaultMessageHandler class and override the 
handleMessage() method for the specific message types we are interested in

� Create a subclass of either MessageHandlerAdapter or one of the 
MessageHandlerCallback subclasses. In its constructor, pass a new instance 
of the DefaultMessageHandler subclass into the constructor of the 
MessageHandlerAdapter or MessageHandlerCallback

1. Add the com.ibm.collaboration.realtime.messages.MessageHandlerListener 
extension point to the plug-in. 

2. We create a new messageHandler or messageHandlerCallback extension 
element, depending on whether or not we want to interact with the message 
before or after it is processed. Callback handlers can process message 
events before or after they are delivered to the registered message handlers, 
and can optionally stop the continued processing of a message event.

3. The class associated with the extension point subscribes to messages from 
the message bus. If we are using the messageHandler extension element, 
our class must be a subclass of the MessageHandlerAdapter class. If we use 
the messageHandlerCallback element, we have the choice of 
MessageHandlerPreCallback or MessageHandlerPostCallback. In either 
case, we pass a new instance of our DefaultMessageHandler subclass into 
the constructor of the Superclass.
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Example 4-25 shows a sample implementation that extends 
MessageHandlerAdapter.

Example 4-25   Sample MessageHandlerAdapter subclass

public class MessageHandlerAdapterSample extends MessageHandlerAdapter
{

public MessageHandlerAdapterSample(MessageHandler handler)
{

super(handler);
}

public MessageHandlerAdapterSample()
{

super(new MessageHandlerSample());
}

}

Example 4-26 shows a sample implementation that extends 
MessageHandlerPreCallback.

Example 4-26   Sample MessageHandlerPreCallback subclass

public class MessageHandlerPreCallbackSample extends 
MessageHandlerPreCallback
{

public MessageHandlerPreCallbackSample(MessageHandler handler)
{

super(handler);
}

public MessageHandlerPreCallbackSample()
{

super(new MessageHandlerSample());
}

}

4. The final step is to subclassify 
com.ibm.collaboration.realtime.messages.DefaultMessageHandler and 
override the appropriate handleMessage() methods for the specific message 
types we are interested in intercepting. Methods that are not explicitly 
overridden are handled by the handleDefaultMessage() method. 
Example 4-27 on page 157 shows a sample implementation.
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Example 4-27   Sample DefaultMessageHandler subclass

public class MessageHandlerSampleImplementation extends 
DefaultMessageHandler
{

public MessageHandlerSampleImplementation()
{
}

public void handleDefaultMessage(Message message)
{

// Do default something here...

}

public void handleMessage(ImTextReceivedMessage arg0)
{

System.out.println("Redbook: ImTextReceivedMessage");
//Output the message text
System.out.println("Redbook: " + arg0.getText());

}

}
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Part 3 Example 
plug-ins

Part 3
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Chapter 5. Introduction to building a 
plug-in: modifying the UI

This chapter provides methods and instructions to create a UI plug-in used to 
brand the IBM Lotus Sametime 7.5 Connect Client with your own corporate logos 
and images. In addition, one of these branded areas will be extended to include 
basic business funtionality. While the functionality in this example is basic, it is by 
no means a limit on what can be done. 

5

Attention: All sample code used within this chapter can be downloaded from 
the IBM Redbooks FTP site. Please refer to Appendix A, “Additional material” 
on page 557 for detailed instructions on how to download and deploy the code 
sample:

ftp://www.redbooks.ibm.com/redbooks/SG247346
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5.1  Introduction

A branding application provides a method to specify logos and related branding 
information in Lotus Sametime Connect in the login dialog, contact list, and chat 
window. The branding UI defines for a simple image that can appear any of these 
locations and can appear as a static image, display a Web page, or call another 
program.

There are three locations that can be branded:

� The Sametime Login Window

� The Sametime Hub (Buddy List)

� The Chat Windows

It is important to note that the plug-in we will create in this chapter applies to 
branding the Sametime 7.5 Connect client only. If you wish to brand the Java 
connect client you should refer to the Sametime Java Toolkit Guide and the 
Sametime Java Toolkit Tutorial, which are located in the (client\stjava\doc) 
directory of the Sametime 7.5 SDK.

5.2  A preview of what you will build in this chapter

The following section describes the scenario that we use as a context for the 
branding plug-in. It also illustrates a preview of the plug-in you will create. 

5.2.1  Introduction to the scenario

For the purpose of providing a realistic business context to this chapter, we use 
the River Bend Coffee and Tea Company as the basis for the development 
scenario. River Bend Coffee and Tea Company, a subsidiary of WWCorp, is a 
fictitious company that uses Sametime 7.5 for its real-time collaborative 
application needs. It operates a chain of 20 retail stores in 12 cities worldwide. In 
addition, the company runs an Internet-based retail operation, offers small-scale 
catering services, and has launched a certification program for employees and 
clients who wish to become skilled roast masters.

Note: Any changes you make to the Chat window will also be reflected in 
Group Chat Windows.
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Currently, the company uses Sametime 7.5 to:

� Provide real-time collaboration and instant messaging services to its 
employees.

� Facilitate collaboration and communication among its geographically 
dispersed work force.

� Communicate and coordinate relationships with its vendors and clients.

� Manage, deliver, and track training to employees and clients.

� Support enterprise-wide document management, including regulatory 
compliance, corporate accountability, and information flow.

� Communicate with a sibling subsidiary, a retail organization that specializes in 
recorded music products.

5.2.2  Preview of custom branding results

When creating or making changes to the UI, visualizing the end result is a good 
place to start. Visualizing the end result will help you save time. With that in mind, 
let us have a look at what a finished branding plug-in will look like once deployed 
to the enterprise.

Note: The sample screen captures and tasks that we present throughout the 
chapter are intended to support the development scenario. The fictitious user 
names, documents, titles, and store locations are used solely to simulate the 
IBM Workplace environment and to demonstrate functions and features. They 
are not intended to depict real people, content, or company policies. Any 
likeness to real persons, content, or companies is coincidental and 
unintended.
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A branded login window
Figure 5-1 shows an example of a image branded Login window.

Figure 5-1   Logon window with branding

In Figure 5-1, an image file was chosen for the Login window. There is no 
underlying functionality. Other options will be explored in other branding areas 
later in this chapter; however, it should be noted that the branding examples 
option shown later in this chapter can be applied to this branding area.

A branded chat window
Figure 5-2 on page 165 shows an example of a branded chat window.

Note: An image 393x32 pixels worked best for the style of image we chose for 
this branding area. The maximum size for this space is 393x42 pixels.

Custom Branding
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Figure 5-2   Chat window with branding

In Figure 5-2, an image is shown in the top right portion of the Chat window. If the 
image is hovered over with the cursor, a “tip box” appears with the text “click to 
visit the Web site.” Once clicked, the image will open a URL to the designated 
Web site, which could be used to direct users to an FAQ or help Web site.
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A branded hub window (Buddy List)
In our final example, Figure 5-3, an image is presented that, when clicked, will 
create a new memo addressed to the Sametime Help group. This is a simple 
example of extending functionality; however, this type of functionality can be 
extended beyond this basic example to call to any program.

Figure 5-3   Hub window with branding

5.3  Preparing to build a branding plug-in

Attention: All sample code used within this chapter example can be 
downloaded from the Redbooks FTP site. Please refer to Appendix A, 
“Additional material” on page 557 for detailed instructions on how to download 
and deploy the code sample:

ftp://www.redbooks.ibm.com/redbooks/SG247346
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One of the first things we should ask ourselves is “What do we need to create this 
plug-in?”. Before you jump into the process of creating a branding plug-in, there 
are a few items that will need to be set up or reviewed. 

5.3.1  Preparing your development environment

Preparing your Eclipse 3.2 environment to develop Sametime 7.5 plug-ins is 
explained in Chapter 3, “Setting up the Integrated Development Environment” on 
page 37. 

What you will need:

� Eclipse 3.2 configured to develop plug-ins for Sametime 7.5 (refer to 
Chapter 3, “Setting up the Integrated Development Environment” on page 37)

� Sametime 7.5 SDK

� Understanding of the only package dependency which is the 
com.ibm.collaboration.realtime.ui package (refer to the Sametime SDK)

� A photo editor application or existing logo in the appropriate sizes for the area 
you are branding.

– Hub Window (Buddy List) Top: A maximum of 256 w x 26 h pixels

– Hub Window (Buddy List) Bottom: A maximum of 256 w x 32 h pixels

– Login Window: A maximum of 393 w x 42 h pixels

Important: If you are creating a series of branding plug in styles (perhaps 
different departments in your organization will have different images or 
functions), we recommend that you start with a new Eclipse Workspace for 
each branding plug-in. As stated in Chapter 3, “Setting up the Integrated 
Development Environment” on page 37, each new workspace will require new 
preparation. 

Caution: Eclipse 3.2 seems to cache previous branding plug-in data when 
testing. This occurs even if you uncheck the previous plug-in from being run 
when testing the newer one. This can result in branding data/settings from a 
previous branding plug-in appearing in the current plug-in, which can make it 
very difficult during testing.

Note: Note that this area may become wider if users expand the 
window. Therefore code the layout for this possibility.
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– Chat Window: A maximum of 92 w x 64 h Pixels

� Sametime 7.5 Connect Client installed on the same machine as Eclipse 3.2 
for testing

5.3.2  A look at the com.ibm.collaboration.realtime.ui package

There is only one Class in the com.ibm.collaboration.realtime.ui package. It is the 
STBrandingArea Class. STBrandingArea defines branding areas for the login 
dialog, Contact List, and chat window. Areas can be a static image, URL, or 
application-defined composite. 

There is only one Method for the STBrandingArea Class. It is the createControl 
Method, which is called to create a branding area control. 

� Parameters:

– parent: Composite where the control will be laid out

� Returns:

– Your Control

5.3.3  Extensions for the com.ibm.collaboration.realtime.ui package

Here we discuss extensions for the com.ibm.collaboration.realtime.ui package.

Client locations available to branding
There are three locations available to branding within the Sametime 7.5 Connect 
Client. They are Login, Chat, and Hub. You will also need to know how each is 
referenced for display in the targetView, as shown in Table 5-1 (this will also be 
reviewed in each example created in this chapter).

Table 5-1   Client location targetViews

Note: Note that this area may become wider on different operating 
systems. Therefore, code the layout for this possibility.

Location targetView

Login com.ibm.collaboration.realtime.login

Hub com.ibm.collaboration.realtime.imhub

Chat com.ibm.collaboration.realtime.chatwindow
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The Stbranding extension
There is only one extension for the com.ibm.collaboration.realtime.ui package. 
The Stbranding extension has three elements that can be used for different styles 
of branding for your Sametime 7.5 Connect Client. The three elements are 
Image, Control, and Website. Table 5-2 describes the function of each element. 
As you will see in our plug-in example, you can create an extension element for 
each of the designated branding areas.

Table 5-2   Stbranding extension elements

5.4  Building a branding plug-in

Open Eclipse 3.2 to the workspace that has already been configured to create 
Sametime 7.5 plug-ins. If you have not already configured your Eclipse 
environment, please refer to Chapter 3, “Setting up the Integrated Development 
Environment” on page 37 before continuing.

All branding plug-ins begin the same
You may wish to create a branding for all three brandable areas, or you may wish 
to create a branding for one or two only. All three brandable areas have certain 
plug-in characteristics in common. For that reason, we will first create the plug-in 
commonalities and then create a separate section for each of the branding areas.

The commonalities we will now create are shown in Table 5-3.

Table 5-3   Common elements 

Extension element Does this

Image Displays an image.

Website Retrieves and displays a Web page.

Control Creates a custom control that can access other 
programs. Can be set to display a clickable image 
that will launch the control function.

Common to all elements of the branding plug-in

Create the Plug-in Project.

Create the Plug-in Dependencies.

Create the stbranding Extension.
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Task overview
The following tasks are used for building the branding plug-in. Detailed 
instructions for each task are included on the following pages.

Task 1: Create the plug-in project.

Task 2: Create the plug-in dependencies.

Task 3: Create the plug-in extension.

Task 1: Create the plug-in project
1. In your Eclipse Environment, select File → New → Project....

2. Select Plug-in Project, as shown in Figure 5-4, and then click Next.

Figure 5-4   Select Plug-in Project 
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3. In the Plug-in Project window, enter the plug-in Project name, as shown in 
Figure 5-5. Leave all other options as default. Click Next. 

Figure 5-5   Plug-in Project window

4. In the Plug-in Content window, select or enter the properties shown in 
Figure 5-6 on page 172.

– Plug-in Properties

• A version number is provided. Change this if you have created previous 
versions of the same plug-in.

• In the Plug-in Name field, provide a descriptive name (especially if you 
are creating several versions).

• Leave the other properties as their defaults.

– Plug-in options

• Select Generate an activator, a Java class that controls the 
plug-in’s life cycle.

• Select This plug-in will make contributions to the UI. 

– Rich Client Application

• Choose No for Creating a Rich Client Application.

5. Click Finish to create the plug-in framework.
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Figure 5-6   Plug-in Content window

You will now be in the Plug-in Development perspective. In the center of your 
window, you see a window with your plug-in overview properties. Figure 5-7 on 
page 173 shows the Plug-in Development Overview window.
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Figure 5-7   Plug-in Development Overview window
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Task 2: Create the Plug-in Dependencies
You now need to declare your plug-in dependencies. 

1. At the bottom of the window, you will see a series of tabs. Click the 
Dependencies tab, as highlighted in Figure 5-8.

2. In the required plug-ins section, you will see the existing plug-in 
dependencies:

– org.eclipse.ui

– org.eclipse.core.runtime

3. Click the Add button under Required Plug-ins.

Figure 5-8   Dependencies tab

4. Scroll through the list of available plug-ins and select 
com.collaboration.realtime.ui, as shown in Figure 5-9 on page 175.
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Figure 5-9   Select com.collaboration.realtime.ui

5. Click OK and verify that your Dependencies window looks like Figure 5-10.

Figure 5-10   Dependency tab with com.collaboration.realtime.ui dependency added
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Task 3: Create the plug-in extension
1. After you have selected the Dependencies, click the Extensions tab.

2. The All Extensions pane will be empty, as shown in Figure 5-11. Click the 
Add button to add the stbranding extension.

Figure 5-11   Extensions window
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3. Select the com.ibm.collaboration.reatime.ui.stbranding extension, as 
shown in Figure 5-12, and then click Finish.

Figure 5-12   Selecting com.ibm.collaboration.reatime.ui.stbranding extension
 Chapter 5. Introduction to building a plug-in: modifying the UI 177



Your Extensions tab should now show the stbranding extension and look like 
Figure 5-13.

Figure 5-13   Extensions tab with com.ibm.collaboration.reatime.ui.stbranding extension 
added

5.4.1  Creating a branded login window

Now that the plug-in basics have been set up, you need to set up your extension 
element. The extension element determines the type of brand and in which 
branding area it will appears. 

1. In the All Extensions pane, right-click the 
com.ibm.collaboration.reatime.ui.stbranding extension.
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2. Select New → stbranding, as shown in Figure 5-14.

Figure 5-14   Selecting stbranding

The Extensions tab will now show the stbranding extension, as shown in 
Figure 5-15. On the right side of the window are the properties for this extension.

Figure 5-15   Displaying the stbranding extension 
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3. Set the Properties, as shown in Figure 5-16.

a. In the id field, enter com.riverbend.sametime.branding.login.

b. Change the name to something more easily read. In our example, it is 
renamed to Login Branding.

c. Change the targetView to com.ibm.collaboration.realtime.login (this is how 
the plug image knows where to display.

d. Height and width are not necessary to set in this instance, as we have set 
the height in the image file.

e. Set valign to Top.

Figure 5-16   Defining the properties of the stbranding extension element

Task 2: Associate an image to the element
Next, we need an image to associate with this element.

Tip: Resizing the All Extensions editor window will provide better viewing 
for the fields you need to fill in.

Note: If you plan to brand the chat and hub windows and already have the 
images, you can import all required images in this step.
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1. First, you will need a folder where you will import the image(s). Select File → 
New → Folder.

2. Name the new folder images, as shown in Figure 5-17, and then click Finish.

Figure 5-17   Creating the images folder

You will now see a folder called images in the Package Explorer frame, as shown 
in Figure 5-18.

Figure 5-18   New images folder

3. Now you need to import the image file(s). Select File → Import.
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4. In the import window, highlight File System, as shown in Figure 5-19, and 
then click Next. This launches the File System Wizard.

Figure 5-19   Selecting File System where images folder is located

5. On the top right corner of the File System Wizard window, click the Browse... 
button.

6. Navigate to the folder with you image files, and then click OK.

7. In the next File System Wizard window, click the check box beside your folder. 
This will display all images in that folder in the right side pane. Figure 5-20 on 
page 183 shows the image files contained in the Pics folder.
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Figure 5-20   Select image files

8. Click the check box next to the file name to select all images required for this 
plug-in.

9. Click Finish to import the files.

Note: Remember that there are three branding areas and you could need 
up to three images
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10.Verify the images are listed under the images folder, as shown in Figure 5-21. 

Figure 5-21   Image files moved to images folder

11.Next, click the Extensions tab to display the All Extensions pane and 
right-click the element you created for login (in this example, called Login 
Branding).

12.Choose New → image, as shown in Figure 5-22.

Figure 5-22   Selecting new image

An Image entry will display under your login branding element property 
details. 

Note: In this example, an image is shown. The other options to display are 
Website and Control. Selecting Website simply displays a Web page in the 
designated area. Selecting Control will be demonstrated in the next two 
examples in this chapter.
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13.Highlight the image it to see the properties in the right pane, as shown in 
Figure 5-23.

Figure 5-23   Displaying the image property details

14.Click the Browse button

15.Expand your plug-in.

16.Expand the images folder.
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17.Select the image you want to appear in the login window, as shown in 
Figure 5-24, and then click OK.

Figure 5-24   Selecting the image

18.Click File → Save.

That’s it! You have just created a plug in that will brand the Login window.

5.4.2  Creating a chat window branding plug-in

In this section, you will see how to create a chat window branding that, when 
clicked, will open a browser to a designated Web site. While this example is 
simple in that it will only open the Web page, you can extend it further to pass on 
the user’s credentials and direct them to the Sametime Meeting Center or any 
other password protected Web site. There are a few possibilities here that you 
can explore.

Note: You will only be able to see this change in your own Sametime client 
as you test through Eclipse. You have only created the plug-in. You must 
now deploy it for users to see it. How to test this plug in is shown later in 
5.5, “How to test your branding plug-in” on page 210. If you want to test this 
before creating the Chat window plug-in and the Hub (buddy list) window 
plug-in, skip ahead to that section.

For information about how to deploy plug-ins, see Chapter 12, “Deploying 
plug-ins for Sametime 7.5” on page 525.
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1. If your Eclipse Workspace is not open with your plug in commonalities or your 
login brand, do so now (see “All branding plug-ins begin the same” on 
page 169).

2. Select the Extensions tab (see Figure 5-25).

Figure 5-25   Displaying the Extensions tab

3. In the All Extensions pane, right-click the 
com.ibm.collaboration.reatime.ui.stbranding extension.

Hint: If you cannot find the Extension tab (it is not where it was last 
displayed), double-click the Manifest file in the Package Explorer 
perspective to display it.
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4. Select New → stbranding, as shown in Figure 5-26.

Figure 5-26   Selecting stbranding 

This will place a new extension element under your Extension 
(com.ibm.collaboration.realtime.ui.stbranding).

5. Define in the element property details, as shown in Figure 5-27 on page 189.

a. Change the id to com.riverbend.sametime.branding.chat.

b. Change the name to Chat Branding.

c. Change the targetView to com.ibm.collaboration.realtime.chatwindow.

d. In our example we changed the height to 64 (set yours accordingly).

e. In our example we changed the width to 64 (set yours accordingly).

f. Choose to align to the top or bottom of the window.

Note: The maximum for this brandable space is 92x 64 pixels.
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Figure 5-27   Chat branding element property details

6. In the All Extensions pane, right-click the element you created for login (in this 
example, Chat Branding).

7. Select New → Control, as shown in Figure 5-28.

Figure 5-28   Choosing new control for chat branding element
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8. You will see a new properties entry under the Chat Branding element. Click 
the new entry.

9. On the right side of the editor frame, you will now see the Extension Element 
Details pane. Click the word Class, as shown in Figure 5-29. This will create a 
new class for your plug-in control.

Figure 5-29   Create a new class
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10.In the Create a new Java class window that opens, give the class a name. 
The example uses ChatBrandingArea, as shown in Figure 5-30.

11.Leave all the other fields as the default and click OK.

Figure 5-30   Naming the new Java class

You have just created a class (in the example case called ChatBrandingArea). 
Note that the to do’s are placed in the class code, as shown in Figure 5-31 on 
page 192. These are intended to remind you to add your functionality here.

Note: Be sure you are not naming this class with a protected name, for 
example, ...Stbranding,
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Figure 5-31   To do’s added to the class code

Further modifications for the Chat Window Branding plug-in
For those of you who like to write your own Java/Eclipse code, this is where it 
gets added to the new class you just created. If you create your own code, and it 
tests fine, skip ahead to the next section when ready. To see how to test your own 
code, refer to 5.5, “How to test your branding plug-in” on page 210.

For those of you that would prefer to have the Java/Eclipse code provided, 
continue on from this point.

Considerations for additional code
There are a few things you need to consider before creating your Java/class 
code, as well as a few things you need to create for required functionality.

1. Required tasks

a. Create the control.

b. Properties of the control.

c. Which image will be used.

2. Optional tasks/features

a. Will there be tool tips or help when the cursor hovers over the branding 
area?

b. Should the cursor change to prompt users?

c. What will the control do? This one is important to evaluate. The purpose of 
using the control element is to have the branded area “do something” 
when the user clicks it. What that something is entirely up to you and your 
imagination. In this example, the click will perform the simple task of 
opening a browser to a pre-determined Web site. The next example in this 
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chapter is similar in that it will open a new memo in the user’s mail client 
and address it to the Sametime Helpdesk. Beyond that, the sky is the limit. 
A Control can do virtually anything your capable of coding. There are a few 
examples/ideas in chapters later in this IBM Redbook, for example, have 
the control call to a Web service.

Modifications including an image, cursor change, and tool tip
Now that we have given some thought to what we want the control to do, let us 
have a look at some finished code that will:

� Display the image “rb_logo_64x64px.gif” that will be used in the control area

� Change the cursor to a hand when over the control area

� Display the tool tip “Click to go to the website” when the cursor hovers over 
the control area

Classes used in the creation of additional code
The following classes are used in the creation of this code. For more information 
about these classes and their methods, please refer to http://www.eclipse.org.

� org.eclipse.swt.events.MouseEvent

� org.eclipse.swt.layout.GridData

� org.eclipse.swt.layout.GridLayout

� org.eclipse.swt.program.Program

� org.eclipse.swt.widgets.Composite

� org.eclipse.swt.widgets.Control

� org.eclipse.swt.widgets.Label

Example 5-1   Example code for creating ChatBrandingArea class

package Change.to.your.package.name;

import org.eclipse.swt.SWT;
import org.eclipse.swt.events.MouseAdapter;
import org.eclipse.swt.events.MouseEvent;
import org.eclipse.swt.layout.GridData;
import org.eclipse.swt.layout.GridLayout;
import org.eclipse.swt.program.Program;
import org.eclipse.swt.widgets.Composite;

Note: This code can be pasted directly into your class code; however you will 
need to change some text to match your naming schema. These items will 
appear in BOLD.
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import org.eclipse.swt.widgets.Control;
import org.eclipse.swt.widgets.Label;

import com.ibm.collaboration.realtime.ui.STBrandingArea;

public class Chatwindowbrand extends STBrandingArea {
public Control createControl(Composite parent) { 

        Composite comp = new Composite(parent, SWT.NONE); 
        comp.setBackground(parent.getBackground()); 
        GridLayout gl = new GridLayout(); 
        gl.marginHeight = 0; 
        gl.marginWidth = 0; 
        comp.setLayout(gl); 
        Label label = new Label(comp, SWT.NONE); 
        label.setLayoutData(new 
GridData(GridData.HORIZONTAL_ALIGN_CENTER | 
GridData.VERTICAL_ALIGN_CENTER));
label.setImage(Activator.getCHAT_WINDOW_IMAGE());
        label.setToolTipText("What text you want to appear when cursor 
hovers"); 
        
label.setCursor(label.getDisplay().getSystemCursor(SWT.CURSOR_HAND)); 
        label.addMouseListener(new MouseAdapter() { 
                public void mouseUp(MouseEvent e) { 
                     Program.launch("http://The Website you want to 
open in the browser/");               
                                        
                } 
        }); 
        return comp; 
}

} 

Table 5-4 is a listing of all the changes you should have made to your 
ChatBrandingArea class code.

Table 5-4   ChatBrandingArea.java code changes.

Replace this 
code

With Located on line

Change.to.your.
package.name

The name of your package. In our example, 
that would be com.riverbend.chat.branding.

1
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Lightbulb - identifying exceptions in the Eclipse editor
If you are new to Eclipse, you are probably wondering why there is a little light 
bulb and red X box on the left hand side of this code, as shown in Figure 5-33. 
Click the light bulb. 

Figure 5-32   Lightbulb Icon in Eclipse 3.2 class editor

This will display two boxes that show there is an issue with the code, and offers 
possible solutions to correct it. In this case, you are being told that 
getImageDescriptor is not defined in the activator file.

Figure 5-33   getImage descriptor undefined - use the light bulb for possible solutions

"What text you 
want to appear 
when cursor 
hovers"

Replace with the text you want to appear when 
the cursor hovers over the control. In our 
example, the text is “Go to the Website”.

27

"http://The 
Website you 
want to open in 
the browser/"

Replace with the URL of the Web site you 
want to open when the user clicks the control.

31

Replace this 
code

With Located on line
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To correct this issue, do the following:

1. Look in the Package Explorer frame on the left. 

2. Expand the src folder.

3. Expand the plug-in package (under the src folder).

4. Double-click the activator.java file, as shown in Figure 5-34.

Figure 5-34   Selecting activator.java file

This will open the activator.java code.

5. Replace the code that is there with the code shown in Example 5-2.

Example 5-2   Activator.java code

package Change.to.your.package.name;

import org.eclipse.jface.resource.ImageDescriptor;
import org.eclipse.swt.graphics.Image;
import org.eclipse.ui.plugin.AbstractUIPlugin;
import org.osgi.framework.BundleContext;

/**
 * The activator class controls the plug-in life cycle
 */
public class Activator extends AbstractUIPlugin {

// The plug-in ID
public static final String PLUGIN_ID = 

"com.riverbend.chat.branding";
public static Image CHAT_WINDOW_IMAGE;

Note: Again, items bolded in the provided code will need to be changed to 
match your plug-in’s naming schema
196 Extending Sametime 7.5: Building Plug-ins for Sametime



// The shared instance
private static Activator plugin;

/**
 * The constructor
 */
public Activator() {

plugin = this;
}

/*
 * (non-Javadoc)
 * @see 

org.eclipse.ui.plugin.AbstractUIPlugin#start(org.osgi.framework.BundleC
ontext)

 */
public void start(BundleContext context) throws Exception {

CHAT_WINDOW_IMAGE = 
getImageDescriptor("Chat_window_image.gif").createImage();

super.start(context);
}

/*
 * (non-Javadoc)
 * @see 

org.eclipse.ui.plugin.AbstractUIPlugin#stop(org.osgi.framework.BundleCo
ntext)

 */
public void stop(BundleContext context) throws Exception {

CHAT_WINDOW_IMAGE.dispose();
plugin = null;
super.stop(context);

}

/**
 * Returns the shared instance
 *
 * @return the shared instance
 */
public static Activator getDefault() {

return plugin;
} 

    /** 
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     * Returns an image descriptor for the image file at the given 
     * plug-in relative path. 
     * 
     * @param path the path 
     * @return the image descriptor 
     */ 
    public static ImageDescriptor getImageDescriptor(String path) { 
            return 
AbstractUIPlugin.imageDescriptorFromPlugin("com.riverbend.chat.branding
", path); 
    }

public static Image getCHAT_WINDOW_IMAGE() {
return CHAT_WINDOW_IMAGE;

} 

Table 5-5 is a listing of all the changes you should have made to your 
Activator.java code.

Table 5-5   Activator.java code changes needed.

6. Select File → Save.

7. Close the Activator.java and ChatBrandingArea.java tabs.

That’s it! You are now ready to test your plug-in. You can either test it now by 
skipping ahead to 5.5, “How to test your branding plug-in” on page 210 or you 
can add the Hub Branding Plug-in first.

Replace this code With Located on line

Change.to.your.package.
name

The name of your package. 
In our example, that would 
be 
com.riverbend.chat.brandi
ng.

1

Chat_window_image.gif The name of your chat 
window image.

33

Hub_window_image.jpg The name of your hub 
window image.

34
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5.4.3  Creating a hub branding plug-in

In this section, you will see how to create a hub window branding that, when 
clicked, will open the user’s e-mail client, create a new memo with a subject, a 
Body portion, and an address to mail it to. You can extend it further to pass on the 
user’s credentials and direct them to any program on the desktop or any 
back-end system. There are a many possibilities here that you can explore.

1. If your Eclipse Workspace is not open to your Sametime Plug-in Development 
environment, open that now.

2. Select the Extensions tab, as shown in Figure 5-35.

Figure 5-35   Displaying the Extensions tab

Note: You will only be able to see this change in your own Sametime client as 
you test through Eclipse. You have only created the plug-in. You must now 
deploy it for users to see it. For information about how to deploy plug-ins, see 
Chapter 12, “Deploying plug-ins for Sametime 7.5” on page 525.

Hint: If you cannot find the Extension tab (it is not where it was last 
displayed), double-click the Manifest file in the Package Explorer 
perspective to display it.
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� In the All Extensions pane, right-click the 
com.ibm.collaboration.reatime.ui.stbranding extension.

� Choose New → stbranding, as shown in Figure 5-36.

Figure 5-36   Selecting stbranding element

This will place a new extension element under your Extension.

3. Define the element property details, as shown in Figure 5-37 on page 201:

a. Change the id to com.riverbend.sametime.branding.hub.

b. Change the name to Hub Branding.

c. Change the targetView to com.ibm.collaboration.realtime.imhub.

• Hub Window (Buddy List) Top: A maximum of 256 w x 26 h Pixels

• Hub Window (Buddy List) Bottom: A maximum of 256 w x 32 h Pixels

d. Choose to align to the top or bottom of the window.

4. Select File → Save.
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Figure 5-37   New extension element

5. Display the All Extensions pane and right-click the element you created for 
hub (in this example called Hub Branding).

6. Select New → Control, as shown in Figure 5-38.

Figure 5-38   Creating a new control
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7. You will see a new properties entry under the Hub Branding element. Click the 
new entry.

8. On the right side of the frame, you will now see the Extension Element Details 
pane. Click the word Class (Figure 5-39). This will create a new class for your 
plug-in control.

Figure 5-39   Creating a new class
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9. In the Create Class window that opens, give the class a name. The example 
uses HubBrandingArea, as shown in Figure 5-40.

Figure 5-40   Naming the HubBrandingArea class

Important: Be sure you are not naming this class with a protected name, 
for example, Stbranding.
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10.Leave all other fields as the default and click Finish.

You have just created a class (in the example case called HubBrandingArea). 
Note the to do’s are placed in the Class code, as shown in Figure 5-41. These 
are intended to remind you to add your functionality here.

Figure 5-41   To do’s added to the class code

Further modifications for the hub window plug-in
For those of you who like to write your own Java/Eclipse code, this is where it 
gets added to the new class you just created. To see how to test your code, refer 
to 5.5, “How to test your branding plug-in” on page 210”.

For those of you that would prefer to have the Java/Eclipse code provided, 
continue on from this point.

Considerations for the modifications
There are a few things you need to consider before creating your Java/class 
code, as well as a few things you need to create for required functionality.

� Required

– Create the control.

– Properties of the control.

– Which image will be used.

� Optional

– Will there be tool tips or help when the cursor hovers over the branding 
area?

– Should the cursor change to prompt users?
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– What will the control do? This one is important to evaluate. The purpose of 
using the control element is to have the branded area “do something” 
when the user clicks it. What that something is entirely up to you and your 
imagination. In this example, the click will perform the simple task of 
creating a new memo with a subject, a Body portion, and an address to 
mail it to. A Control can do virtually anything your capable of coding. There 
are a few examples/ideas in chapters later in this book, for example, have 
the control call to a Web service.

Now that we have given some thought to what we want the control to do, let us 
have a look at some finished code that will:

� Display the image “Large_Banner_Get_help.gif” that will be used in the 
control area.

� Change the cursor to a hand when over the control area.

� Display the tool tip “Get Sametime Help” when the cursor hovers over the 
control area.

The following classes are used in the creation of this code. For more information 
about these classes and their methods, please refer to http://www.eclipse.org.

� org.eclipse.swt.events.MouseEvent

� org.eclipse.swt.layout.GridData

� org.eclipse.swt.layout.GridLayout

� org.eclipse.swt.program.Program

� org.eclipse.swt.widgets.Composite

� org.eclipse.swt.widgets.Control

� org.eclipse.swt.widgets.Label

Example 5-3   Example code for creating HubBrandingArea class 

package Change.to.your.project.name;

import org.eclipse.swt.SWT;
import org.eclipse.swt.events.MouseAdapter;
import org.eclipse.swt.events.MouseEvent;
import org.eclipse.swt.layout.GridData;
import org.eclipse.swt.layout.GridLayout;
import org.eclipse.swt.program.Program;

Note: The code in Example 5-3 on page 205 can be pasted directly into 
your class code; however, you will need to change some text to match your 
naming schema. These items will appear in BOLD.
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import org.eclipse.swt.widgets.Composite;
import org.eclipse.swt.widgets.Control;
import org.eclipse.swt.widgets.Label;

import com.ibm.collaboration.realtime.ui.STBrandingArea;

public class HubBrand extends STBrandingArea {
public Control createControl(Composite parent) { 

        Composite comp = new Composite(parent, SWT.NONE); 
        comp.setBackground(parent.getBackground()); 
        GridLayout gl = new GridLayout(); 
        gl.marginHeight = 0; 
        gl.marginWidth = 0; 
        comp.setLayout(gl); 
        Label label = new Label(comp, SWT.NONE); 
        label.setLayoutData(new 
GridData(GridData.HORIZONTAL_ALIGN_CENTER | 
GridData.VERTICAL_ALIGN_CENTER)); 

        label.setImage(Activator.HUB_WINDOW_IMAGE);
        label.setToolTipText("Get Sametime Help"); 
        
label.setCursor(label.getDisplay().getSystemCursor(SWT.CURSOR_HAND)); 
        label.addMouseListener(new MouseAdapter() { 
                public void mouseUp(MouseEvent e) { 
                     Program.launch(
                     "mailto:Sametime.Helpdesk@riverbend.com" +
                     "?Subject=I am having an issue with...." +
                     "?Body=Hello. I am having problems with the ______ 
area of Sametime.");                                                     
                } 
        }); 
        return comp; 
}

} 

Table 5-6 on page 207 is a listing of all the changes you should have made to 
your HubBrandingArea class code.
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Table 5-6   HubBrandingArea class code changes

If you created the Chat Brand from the previous section and already changed the 
Activator.java code, you are finished. Select File → Save, and then skip to 5.5, 
“How to test your branding plug-in” on page 210. If you did not create the Chat 
Brand from the previous section, continue on from this point.

If you are new to Eclipse, you are probably wondering why there is a little light 
bulb and red X box on the left hand side of this code. Click the light bulb and 
leave the cursor still (do not move it after the click). This will display two boxes 
that show there is an issue with the code, and offers possible solutions to correct 
it. In this case, you are being told that getImageDescriptor is not defined in the 
activator file.

To correct this issue, do the following:

1. Look in the Package Explorer frame on the left. 

2. Expand the src folder.

3. Expand the plug-in package (under the src folder).

Replace this code With Located on 
line

Change.to.your.pro
ject.name

The name of your package. In our example 
that would be com.riverbend.chat.branding.

1

“Get Sametime 
Help”

The text you want to appear when the cursor 
hovers over the control area.

27

Sametime.Helpdesk@
riverbend.com

The e-mail address you want to send the 
note to.

32

“I am having an 
issue with....”

The Subject you want to place in the e-mail 
Subject field.

33

“Hello. I am 
having problems 
with the ______ 
area of Sametime."

Any predetermined text you want to appear 
in the body of the e-mail.

34
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4. Double-click the activator.java file, as shown in Figure 5-42.

Figure 5-42   Selecting activator.java

This will open the activator.java code.

5. Replace the code that is there with the code shown in Example 5-4.

Example 5-4   com.riverbend.sametime.branding package

package com.riverbend.sametime.branding;

import org.eclipse.jface.resource.ImageDescriptor;
import org.eclipse.swt.graphics.Image;
import org.eclipse.ui.plugin.AbstractUIPlugin;
import org.osgi.framework.BundleContext;

/**
 * The activator class controls the plug-in life cycle
 */
public class Activator extends AbstractUIPlugin {

// The plug-in ID
public static final String PLUGIN_ID = 

"com.riverbend.chat.branding";
public static Image CHAT_WINDOW_IMAGE;
public static Image HUB_WINDOW_IMAGE;

// The shared instance

Note: If you did not do the chat window branding section prior to this, you 
will need to remove the lines in Bold from your code. If you did do the prior 
step you will only need to change the name of the two image files to match 
the name of your images
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private static Activator plugin;

/**
 * The constructor
 */
public Activator() {

plugin = this;
}

/*
 * (non-Javadoc)
 * @see 

org.eclipse.ui.plugin.AbstractUIPlugin#start(org.osgi.framework.BundleC
ontext)

 */
public void start(BundleContext context) throws Exception {

CHAT_WINDOW_IMAGE = 
getImageDescriptor("Images/rb_logo_64x64px.gif").createImage();

HUB_WINDOW_IMAGE = 
getImageDescriptor("Images/Large_Banner_Get_help.jpg").createImage();

super.start(context);
}

/*
 * (non-Javadoc)
 * @see 

org.eclipse.ui.plugin.AbstractUIPlugin#stop(org.osgi.framework.BundleCo
ntext)

 */
public void stop(BundleContext context) throws Exception {

CHAT_WINDOW_IMAGE.dispose();
HUB_WINDOW_IMAGE.dispose();
plugin = null;
super.stop(context);

}

/**
 * Returns the shared instance
 *
 * @return the shared instance
 */
public static Activator getDefault() {

return plugin;
} 
 Chapter 5. Introduction to building a plug-in: modifying the UI 209



    /** 
     * Returns an image descriptor for the image file at the given 
     * plug-in relative path. 
     * 
     * @param path the path 
     * @return the image descriptor 
     */ 
    public static ImageDescriptor getImageDescriptor(String path) { 
            return 
AbstractUIPlugin.imageDescriptorFromPlugin("com.riverbend.chat.branding
", path); 
    }

public static Image getCHAT_WINDOW_IMAGE() {
return CHAT_WINDOW_IMAGE;

} 

6. Select File → Save.

That’s it! Your finished creating the Hub Branding portion of your plug-in.

Now you need to test. 

5.5  How to test your branding plug-in

Now that you have created a Sametime 7.5 plug-in, you will want to test it before 
deploying it. Testing is done through your Eclipse 3.2 environment, but to do this, 
you will need to create a launch configuration. The launch configuration is used 
to run or debug the plug-ins using the Lotus Sametime Connect target platform 
you created when you set up the IDE.

Follow the steps below to create a launch configuration.

1. If Eclipse is not already running, start Eclipse. Be sure to choose the same 
workplace directory you created and configured for Sametime plug-ins.

2. In the Plug-in Development perspective, select Run → Run… in order to 
configure the runtime environment.

3. Select Eclipse Application from the configuration list.

Note: You will only be able to see this change in your own Sametime client as 
you test through Eclipse. You have only created the plug-in. You must now 
deploy it for users to see it. For information about how to deploy plug-ins, see 
Chapter 12, “Deploying plug-ins for Sametime 7.5” on page 525.
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4. Click the New icon (the leftmost icon above the configuration list). You can 
also just double-click Eclipse Application from the configuration list.

5. In the Name field replace, the default configuration name with a new one, for 
example, ST Branding, or ST 7.5.

6. In the Location field, replace the default location with a new workspace, for 
example, ${workspace_loc}/../STconfiguration.

7. In the Program to Run section, click the Run an Application radio button.

8. If necessary, click the drop-down arrow and select 
com.ibm.collaboration.realtime.application.RTCApplication.

9. If necessary, click the drop-down arrow next to the Runtime JRE field and 
select the J9 JCL Desktop run time configuration you created earlier (JCL 
Desktop or what you named it).

Note: The workspace you specify here is the one that Lotus Sametime 
Connect will use to store product settings when you launch it from Eclipse. 
This is not the same workspace that Lotus Sametime Connect uses when you 
launch it outside of the Eclipse IDE. 

You should not select the same workspace directory that you are using for 
Eclipse configuration settings (the one you selected in previous steps). If you 
select the Clear workspace data before launching option, all IM client 
settings stored in the Lotus Sametime Connect workspace you specify above 
(C:\eclipse32\eclipse\runtime-workspace) will be discarded whenever you 
launch this configuration.
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Figure 5-43 shows the Main tab of the new configuration window.

Figure 5-43   Creating a new launch configuration

10.Select the Arguments tab and enter the following in the VM arguments field 
(not the Program arguments field):

-Xint -Xtrace:none -Xgcpolicy:gencon -Djava.home=<JRE_HOME>
-Dcom.ibm.pvc.webcontainer.port=7777

<JRE_HOME> is the location of the J9 JCL Desktop run time environment on the 
Lotus Sametime 7.5 SDK.

Note: This is one continuous line of text
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Figure 5-44   Example of VM arguments

For example: If the SDK (for Windows) is installed in c:\st75sdk, the VM 
arguments field should contain the following (which is one continuous line 
of text):

-Xint -Xtrace:none -Xgcpolicy:gencon 
-Djava.home=C:\st75sdk\client\connect\j9-runtime\win32 
-Dcom.ibm.pvc.webcontainer.port=7777

Figure 5-44 shows this code entered into the VM arguments field.

Linux only: 

� Select the Environment tab and create a new environment variable called 
MOZILLA_FIVE_HOME. 

� The value of the variable should be the path where Mozilla is installed on 
your machine, for example, /usr/lib/mozilla-1.7.13.
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11.Select the Plug-ins tab.

12.Click the radio button beside Choose fragments and plug-ins to run from 
the list.

13.Make sure all plug-ins you wish to test are selected under the Workspace 
Plug-ins section. You may or may not want to test all plug-ins simultaneously.

The tab should look like Figure 5-45.

14.Click Apply to save your changes, and then click Run to launch the 
configuration.

Figure 5-45   Selecting plug-ins to test

This should cause your Sametime Connect client to launch from the development 
environment with the plug-ins you chose to include/test.

To run the plug-ins in debug mode, use Run → Debug… to launch the 
configuration.
214 Extending Sametime 7.5: Building Plug-ins for Sametime



Chapter 6. Leveraging Web services 
and building a calendar 
lookup plug-in for Sametime 
Connect

In this chapter, we discuss the use of Web services within a plug-in, and show an 
example of a calendar lookup Web service integrated into a IBM Lotus Sametime 
Connect plug-in, enabling users to look up the calendar details for someone in 
their contact list from within the Sametime Connect client.

We cover the following topics:

� Using Eclipse tooling to create a Web service client

� Using a Web service client in a plug-in

� Creating the calendar lookup plug-in

� Extending this plug-in

6

© Copyright IBM Corp. 2007. All rights reserved. 215



Attention: The sample code used within this chapter can be downloaded from 
the Redbooks FTP site. Please refer to Appendix A, “Additional material” on 
page 557 for detailed instructions on how to download and deploy the code 
sample:

ftp://www.redbooks.ibm.com/redbooks/SG247346

Important: While the sample code for this example is provided for download, 
keep in mind that there are specific parameters - unique to your organization - 
that need to be used in order to test this functionality in your environment. If 
you wish to deploy this plug-in for use in your organization, you will most likely 
need to work with your server administration team to review specific 
parameters and security requirements. 

We recommend using this example as a baseline and framework on how to 
develop a useful plug-in that utilizes Web services. Once you understand the 
key concepts and the approach, you can leverage many additional Web 
services that may be particularly useful to your organization. 
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6.1  Overview of the plug-in

In the current push towards Service Oriented Architectures (SOA), the ability to 
make use of Web services within plug-ins becomes more important. In this 
chapter, we show how to leverage Web services within the Sametime Connect 
client. In particular, we leverage a custom Web service to perform calendar 
lookups from within the Sametime Connect client.

6.1.1  Using the calendar lookup plug-in

Figure 6-1 shows the calendar lookup plug-in.

Figure 6-1   Using the calendar lookup plug-in

The calendar lookup plug-in enables a user to retrieve the calendar details for 
someone in their contact list without leaving the Sametime Connect client. It 
works for both online and offline contacts, giving additional clues as to the 
contact’s whereabouts and availability. A user can right-click the contact’s name 
in their buddy list and is presented with a pop-up window containing details of 
that user’s calendar entries for the current day. Details include the calendar entry 
type, start time, end time, and subject.
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6.1.2  Value to the user 

The ability to use Web services within a plug-in opens up a myriad of 
possibilities. The current buzz around Web services-based Service Oriented 
Architectures means more and more enterprise functionality will be exposed 
through a Web services interface.

6.1.3  Value to the developer

The value to the developer here is the “how-to” of integrating with Web services. 
We use free, standards-based Eclipse tooling to generate a Web service client, 
then show how to call it from within a Sametime Connect plug-in. We also show 
how to create an Eclipse-based user interface to display the calendar lookup 
results.

6.2  Using Eclipse tooling to create a Web service client

The Eclipse Web Tools Platform (WTP) project 
(http://www.eclipse.org/webtools/) extends the Eclipse platform with tools for 
developing Java Enterprise Edition and Web applications. Of special interest to 
us are tools to develop Java Web services and Web service clients. These tools 
come from the Apache Axis project, an open-source Java Web services toolkit 
(read more about it at http://ws.apache.org/axis/).

The Eclipse WTP project was one of ten projects involved in the Callisto 
Simultaneous Release in June 2006 (http://www.eclipse.org/callisto/).

6.2.1  Installing the Web Tools Platform

Follow these instructions to install the WTP using the Eclipse Update Manager. 

1. Select Help → Software Updates → Find and Install....

2. Select the Search for new features to install radio button, then click Next.
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3. You should see the Callisto Discovery Site in the list of update sites to visit, as 
shown in Figure 6-2. Select it, and then click Finish.

Figure 6-2   Eclipse Update Manager

Eclipse queries the Callisto Discovery Site to discover which features are 
available for you to install. 

Note: For most distributions of Eclipse, there should already be a Callisto 
Discovery Site defined in its Update Manager. If you do not see it you can try 
adding the URL (http://download.eclipse.org/callisto/releases/) as a 
remote update site in your Update Manager.
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4. When the search results display, expand the Callisto Discovery Site item 
and select the Web and J2EE Development feature, as shown in Figure 6-3.

Figure 6-3   Installable features from Callisto Discovery Site

Note the warning at the top of the dialog (Figure 6-3) that the Web and J2EE 
Development feature is dependent on a number of other features. 

5. Click the Select Required button to select the other features we need, and 
then click Next. 

6. Accept the license agreement, and then click Next. 

7. An information dialog displays which lists the features that are about to be 
installed. Click Finish. 

The Update Manager will now download the requisite plug-ins and install 
them into Eclipse. This is a fairly large download, so it will take a few minutes.

8. After the download has completed, the installation will begin. You may be 
prompted by Eclipse about feature verification to confirm that the feature you 
are about to install has not been digitally signed. Figure 6-4 on page 221 
shows the Verification window.
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You can ignore this prompt and click Install All.

Figure 6-4   Feature Verification

9. Click Yes when prompted to restart the workbench. 

10.After Eclipse has restarted, select Window → Preferences... to open the 
Preferences dialog. 
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You will see that a number of new entries have been created, including one for 
Web Services as shown in Figure 6-5.

Figure 6-5   Eclipse Preferences

6.2.2  Creating a Web service client

We are going to use the WTP tooling to create a client for a currency converter 
Web service hosted by XMethods (http://www.xmethods.net), a site that lists 
publicly available Web services. The WTP tooling allows us to specify the URL of 
a Web Services Definition Language (WSDL) file, and it will generate the Java 
classes for the Web services client.

We start by creating a new Java project to house our Web service client. 

1. From the menu bar, select File → New → Project → Java Project, and then 
click Next. 

2. Give the project a meaningful name and click Finish. 

3. If prompted to change perspectives, click No, as we can do all we need to do 
from the PDE perspective.
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4. To create our Web service client, right-click the project name and select 
New → Other... → Web Services → Web Service Client and click Next, as 
shown in Figure 6-6.

Figure 6-6   Creating a new Web Service Client

5. In the Enter a URL to a WSDL, WSIL or HTML document field, click 
Browse.... 
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6. Enter the URL for the Web services’ WSDL file in the top field, as shown in 
Figure 6-7. In our case, we can find this from the XMethods site.

Figure 6-7   Add the URL of the Web service’s WSDL file

7. Since there is only one WSDL available to select, click OK. 
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8. Make sure the Client type is set to Java Proxy, and the slider is set to the 
lowest value, Develop client, as shown in Figure 6-8.

Figure 6-8   Web service client details

9. Click Finish.

The wizard interrogates the Web services’ WSDL file and generates Java 
classes to act as a client. You may see some warnings in the Java files generated 
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by the wizard. It is safe to let Eclipse’s Quick Fix mechanism take care of these, 
as shown in Figure 6-9.

Figure 6-9   Eclipse’s Quick Fix mechanism

We can now write a simple Java class that makes use of the code created by the 
wizard to interact with the Web service. 

1. Right-click the package name in the project and select New → Class.

2. Enter the class name

3. In the Which method stubs would you like to create? section, select

� public static void main(String[] args)

� Inherited abstract methods

as shown in Figure 6-10 on page 227.
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Figure 6-10   Create a class to test the Web service client

This particular Web service takes two parameters: 

� The country of the currency to convert from

� The country of the currency to convert to 

The Web service calculates the equivalent of one unit of currency A in currency 
B. Example 6-1 shows the code to do this.

Example 6-1   The WebServiceClient class that calls the Web service

package net.xmethods.www.sd.CurrencyExchangeService_wsdl;

import java.rmi.RemoteException;

import javax.xml.rpc.ServiceException;

public class WebServiceClient
{
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/**
 * @param args
 */
public static void main(String[] args)
{

try
{

CurrencyExchangeServiceLocator locator = new 
CurrencyExchangeServiceLocator();

CurrencyExchangePortType service = 
locator.getCurrencyExchangePort();

String country1 = "uk";
String country2 = "us";
System.out.println(service.getRate(country1, country2));

}
catch (ServiceException se)
{

se.printStackTrace();
}
catch (RemoteException re)
{

re.printStackTrace();
}

}

}

We need to change the default JRE before we can test our client. 

1. Select Window → Preferences... → Java → Installed JREs. 
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2. Deselect the JCL Desktop and select the full JRE, as shown in Figure 6-11, 
and then click OK.

Figure 6-11   Add the full JRE to the project’s build path
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3. Right-click the test class and select Run As → Java Application. 

You will see the result of the call to the Web service in the Console view, as 
shown in Figure 6-12.

You can also see in Figure 6-12 that at this particular moment, one Pound 
Sterling was worth 1.8652 US dollars.

Figure 6-12   The output from running the WebServiceClient class

When the Web service client is successfully calling the Web service, we can 
switch the default JRE back to the JCL Desktop.

6.3  Using a Web service client in a plug-in

We will now take the classes created by the Web service client wizard and use 
them within a Sametime Connect plug-in. To do this, we need to export the 
classes as a jar file and then import the jar file into the plug-in.

1. Right-click the package and select Export... → Java → JAR file.
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Figure 6-13   Select JAR file as the Export type

2. Select just the top-level package, and make sure the Export generated class 
files and resources option is checked. 
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3. Specify an export destination, for example, c:\webserviceclient.jar, and then 
click Finish (see Figure 6-14).

Figure 6-14   JAR file specification

We now have a JAR file containing classes that can be used to communicate 
with the Web service. The next step is to incorporate these classes into a 
Sametime Connect plug-in.

6.3.1  Creating the plug-in project and plug-in

We need to create a new plug-in project to house our new plug-in, and a new 
folder within the plug-in project to hold the Web service client jar file. 

1. Select File → New → Project → Plug-in Project. 

2. Enter a meaningful project name (for example, Web Service Client Plug-in), 
and then click Next. 
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3. We are not going to make any contributions to the core Eclipse UI, so we can 
deselect the This plug-in will make contributions to the UI option, and then 
click Finish.

Figure 6-15   Plug-in project details

6.3.2  Importing the Web service client JAR

In order to use the Web service client JAR in our plug-in, we need to import it into 
our project. 

1. Right-click the project and select New → Folder. 

2. For convenience, call the folder lib. 

3. To add the JAR file, right-click the new folder and select Import... → File 
System. 

4. Find the JAR file you exported in the last section and click Finish. 

Figure 6-16 on page 234 shows the project after the JAR file has been 
imported.
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Figure 6-16   Plug-in project following import of JAR file

6.3.3  Calling the Web service from the plug-in

In order to use the classes within the Web service client JAR file in our plug-in, 
we need to add the JAR file to the plug-in’s build path. 

1. Open the Runtime tab in the plug-in manifest and locate the Classpath area 
in the bottom right corner. 

2. Click Add... and select the Web service client JAR file from the previous step. 

3. Make sure the Update the build path option is checked, so the JAR file gets 
added to the plug-in’s build path as well.

Figure 6-17   Adding the Web service client JAR file to the plug-in’s classpath

Figure 6-18 on page 235 shows the Classpath list after the client JAR file has 
been added.
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Figure 6-18   Plug-in’s Classpath settings

Now that the JAR file is on the plug-in’s build path, we can use the classes within 
it to call the Web service from our plug-in. We will add a button to the Sametime 
Connect client’s toolbar that calls the Web service and displays the result in a 
dialog box.

We start by adding an extension to the Connect toolbar. 

1. In the plug-in’s manifest file, click the Extensions tab and add the 
org.eclipse.ui.viewActions extension point. 

2. Our plug-in does not already have the org.eclipse.ui plug-in set as a 
dependency. Click Yes when prompted to add it to the list, as shown in 
Figure 6-19.

Figure 6-19   New plug-in dependency prompt

3. Add a new viewContribution extension element, and make sure to set the 
targetID property to be com.ibm.collaboration.realtime.imhub, otherwise the 
action will not appear in the toolbar.

4. Add a new action extension element, set the toolbarPath property to an 
appropriate value (see 4.3.2, “Adding an action to the Tool Bar” on page 82 
for more details), and choose an icon to display in the toolbar. You may need 
to import one into the project if you have not already done so.

Note: The following section assumes you have read and are familiar with 
4.3.2, “Adding an action to the Tool Bar” on page 82.
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5. Our class needs to extend the 
com.ibm.collaboration.realtime.imhub.actions.BuddyListAction class, so we 
need to add the com.ibm.collaboration.realtime.imhub plug-in as a 
dependency. 

Go to the Dependencies tab and add the imhub plug-in to the list.

While we are adding plug-in dependencies, now is a good time to add the 
classes that the Web service client JAR file needs in order to function. 

We noted earlier that Eclipse WTP uses the Apache Axis toolkit to help it create 
the Web service client classes. The Web service client classes that were created 
rely on parts of the Apache Axis toolkit to handle the communication with the 
Web service. Fortunately for us, Sametime Connect includes the Apache Axis 
classes we need in a plug-in that is shipped with the client, org.apache.axis. 
Adding this plug-in to our dependencies list is all that is needed to utilize the Web 
service client classes within our plug-in. 

Figure 6-20 shows the plug-in dependencies list after we have added the 
com.ibm.collaboration.realtime.imhub and org.apache.axis plug-ins.

Figure 6-20   Updated list of plug-in dependencies

1. Click the class link to create the action’s class file.

2. Select the correct package.

3. Enter the class name.

4. Remove the default interface. 

5. Add the Superclass 
com.ibm.collaboration.realtime.imhub.actions.BuddyListAction.
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6. Deselect the option to implement Inherited abstract methods; we only need to 
override the superclass’ run() method.

In the run() method, we use the Web service client classes in the JAR file to 
call the Web service, and display the results in a JFace dialog box, as shown 
in Example 6-2.

Example 6-2   WebServiceActionDelegate’s run() method

public void run()
{

try
{

CurrencyExchangeServiceLocator locator = new 
CurrencyExchangeServiceLocator();

CurrencyExchangePortType service = 
locator.getCurrencyExchangePort();

String country1 = "uk";
String country2 = "us";

String exchangeRate = new Float(service.getRate(country1, 
country2)).toString();

MessageDialog.openInformation(null, "XMethods Web service 
plugin", "The exchange rate for US to UK is currently\n" + 
exchangeRate);

}
catch (RemoteException e)
{

e.printStackTrace();
}
catch (ServiceException e)
{

e.printStackTrace();
}

}
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7. Select Run → Run to launch the run time workspace.

A new icon is added to the toolbar, as shown in Figure 6-21.

Figure 6-21   Sametime Connect client showing new toolbar item

8. Click the icon to invoke our action’s run() method, which calls the Web service 
and displays the results in a dialog box, as shown in Figure 6-22.

Figure 6-22   Result of invoking the Web service
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6.4  Creating the calendar lookup plug-in

This next section describes the construction of a calendar lookup plug-in. When 
a user right-clicks a buddy’s name in their contact list, a pop-up window displays 
the user’s calendar entries for the current day, as shown in Figure 6-23.

Figure 6-23   Calendar lookup plug-in showing buddy’s calendar details

Why is this useful? Maybe you would like to make sure that someone is not in a 
meeting before you send them a message. Or, you may have already sent them a 
message, and are wondering why they have not replied. If your contact is offline, 
you may be wondering where they are and if are they likely to be available at 
some point later in the day.

A calendar lookup plug-in could help in all of these scenarios.
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6.4.1  The calendar lookup Web service

For the purposes of this sample, we developed a calendar lookup Web service, 
using the built-in Web service capabilities of IBM Lotus Domino 7. We created a 
native Web service design element that takes a user’s name as a parameter and 
does the following:

1. Looks up the user in the Domino NAB and ascertains their mail file location

2. Retrieves the user’s calendar entries for the current day

3. For each entry, creates a CalendarEntry object containing the entry type, 
duration, and title

4. Returns an array of CalendarEntry objects inside a CalendarLookup object

The WSDL of the calendar lookup Web service is used in the creation of a Web 
service client, which in turn is used by a custom plug-in.

6.4.2  The calendar lookup plug-in

The calendar lookup plug-in follows the example shown in 4.3.4, “Adding to the 
context (right-click) menu” on page 90. To do this, we:

1. Create a plug-in project and a plug-in, and contribute to the 
org.eclipse.ui.popupMenus extension point. 

2. Specify the com.ibm.collaboration.realtime.livenames.PersonSelection 
interface as our object contribution, so our custom action will apply to the 
context menu of a person in our contact list.

3. Create our Web service client classes in exactly the same way as we did for 
the XMethods currency converter Web service. 

4. Give the Eclipse WTP Web service client wizard the URL of our Domino Web 
service’s WSDL file, and let it take care of constructing the Web service client 
classes for us. 

5. Export the client classes as a JAR file, and then import them in to our plug-in 
project. We need to add the JAR file to the classpath of the plug-in, and add 
the org.apache.axis plug-in to the list of our plug-in’s dependencies, just as 
we did in the currency converter example.

After these pieces are in place, we can begin building the functionality behind our 
plug-in. The plug-in consists of the following classes, each of which is described 
in the following pages:

� Activator: Created during the plug-in project creation, and controls the life 
cycle of the plug-in.
240 Extending Sametime 7.5: Building Plug-ins for Sametime



� CalendarLookupAction: Extends LiveNameActionDelegate, Its run() method 
is called when the menu action is clicked.

� CalendarDetailsWindow: A subclass of SWT Window, it provides the pop-up 
window that holds the Business Card and the table of calendar results.

� CalendarEntryWebServiceLookup: Uses the Web service client code to call 
the calendar lookup Web service.

� CalendarEntryResult: A class to hold individual calendar entries returned 
from the Web service.

� CalendarEntriesContentProvider: The content provider for the JFace 
TableViewer used to display the calendar entries.

� CalendarEntriesLabelProvider: The label provider for the TableViewer.

Activator.java
We modify the Activator class created by the plug-in project wizard to set up an 
image cache to help with the creation and disposal of the images we use in our 
plug-in.

We set up a java.util.HashMap to hold the SWT Image objects created by the 
plug-in, keyed on an ImageDescriptor. 

In the getImage() method, shown in Example 6-3, we take an ImageDescriptor 
as a parameter and check the HashMap for the corresponding Image object. If 
the Image exists, we return it. If it does not, we create it and put it into the 
HashMap before returning it.

Example 6-3   Activator’s getImage() method

/**
 * Check cache for existing Image object, create new Image
 * if none exists already for key
 *
*/
public Image getImage(ImageDescriptor imageDescriptor)
{

if(imageDescriptor == null)
return null;

A note about SWT Image objects: An Image is a Java object that wraps a 
native OS resource and thus must be properly managed. The rule is that if you 
create it, you must dispose of it to prevent memory leaks. Such objects will not 
be automatically managed and disposed of by the Java garbage collector.
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Image image = (Image) imageMap.get(imageDescriptor);
if (image == null)
{

image = imageDescriptor.createImage();
imageMap.put(imageDescriptor, image);

}
return image;

}

The stop() method calls the clearImageCache() method before the plug-in shuts 
down. The clearImageCache() method, shown in Example 6-4, iterates through 
the HashMap, calling the dispose() method of each Image object in the cache.

Example 6-4   Activator’s clearImageCache() method

/**
 * Call dispose() on any Image objects in the cache
 *
*/
public void clearImageCache()
{

Iterator iter = imageMap.values().iterator();
while (iter.hasNext())

((Image) iter.next()).dispose();
imageMap.clear();

}

CalendarLookupAction.java
It is the run() method within this class that is called when the context menu action 
is clicked. We retrieve the com.ibm.collaboration.realtime.people.Person object 
that represents the contact that was selected, and pass it to a new instance of 
the CalendarDetailsWindow class. As shown in Example 6-5 on page 243, we 
then call the open() method of the CalendarDetailsWindow class to launch the 
pop-up window.
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Example 6-5   CalendarLookupAction’s run() method

public void run(IAction arg0)
{

Person persons[] = getSelectedPersons();
Person person = persons[0];
CalendarDetailsWindow detailsWindow = new 

CalendarDetailsWindow(null, person);
detailsWindow.open();

}

CalendarDetailsWindow.java
This class creates the pop-up window that is launched when the menu action is 
clicked, and populates the window with the selected individual’s Business Card 
object and a table containing their calendar entries for the current day.

The createContents() method is used to return an org.eclipseswt.widgets.Control 
object that makes up the user interface of the window. Example 6-6 shows how 
we create the Shell object that holds the user interface, and how we set its size 
and title. We call the image cache managed by the Activator class to return the 
image for the window.

Example 6-6   createContents() method creates the window’s Shell object

final Shell shell = parent.getShell();
shell.setLayout(new FillLayout());
shell.setSize(WIDTH, HEIGHT);
shell.setText("Calendar details for " + person.getDisplayName());
shell.setImage(Activator.getDefault().getImage(Activator.getImageDescri
ptor("images/calendar.gif")));

We then create a new org.eclipse.swt.widgets.Composite object, split it in half 
using an org.eclipse.swt.layout.FillLayout, add the Business Card object to the 
top half, and the table for the calendar entries to the bottom half (see 
Example 6-7).

Example 6-7   Setting up the contents of the window

final Composite comp = new Composite(parent, SWT.NONE);
comp.setLayout(new FillLayout(SWT.VERTICAL));

bizCard = new MyBusinessCard(comp, MyBusinessCard.DIRECTORY_INFO | 
MyBusinessCard.IMAGE | MyBusinessCard.LIVENAME);
bizCard.setPerson(person);

final Table table = new Table(comp, SWT.MULTI | SWT.READ_ONLY);
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final TableLayout layout = new TableLayout();
table.setLayout(layout);
table.setLinesVisible(true);
table.setHeaderVisible(true);

We add columns to the table, setting their title, width, and alignment, as shown in 
Example 6-8.

Example 6-8   Creating the table columns

String[] columnNames = new String[] { "", "Time", "Description" };
int[] columnWidths = new int[] { 18, 90, 302 };
int[] columnAlignments = new int[] { SWT.LEFT, SWT.CENTER, SWT.LEFT };

for (int i=0; i<columnNames.length; i++)
{

TableColumn tableColumn = new TableColumn(table, 
columnAlignments[i]);

tableColumn.setText(columnNames[i]);
tableColumn.setWidth(columnWidths[i]);

}

Finally, we create a new JFace TableViewer object to help with the display of the 
table’s contents. We assign the content provider and label provider to the 
TableViewer before calling its setInput() method with the results from the call to 
the calendar lookup Web service (Example 6-9).

Example 6-9   Creating the JFace TableViewer

final TableViewer calendarTableViewer = new TableViewer(table);
calendarTableViewer.setContentProvider(new 
CalendarEntriesContentProvider());
calendarTableViewer.setLabelProvider(new 
CalendarEntriesLabelProvider());
calendarTableViewer.setInput(new 
CalendarEntryWebServiceLookup(person));

CalendarEntryWebServiceLookup.java
This is the class that handles the communication with the Web service. Its 
constructor is called from the CalendarDetailsWindow class, which passes in the 
Person object whose calendar details we are interested in. We retrieve the String 
representation of the user’s name and call the Web service, as shown in 
Example 6-10 on page 245.
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Example 6-10   Calling the Web service

CalendarLookupServiceElementLocator locator = new 
CalendarLookupServiceElementLocator();
CalendarLookupServicePortType service = 
locator.getCalendarLookupServicePort();

CalendarLookup request = 
service.performCalendarLookup(person.getDisplayName());

From the CalendarLookup object we get back from the Web service, we extract 
the array of CalendarEntry objects that represent individual calendar entries. For 
each calendar entry, we create a CalendarEntryResult object, and then add each 
one to an array, as shown in Example 6-11.

Example 6-11   Unpacking the results from the Web service

CalendarEntry[] resultsArray = request.getCalendarEntries();

if(resultsArray.length == 0)
{

CalendarEntryResult noEntry = new CalendarEntryResult();
noEntry.setTitle("No calendar entries for today");
noEntry.setEntryType("NoDetails");
noEntry.setDuration("");
CalendarEntryResult[] noEntriesArray = { noEntry };
setCalendarEntries(noEntriesArray);

}
else
{

CalendarEntryResult[] lookupResultsArray = new 
CalendarEntryResult[resultsArray.length];

for (int i=0; i<resultsArray.length; i++)
{

CalendarEntry calendarResult = 
(CalendarEntry)resultsArray[i];

CalendarEntryResult proxyResult = new 
CalendarEntryResult();

proxyResult.setTitle(calendarResult.getTitle());
proxyResult.setEntryType(calendarResult.getEntryType());
proxyResult.setDuration(calendarResult.getDuration());
lookupResultsArray[i] = proxyResult;

}
setCalendarEntries(lookupResultsArray);

}
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As mentioned in the previous section, this CalendarEntryWebServiceLookup 
object forms the input for the CalendarDetailsWindow’s TableViewer.

CalendarEntryResult.java
This is a simple class used to hold the values of an individual calendar entry as 
returned from the Web service; it contains the title, duration, and the entry type.

CalendarEntriesContentProvider.java
This class acts as the content provider for the CalendarDetailsWindow’s 
TableViewer object. In the getElements() method it inherits from the 
org.eclipse.jface.viewers.IStructuredContentProvider interface, it returns an array 
of CalendarEntryResult objects from the CalendarEntryWebServiceLookup 
object returned from the Web service (Example 6-12).

Example 6-12   Content provider’s getElements() object

public Object[] getElements(Object inputElement)
{

return ((CalendarEntryWebServiceLookup) 
inputElement).getCalendarEntries();

}

CalendarEntriesLabelProvider.java
This class acts as the label provider for the CalendarDetailsWindow’s 
TableViewer object. It implements two methods from the 
org.eclipse.jface.viewers.ITableLabelProvider interface, getColumnImage() and 
getColumnText(). 

In getColumnImage(), the entry type of the CalendarEntryResult is used to 
determine which icon is used in the table’s first column (whose column index is 
0), to depict what kind of calendar entry it is. The image is pulled from the image 
cache in the Activator class by calling its getImage(ImageDescriptor) method 
(see Example 6-13).

Example 6-13   CalendarEntriesLabelProvider’s getColumnImage() method

public Image getColumnImage(Object element, int columnIndex)
{

switch (columnIndex)
{

case 0:
if(((CalendarEntryResult) 

element).getEntryType().equalsIgnoreCase("NoDetails"))
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return 
Activator.getDefault().getImage(Activator.getImageDescriptor("images/no
details.gif"));

if(((CalendarEntryResult) 
element).getEntryType().equalsIgnoreCase("Appointment"))

return 
Activator.getDefault().getImage(Activator.getImageDescriptor("images/ap
pointment.gif"));

if(((CalendarEntryResult) 
element).getEntryType().equalsIgnoreCase("Anniversary"))

return 
Activator.getDefault().getImage(Activator.getImageDescriptor("images/an
niversary.gif"));

if(((CalendarEntryResult) 
element).getEntryType().equalsIgnoreCase("AllDayEvent"))

return 
Activator.getDefault().getImage(Activator.getImageDescriptor("images/al
ldayevent.gif"));

if(((CalendarEntryResult) 
element).getEntryType().equalsIgnoreCase("Meeting"))

return 
Activator.getDefault().getImage(Activator.getImageDescriptor("images/me
eting.gif"));

if(((CalendarEntryResult) 
element).getEntryType().equalsIgnoreCase("Reminder"))

return 
Activator.getDefault().getImage(Activator.getImageDescriptor("images/re
minder.gif"));

else
return null;

}
return null;

}
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In getColumnText(), the text values for the calendar entry’s duration and title are 
pulled from the CalendarEntryResult object (see Example 6-14).

Example 6-14   CalendarEntriesLabelProvider’s getColumnText() method

public String getColumnText(Object element, int columnIndex)
{

switch (columnIndex)
{

case 1:
return (((CalendarEntryResult) element).getDuration());

case 2:
return ((CalendarEntryResult) element).getTitle();

}
return "";

}

6.5  Extending this plug-in

There are a number of ways that this calendar lookup plug-in could be extended:

� Calendar details for multiple contacts: The Web service could be improved to 
accept multiple contact names, and could return multiple 
CalendarEntryWebServiceLookup objects. We would need to change the 
CalendarLookupAction class to retrieve the names of all those contacts 
selected, not just the first.

� Free time lookup for one or multiple contacts: Functionality could be added to 
the Web service to do a free time lookup for contacts in the contact list. In a 
Domino environment, this could be done by utilizing the freeTimeSearch() 
method of the Session class in Java, or the FreeTimeSearch method in the 
LotusScript NotesSession class.

� Creating calendar entries: An extension of this idea is to modify the Web 
service to actually create calendar entries in a contact’s mail file, perhaps 
using free time search results as a starting point.

� Scheduling an online meeting: The Sametime Online Meeting Toolkit is a new 
feature of Sametime 7.5, and provides Web service-like functionality that can 
be used to create, update, delete, and search for meetings on a Sametime 7.5 
server. Again, the meeting parameters could be determined based on the 
contact’s retrieved calendar availability.
248 Extending Sametime 7.5: Building Plug-ins for Sametime



Chapter 7. Advanced plug-in example: 
The Sametime Server 
Statistics Plug-in

This chapter examines the development of a Sametime plug-in that allows a 
Sametime administrator to monitor several Sametime servers in real time. The 
plug-in makes use of the new Sametime Monitoring and Statistics toolkit and 
allows the user to view and sort on a variety of useful statistics. The data is 
displayed in graph format to showcase the possibilities for creating a professional 
and useful user interface for your back-end data.

The chapter is broken down into the following topics:

� Plug-in overview

� Create the servlet

� Create the plug-in

� Extension Ideas

7
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Attention: All sample code used within this chapter can be downloaded from 
the IBM Redbooks FTP site. Please refer to Appendix A, “Additional material” 
on page 557 for detailed instructions on how to download and deploy the code 
sample:

ftp://www.redbooks.ibm.com/redbooks/SG247346
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7.1  Overview of the Sametime Server Statistics plug-in

As described in the chapter introduction, the Sametime Server Statistics plug-in 
will allow the user to monitor multiple Sametime servers. An example of the UI is 
shown in Figure 7-1. 

Figure 7-1   An overview of the Sametime Server Statistics plug-in to be developed in this 
example

Users will configure their plug-in by accessing it from the Sametime connect 
client’s File → Preferences menu. They will then enter their server’s fully 
qualified DNS name, along with a Sametime administrator username/password 
pair. This information will be stored on the user's machine in a properties file. The 
username/password will be Base64 encoded in the properties file to help provide 
a measure of security.
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The user can monitor their server with a plug-in by accessing statistics made 
available on the Sametime server via servlets. The Sametime statistics servlet is 
a new addition in Sametime 7.5 and allows a user to programmatically access 
and retrieve statistical information in XML format. The plug-in will query this 
servlet and then parse the returned XML using the Document Object Model 
(DOM). The Sametime stlogserv servlet is a custom servlet created as a part of 
this exercise. This servlet gathers the statistical history from the Sametime log 
database (stlog.nsf) and converts the data into JFreeCharts for display inside the 
plug-in. 

The plug-in demonstrates not only how extension points in the Sametime 
connect client can be utilized, but gives an interesting view into what can be done 
with any system that can output information in XML format.

7.1.1  Downloading and deploying the application

To get a more detailed look at the overall architecture of this example application, 
including the source code for the custom servlet and Sametime Connect plug-in, 
please review Appendix A, “Additional material” on page 557. Deploy the custom 
stlogserv servlet on your Sametime Server. This servlet will gather statistics from 
the Sametime log database and create JFreeChart graphs from the results.

Deploy the servlet on your Sametime Server:

1. Ensure that your Domino server is stopped.

2. The stlogserv.class is the compiled version of the stlogserv.java file (more 
information about this later). You will need to place stlogserv.class in your 
<Sametime Install directory>\Data\Domino\Servlet directory, for example, 
C:\Lotus\Domino\Data\Domino\Servlet.

Attention: The J9 virtual machine (J9 VM) is a slimmed down version of the 
1.4.2 Java runtime environment (JRE) so you may encounter issues when 
utilizing a toolkit that references classes not fully supported by the J9 JVM. For 
example, the JFreeChart API requires AWT classes not included in the J9 VM. 
The Sametime Server Statistics plug-in works around this issue by performing 
the necessary JFreeChart functions in a custom servlet located on the 
Sametime server itself, which can run with the full 1.4.2 JRE. The resulting 
graphs are then accessed and displayed by the client side plug-in. Refer to 
2.6, “J9 JCL Desktop” on page 32 for more information about the J9 VM.

Attention: The code provided and discussed in this example is available for 
download. Please refer to Appendix A, “Additional material” on page 557 for 
detailed instructions on how to download the sample code. 
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3. Unzip jcommon-1.0.5.jar and jfreechart-1.0.2.jar to your Sametime server’s 
Domino servlet directory, for example, C:\Lotus\Domino\Data\Domino\Servlet.

4. Domino looks at a file called servlet.properties when its HTTP process starts 
up to see if it needs to load any servlets into memory. Locate 
servlet.properties and open it with Notepad. The properties file can be found 
in your Domino data directory, for example, C:\Lotus\Domino\Data.

5. Search for the line that begins with servlets.startup=. Change it to the 
following:

servlets.startup= stlogserv

6. Save and close the servlets.properties file. 

7. Locate notes.ini and open it with Notepad. The notes.ini file can be found in 
your Domino directory, for example, C:\Lotus\Domino.

8. Search for the line that begins with JavaUserClasses= and change it to match 
the following:

JavaUserClasses=C:\Lotus\Domino\Data\Domino\Servlet\jcommon-1.0.5.ja
r;C:\Lotus\Domino\Data\Domino\Servlet\jfreechart-1.0.2.jar

Change the directory paths to match your particular installation path.

9. Save and close the notes.ini file.

10.Start your Domino server. When the servlet manager starts, you should see 
the stlogserv servlet initiate on your Domino server console soon after you 
see messages about HTTP starting up.

Deploy the plug-in to your plug-in directory for your installed Sametime 7.5 
connect client:

1. Drop the com.ibm.redbook.sametime.statistics_1.0.0.jar file in your plug-in 
directory, for example, C:\Program Files\IBM\Sametime Connect 7.5 
Blue\plugins.

2. Restart your Sametime connect client.

Attention: You can also download these two jar files directly from 
http://www.jfree.org. The JFree API is used to create the graphs for the 
plug-in.

Attention: Once the servlets are deployed, you can go to http://<Your 
Sametime Server Name>/servlet/stlogserv in your Web browser. It should tell 
you how many graphs your stlogserv servlet has put together. The graphs, 
which are stored as PNG files, are located in your Domino html directory, for 
example, C:\Lotus\Domino\Data\Domino\html directory.
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You are now ready to use the Sametime server statistics plug-in!

7.1.2  Using the plug-in

Many of the sample plug-ins use the mini-app plug-in screen real estate at the 
bottom of your connect client. While this is a common way to display information 
in Sametime Connect, the Sametime Server Statistics plug-in must display large 
graphs as well as statistical information. If this information were displayed in a 
mini-app, an administrator would continuously have to scroll in this limited space 
to see updated information. For usability purposes, the Sametime Server 
Statistics plug-in will display the statistical data in a new window that can be 
accessed from the Sametime Connect file menu in the system tray. To get 
started, launch your Sametime connect client and configure the Sametime server 
statistics plug-in:

1. From the connect client’s File menu, select Preferences.

2. You will notice that one of the selections you can now make is ‘Sametime 
Server Statistics. Select it.
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3. Click Add Server and enter the fully qualified server name, the administrator 
ID, and password of the Sametime server you want to administer (ensure that 
the server has the servlet deployed on it before you get to this step) (see 
Figure 7-2).

Figure 7-2   Configuring the Sametime Server Statistics Plug-in
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4. Click OK.

To access the plug-in, right-click your Sametime icon in the system tray and 
select Sametime Server Statistics from the menu that pops up.The monitoring 
UI will load up (see Figure 7-3).

Figure 7-3   Launching the Sametime monitoring plug-in UI

1. Select the server you want to monitor from the Sametime Server’s drop- down 
menu and the period of time you would like to monitor. The monitoring 
choices are either day, week, or month.

2. Click Update Statistics to view the graph and user information. 

The first tab shows statistics for community users. Community users refers to the 
people logged into the Sametime connect client as well as users logged into the 
meeting center, since meetings also provide instant messaging and awareness 
capabilities. 
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The second tab provides meeting center statistics for people utilizing Web 
conferencing, and the third tab provides details on each meeting active on the 
server. The user can click the meeting link to open a Web browser and bring up 
the Sametime Attend a meeting details page.

7.1.3  Value to the user 

Developing and deploying plug-ins is a fun experience. Developing and deploying 
a plug-in with great business value is even better. The authors decided to use this 
particular example because two valuable and interesting features provided by 
Sametime could be tied together.

A Sametime administrator will often find it necessary to send system wide 
messages to their Sametime community for any number of purposes. The 
monitoring tool seamlessly ties in with the ability to send these alerts by allowing 
the administrator to quickly analyze their Sametime servers.

An administrator who needs to perform maintenance could use her monitoring 
plug-in to see a history of the server’s usage and select a time of day, week, or 
month that reflects the lowest usage. On the day of maintenance, she can again 
quickly check to see how many meetings are currently active, who is moderating 
them, and then send her community wide message about server maintenance. 

7.1.4  Value to the developer

The Sametime monitoring plug-in showcases an additional Sametime toolkit and 
illustrates a framework of how to integrate a useful application and output data in 
a pleasing graphical format. It also provides an awareness to the more common 
areas and issues a plug-in developer is likely to encounter when attempting a 
similar project. 

7.2  Building the application

The next section is broken down into a couple of parts. The first section will focus 
on creating the servlet. The second section will focus on creating the plug-in 
itself.

Ensure that Eclipse is installed and configured for developing Sametime plug-ins.

Attention: For more information about installing and configuring Eclipse, refer 
to Chapter 3, “Setting up the Integrated Development Environment” on 
page 37.
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7.2.1  Create the Servlet

As mentioned previously the Sametime Connect 7.5 client uses a compacted 
Java Virtual Machine (JVM) called J9 to run on. This JVM does not contain the 
full number of Java classes included in the standard 1.4.2 or 1.5 Sun JVM. Some 
of the classes not contained in the J9 JVM are AWT classes. These are usually 
used for graphical user interface (GUI) objects in Java applications. It is likely that 
the AWT classes were pared down in the J9 JVM because the Eclipse platform 
usually makes use of SWT or Swing objects to display GUIs to users. To really 
show off the Sametime statistics data, the authors wanted to use the AWT based 
JFree API to generate the graphs. 

The solution we present for this issue is to place the workload on the server. The 
servlet we create for the Sametime server will not only gather statistics from the 
server, but also create the graphs from the information in stlog.nsf instead of 
having the plug-in do it. The servlet will then export the graphs out as PNG 
graphic files and store them in the Sametime server's Domino HTML directory. 
The plug-in will then access the graph pictures via a HTTP connection to the 
server and then display them for the user.

7.2.2  The stlogserv servlet code

The next section covers the code that makes up the stlogserv servlet. This code 
is not specific to the Sametime Connect client API, but it does show us how to get 
data out of back-end systems and into a usable format.

So let us look at the various components of the stlogserv.java file.

The first part is the class declaration for our servlet and the beginning of the 
doGet function (see Example 7-1).

Example 7-1   The class declaration for the servlet

public class stlogserv extends HttpServlet{

Database stlog = null;
PrintWriter out = null;
boolean debug = false;
boolean xml_out = false;
int numCharts = 0;

public void doGet(HttpServletRequest req, HttpServletResponse res) 
throws ServletException, IOException{
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Notice the class stlogserv extends the HttpServlet class. This allows us to use 
the servlet functionality in our program. Then we declare some variables that will 
be handy for us in the program. One is the Notes Database object, stlog, that will 
eventually point to the stlog.nsf database. Notice there are two Boolean variables 
listed here as well. If you want, you can change the debug variable to true to get 
debug statements sent to the Domino console when the servlet is executed. The 
variable, xml_out, can be set to true if you want a XML document sent to the user 
with the statistics we use to create the graphs. After the variable declarations for 
the class we have our first function, which is doGet. This function is called when 
a user calls a doGet with the servlet. Notice that it takes in the 
HttpServletRequest and response objects. This is the main function of our 
program that will kick off the rest of the functions.

The next bit of important code in this function is shown in Example 7-2.

Example 7-2   Open the Notes Database

try{
NotesThread.sinitThread();
Session session = NotesFactory.createSession();
stlog = session.getDatabase("", "stlog.nsf");
if(stlog.isOpen() == true){

debugOut("stlog DB was Open");

}else{
debugOut("stlog DB not Open");
stlog.open();

} 

The Notes API requires that all functionality be encapsulated in try and catch 
statements. So we start our try and then instantiate a Notes API session object. 
Since this servlet runs on the Domino/Sametime server, it does not require any 
authentication information to create a Domino session. Next, we try to find the 
stlog.nsf database. We then need to test if the database is open. It may seem 
odd to do this, but the Notes API will sometimes give errors when you try to 
access elements of a closed database.
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Now that we have opened our database we implement the code shown in 
Example 7-3.

Example 7-3   create a vector object for field data

Vector vec1 = new Vector();
vec1.addElement("TotalLogins");
vec1.addElement("TotalUsers");
processSTLOGView("Notes Community Users and Logins by Day", vec1);
processSTLOGView("Notes Community Users and Logins by Week", vec1);
processSTLOGView("Notes Community Users and Logins by Month", vec1);

We create a Java Vector object to store the field data we want to access. The 
data will come from fields in documents we access through specific views. This is 
where we call the processSTLOGView function. This function takes the name of 
the Notes view we want to look for documents in (remember that the database 
we are searching is stlog.nsf) and it also takes the Vector of fields we want to 
look for in those documents. Then the function creates a graph using the fields as 
lines on the graph. Let us take a more in depth look at this function in 
Example 7-4.

Example 7-4   The STLOGView function

public void processSTLOGView(String view_name, Vector stats){
debugOut("Function: processSTLOGView running");
debugOut("View name Desired in stlog.nsf: " + view_name);

int date_count =0;

try{
View curr_view = stlog.getView(view_name);

if(curr_view == null){
debugOut("There is no view by that name");
debugOut("Exiting out of the function");
return;

}else{
debugOut("The View was found");

}

We initialize a variable called date_count to 0, and we are going use this variable 
to limit the number of documents we get. Limiting this variable should help us get 
a certain number of values to show on our graph, therefore allowing us to show 
points on the graph with proper labeling. Next, we try to find a view in the 
stlog.nsf database called whatever we gave the function as a view name 
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parameter. If the view is not found, a debug statement is made and the function 
returns.

The next part of the code is shown in Example 7-5.

Example 7-5   Create a JFree object to store graph data

DefaultCategoryDataset dataset = new DefaultCategoryDataset();

ViewEntryCollection entry_colec = curr_view.getAllEntries();

if(entry_colec == null){
debugOut("There are no entries in the ViewEntryCollection");
debugOut("Exiting function.");
return;

}else{
debugOut("There are " + entry_colec.getCount() + " entries 

collection found");
}

Our first line displayed here creates a new DefaultCategoryDataset object. This 
is the JFree object that we will use to store our data to create a graph.

After that line, we create a Notes API ViewEntryCollection object. This object will 
help us go through all of the documents in the view in which we are interested. 
Again, we check to make sure that the object is not null and there is something in 
the collection we can use.

Now we sort through the documents that contain the statistics we want in 
Example 7-6.

Example 7-6   Sort through the Domino documents

//Get the first entry in the entry collection 
ViewEntry entry = entry_colec.getFirstEntry();

  
//A while loop to go thru the entries in our entry collection 
//We check to see if the entry object is null or if we have less than 
12 stats 
while ((entry != null)&&(date_count < 12)) {

        

Attention: For more information about this object and other JFree objects, go 
to http://www.jfree.org.
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            //Grab the Notes API document object from the entry 
object
Document doc = entry.getDocument();

    //Get the first Notes API Item object called DateTime
    Item date_item = doc.getFirstItem("DateTime");
    //Convert the date_item Item object into a String
    String date =date_item.getDateTimeValue().getLocalTime();
    //Get rid of the year part of the date
    date = date.substring(0,5);
    debugOut("Entry's date is:" + date);
    //Recycle the Notes API Item object
    date_item.recycle();
    
    
    //This for loop goes thru the document looking for fields 
    //given to the function in the vector
    for (int i = 0;i < stats.size(); i++ ){
    //Grab the first instance in this document of an Item 

//with a stat name we want
    Item item  = doc.getFirstItem((String)stats.elementAt(i));
    
    if (item == null){
    debugOut("There is not a field like that");
    }else{
    debugOut("Found field:" + item.getName());
    debugOut("Value:" + item.getValueInteger());
    
    //Here is where we add the stat's name, 

//value, and date to our dataset for the graph
    dataset.addValue(item.getValueInteger(), item.getName(), 

date);

    //We need to recycle the Notes Item object
    item.recycle();
    }
        
    }
    //Here we increment our date_count to keep

// our documents retrieved limited
        date_count++;
        
        //Go to the next entry in the entry collection
        entry = entry_colec.getNextEntry();

        //Recycle the Notes API document object
262 Extending Sametime 7.5: Building Plug-ins for Sametime



        doc.recycle();
        }

This code searches through the entry collection object and tries to find the values 
for the items we wanted in this function. The date of the item is also added to the 
dataset.

The next section creates the graph object with our dataset and exports it into a 
file to be saved in the Sametime server's HTML directory, as shown in 
Example 7-7.

Example 7-7   Create the graph

//Here is where we create the graph from the dataset just created above
//For more information go to www.jfree.org 
JFreeChart chart = ChartFactory.createLineChart(
view_name, // chart title
"Date", // domain axis label
"Number", // range axis label
dataset, // data
PlotOrientation.VERTICAL, // orientation
true, // include legend
true, // tooltips
false); // urls

    
//Add a subtitle to our graph
chart.addSubtitle(new TextTitle("Values arranged by date"));

debugOut("Chart created");

//Here we need to figure out what file name to give our view
//we are working with. These names are expected by the plug-in.
String file_name = "default.png";
 
if(view_name.equalsIgnoreCase("Notes Community Users and Logins by 

Day")){
file_name = "Community_Day.png";

}
if(view_name.equalsIgnoreCase("Notes Community Users and Logins by 

Week")){
file_name = "Community_Week.png";

}
if(view_name.equalsIgnoreCase("Notes Community Users and Logins by 

Month")){
file_name = "Community_Month.png";
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}
if(view_name.equalsIgnoreCase("Notes Meeting Statistics by Day")){

file_name = "Meeting_Day.png";
}
if(view_name.equalsIgnoreCase("Notes Meeting Statistics by Week")){

file_name = "Meeting_Week.png";
}
if(view_name.equalsIgnoreCase("Notes Meeting Statistics by Month")){

file_name = "Meeting_Month.png";
}

//Get the working directory. Since this servlet is running from 
Domino 

//the working directory should be <Drive>:\Lotus\Domino 
String cur_dir = System.getProperty("user.dir");
debugOut("Current Working Dir is:" + cur_dir);

//We need to place the graphic file in the HTML directory of Domino
//So we take the working directory and append the rest of the 

filepath we need
String new_dir = cur_dir + "\\Data\\Domino\\html";
//Create a new file with our dir and file name
File imgFile = new File(new_dir , file_name);

try 
{

//Export the graph into a graphic file 
ChartUtilities.saveChartAsPNG(imgFile, chart, 600, 400);

debugOut("File written:" + new_dir + file_name);
numCharts++;

} 
catch (Exception e) 
{

 
e.printStackTrace();
}
//Recycle our Domino objects 
entry_colec.recycle();
curr_view.recycle();
}catch (NotesException n){

out.println("Notes Execption:" + n); 
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This wraps up the processSTLOGView function. Notice that the doGet function 
calls the above section of code several times to get graphs created for the 
Community and Meeting statistics with respect to day, month, and year. Feel free 
to modify the servlet to create graphs of additional information and to use the 
XML mode to get the information in an easy to use format.

7.2.3  Set up the stlogserv Servlet on your Sametime server

To deploy the servlet to your Sametime server, you need to move the JFree API 
files and the compiled stlogserv class file to your Sametime server. For the 
complete directions, refer to 7.1.1, “Downloading and deploying the application” 
on page 252. Congratulations! Your first task is complete.

7.3  Create the plug-in

In the previous section, the servlet was pulled together. In the next section, we 
cover creating the actual Sametime plug-in.

7.3.1  Prepare your development environment

The first thing you will need to do is create a new project for your Sametime 
Server Statistics plug-in. 

1. In your Eclipse workspace configured for Sametime development, select 
File → Project to display the New Project wizard. 

2. In the window that appears, select Plug-in Development ' Plug-in Project 
and click Next. 

3. Name your new project com.ibm.redbook.sametime.statistics and click Next. 

4. Modify the Plug-in Properties as appropriate for your environment. 

5. In the Plug-in Options section, make sure that Generate an Activator is 
selected. This will instruct the New Project wizard to automatically create a 

Important: Building an Eclipse plug-in user interface (UI) is a lengthy topic 
covered in a number of articles, online tutorials, and books. For the sake of 
brevity, the authors decided to assume that you have some experience 
creating and modifying SWT and JFace widgets to build an Eclipse plug-in UI. 
The following sections focus on the methods for retrieving statistical 
information for display, rather than the display code itself. Please download the 
code for the Sametime Server Statistics plug-in to see how we built the UI or to 
modify it according to your own style. A good reference book is the second 
edition of Eclipse: Building Commercial-Quality Plug-ins by Clayberg, et al.
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class for you that extends a standard Eclipse plug-in. Using this class, you 
can control the functionality of your plug-in based off the standard life cycle of 
an Eclipse plug-in. 

6. Name your Activator class 
com.ibm.redbook.sametime.statistics.STStatsPlugin.

7. Click Finish. Your new project will now appear in the Eclipse Package 
Explorer view.

7.3.2  Create a Base64 encoding/decoding class 

Sametime 7.5 introduced a new statistics service. According to the Sametime 
Monitoring and Statistics Toolkit Guide (located in the SDK at location 
\st75sdk\server\stats\), the service can be called programmatically and will return 
a snapshot of current statistics on the server in XML format. The service is called 
using a standard HTTP GET request. However, as a security measure, it also 
requires that the authorization header of the HTTP GET request be set with a 
Base64 encoded value.

The Sametime Monitoring and Statistics Toolkit Guide gives an example of how 
to call the Sametime statistics service using the Sun JDK™, as shown in 
Example 7-8.

Example 7-8   The Sametime Monitoring and Statistics Toolkit example

String auth = new String (username + ":" + password);
String encoding = new sun.misc.BASE64Encoder().encode(auth.getBytes());
connection.setRequestProperty("Authorization", "Basic " + encoding);

Unfortunately, the example code will not work in the Sametime Connect Eclipse 
environment. The code fails because Sametime is using the J9 JCL Desktop JRE 
that does not support this particular method provided by Sun. The end result is 
that we will have to implement our own Base64 encoder class so that our plug-in 
can call the Sametime statistics service.

Add a new class to your project named Base64Coder. Add the code in 
Example 7-9 on page 267 to complete the implementation of this class. Now, our 
plug-in will be able to encode/decode Strings using Base64 algorithms and 
programmatically access the Sametime statistics service. In addition, this class 
will also be used when you implement code for saving and retrieving server 
information from a properties file.
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Example 7-9   Implement your own Base64 encoder class

public class Base64Coder
{

// Mapping table from 6-bit nibbles to Base64 characters.
private static char[] map1 = new char[64];
static {

int i = 0;
for (char c = 'A'; c <= 'Z'; c++)

map1[i++] = c;
for (char c = 'a'; c <= 'z'; c++)

map1[i++] = c;
for (char c = '0'; c <= '9'; c++)

map1[i++] = c;
map1[i++] = '+';
map1[i++] = '/';

}

// Mapping table from Base64 characters to 6-bit nibbles.
private static byte[] map2 = new byte[128];
static {

for (int i = 0; i < map2.length; i++)
map2[i] = -1;

for (int i = 0; i < 64; i++)
map2[map1[i]] = (byte) i;

}

/**
 * Encodes a string into Base64 format.
 * 
 * @param sa String to be encoded.
 * @return A String with the Base64 encoded data.
 */
public static String encode(String s) {

return new String(encode(s.getBytes()));
}

/**
 * Encodes a byte array into Base64 format.
 * 
 * @param inan array containing the data bytes
 * @return A character array with the Base64 encoded data.
 */
public static char[] encode(byte[] in) {

int iLen = in.length;
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int oDataLen = (iLen * 4 + 2) / 3; // output length without 
padding

int oLen = ((iLen + 2) / 3) * 4; // output length including 
padding

char[] out = new char[oLen];
int ip = 0;
int op = 0;
while (ip < iLen) {

int i0 = in[ip++] & 0xff;
int i1 = ip < iLen ? in[ip++] & 0xff : 0;
int i2 = ip < iLen ? in[ip++] & 0xff : 0;
int o0 = i0 >>> 2;
int o1 = ((i0 & 3) << 4) | (i1 >>> 4);
int o2 = ((i1 & 0xf) << 2) | (i2 >>> 6);
int o3 = i2 & 0x3F;
out[op++] = map1[o0];
out[op++] = map1[o1];
out[op] = op < oDataLen ? map1[o2] : '=';
op++;
out[op] = op < oDataLen ? map1[o3] : '=';
op++;

}
return out;

}

/**
 * Decodes a Base64 string.
 * 
 * @param sa Base64 String to be decoded.
 * @return A String containing the decoded data.
 * @throws IllegalArgumentException
 *             if the input is not valid Base64 encoded data.
 */
public static String decode(String s) {

return new String(decode(s.toCharArray()));
}

/**
 * Decodes Base64 data.
 * 
 * @param ina character array containing the encoded data.
 * @return An array containing the decoded data bytes.
 * @throws IllegalArgumentException
 *             if the input is not valid Base64 encoded data.
 */
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public static byte[] decode(char[] in) {
int iLen = in.length;
if (iLen % 4 != 0)

throw new IllegalArgumentException(
"Length of Base64 encoded string is not a multiple of 

4.");
while (iLen > 0 && in[iLen - 1] == '=')

iLen--;
int oLen = (iLen * 3) / 4;
byte[] out = new byte[oLen];
int ip = 0;
int op = 0;
while (ip < iLen) {

int i0 = in[ip++];
int i1 = in[ip++];
int i2 = ip < iLen ? in[ip++] : 'A';
int i3 = ip < iLen ? in[ip++] : 'A';
if (i0 > 127 || i1 > 127 || i2 > 127 || i3 > 127)

throw new IllegalArgumentException(
"Illegal character in Base64 encoded data.");

int b0 = map2[i0];
int b1 = map2[i1];
int b2 = map2[i2];
int b3 = map2[i3];
if (b0 < 0 || b1 < 0 || b2 < 0 || b3 < 0)

throw new IllegalArgumentException(
"Illegal character in Base64 encoded data.");

int o0 = (b0 << 2) | (b1 >>> 4);
int o1 = ((b1 & 0xf) << 4) | (b2 >>> 2);
int o2 = ((b2 & 3) << 6) | b3;
out[op++] = (byte) o0;
if (op < oLen)

out[op++] = (byte) o1;
if (op < oLen)

out[op++] = (byte) o2;
}
return out;

}

}
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7.3.3  Create a Sametime server information object class

The Sametime Server Statistics plug-in will allow the user to monitor multiple 
Sametime servers at a time. Since each server will need to store many pieces of 
information pertinent to its environment, you will implement a new STServerInfo 
object class to accommodate the storage of this information.

Add a new class to your project named STServerInfo. This class will be 
responsible for storing information, such as the fully qualified DNS name of the 
Sametime server, a user name and password for servlet authentication, the stats 
returned from the server to be displayed by the plug-in, and a list of currently 
active meetings on the server. The class will also contain the methods for 
contacting the statistics servlets and for parsing the returned XML data.

Add the global variables in Example 7-10 to the STServerInfo class. These 
variables will contain information that will be retrieved and modified later by other 
pieces of the plug-in.

Example 7-10   Variables for the STServerInfo Class

String serverName = "";
String userName = "";
String password = "";

int ConcurrentLogins = 0;
int ConcurrentLoggedInUsers = 0;
int ConcurrentImCnls = 0;
int InstantMeetingClients = 0;
int InstantMeetings = 0;
int ScheduledMeetingClients = 0;
int ScheduledMeetings = 0;
int AverageMeetingStartupDuration = 0;

Vector meetingList = new Vector();

Add the constructor in Example 7-11 on page 271 to the STServerInfo class. The 
object will be instantiated with a string containing the fully qualified DNS name of 
the Sametime server, the user name for authentication, and a password for 
authentication. This data will be stored for later retrieval by the plug-in.
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Example 7-11   Adding a constructor to the STServerInfo Class

public STServerInfo(String server, String name, String pwd)
{

this.serverName = server;
this.userName = name;
this.password = pwd;

}

The Sametime Server Statistics plug-in gathers data by querying two servlets 
that reside on the Sametime server. The first servlet is the Sametime statistics 
servlet located at http://<Your Sametime Server Name>/servlet/statistics. This 
servlet requires authentication with a Base64 encoded username/password pair. 
The servlet returns a snapshot of current statistics on the server as well as a list 
of the currently active meetings. However, the servlet will only return statistics 
obtained since the last time it was queried. Since we are interested in a deeper 
statistical history, in an earlier exercise we created our own custom servlet called 
stlogserv that is located at http://<Your Sametime Server 
Name>/servlet/stlogserv. As we discussed previously, this custom servlet will 
generate JFreeChart graphs based off the Sametime server's statistics history 
located in stlog.nsf. The plug-in will then download and display the charts to the 
user.

Add the function in Example 7-12 to the STServerInfo class. This function will be 
used to query the Sametime Statistics servlet that is shipped with Sametime 7.5. 
The function will initiate an HTTP GET connection to the servlet and set the 
authorization header to contain the Base64 encoded username/password pair. 
After the connection has been made, the function will catch the XML data 
returned from the servlet and place it in a String variable. The function will return 
this XML string.

Example 7-12   Query the Sametime statistics servlet

// query the Sametime statistics servlet and return the results
public String getServerStatistics(String server, String username, 
String password)
{

String xmlResults = "";

try
{

URL url = new URL("http://" + server + "/servlet/statistics");

// initiate an HTTP GET to the statistics servlet
HttpURLConnection conn = (HttpURLConnection) 

url.openConnection();
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conn.setRequestMethod("GET");
conn.setUseCaches(false);

// encode the username and password
String auth = new String(username + ":" + password);
String encoding = Base64Coder.encode(auth);

// modify HTTP headers to add our authorization
conn.setRequestProperty("Authorization", "Basic " + encoding);

// catch the servlet response
BufferedReader in = new BufferedReader(new 

InputStreamReader(conn.getInputStream()));
String line = "";
while ((line = in.readLine()) != null)
{

xmlResults += line;
}

// close connections, buffers
in.close();
conn.disconnect();

}
catch (Exception e)
{

e.printStackTrace();
}

// The first time the Statistics servlet is called, it will return 
blank XML.

// If blank XML is returned, connect to the servlet again for the 
stats.

if (xmlResults.equalsIgnoreCase("<?xml version=\"1.0\" 
encoding=\"UTF-8\" ?><SametimeStatistics></SametimeStatistics>"))

xmlResults = getServerStatistics(server, username, password);

return xmlResults;
}

The class now contains a function for querying the Sametime statistics servlet. 
Now, you will create an additional function for querying the custom stlogserv 
servlet. The code is similar to the previous function. However, there is no need to 
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authenticate to this servlet or to check to see if blank XML has been returned. 
Add the function in Example 7-13 to the STServerInfo class.

Example 7-13   Query our custom servlet stlogserv

// query the "stlogserv" servlet to gather information from STLog.nsf 
and generate the charts
public String getSTlogStatistics(String server)
{

String xmlResults = "";

try
{

URL url = new URL("http://" + server + "/servlet/stlogserv");

// initiate an HTTP GET to the stLog servlet
HttpURLConnection conn = (HttpURLConnection) 

url.openConnection();
conn.setRequestMethod("GET");
conn.setUseCaches(false);

// catch the servlet response
BufferedReader in = new BufferedReader(new 

InputStreamReader(conn.getInputStream()));
String line = "";
while ((line = in.readLine()) != null)
{

xmlResults += line;
}

// close connections, buffers
in.close();
conn.disconnect();

}
catch (Exception e)
{

e.printStackTrace();
}

return xmlResults;
}

The Sametime statistics servlet will return a snapshot of the current statistics on 
the server. In addition, it will return a list of the currently active meetings on the 
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Sametime server. To make this data accessible to the rest of the plug-in, create a 
MeetingInfo helper class. Add the code in Example 7-14 to the STServerInfo 
object class. As you can see, the MeetingInfo helper class will contain 
information about a currently active meeting. 

Example 7-14   Make the returned statistics available to the rest of the plug-in

public class MeetingInfo
{

String name ="";
String manager = "";
String uid = "";
int numClients = 0;
String managerFullName = "";
String meetingURL = "";

}

As the XML data returned from the Sametime statistics servlet is parsed, and 
active meeting elements are encountered, a new MeetingInfo object should be 
created and added to the global meetingList Vector. Add the function in 
Example 7-15 to the STServerInfo class to accomplish this task.

Example 7-15   Create a list of active meetings

public void addMeeting(String name, String manager, String uid, int 
numClients, String managerFullName)
{

MeetingInfo meeting = new MeetingInfo();

meeting.name = name;
meeting.manager = manager;
meeting.uid = uid;
meeting.numClients = numClients;
meeting.managerFullName = managerFullName;
meeting.meetingURL = "http://" + serverName + "/stconf.nsf/meeting/" 

+ uid;

meetingList.add(meeting);
}
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Add the function in Example 7-16 to the STServerInfo class to return the Vector 
list of stored meetings.

Example 7-16   Return the Vector list of stored meetings

public Vector getMeetings()
{

return meetingList;
}

The STServerInfo object class now contains variables for general server 
information as well as the statistics for the server. In addition, a MeetingInfo 
helper class was added to contain information about the currently active 
meetings on the Sametime server. In order to complete the implementation of the 
STServerInfo class, you will need to add one more method. This method will be 
responsible for parsing the XML data returned by the Sametime statistics servlet 
and storing the statistics that the plug-in is interested in displaying.

The XML will be parsed using the Document Object Model (DOM). By using this 
method, we can gain direct access to any XML node as well as the child nodes 
underneath the tag. You will then be able to access the names, values, and 
attributes of a given XML node.

A statistic node in the XML takes the form in Example 7-17. It consists of a node 
named "Statistic" with an attribute called "name". The name attribute will contain 
the name of the current statistic. The statistic node has one child node named 
"Value". The value node will contain the current value of the current statistic.

Example 7-17   A statistic node

<Statistic name="InstantMeetings">
<Value>0</Value>

  </Statistic>
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A meeting node in the XML takes the form in Example 7-18. It consists of a node 
named "Meeting".  The meeting node has several child nodes named 
"MeetingId", "Name", "ConnectionCount", "Chair", and "ChairDisplayName".  
These nodes will contain the current values for the current meeting.

Example 7-18   A meeting node

<Meeting>
<MeetingId>B31D0E52C7DA6E49852571F60053D943</MeetingId>
<Name>Test Meeting</Name>
<ConnectionCount>25</ConnectionCount>
<Chair>Anonymous</Chair>
<ChairDisplayName>Anonymous</ChairDisplayName>

</Meeting>

Add the method in Example 7-19 to the STServerInfo object class to parse the 
XML and store the statistics.

Example 7-19   Parsing the XML and storing statistics

public void crunch_st_stat_xml(String xmlString)throws Exception
{

// clear stored active meetings for this server
meetingList.removeAllElements();

// create an input source from the XML string to be used by DOM
Reader xmlReader = new StringReader(xmlString);
InputSource xmlInput = new InputSource(xmlReader);

try 
{

// create a new DOM Document from the returned XML
DocumentBuilderFactory docBuilderFactory = 

DocumentBuilderFactory.newInstance();
docBuilderFactory.setIgnoringElementContentWhitespace(true);
DocumentBuilder docBuilder = 

docBuilderFactory.newDocumentBuilder();
Document doc = docBuilder.parse(xmlInput);
doc.getDocumentElement().normalize();

// get the XML top-level node
Element rootNode = doc.getDocumentElement();

// get all the "Statistic" XML nodes
NodeList statNodes = rootNode.getElementsByTagName("Statistic");
for (int x=0; x < statNodes.getLength(); x++)
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{
// get the current "Statistic" node
Node curNode = statNodes.item(x);
Element curElem = (Element) curNode;

// get the current stat name
String statName = curElem.getAttribute("name");

// get the "Value" node for the current statistic
NodeList valueList = curElem.getElementsByTagName("Value");
Element valueElement = (Element) valueList.item(0);

// get the value of the current statistic
String statValue = 

valueElement.getFirstChild().getNodeValue();

// store only the returned statistics we are interested in
if(statName.equals("ConcurrentLogins"))

ConcurrentLogins = Integer.parseInt(statValue);
if(statName.equals("ConcurrentLoggedInUsers"))

ConcurrentLoggedInUsers = Integer.parseInt(statValue);
if(statName.equals("ConcurrentImCnls"))
    ConcurrentImCnls = Integer.parseInt(statValue);
if(statName.equals("InstantMeetingClients"))

InstantMeetingClients = Integer.parseInt(statValue);
if(statName.equals("InstantMeetings"))
    InstantMeetings = Integer.parseInt(statValue);
if(statName.equals("ScheduledMeetingClients"))
    ScheduledMeetingClients = Integer.parseInt(statValue);
if(statName.equals("ScheduledMeetings"))
    ScheduledMeetings = Integer.parseInt(statValue);
if(statName.equals("AverageMeetingStartupDuration"))
{

double d = Double.parseDouble(statValue);
    AverageMeetingStartupDuration = (int) d;
}

}

// get all the "Meeting" XML nodes
NodeList meetingNodes = rootNode.getElementsByTagName("Meeting");
for (int z=0; z < meetingNodes.getLength(); z++)
{

// get the current "Meeting" node
Node curMeetingNode = meetingNodes.item(z);
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// "Meeting" detail information
String meetingName = "", meetingChair = "", meetingUID = "", 

meetingConnections = "", meetingChairFull = "";

// get the detail nodes for the current "Meeting"
NodeList curMeetingDetails = curMeetingNode.getChildNodes();
for (int i=0; i < curMeetingDetails.getLength(); i++)
{

// get the current "Meeting" detail information
Element meetingDetail = (Element) 

curMeetingDetails.item(i);
String meetingDetailName = meetingDetail.getNodeName();
String meetingDetailValue = 

meetingDetail.getFirstChild().getNodeValue();

// assign the current detail information
if (meetingDetailName.equals("Name"))

meetingName = meetingDetailValue;
if (meetingDetailName.equals("Chair"))

meetingChairFull = meetingDetailValue;
if (meetingDetailName.equals("MeetingId"))

meetingUID = meetingDetailValue;
if (meetingDetailName.equals("ConnectionCount"))

meetingConnections = meetingDetailValue;
if (meetingDetailName.equals("ChairDisplayName"))

meetingChair = meetingDetailValue;

}

// store the "Meeting" information
addMeeting(meetingName, meetingChair, 

meetingUID,Integer.parseInt(meetingConnections), meetingChairFull);
}

}
catch (Exception e)
{

e.printStackTrace();
}

}
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7.3.4  Implement a properties file

The Sametime Server Statistics plug-in allows the user to query multiple 
Sametime servers for statistics information. The information required for these 
queries are the Sametime server name, a user name, and a password for 
authentication to the servlet. You will implement a standard properties file for 
storage of this information about the user's machine. This will ensure that the 
user will only have to enter the information aboute time and not every time the 
plug-in is started.

Remember the Activator class you created named STStatsPlugin? The 
STStatsPlugin class extends a standard Eclipse plug-in and contains methods 
for the life cycle of the plug-in. When your plug-in is finished, the user will be able 
to modify information in the Sametime preferences or access the Sametime 
Server Statistics dialog window. To ensure that the stored Sametime servers are 
loaded and ready when either of these actions takes place, you will want to add 
the code for saving/loading information from the properties file in your 
STStatsPlugin class.

The plug-in will need to keep a global list of Sametime servers that the user 
wishes to monitor. Since we already have a STServerInfo object that contains all 
the information for a given server, you will need to implement a new Vector list 
that can be used to store these objects. Add the following global variable to your 
STStatsPlugin class:

public Vector sametimeServers = new Vector();

Add the methods in Example 7-20 that will allow you to modify the Vector list of 
STServerInfo objects in the future after different UI events occur.

Example 7-20   Modifying the Vector list of the STServerInfo objects

// return the list of stored Sametime servers
public Vector getServers()
{

return sametimeServers;
}

// add a new server to the Sametime server list
public void addServer(String server, String username, String password)
{

STServerInfo info = new STServerInfo(server, username, password);
sametimeServers.add(info);

}

// remove a server from the Sametime server list
public void removeServer(int x)
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{
sametimeServers.removeElementAt(x);

}

// remove all servers from the Sametime server list
public void removeAllServers()
{

sametimeServers.removeAllElements();
} 

Now that we have a Vector list that can be used to store our Sametime server 
objects, the next step is to implement a function that populates this list from a 
previously saved properties file. Before you can implement this functionality, you 
must decide how to store the data. The Sametime Server Statistics plug-in will 
store the fully qualified DNS name of a Sametime server and the associated 
username/password pair in the properties file. It is never a good idea to store a 
password in clear text on a user's machine. To get around this potential security 
hole, the Sametime Server Statistics plug-in will Base64 encode the 
username/password pair in the properties file. When the properties file is read 
when the plug-in starts, it will Base64 decode this string. As you will recall, you 
already implemented the Base64 algorithms for authentication to the Sametime 
statistics servlet. We will reuse the Base64Coder class for reading/writing the 
properties file.

You will store a new property in the properties file for each server to be 
monitored. The name of each property will simply be the name of the server. The 
value for each property will be the Base64 encoded username/password pair. 
For example, assume an administrator wants to monitor a server named 
server.company.com with a user named Administrator and a password of 
password.  The resulting entry stored in the properties file on the user's machine 
would be:

server.company.com=QWRtaW5pc3RyYXRvcjpwYXNzd29yZA==

Add the function in Example 7-21 on page 281 to the STStatsPlugin class. This 
function will load the list of stored Sametime servers from a properties file named 
ststats.properties, decode the username/password pairs, and create new 
STServerInfo objects accordingly.
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Example 7-21   Load the stored values from the properties file

// load config information from the properties file
public void loadSettings()
{

removeAllServers();

Properties props = new Properties();
String path = 

STStatsPlugin.getDefault().getStateLocation().toString();
File propfile = new File(path, "ststats.properties");
try 
{

props.load(new FileInputStream(propfile));

// for each stored property in the file
Enumeration elem = props.propertyNames();
while (elem.hasMoreElements()) 
{

// get the server & authorization key-value pair
String server = (String) elem.nextElement();
String auth = props.getProperty(server);

// decode the authorization that was stored
auth = Base64Coder.decode(auth);
// separate the username and password
String[] nameAndPassword = auth.split(":");

// add the server info to the list of Sametime servers
addServer(server, nameAndPassword[0], nameAndPassword[1]);

}
} 
catch (IOException e)
{

e.printStackTrace();
}

} 
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The next step is to implement a function that saves the current Vector list of 
STServerInfo objects to the properties file. Add the code in Example 7-22 to the 
STStatsPlugin class.

Example 7-22   Save values to the properties file

// save config information to the properties file
public void saveSettings()
{

try 
{

// open a new properties file
String path = 

STStatsPlugin.getDefault().getStateLocation().toString() + 
File.separator + "ststats.properties";

FileWriter fw = new FileWriter(path);
BufferedWriter bw = new BufferedWriter(fw);
PrintWriter pw = new PrintWriter(bw);

// for each stored Sametime server
for (int x=0; x < sametimeServers.size(); x++)
{

// get the Sametime server's information
STServerInfo info = (STServerInfo) 

sametimeServers.elementAt(x);
// combine the username and password
String auth = info.userName + ":" + info.password;
// encode the authorization for storage in the properties file
auth = Base64Coder.encode(auth);
// write the server info to the properties file
pw.println(info.serverName + "=" + auth);

}

// close the buffers and writers
pw.close();
bw.close();
fw.close();

}
catch (Exception e)
{

e.printStackTrace();
}

} 
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Finally, to complete the STStatsPlugin class, you will want to make sure that the 
Sametime servers stored in the properties file are loaded when the plug-in starts. 
By doing this, you are ensuring that the data will be immediately accessible to 
both the Preferences page and the Sametime Server Statistics dialog window. 
Add a call to your loadSettings() function in the standard Eclipse plug-in start 
method. When finished, the code should look as in Example 7-23.

Example 7-23   Ensure properties file values are loaded at start up

public void start(BundleContext context) throws Exception 
{

super.start(context);
loadSettings();

}

7.3.5  Create a preferences page

The next step is to create a preferences page for the plug-in so that the user can 
enter information about Sametime servers that he/she wishes to monitor.  You 
will do this by extending a standard Eclipse preferences page. Add the extension 
in Example 7-24 to plugin.xml.

Example 7-24   Extending a standard Eclipse preferences page

<extension
         point="org.eclipse.ui.preferencePages">
      <page
            
class="com.ibm.redbook.sametime.statistics.STStatsPreferencePage"
            
id="com.ibm.redbook.sametime.statistics.STStatsPreferencePage"
            name="Sametime Server Statistics"/>
   </extension>

Notice that it references a class called STStatsPreferencePage. Add a new class 
to your project with this name. In order to implement an Eclipse plug-in 
preference page, the class will need to extend the appropriate classes. Make the 
class an extension of a PreferencePage with the class declaration in 
Example 7-25.

Example 7-25   Adding the STStatsPreferencePage class

public class STStatsPreferencePage extends PreferencePage
implements IWorkbenchPreferencePage 
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The next step is to implement the createContents() method to contain the UI 
code you wish to display in the Sametime Server Statistics plug-in preferences 
page. After the UI is complete, you will need to retrieve and store information for 
display purposes. Use the methods contained in the STStatsPlugin class for 
accessing and modifying the list of stored Sametime servers. You can also 
access the methods for loading and saving the properties file. For example, the 
code in Example 7-26 will iterate through the list of Sametime servers and place 
the server name, user name, and password in String variables. You can then 
display these String variables accordingly in your custom preferences page UI.

Example 7-26   Implementing the createContent method

// get the list of stored Sametime servers
Vector sametimeServers = STStatsPlugin.getDefault().getServers();

// for each Sametime server
for (int x=0; x < sametimeServers.size(); x++)
{

// get the Sametime server info
STServerInfo info = (STServerInfo) sametimeServers.elementAt(x);

String server = info.serverName;
String user = info.userName;
String pwd = info.password;

} 

In order to finish the preferences page, you will need to override some of the 
default methods of the PreferencePage class.  For example, if a user clicks the 
Restore Defaults button, you will want to clear the current list of stored 
Sametime servers and update the properties file. You can implement this 
functionality by adding the function in Example 7-27 to your 
STStatsPreferencePage class.

Example 7-27   Overriding default methods of the PreferencePageClass

// the "Restore Defaults" button was clicked on the preference page
protected void performDefaults()
{

// remove all the stored servers
STStatsPlugin.getDefault().removeAllServers();
// update the properties file
STStatsPlugin.getDefault().saveSettings();

}
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Next, override the default functionality of the Apply or OK buttons by adding the 
function in Example 7-28 to your STStatsPreferencePage class. As you can see, 
it simply saves the current list of stored Sametime servers to the properties file.

Example 7-28   Overriding the default functionality of the Apply or OK buttons

// the "Apply" or "OK" button was clicked on the preference page
public boolean performOk()
{

// update the properties file
STStatsPlugin.getDefault().saveSettings();
return super.performOk();

}
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As noted at the beginning of this section, the author's assume you have 
experience building an Eclipse user interface. Using the methods outlined above, 
you can create a preferences page to store and retrieve the current list of 
Sametime servers to monitor (see Figure 7-4). You can view how the Sametime 
Server Statistics plug-in preference page UI was created by examining the 
source code.

Figure 7-4   The Plug-in’s preferences page

7.3.6  Create a Sametime statistics dialog window

At this point, the Sametime Server Statistics plug-in can create STServerInfo 
objects to contain the information and statistics for a given server. The plug-in 
can also contact the custom stlogserv servlet (to generate charts) and the 
Sametime statistics servlet that ships with Sametime 7.5 to catch the returned 
XML. There is also a method for parsing the returned XML using DOM and 
storing the returned statistics. Additionally, the plug-in has the capability to read 
and write information from a properties file. In the last section, you were given 
examples of how to manipulate and retrieve the stored data from the UI of your 
choice. Much like the last section, we will leave the UI portion of code up to your 
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imagination. The rest of this section will contain tips on retrieving and storing the 
information for display purposes.

The first step is to add a new class to the project named STStatsDialog. This 
class will contain your custom UI and display the stored information retrieved 
from the Sametime servlets. Extend a standard JFace Dialog with the following 
class declaration:

public class STStatsDialog extends Dialog

Add the unimplemented methods to your class. Place your custom UI code into 
the createDialogArea()  method.

The example code in Example 7-29 assumes you have a SWT button in your UI 
named updateButton and a Combo drop-down list containing a list of Sametime 
servers named serverList. It also assumes there is a global STServerInfo 
variable named currentServer that contains the currently selected Sametime 
server object. This code will demonstrate how to call the Sametime statistics 
servlets to update the currentServer object.

Example 7-29   Calling the Sametime statistic servlets to perform an update

// the Update button was clicked
updateButton.addSelectionListener(new SelectionListener()
{

public void widgetSelected(SelectionEvent event)
{

// get the currently selected Sametime server
Vector sametimeServers = STStatsPlugin.getDefault().getServers();
currentServer = (STServerInfo) 

sametimeServers.elementAt(serverList.getSelectionIndex());

try 
{

// gather the statistics for the currently selected server
// connect to the "stlogserv" servlet
String results;
results = 

currentServer.getSTlogStatistics(currentServer.serverName);

// do something with the results
 

// connect to the Sametime statistics servlet
results = 

currentServer.getServerStatistics(currentServer.serverName, 
currentServer.userName, currentServer.password);
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// parse the returned XML data and store the statistics
currentServer.crunch_st_stat_xml(results);

} 
catch (Exception e) 
{

e.printStackTrace();
}

// update the UI to reflect statistics changes

}

public void widgetDefaultSelected(SelectionEvent event){}
}); 

The Sametime Server Statistics plug-in interacts with the stlogserv servlet. As 
you will recall, this custom servlet interacts with the stlog.nsf database on the 
Sametime server to create a statistics history. It then uses this statistics history to 
generate JFreeChart charts. The charts are stored in the base HTML directory of 
the server and have specific names. Use Table 7-1 to decide which chart you 
wish to download and display.

Table 7-1   The JFreeCharts

After you determine which chart to display in your custom UI, the next step is to 
actually download the chart and display it. Use the function in Example 7-30 on 
page 289 to create a SWT image from a URL and return the new image.

File name Description

Community_Day.png Community statistics chart by day

Community_Week.png Community statistics chart by week

Community_Month.png Community statistics chart by month

Meeting_Day.png Meeting statistics chart by day

Meeting_Week.png Meeting statistics chart by week

Meeting_Month.png Meeting statistics chart by month
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Example 7-30   Downloading and displaying the chart

// get the Sametime stats chart (generated by the servlet) from a URL
private Image getImageFromURL(String imgName)
{

Image img = null;

try 
{

URL url = new URL("http://" + currentServer.serverName + "/" + 
imgName);

ImageDescriptor id = ImageDescriptor.createFromURL(url);
img = id.createImage();

} 
catch (Exception e) {}

return img;
}

The function returns a SWT Image object. You can add the new Image object to 
your UI by placing it on a SWT Label. For example, use the code in 
Example 7-31 to download and display a Sametime statistics chart in your UI.

Example 7-31   Adding the new SWT object to your UI

// the chart (generated by the servlet) that should be retrieved
String filename = "Community_Day.png";

// retrieve and display the currently selected stats chart
Label label = new Label(comp, SWT.NONE);
Image img = getImageFromURL(filename);
label.setImage(img);
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The Sametime Server Statistics plug-in downloads and displays the image in a 
tabbed user interface (see Figure 7-5). You can review the source code for tips 
on creating your own display.

Figure 7-5   The interface

If you wish to display Sametime statistics stored in your currentServer 
STServerInfo object, you can do so by creating a new Label and accessing the 
data directly. For example, the code in Example 7-32 will add a label to a SWT 
Composite named "comp" that displays the current number of active scheduled 
meetings on the Sametime server. You can use similar code to quickly display 
any of the stored statistics.

Example 7-32   Adding a new Label to the SWT Composite

new Label(comp, SWT.NONE).setText("Current number of active scheduled 
meetings: " + currentServer.ScheduledMeetings); 

Figure 7-6 shows the resulting UI.

Figure 7-6   The resulting UI
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Finally, the STServerInfo object contains a list of currently active meetings on the 
Sametime server. You can access this data and display it in your UI by using the 
getMeetings() method you implemented earlier as a part of your STServerInfo 
class. For example, the code in Example 7-33 will create a SWT Tree structure 
and add the current list of active meetings to the tree. It will add the meeting 
name to the tree and then add the meeting details as sub-items.

Example 7-33   Creating a SWT Tree structure and adding active meetings

// the tree to display meeting information
final Tree tree = new Tree(comp, SWT.SINGLE | SWT.BORDER);
tree.setLayoutData(new GridData(GridData.FILL_BOTH));

// get the currently stored Sametime servers
Vector currentMeetings = currentServer.getMeetings();

// for each stored meeting
for (int x=0; x < currentMeetings.size(); x++)
{

MeetingInfo meeting = (MeetingInfo) currentMeetings.elementAt(x);

// add a new meeting node to the tree
TreeItem root = new TreeItem(tree, SWT.NULL);
root.setText(meeting.name);

// add the meeting information to the new meeting node
TreeItem item1 = new TreeItem(root, SWT.NULL);
item1.setText("Meeting manager: " + meeting.manager);
TreeItem item2 = new TreeItem(root, SWT.NULL);
item2.setText("Meeting manager full name: " + 

meeting.managerFullName);
TreeItem item3 = new TreeItem(root, SWT.NULL);
item3.setText("Number of connected clients: " + 

Integer.toString(meeting.numClients));
TreeItem item4 = new TreeItem(root, SWT.NULL);
item4.setText("Meeting UID: " + meeting.uid);
TreeItem item5 = new TreeItem(root, SWT.NULL);
item5.setText(meeting.meetingURL);

} 
 Chapter 7. Advanced plug-in example: The Sametime Server Statistics Plug-in 291



The resulting SWT Tree structure would look like Figure 7-7.

Figure 7-7   The resulting SWT Tree structure

As noted at the beginning of this section, the authors assume you have 
experience building an Eclipse user interface. Using the methods outlined above, 
you can create SWT widgets populated with data from your STServerInfo 
objects. You can then arrange those widgets accordingly in a dialog window. You 
can view how the Sametime Server Statistics plug-in dialog window was created 
by examining the source code.

7.3.7  Add a Sametime Server Statistics menu item

After you have finished implementing your custom UI in the STStatsDialog class, 
you will want to display the dialog window after performing some action in 
Sametime Connect. The Sametime Server Statistics plug-in adds a file menu 
item to Sametime Connect. When the new file menu item is selected, the 
STStatsDialog you created in the last section will be displayed.

Add the extension in Example 7-34 to plugin.xml. Please note that the "id" of your 
new actionSet extension must begin with "com.ibm.collaboration.realtime" in 
order to be displayed in Sametime Connect.

Example 7-34   Adding an extension to plugin.xml

<extension
         point="org.eclipse.ui.actionSets">
      <actionSet
            description="Sametime Statistics Action Set"
            
id="com.ibm.collaboration.realtime.statistics.STStatsActionSet"
            label="Sametime Statistics Action Set"
            visible="true">
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         <action
               
class="com.ibm.redbook.sametime.statistics.STStatsActionSet"
               
id="com.ibm.redbook.sametime.statistics.STStatsActionSet"
               label="Sametime Server Statistics"
               menubarPath="sametime/plugins"
               tooltip="View Sametime server statistics"/>
      </actionSet>

</extension> 

As you can see, the extension references a STStatsActionSet class. Add a new 
class to your project named STStatsActionSet. Use the following class 
declaration to make your new class execute whenever the file menu item is 
clicked:

public class STStatsActionSet implements IWorkbenchWindowActionDelegate

Add the unimplemented methods to your class. Modify the run() method to 
instantiate a new STStatsDialog and display it to the user. When finished, the 
code will look like Example 7-35.

Example 7-35   Adding unimplemented methods to your class

// The right-click menu was clicked.
public void run(IAction arg0) 
{

// Open the Sametime statistics dialog window.
Shell shell = new Shell(Display.getCurrent());
STStatsDialog dialog = new STStatsDialog(shell);
dialog.open();

}

 Chapter 7. Advanced plug-in example: The Sametime Server Statistics Plug-in 293



The plug-in is complete! Congratulations on creating the Sametime Server 
Statistics plug-in for Sametime Connect (see Figure 7-8). Feel free to download 
the plug-in and source code and modify it accordingly for deployment in your 
infrastructure.

Figure 7-8   The completed Sametime server monitoring plug-in

7.4  Extension Ideas

Utilizing the code provided in Appendix A, “Additional material” on page 557 as a 
basis for your project should allow you to extend the Sametime server statistics 
plug-in in any number of ways. 

Some ideas from the authors include:

� Utilizing the framework to pull data out of other back-end systems, formatting 
it and displaying it via a Sametime plug-in
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� Expanding the dataset used in this example and displaying even more 
statistics extracted from your stlog.nsf database

However you choose to continue, we hope this chapter provided an informative 
tutorial on what can be done with not only Sametime plug-ins but the Eclipse 
platform and Eclipse plug-ins themselves. 
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Chapter 8. Advanced plug-in example: 
SAP integration

This chapter examines how to create a plug-in that integrates with a back-end 
system, such as SAP®, to extract data for several different scenarios. These 
samples are use cases that show the business value of having real-time access 
to a back-end system without having to open a separate user interface. There are 
three examples within the plug-in. They are:

� Human Resources Integration

� Inventory Status

� Order Status

8
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Important: The following example is intended to show how a custom 
Sametime Plug-in can integrate with a back-end system such as SAP. Please 
note the following when working with this example:

� You need knowledge of your SAP System, or at least have access to an 
SAP Administrator or Developer who can help with the configuration of the 
system 

� Each specific client SAP implementation may differ slightly from the 
configuration used in this example. Accordingly, you will need to work 
closely with an SAP Administrator or Developer to understand the key 
configuration parameters and make adjustments to the code examples 
where appropriate. 

� Please note that due to licensing restrictions, we cannot distribute the SAP 
Java Connector and you will need to obtain it from an SAP Administrator or 
Developer and install it.
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8.1  Plug-in overview

As described in the chapter introduction, the SAP integration plug-in will allow the 
user to access data from an SAP system. 

The plug-in will provide three SAP integration use cases, each on a separate tab, 
as shown in Figure 8-1 on page 300.

� Human Resources Tab
� Inventory Tab
� Order Status Tab
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Figure 8-1   Overview of the functional tabs within the plug-in

Tabs for Functionality 

HR

Inventory

Order Status
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Human resources use case
The human resources use case pulls organizational information from SAP and 
displays it in a filterable tree. An example of the human resources user interface 
is shown in Figure 8-2.

Figure 8-2   Example of the human resources user interface
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Inventory use case
The inventory use case allows the user to select a product from a list and then 
check its availability. An example of the inventory user interface is shown in 
Figure 8-3.

Figure 8-3   An example of the inventory user interface

Order status use case
The order status use case allows the user to enter an order number and retrieve 
the status from SAP. An example of the order status user interface is displayed in 
Figure 8-4 on page 303.
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Figure 8-4   An example of the order status user interface

This plug-in provides interesting examples that show users the value of real-time 
access to any back-end system, not just SAP.

Users will configure their plug-in by accessing it from the Sametime Connect 
client’s File → Preferences menu. They will then enter the SAP configuration 
information (user name, password, server address, and so on). This information 
will be stored on the user's machine in a properties file. Default preferences can 
be configured, such as SAP server address. It is also possible to encrypt this 
information, as described in 7.3.2, “Create a Base64 encoding/decoding class” 
on page 266, and 7.3.5, “Create a preferences page” on page 283.

Attention: A user can also configure the plug-in to use a static dummy test 
data system, instead of SAP, by changing a preference. When reading the rest 
of this chapter, assume that the words SAP and dummy test data system to be 
interchangeable (except when discussing SAP APIs or configuration).
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8.1.1  Value to the user 

This plug-in is designed to show the business value of real-time integration with a 
back-end system, such as SAP. Often a user has to access several different 
systems through a slow process to perform a task. The following examples show 
how Sametime can be used to:

� Integrate a corporate directory with Sametime

� Check current inventory levels

� Check the status of an order

HR (corporate directory) integration
Integration between the corporate directory and Sametime can be quite valuable. 
One example is a client that is using an external IM client and wants to look up a 
phone number to speak with his sales or support representative. It could also be 
that the sales person is not available but it is urgent, so the client uses the 
corporate directory to contact the sales person’s manager or someone else from 
the sales person’s team.

An internal use case could be checking the status of a workflow, such as 
expense reimbursement or vacation approval. The corporate directory allows the 
employee to find someone who is online right now that can answer that question. 
It could be the manager or a colleague of someone who is unavailable.

Inventory integration
A client wants to place an order, but only if the inventory is in stock. If it is not in 
stock, they want to know when it will be available. It is possible for the customer 
service representative (CSR) to quickly check this status while talking to the 
client. The CSR can now handle more requests and the client is impressed by 
the quick answers and accurate information, resulting in more repeat business.

Order status integration
A client or colleague wants to know the status of an order. This provides an easy 
way to discover that information without logging into an ERP front end. This could 
also be achieved using an instant messaging bot that uses a technical user to 
query the system.

8.1.2  Value to the developer

A developer can learn how to integrate Sametime with a back-end system, such 
as SAP, to create value for the company’s users. Back-end integration is one of 
the most challenging tasks facing a collaboration developer.
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This plug-in uses the following extension points:

� com.ibm.collaboration.realtime.imhub.miniApps

� org.eclipse.ui.runtime.preferences

� org.eclipse.ui.preferencePages

8.1.3  Downloading and deploying the plug-in

To download and deploy the plug-in, the following steps are required:

1. Download the plug-in, as described in Appendix A, “Additional material” on 
page 557.

2. Unzip the file com.ibm.redbooks.st75.sap.zip into your Sametime 7.5 Connect 
client directory, for example, C:\Program Files\IBM\Sametime Connect 
7.5\plugins.

3. Configure the back-end system.

a. If you do not have a back-end system, please set your preferences to not 
use SAP, as described in 8.1.4, “Using the plug-in” on page 305.

b. If you will connect to an SAP system and possess a valid SAP license 
(check with your SAP department if you are unsure), you need to install 
the SAP Java Connector (JCo), as described in 8.2.2, “SAP Java 
Connector installation” on page 338.

4. Restart the Sametime Connect client.

You are now ready to use the SAP Integration plug-in.

8.1.4  Using the plug-in

After starting the Sametime Connect client you should see a new MiniApp called 
SAP Integration. If you do not see it, please recheck your steps in Ê, 
“org.eclipse.ui.preferencePages” on page 305.

Set the SAP integration preferences by selecting File → Preferences. You 
should now see a new preference page called SAP Preferences. Click this page. 
To use SAP, enter your SAP data and click the check box next to Do you want to 
use the SAP system?. To use the test data system, make sure the Do you want 
to use the SAP system? option is unchecked and then the SAP specific 
information (user name and so on) will be ignored.
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Human resources example
This example allows you to view organizational information from the SAP system 
and filter it. The default is to show the whole corporate hierarchy, as shown in 
Figure 8-5.

Figure 8-5   Human resources example showing the complete organizational hierarchy

To filter this selection, there are two steps to follow:

1. Select a manager from the organizational tree. A manager is an employee 
that has employees under him or her.

2. In the HR Filter combo box, select Selected Manager.

An example of a filtered organizational tree is shown in Figure 8-6 on page 307.
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Figure 8-6   An example of a filtered organizational hierarchy

To undo the filter, in the Org Filter combo box, choose All.

The result should be the same as that in the first HR example shown in 
Figure 8-5 on page 306.
 Chapter 8. Advanced plug-in example: SAP integration 307



If you select an employee that is not a manager, then the tree will be empty and 
you will see an error message below the tree. An example of this is shown in 
Figure 8-7.

Figure 8-7   An example of the error message when the filter is applied on a non-manager

You can undo the filter by following these steps:

1. In the HR Filter combo box, select All.

2. Select an employee who is a manager.

3. In the HR Filter combo box, select Selected Manager.

Inventory example
The inventory use case lets you select a product from a given factory (known as 
a plant in SAP). You then enter the desired quantity and click the Search button. 
The plug-in checks the availability in the SAP system of the product you selected 
for the quantity that you entered. Figure 8-8 on page 309 is an example of how 
the results might look.
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Figure 8-8   An example of the inventory search results

Order status example
The order status example lets you enter an order number and check the status in 
the SAP system. Simply follow these two steps:

1. Enter the order ID.

2. Click the Search button.

Attention: You will need to get a sample order ID from the SAP system before 
you can test this.
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The order status results should look like Figure 8-9.

Figure 8-9   Order status results

If the order ID is not found, you will get an error message, as shown in 
Figure 8-10 on page 311.
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Figure 8-10   Order status when the order id is not found

8.1.5  Planning

If you would like to connect to an SAP system, you will need to get the 
connection data (user, password, and so on) from an SAP administrator. All of 
the data you need is on the SAP Preferences page.

For each of the use cases, you will need to get some information from someone 
who knows SAP. Below is a list of data you will need for each use case:

� Human resources: Organization ID

� Inventory: Plant ID

� Order Status: Order ID

You will also need to know what the beginning and end dates for your system 
data should be. In our example, our SAP system has test data starting in 1999. 
Your SAP system may only have data starting from a different year.

Although not necessary for this example, it is also helpful to install an SAP GUI 
on the development machine, so that you can find and test SAP functions, known 
as BAPIs and RFCs.
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It is also helpful to use a visual tool to create the user interface code. Eclipse 
provides the Visual Editor (VE) tool. The 3.2.0 version of VE was unable to show 
the SapMiniApp code (there was only a gray box). There are other GUI tools for 
Eclipse that provide more features. Some of them are:

� Cloudgarden’s Jigloo: http://cloudgarden.com/jigloo/index.html

� SWT Designer: http://www.swt-designer.com/

Cloudgarden’s Jigloo was tested with the Sametime 7.5 toolkit and was able to 
display, edit, and create a user interface for the AbstractMiniApp extension point.

8.2  Building the sample application

The SAP integration plug-in is a MiniApp with three tabs, each containing a 
different integration use case. Below is an overview of the steps required to build 
the plug-in:

Create a new plug-in project.

Create the data models and preferences.

Install and configure the SAP Java Connector or configure the plug-in to use 
dummy data.

Create the human resources example.

Create the inventory example.

Create the order status example.

Deploy the plug-in.

The plug-in is made up of the packages shown in Table 8-1.

Table 8-1   Package overview

Package Name Description

com.ibm.redbooks.st75.sap This is the default package that contains 
the Activator and the SapMgr that 
connects to SAP.

com.ibm.redbooks.st75.sap.actions This package contains the plug-in actions.

com.ibm.redbooks.st75.sap.models This package contains the data models.

com.ibm.redbooks.st75.sap.preferences This package stores the preferences for 
the SAP connection.

com.ibm.redbooks.st75.sap.ui This package stores the user interface 
classes and code.
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8.2.1  Create project and base objects

Create a new plug-in project titled com.ibm.redbooks.st75.sap that will make 
visual contributions, but do not use any templates.

Figure 8-11   Create a new plug-in project

Create SapMiniApp
To be able to see the Sametime extension points, you need to add them as 
dependencies. Perform the following steps:

1. Open the plugin.xml file by double-clicking it in the Package Explorer.

2. Click the Dependencies tab.

3. Click the Add... button. 
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4. Select the com.ibm.collaboration.realtime.imhub plug-in, as shown in 
Figure 8-12.

Figure 8-12   Select the com.ibm.collaboration.realtime.imhub plug-in

5. Click OK. 

The dependency tab should look like Figure 8-13 on page 315.
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Figure 8-13   Updated dependencies

Now that the extension point can be seen by the plug-in, you need to add it to the 
project.

6. Click the Extensions tab.

7. Click the Add... button.
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8. Select com.ibm.collaboration.realtime.imhub.miniApps, as shown in 
Figure 8-14.

Figure 8-14   Select com.ibm.collaboration.realtime.imhub.miniApps

9. Add a new Extension by right-clicking 
com.ibm.collaboration.realtime.imhub.miniApps.

10.Select miniApp.

11.Update the fields to look like Figure 8-15 on page 317.
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Figure 8-15   Updated SapMiniApp Extension

12.You should now save and close the plugin.xml.

13.Open the newly created SapMiniApp class.
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14.Edit the createControl method, as shown in Example 8-1 to add a TabFolder 
and three tabs, one for each example we will create. The creation of the tabs 
will be factored out into separate methods, as shown in Example 8-1. You will 
see error messages until you have made all the changes.

Example 8-1   Create the basic user interface

public Control createControl(Composite parent) {
GridLayout parentLayout = new GridLayout();
parentLayout.makeColumnsEqualWidth = true;
parent.setLayout(parentLayout);
parent.setSize(375, 400);

tabFolderSAP = new TabFolder(parent, SWT.NONE);
GridData tabFolderSAPLData = new GridData();
tabFolderSAPLData.heightHint = 374;
tabFolderSAPLData.widthHint = 334;
tabFolderSAP.setLayoutData(tabFolderSAPLData);
tabFolderSAP.setSize(334, 374);

createHRTab();
createInventoryTab();
createOrderStatusTab();

tabFolderSAP.setSelection(0);
return parent;

}// end method

private void createHRTab() {
tabItemHR = new TabItem(tabFolderSAP, SWT.NONE);
tabItemHR.setText("HR");

}// end method

private void createInventoryTab() {

Important: All GUI components were created as member (that is, class level) 
variables, but the configuration (layout) objects are local. There are two 
common ways of defining layouts:

1. Define new objects for each component. This is the method this example 
follows because it is easier to understand the code and debug it later.

2. Create one layout object, for example, GridData gd, that is recreated (for 
example, gd = new GridData()) for each object where the layout is different.

If you are new to Eclipse, then we recommend you stick with option 1.
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tabItemHR = new TabItem(tabFolderSAP, SWT.NONE);
tabItemHR.setText("Inventory");

}// end method

private void createOrderStatusTab() {
tabItemHR = new TabItem(tabFolderSAP, SWT.NONE);
tabItemHR.setText("Order Status");

}// end method

If you have not already done so, configure a target run time, as described in 
3.3.5, “Task 5: Configure the target platform” on page 48. Make sure that this 
plug-in is included.

Run the plug-in. It should look like Figure 8-16.

Figure 8-16   SapMiniApp with the base user interface

Tip: You can also perform the step above in your visual tool for user interfaces. 
Remember to factor out the tab creation into separate methods so that it is 
easier to read and maintain your code.
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Update Activator.java
To facilitate logging and debugging, add the two methods Example 8-2 to the 
Activator.java file.

Example 8-2   Add logging methods

/**
* Logs to a file
*
*/
public static void log(String title, String message) {

IStatus status = new Status(IStatus.INFO, title, 0, message, 
(Throwable) null);

getDefault().getLog().log(status);
} //end method

/**
* Logs errors to a file
*
*/
public static void logError(String title, String message) {

IStatus status = new Status(IStatus.ERROR, title, 0, message, 
(Throwable) null);

getDefault().getLog().log(status);
} //end method

Create data objects
We will now create the data objects required for all three examples. Create a new 
a package titled com.ibm.redbooks.st75.models. Table 8-2 is an overview of the 
classes to create.

Table 8-2   Data object overview

Data object Description

Person Contains all relevant information for 
employees and managers.

Organization Contains all the employees in the 
organization.

Product Contains all product information, such as 
price.

Order Contains all information regarding a given 
order, including products, status, and so 
on.
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Person.java
This object (Example 8-3) holds all the information about an employee or a 
manager. It is mostly a plain old java object (POJO), except for two extra 
constructors that allow us to create a new Person with all of the required data in 
one method call, instead of multiple ones. The other interesting method is 
addEmployee. This is different from setEmployees in that it allows us to add 
employees one at a time instead of all at once. This made the reading of 
hierarchy information out of SAP much easier.

Example 8-3   Person.java

package com.ibm.redbooks.st75.sap.models;

public class Person {
private String name;
private boolean managerFlag;
private String orgName;
private int orgCode;
private Person [] employees;
private Person manager;
private int id;
private int managerId;

public Person(){
super();

}

public Person(String name, String orgName, int orgCode, 
boolean managerFlag, Person[] employees, 
Person manager){

super();
this.setName(name);
this.setOrgName(orgName);
this.setOrgCode(orgCode);
this.setManagerFlag(managerFlag);
this.setEmployees(employees);
this.setManager(manager);

}

public Person(String name, int id, String orgName, int orgCode, 
boolean managerFlag, Person[] employees, 
Person manager){

super();
this.setName(name);
this.setOrgName(orgName);
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this.setOrgCode(orgCode);
this.setManagerFlag(managerFlag);
this.setEmployees(employees);
this.setManager(manager);
this.setId(id);

}

/*
 * Adds an employee to the manager and automatically sets {@link 

#managerFlag}
 * if this is the first employee.
 * 
 * @param person The new employee to add
 */
public void addEmployee(Person person){

//minimum size for the array
int iSize = 1;
Person [] newEmployees = null;
//make the array one bigger if there are already employees
if(this.employees != null){

iSize = this.employees.length + 1;
newEmployees = new Person[iSize];
//copy the old employees if there are any
System.arraycopy(this.employees, 0, newEmployees, 0, 

this.employees.length);
} else {

newEmployees = new Person[iSize];
}//end if

//add the new employee to the end of the array
newEmployees[iSize-1] = person;

//set the manager flag, if it is not set
if(!hasManagerFlag())

setManagerFlag(true);
}//end method

public int getId() {
return id;

}

public void setId(int id) {
this.id = id;

}
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public boolean hasManagerFlag() {
return managerFlag;

}
public void setManagerFlag(boolean managerFlag) {

this.managerFlag = managerFlag;
}
public String getName() {

return name;
}
public void setName(String name) {

this.name = name;
}
public int getOrgCode() {

return orgCode;
}
public void setOrgCode(int orgCode) {

this.orgCode = orgCode;
}
public String getOrgName() {

return orgName;
}
public void setOrgName(String orgName) {

this.orgName = orgName;
}
public Person[] getEmployees() {

return employees;
}
public void setEmployees(Person[] employees) {

this.employees = employees;
}
public Person getManager() {

return manager;
}
public void setManager(Person manager) {

this.manager = manager;
}

public int getManagerId() {
return managerId;

}

public void setManagerId(int managerId) {
this.managerId = managerId;

}
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}

Organization.java
The Organization object (Example 8-4) stores the employees in a given 
department or organization.

Example 8-4   Organization.java

package com.ibm.redbooks.st75.sap.models;

public class Organization {
private Person[] employees;
private String name;
private int id;

public Person[] getEmployees() {
return employees;

}//end method

public void setEmployees(Person[] employees) {
this.employees = employees;

}//end method

public String getName() {
return name;

}//end method

public void setName(String name) {
this.name = name;

}//end method

public int getId() {
return id;

}

public void setId(int id) {
this.id = id;

}
}

Product.java
The Product class (Example 8-5 on page 325) stores all information related to a 
product, such as price, the plant where it is located, and availability.
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Example 8-5   Product.java

package com.ibm.redbooks.st75.sap.models;

public class Product {
private String productId;
private String name;
private String plant;
private double price;
private String currency;
private int quantity;
private String units;
private String availabilityDate;

public Product(){
super();

}//end constructor

public Product(String productId, String name, String plant, double 
price, String currency, 

int quantity, String units, String availabilityDate){
super();
setProductId(productId);
setName(name);
setPlant(plant);
setPrice(price);
setCurrency(currency);
setQuantity(quantity);
setUnits(units);
setAvailabilityDate(availabilityDate);

}//end constructor

public String getPlant() {
return plant;

}
public void setPlant(String plant) {

this.plant = plant;
}
public String getName() {

return name;
}
public void setName(String name) {

this.name = name;
}
public String getCurrency() {
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return currency;
}
public void setCurrency(String currency) {

this.currency = currency;
}
public double getPrice() {

return price;
}
public void setPrice(double price) {

this.price = price;
}
public String getUnits() {

return units;
}
public void setUnits(String units) {

this.units = units;
}

public String getAvailabilityDate() {
return availabilityDate;

}

public void setAvailabilityDate(String availabilityDate) {
this.availabilityDate = availabilityDate;

}

public String getProductId() {
return productId;

}

public void setProductId(String productId) {
this.productId = productId;

}

public int getQuantity() {
return quantity;

}

public void setQuantity(int quantity) {
this.quantity = quantity;

}

}
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Order.java
Example 8-6 shows the order.java object.

Example 8-6   Order.java

package com.ibm.redbooks.st75.sap.models;

public class Order {
private int deliveryId;
private int deliveryQuantity;
private double total;
private int orderId;
private String units;
private String orderDate;
private String deliveryDate;
private String description;
private String status;
private int price;
private String currency;
private int quantity;
private String productId;

public String getDescription() {
return description;

}
public void setDescription(String currentLocation) {

this.description = currentLocation;
}
public String getDeliveryDate() {

return deliveryDate;
}
public void setDeliveryDate(String deliveryDate) {

this.deliveryDate = deliveryDate;
}
public String getOrderDate() {

return orderDate;
}
public void setOrderDate(String orderDate) {

this.orderDate = orderDate;
}
public int getOrderId() {

return orderId;
}
public void setOrderId(int orderNumber) {

this.orderId = orderNumber;
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}
public String getCurrency() {

return currency;
}
public void setCurrency(String currency) {

this.currency = currency;
}
public int getPrice() {

return price;
}
public void setPrice(int price) {

this.price = price;
}
public String getStatus() {

return status;
}
public void setStatus(String status) {

this.status = status;
}
public int getQuantity() {

return quantity;
}
public void setQuantity(int quantity) {

this.quantity = quantity;
}
public int getDeliveryQuantity() {

return deliveryQuantity;
}
public void setDeliveryQuantity(int deliveryQuantity) {

this.deliveryQuantity = deliveryQuantity;
}
public String getProductId() {

return productId;
}
public void setProductId(String productId) {

this.productId = productId;
}
public double getTotal() {

return total;
}
public void setTotal(double total) {

this.total = total;
}
public String getUnits() {

return units;
328 Extending Sametime 7.5: Building Plug-ins for Sametime



}
public void setUnits(String units) {

this.units = units;
}
public int getDeliveryId() {

return deliveryId;
}
public void setDeliveryId(int deliveryId) {

this.deliveryId = deliveryId;
}

}

Create preferences
The easiest way to create the preferences is by using the standard Eclipse 
template.

Open the plugin.xml by double-clicking it in the Package Explorer. 
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Click the Extensions tab. Click the Add... button (see Figure 8-17).

Figure 8-17   Click the Add... button
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Select the org.eclipse.ui.preferencePages Extension (see Figure 8-18).

Figure 8-18   Select the org.eclipse.ui.preferencePages extension
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Select the default template and click Next (see Figure 8-19)

Figure 8-19   Select the default template and click Next

3. Change the page class name to SapPreferencePage and the page name to 
Sap Preferences and then click Finish (see Figure 8-20 on page 333).
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Figure 8-20   Change the names of the class and page and then click Finish

4. If you expand your extension points and highlight the new Sap Preferences 
Extension, your window should look like Figure 8-21.

Figure 8-21   The extensions tab after adding the preferences extension.
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The next step is to customize the template preference code to work for the 
plug-in. We will add the SAP login parameters and those required for the different 
use cases.

PreferenceConstants.java
Change the constants first, as shown in the code in Example 8-7. The constants 
are used to define unique IDs for each of the preferences. They are used by the 
plug-in to save the preferences and by the PreferenceInitializer to set default 
values.

Example 8-7   PreferenceConstants.java

package com.ibm.redbooks.st75.sap.preferences;

/**
 * Constant definitions for plug-in preferences
 */
public class PreferenceConstants {

public static final String P_PATH = "pathPreference";

public static final String TITLE = "title";

public static final String CLIENT_NUMBER = "clientNumber";

public static final String SYSTEM_NUMBER = "systemNumber";

public static final String USER_NAME = "userName";

public static final String PASSWORD = "password";

public static final String USE_SAP = "useSap";

public static final String HOST = "host";

public static final String LANGUAGE = "language";

public static final String PLANT = "plant";

public static final String ORGANIZATION = "organization";
}

Tip: If you do not follow this order when updating the preference classes, you 
will have temporary errors because elements are being deleted and changed.
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PreferenceInitializer.java
Set any default values for the SAP connection (see Example 8-8). You do not 
have to set default values for all of the fields. If you would prefer not to set any 
default values, then just delete all the store.setDefault commands.

Example 8-8   PreferenceInitializer.java

package com.ibm.redbooks.st75.sap.preferences;

import 
org.eclipse.core.runtime.preferences.AbstractPreferenceInitializer;
import org.eclipse.jface.preference.IPreferenceStore;

import com.ibm.redbooks.st75.sap.Activator;

/**
 * Class used to initialize default preference values.
 */
public class PreferenceInitializer extends 
AbstractPreferenceInitializer {

/*
 * (non-Javadoc)
 * 
 * @see 

org.eclipse.core.runtime.preferences.AbstractPreferenceInitializer#init
ializeDefaultPreferences()

 */
public void initializeDefaultPreferences() {

IPreferenceStore store = Activator.getDefault()
.getPreferenceStore();

//Set default values
store.setDefault(PreferenceConstants.USE_SAP, false);
store.setDefault(PreferenceConstants.LANGUAGE, "EN");
store.setDefault(PreferenceConstants.SYSTEM_NUMBER, "00");
store.setDefault(PreferenceConstants.CLIENT_NUMBER, "800");

}

}
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SapPreferencePage.java
Delete or comment out the example preferences and insert the preferences 
defined in Example 8-9.

Example 8-9   SapPreferencePage.java

package com.ibm.redbooks.st75.sap.preferences;

import org.eclipse.jface.preference.*;
import org.eclipse.ui.IWorkbenchPreferencePage;
import org.eclipse.ui.IWorkbench;
import com.ibm.redbooks.st75.sap.Activator;

/**
 * This class represents a preference page that
 * is contributed to the Preferences dialog. By 
 * subclassing <samp>FieldEditorPreferencePage</samp>, we
 * can use the field support built into JFace that allows
 * us to create a page that is small and knows how to 
 * save, restore and apply itself.
 * <p>
 * This page is used to modify preferences only. They
 * are stored in the preference store that belongs to
 * the main plug-in class. That way, preferences can
 * be accessed directly via the preference store.
 */

public class SapPreferencePage
extends FieldEditorPreferencePage
implements IWorkbenchPreferencePage {

public SapPreferencePage() {
super(GRID);
setPreferenceStore(Activator.getDefault().getPreferenceStore());
setDescription("A demonstration of a preference page 

implementation");
}

/**
 * Creates the field editors. Field editors are abstractions of
 * the common GUI blocks needed to manipulate various types
 * of preferences. Each field editor knows how to save and
 * restore itself.
 */
public void createFieldEditors() {
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addField(new BooleanFieldEditor(PreferenceConstants.USE_SAP,
"&Do you want use the SAP system? (if not dummy data 

will be used)", 
, getFieldEditorParent()));

//Add the SAP parameters
addField(

new StringFieldEditor(PreferenceConstants.USER_NAME, "&User 
Name:", getFieldEditorParent()));

addField(
new StringFieldEditor(PreferenceConstants.PASSWORD, 

"&Password:", getFieldEditorParent()));
addField(

new StringFieldEditor(PreferenceConstants.SYSTEM_NUMBER, 
"&System Number:", getFieldEditorParent()));

addField(
new StringFieldEditor(PreferenceConstants.CLIENT_NUMBER, 

"&Client Number:", getFieldEditorParent()));
addField(

new StringFieldEditor(PreferenceConstants.HOST, "&Host 
Name:", getFieldEditorParent()));

addField(
new StringFieldEditor(PreferenceConstants.LANGUAGE, 

"Language (Ex: EN = English):", getFieldEditorParent()));
addField(

new StringFieldEditor(PreferenceConstants.ORGANIZATION, 
"Organization ID", getFieldEditorParent()));

addField(
new StringFieldEditor(PreferenceConstants.PLANT, "Plant 

ID", getFieldEditorParent()));
}

/* (non-Javadoc)
 * @see 

org.eclipse.ui.IWorkbenchPreferencePage#init(org.eclipse.ui.IWorkbench)
 */
public void init(IWorkbench workbench) {
}

}
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When you have finished, your preference page should look like Figure 8-22.

Figure 8-22   Finished SAP preference page

If you do not have an SAP system to test against, please skip to 8.2.3, “Configure 
the plug-in to run without SAP” on page 341.

8.2.2  SAP Java Connector installation

The SAP Java Connector (JCo) allows Java programs to communicate with SAP. 
As Eclipse is Java-based, this connector can also be used by a plug-in to 
communicate with SAP.

The first step is to download the SAP Java Connector. The latest version can 
downloaded from SAPNet (registration required) at 
http://service.sap.com/connectors.

The connector is a zip file. After downloading it, you can simply unzip onto your 
file system. In this example, we used D:\sapjco.

Tip: Help for installing and using the connector can be found at 
http://help.sap.com/saphelp_nw2004s/helpdata/en/47/80f671ee6e4b41b63
c0fe46bd6e4f8/frameset.htm.
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Add the Java Connector to the development environment
After extracting the JCo, you need to add it to your plug-in.

Right-click the com.ibm.redbooks.st75.sap project folder and select Build 
Path → Configure Build Path....

Click on the Libraries tab (see Figure 8-23).

Figure 8-23   Navigate to the Libraries tab of the Java Build Path

Click Add External JARs.... Navigate to the folder that contains the unzipped 
SAP Java Connector and double-click the sapjco.jar file to add it to the project 
(see Figure 8-24 on page 340).
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Figure 8-24   Java Build Path updated to include the SAP Java Connector

Add the Java Connector to the example plug-in
Perform the following steps:

1. Unzip the com.ibm.redbooks.st75.sap_1.0.0.zip file on to your hard drive.

2. Open the plugins folder to find the file com.ibm.redbooks.st75.sap_1.0.0.jar.

3. Unzip the jar file with either a zip tool, such as WinRar, or using the JVM.

4. Add the JCO files that you unzipped to the folder lib\sapjco.

These files include:

� sapjco.jar

� sapjcorfc.dll

� librfc32.dll

� dev_rfc.trc

� Readme.txt

5. Recreate the jar file and deploy it as described in 8.1.3, “Downloading and 
deploying the plug-in” on page 305.
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8.2.3  Configure the plug-in to run without SAP

It is also possible to configure the plug-in to run without an SAP back-end 
system. To achieve this, please follow these steps:

1. Set the use SAP system preference to false.

2. Create the TestMgr class to contain your test data as described in 8.2.4, 
“Create the SAP and test classes” on page 341.

8.2.4  Create the SAP and test classes

In this section you will create the classes to connect to SAP and a test class in 
case you do not have access to an SAP system.

We will create the classes shown in Table 8-3.

Table 8-3   SAP and Test Classes

IERPMgr.java
The IERPMgr class (Example 8-10) is an interface for connecting to back-end 
systems. It is used by the SapMiniApp so that the user can switch between test 
data and an SAP system without changing the code.

Example 8-10   IERPMgr.java

package com.ibm.redbooks.st75.sap;

import com.ibm.redbooks.st75.sap.models.*;

public interface IERPMgr {

public void createConnection();

public void closeConnection();

public Organization getHRData(int organizationId);

Class Description

IERPMgr Interface for the connection methods for 
the back-end system.

SapMgr The SapMgr connects to SAP and 
retrieves data.

TestMgr The TestMgr simulates a back-end system 
and returns dummy data.
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public Product checkProductStatus(Product product);

public Product[] getInventory(int plantId);

public Order getOrderStatus(String orderId); 

}

SapMgr.java
The SapMgr (Example 8-11) connects to the SAP system and makes the API 
calls. It implements the IERPMgr interface. This class will be updated in later 
sections.

Example 8-11   SapMgr.java

package com.ibm.redbooks.st75.sap;

import com.ibm.redbooks.st75.sap.models.*;

public class SapMgr implements IERPMgr {
public void closeConnection() {

// TODO Auto-generated method stub
}

public void createConnection() {
// TODO Auto-generated method stub

}

public Organization getHRData(int organizationId) {
// TODO Auto-generated method stub
return null;

}
public Product checkProductStatus(Product product){

// TODO Auto-generated method stub
return null;

public Product[] getInventory(int plantId) {
// TODO Auto-generated method stub
return null;

}
public Order getOrderStatus(String orderId) {

// TODO Auto-generated method stub
return null;
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}
}

Add the following variables and update the open and close connection methods, 
as shown in Example 8-12.

Example 8-12   Add variables and update the connection methods

public static final String HR_BAPI_GET_ORG_EMPLOYEES = 
"HRCM_ORGUNIT_EMPLOYEE_LIST_GET";

public static final String HR_BAPI_GET_EMPLOYEE_INFO = 
"HRCM_EMPLOYEE_INFO_GET";

public static final String INV_BAPI_GET_MATERIAL_AVAILABILITY = 
"BAPI_MATERIAL_AVAILABILITY";

public static final String INV_BAPI_GET_MATERIAL_DETAIL = 
"BAPI_MATERIAL_GET_DETAIL";

public static final String INV_BAPI_GET_MATERIAL_BY_PLANT = 
"BAPI_MATERIAL_GETLIST";

public static final String ORDER_BAPI_GET_ORDER_STATUS = 
"BAPI_SALESORDER_GETSTATUS";

private JCO.Client sapConnection;

private JCO.Repository sapRepository;

/*
 * Creates a connection with the SAP System, using the values stored 

in the user's
 * preference page. Please @see 

com.ibm.redbooks.sap.preferences.SapPreferencePage
 * for more information. 
 * 
 * @see com.ibm.redbooks.st75.sap.IERPMgr#createConnection()
 */
public void createConnection() {

try {

IPreferenceStore preferenceStore = 
Activator.getDefault().getPreferenceStore();

String clientNumber = 
preferenceStore.getString(PreferenceConstants.CLIENT_NUMBER);

String systemNumber = 
preferenceStore.getString(PreferenceConstants.SYSTEM_NUMBER);

String host = 
preferenceStore.getString(PreferenceConstants.HOST);
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String userName = 
preferenceStore.getString(PreferenceConstants.USER_NAME);

String password = 
preferenceStore.getString(PreferenceConstants.PASSWORD);

String language = 
preferenceStore.getString(PreferenceConstants.LANGUAGE);

//Use the preferences to create the connection
sapConnection = JCO.createClient(clientNumber, userName, 

password, 
language, host, systemNumber);

sapConnection.connect();
sapRepository = new JCO.Repository("redbooks", sapConnection);

} catch (Exception ex) {
ex.printStackTrace();
Activator.logError("Error creating connection to SAP", 

ex.getMessage());
}

}// end method

/*
 * Closes the connection with the SAP system.
 * @see com.ibm.redbooks.st75.sap.IERPMgr#closeConnection()
 */
public void closeConnection(){

sapConnection.disconnect();
}//end method

Add the helper methods in Example 8-13 to make the integration with SAP 
easier.

Example 8-13   Helper methods for calling SAP BAPIs

/*
 * Checks the SAP BAPI result for errors.
 * 
 * @param returnStructurethe result of the SAP BAPI
 * @return <code>true</code> - if there are erorrs <br>
 * <code>false</code> - if there are no errors
 */
private boolean checkForErrors(JCO.Structure returnStructure){

boolean b = false;
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//make sure there was not an error in the API call
if (!(returnStructure.getString("TYPE").equals("") || 

returnStructure
.getString("TYPE").equals("S"))) {

Activator.logError("BAPI Error", 
returnStructure.getString("MESSAGE"));

b = true;
}//end if-else
return b;

}//end method

public JCO.Function createFunction(String name) throws Exception {
try {

//Create the function template, SAP always uses upper case
IFunctionTemplate ft = 

sapRepository.getFunctionTemplate(name.toUpperCase());
if (ft == null) {

String s = "The SAP Function "  + name + 
" was not found in the SAP system. Please verify this 

" +
"with your SAP developer and/or administrator.";

Activator.log("SapMgr.createFunction", s);
return null;

} else {
return ft.getFunction();

}// end if-else
} catch (Exception ex) {

ex.printStackTrace();
Activator.logError("SapMgr.createFunction", ex.getMessage());
throw new Exception("Problem retrieving JCO.Function object: " 

+ name);
}//end try-catch

}//end method
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TestMgr.java
The TestMgr (Example 8-14) mimics a back-end system. It provides test data so 
that the user interface can be tested independently from a back-end system like 
SAP. This class will be updated in later sections.

Example 8-14   TestMgr.java

package com.ibm.redbooks.st75.sap;

import com.ibm.redbooks.st75.sap.models.*;

public class TestMgr implements IERPMgr {

public void closeConnection() {
// TODO Auto-generated method stub

}

public void createConnection() {
// TODO Auto-generated method stub

}

public Organization getHRData(int organizationId) {
// TODO Auto-generated method stub
return null;

}
public Product checkProductStatus(Product product){

// TODO Auto-generated method stub
return null;

public Product[] getInventory(int plantId) {
// TODO Auto-generated method stub
return null;

}
public Order getOrderStatus(String orderId) {

// TODO Auto-generated method stub
return null;

}
}
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SapMiniApp
You now need to update the UI to use the preferences to determine which 
back-end system to use, SAP or test data.

Update the init method, as shown in Example 8-15.

Example 8-15   Updated init method

public void init() throws Exception {
// check the preferences to use SAP or the test data
IPreferenceStore preferenceStore = Activator.getDefault()

.getPreferenceStore();
boolean bUseSap = preferenceStore

.getBoolean(PreferenceConstants.USE_SAP);
if (bUseSap) {

sapMgr = new SapMgr();
sapMgr.createConnection();
if (null != sapMgr) {

Activator.log("Back-end System", "Using SapMgr");
} else {

Activator.logError("Back-end System", "Error creating 
SapMgr");

}// end if-else

} else {
sapMgr = new TestMgr();
Activator.log("Back-end System", "Using TestMgr");

}// end if-else
}// end method

Constants.java
Create a constants class (see Example 8-16) in the com.ibm.redbooks.st75.sap 
package to store some values that you will reuse for the examples.

Example 8-16   Constants

package com.ibm.redbooks.st75.sap;

public interface Constants {

//inventory UI constants

public static final int INVENTORY_PRODUCT_ID_COLUMN = 0;
public static final int INVENTORY_NAME_COLUMN = 1;
public static final int INVENTORY_PRICE_COLUMN = 2;
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public static final int INVENTORY_CURRENCY_COLUMN = 3;
public static final int INVENTORY_QUANTITY_COLUMN = 4;
public static final int INVENTORY_UNITS_COLUMN = 5;
public static final int INVENTORY_AVAILABILITY_DATE_COLUMN = 6;

public static final int INVENTORY_PLANT_ID = 3200;
public static final String HR_FILTER_ALL = "All";
public static final String HR_FILTER_SELECTED_MANAGER = "Selected 

Manager";
public static final int HR_ORGANIZATION_ID = 50000147;

}

You have now created the foundation for the three examples.

8.2.5  HR example

The HR example (see Figure 8-25) reads the organizational hierarchy out of the 
SAP system. 

Figure 8-25   Organizational hierarchy from the SAP system
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This example also provides a filter that allows you to filter the results to see just 
the employes that are managed by the selected employee (see Figure 8-26).

Figure 8-26   Organizational chart filtered to only show the employees of the selected 
manager.

The first step in changing the user interface is creating the helper classes. We 
will create or update the classes in Table 8-4.

Table 8-4   Overview of the HR classes to create or update

package Class Description

com.ibm.redbooks.st75.ui HRLabelProvider Provides the labels and 
images for the HR 
organizational tree.

com.ibm.redbooks.st75.ui HRTreeContentProvider Determines the hierarchy 
in the HR organizational 
tree.

com.ibm.redbooks.st75.ui HRFilter Filters the HR data in the 
organizational tree.

com.ibm.redbooks.st75.ui SapMiniApp The user interface.

com.ibm.redbooks.st75.ui SapMgr Performs SAP integration.

com.ibm.redbooks.st75.ui TestMgr Provides test data.
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First, you will create the UI helper classes.

HRLabelProvider.java
This class (see Example 8-17) is used by the TreeViewer element to display the 
organization, managers, and employees.

Example 8-17   HRLabelProvider

public class HRLabelProvider implements ILabelProvider {

public Image getImage(Object element) {
/*
 Image image = null;

if (element instanceof Person) {
if (((Person) element).isManagerFlag()) {

image = Activator.EMPLOYEE_IMAGE;
} else {

image = Activator.MANAGER_IMAGE;
}// end if-else

} else {
// throw error
System.err.println("Not a person");

}// end if-else
return image;

*/
return null;

}

public String getText(Object element) {
String sText = null;
if (element instanceof Person) {

sText = ((Person) element).getName();
}// end if
System.out.println("person name = " + sText);

return sText;
}

public void addListener(ILabelProviderListener arg0) {
}

public void dispose() {
}

public boolean isLabelProperty(Object arg0, String arg1) {
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return true;
}

public void removeListener(ILabelProviderListener arg0) {
}

}

HRTreeContentProvider.java
This class (see Example 8-18) is used by the TreeViewer element to display the 
organization, managers, and employees.

Example 8-18   HRTreeContentProvider

public class HRTreeContentProvider implements ITreeContentProvider {

public Object[] getChildren(Object parentElement) {
Object[] oa = new Object[0];
if (parentElement instanceof Person && ((Person) 

parentElement).hasManagerFlag()){
oa = ((Person) parentElement).getEmployees();

} else if (parentElement instanceof Organization){
oa = ((Organization) parentElement).getEmployees();

}//end if-else
return oa;

}

public Object getParent(Object element) {
Object oParent = null;
if (element instanceof Person){

oParent = ((Person) element).getManager();
}//end if
return oParent;

}

public boolean hasChildren(Object element) {
boolean b = false;
if (element instanceof Person){

b = ((Person) element).hasManagerFlag();
}else if (element instanceof Organization){

b = true;
}//end if
return b;

}
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public Object[] getElements(Object element) {
return getChildren(element);

}

public void dispose() {
// TODO Auto-generated method stub

}

public void inputChanged(Viewer viewer, Object oldInput, Object 
newInput) {

}

}

HRFilter.java
This class (see Example 8-19) is used by the TreeViewer to filter the organization 
to only be the selected manager.

Example 8-19   HRFilter

public class HRFilter extends ViewerFilter {
private boolean showAll = true;
private String managerName;
public boolean select(Viewer viewer, Object parentElement, Object 

element) {
boolean b = false;
if(showAll){ //check if anything should be filtered

b = true;
}else if (managerName == null || "".equals(managerName)){

//if the managerName was never set then filter out everything
System.out.println("mgr name is null");
b = false; 

}else if (parentElement instanceof Person && parentElement != 
null){

Person p = (Person) parentElement;
System.out.println("employee & not mgr");
if (managerName.equalsIgnoreCase(p.getName())){

System.out.println("dude is ur mgr");
b = true;

}//end if
}else if (element instanceof Person && element != null){

Person p = (Person) element;
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System.out.println("mgr");
if (managerName.equalsIgnoreCase(p.getName())){

System.out.println("you are manager");
b = true;

}//end if
}//end if-else
return b;

}
public boolean isShowAll() {

return showAll;
}
public void setShowAll(boolean showAll) {

this.showAll = showAll;
}
public String getManagerName() {

return managerName;
}
public void setManagerName(String managerName) {

this.managerName = managerName;
}

}

SapMiniApp changes
The code in Example 8-20 was added to the SapMiniApp to create this user 
interface.

Example 8-20   HR changes to the SapMiniApp

private void createHRTab() {
//START >>  tabItemHRNew
tabItemHRNew = new TabItem(tabFolderSAP, SWT.NONE);
tabItemHRNew.setText("HR");
//START >>  compHRNew
compHRNew = new Composite(tabFolderSAP, SWT.NONE);
GridLayout compHRNewLayout = new GridLayout();
compHRNewLayout.marginRight = 5;
compHRNewLayout.marginLeft = 5;
compHRNewLayout.numColumns = 2;
compHRNew.setLayout(compHRNewLayout);
tabItemHRNew.setControl(compHRNew);
//START >>  lblHRFilter
lblHRFilter = new Label(compHRNew, SWT.NONE);
GridData lblHRFilterLData = new GridData();
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lblHRFilterLData.widthHint = 45;
lblHRFilter.setLayoutData(lblHRFilterLData);
lblHRFilter.setText("HR Filter");
//END <<  lblHRFilter
//START >>  cboHRFilter
cboHRFilter = new Combo(compHRNew, SWT.NONE);
GridData cboHRFilterLData = new GridData();
cboHRFilterLData.grabExcessHorizontalSpace = true;
cboHRFilterLData.horizontalAlignment = GridData.FILL;
cboHRFilter.setLayoutData(cboHRFilterLData);
//add filter items to combo box
String[] hrFilters = { Constants.HR_FILTER_ALL,

Constants.HR_FILTER_SELECTED_MANAGER };
cboHRFilter.setItems(hrFilters);
cboHRFilter.setText("Filter");
cboHRFilter.addSelectionListener(new SelectionAdapter() {

public void widgetSelected(SelectionEvent evt) {
if (Constants.HR_FILTER_SELECTED_MANAGER.equals(cboHRFilter

.getText())) {
hrFilter.setShowAll(false);
treeViewerHR.addFilter(hrFilter);
treeViewerHR.refresh();
if(treeViewerHR.getSelection().isEmpty()){

lblHRError.setText("The selected employee is not a 
manager.");

}//end if
} else {

hrFilter.setShowAll(true);
treeViewerHR.removeFilter(hrFilter);
treeViewerHR.refresh();
lblHRError.setText("");

}// end if-else
}

});
//END <<  cboHRFilter
//START >>  treeViewerHR
GridData treeViewerHRLData = new GridData();
treeViewerHRLData.grabExcessHorizontalSpace = true;
treeViewerHRLData.horizontalAlignment = GridData.FILL;
treeViewerHRLData.verticalAlignment = GridData.BEGINNING;
treeViewerHRLData.horizontalSpan = 2;
treeViewerHRLData.heightHint = 250;
treeViewerHR = new TreeViewer(compHRNew, SWT.BORDER);
treeViewerHR.getControl().setLayoutData(treeViewerHRLData);
//add filter
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hrFilter = new HRFilter();
treeViewerHR.addFilter(hrFilter);
//add providers
treeViewerHR.setContentProvider(new HRTreeContentProvider());
treeViewerHR.setLabelProvider(new HRLabelProvider());
treeViewerHR.getTree().setSize(289, 233);
treeViewerHR.getTree().addSelectionListener(new 

SelectionAdapter() {
public void widgetSelected(SelectionEvent se) {

if (se.item != null) {
String s = ((Person) (se.item.getData())).getName();
hrFilter.setManagerName(s);
treeViewerHR.refresh();

}// end if
}

});

treeViewerHR.setInput(sapMgr.getHRData(Constants.HR_ORGANIZATION_ID));

//END <<  treeViewerHR
//START >>  lblHRError
GridData lblHRErrorLData = new GridData();
lblHRErrorLData.grabExcessHorizontalSpace = true;
lblHRErrorLData.horizontalSpan = 2;
lblHRErrorLData.heightHint = 25;
lblHRErrorLData.horizontalAlignment = GridData.FILL;
lblHRErrorLData.verticalAlignment = GridData.BEGINNING;
lblHRError = new Label(compHRNew, SWT.NONE);
lblHRError.setLayoutData(lblHRErrorLData);
Color colorRed = new Color(getSite().getShell().getDisplay(),255, 

0, 0);
lblHRError.setForeground(colorRed);
//END <<  lblHRError
//END <<  compHRNew
//END <<  tabItemHRNew

}// end method
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SapMgr changes
There are two BAPIs that we will use to collect the information from SAP, as 
shown in Table 8-5. 

Table 8-5   Overview of the SAP BAPIs used in the HR example

The first step is to retrieve the employee IDs, as shown in Example 8-21.

Example 8-21   HR changes to the SapMgr

public Organization getHRData(int organizationId) {
Organization org = null;
JCO.Function functionGetOrgEmployees = null;

JCO.Table tblEmployees = null;

Person[] paEmployees = null;

try {

functionGetOrgEmployees = 
this.createFunction(HR_BAPI_GET_ORG_EMPLOYEES);

//set the parameter values, using defaults for some of them.

functionGetOrgEmployees.getImportParameterList().setValue("01", 
"PLVAR");

functionGetOrgEmployees.getImportParameterList().setValue("O", 
"OTYPE");

functionGetOrgEmployees.getImportParameterList().setValue(""+organizati
onId, "OBJID");

functionGetOrgEmployees.getImportParameterList().setValue("1999-01-01", 
"BEGDA");

BAPI® Description Input Output

HRCM_ORGUNIT
_EMPLOYEE_LIS
T_GET

Retrieves a list of 
employees for the 
given organization 
ID.

Organization ID List of employee 
IDs

HRCM_EMPLOYE
E_INFO_GET

Retrieves 
employee 
information for the 
given employee ID.

Employee ID Detailed employee 
information, 
including the 
manager’s ID.
356 Extending Sametime 7.5: Building Plug-ins for Sametime



functionGetOrgEmployees.getImportParameterList().setValue("2006-01-01", 
"ENDDA");

functionGetOrgEmployees.getImportParameterList().setValue(" ", 
"PATH_ID");

//execute the function
sapConnection.execute(functionGetOrgEmployees);
JCO.Structure returnStructure = 

functionGetOrgEmployees.getExportParameterList().getStructure("RETURN")
;

checkForErrors(returnStructure);

//get results
tblEmployees = 

functionGetOrgEmployees.getTableParameterList().getTable("PERNR_TABLE")
;

//create array to hold results
paEmployees = new Person[tblEmployees.getNumRows()];
//loop through results
for (int i = 0; i < tblEmployees.getNumRows(); i++) {

//move to the next row in the employees table
tblEmployees.setRow(i);
//store the information in the employee array
paEmployees[i] = 

getEmployeeInfo(tblEmployees.getInt("PERNR"));
//Activator.log("HR Employee", "Person ID = " + 

tblEmployees.getString("PERNR"));
}//end for

} catch (Exception ex) {
ex.printStackTrace();
Activator.logError("Error retireving employee IDs", 

ex.getMessage());
}//end try-catch

return org;
}//end method
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Now you need to retrieve the detailed employee information using the ID, as 
shown in Example 8-22.

Example 8-22   Helper methods for calling SAP BAPIs

/*
 * Retrieves information from the SAP system for the given id
 * 
 * @param personId
 * @return 
 */
private Person getEmployeeInfo(int employeeId){

Person person = null;
JCO.Function functionGetEmployeeDetail = null;

try {

functionGetEmployeeDetail = 
this.createFunction(HR_BAPI_GET_EMPLOYEE_INFO);

//set parameters
functionGetEmployeeDetail.getImportParameterList().setValue( 

""+employeeId, "EMP_PERNR");
//get current information, not historical
functionGetEmployeeDetail.getImportParameterList().setValue( 

"01", "PLVAR");
//begin date for the search is 1999-01-01, so anything after 

this will be returned
functionGetEmployeeDetail.getImportParameterList().setValue( 

"1999-01-01", "BEGDA");

sapConnection.execute(functionGetEmployeeDetail);

JCO.Structure returnStructure = 
functionGetEmployeeDetail.getExportParameterList().getStructure("RETURN
");

checkForErrors(returnStructure);

JCO.Structure structureExportParams = 
functionGetEmployeeDetail.getExportParameterList().getStructure("EMP_IN
FO");

person = new Person();
person.setName(structureExportParams.getString("ENAME"));
person.setId(employeeId);
person.setManagerId(structureExportParams.getInt("MPERNR"));
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} catch (Exception ex) {
ex.printStackTrace();
Activator.logError("Error retrieving information for employee 

id = " + employeeId, ex.getMessage());
}//end try-catch
return person;

}// end method

TestMgr changes
Update the TestMgr with test data so that you can test the user interface. This is 
a good way to separate your user interface and the SAP integration. You are 
welcome to change the data in Example 8-23. The key is that you need to have 
an organization, one or more managers, and one or more non-managers. 

Example 8-23   HR changes to the TestMgr

public Organization getHRData() {
Organization org = new Organization();

Person pJohn;
Person pCole;
Person pChris;
Person pMike;
Person[] paEmployees;

Person[] pa;

org.setName("Riverbend HR");

pJohn = new Person("John C. Cummins", "HR", 123, true, null, 
null);

pChris = new Person("Christopher T. Cummins", "HR", 123, false, 
null,

pJohn);
pCole = new Person("Cole Avery Cummins", "HR", 123, false, null, 

pJohn);
pMike = new Person("Michael J. Cummins", "HR", 123, false, null, 

pJohn);

// setup manager test data
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paEmployees = new Person[3];
paEmployees[0] = pChris;
paEmployees[1] = pCole;
paEmployees[2] = pMike;
pJohn.setEmployees(paEmployees);

Person[] paEmpsOrg = new Person[1];
paEmpsOrg[0] = pJohn;

org.setEmployees(paEmpsOrg);

return org;
}//end method

8.2.6  Order status example

The order status uses an order ID to query the back-end system and get the 
current status, as shown in Figure 8-27 and Figure 8-28 on page 361.

Figure 8-27   Order status start screen
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Figure 8-28   Order status results page

SapMiniApp changes
The code in Example 8-24 was added to the SapMiniApp to create this user 
interface.

Example 8-24   Order status UI code in the SapMiniApp

private void createOrderStatusTab() {
tabItemOrderStatus = new TabItem(tabFolderSAP, SWT.NONE);
tabItemOrderStatus.setText("Order Status");
compOrder = new Composite(tabFolderSAP, SWT.NONE);
tabItemOrderStatus.setControl(compOrder);
GridLayout compOrderLayout = new GridLayout();
compOrderLayout.makeColumnsEqualWidth = true;
compOrder.setLayout(compOrderLayout);
compOrder.setSize(334, 350);

compOrderFilter = new Composite(compOrder, SWT.NONE);
RowLayout compOrderFilterLayout = new RowLayout(

org.eclipse.swt.SWT.HORIZONTAL);
GridData compOrderFilterLData = new GridData();
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compOrderFilter.setLayoutData(compOrderFilterLData);
compOrderFilter.setLayout(compOrderFilterLayout);

compOrderStatus = new Composite(compOrder, SWT.NONE);
GridLayout compOrderStatusLayout = new GridLayout();
compOrderStatusLayout.numColumns = 2;
compOrderStatusLayout.horizontalSpacing = 8;
GridData compOrderStatusLData = new GridData();
compOrderStatusLData.heightHint = 296;
compOrderStatusLData.horizontalSpan = 2;
compOrderStatusLData.grabExcessHorizontalSpace = true;
compOrderStatusLData.horizontalAlignment = GridData.FILL;
compOrderStatus.setLayoutData(compOrderStatusLData);
compOrderStatus.setLayout(compOrderStatusLayout);

lblOrderId = new Label(compOrderStatus, SWT.NONE);
GridData lblOrderIdLData = new GridData();
lblOrderIdLData.horizontalAlignment = GridData.END;
lblOrderId.setLayoutData(lblOrderIdLData);
lblOrderId.setText("Order ID");

GridData textOrderIdLData = new GridData();
textOrderIdLData.horizontalAlignment = GridData.FILL;
textOrderIdLData.grabExcessHorizontalSpace = true;
textOrderId = new Text(compOrderStatus, SWT.BORDER);
textOrderId.setEnabled(false);
textOrderId.setLayoutData(textOrderIdLData);

lblDescription = new Label(compOrderStatus, SWT.NONE);
GridData lblDescriptionLData = new GridData();
lblDescriptionLData.horizontalAlignment = GridData.END;
lblDescription.setLayoutData(lblDescriptionLData);
lblDescription.setText("Description");

GridData textDescriptionLData = new GridData();
textDescriptionLData.grabExcessHorizontalSpace = true;
textDescriptionLData.horizontalAlignment = GridData.FILL;
textDescription = new Text(compOrderStatus, SWT.BORDER);
textDescription.setEnabled(false);
textDescription.setLayoutData(textDescriptionLData);

lblStatus = new Label(compOrderStatus, SWT.NONE);
GridData lblStatusLData = new GridData();
lblStatusLData.horizontalAlignment = GridData.END;
lblStatus.setLayoutData(lblStatusLData);
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lblStatus.setText("Status");

GridData textStatusLData = new GridData();
textStatusLData.horizontalAlignment = GridData.FILL;
textStatusLData.grabExcessHorizontalSpace = true;
textStatus = new Text(compOrderStatus, SWT.BORDER);
textStatus.setEnabled(false);
textStatus.setLayoutData(textStatusLData);
// START >> lblProductId
lblProductId = new Label(compOrderStatus, SWT.NONE);
GridData lblProductIdLData = new GridData();
lblProductIdLData.horizontalAlignment = GridData.END;
lblProductId.setLayoutData(lblProductIdLData);
lblProductId.setText("Product ID");
// END << lblProductId
// START >> textProductId
GridData textProductIdLData = new GridData();
textProductIdLData.horizontalAlignment = GridData.FILL;
textProductIdLData.grabExcessHorizontalSpace = true;
textProductId = new Text(compOrderStatus, SWT.BORDER);
textProductId.setEnabled(false);
textProductId.setLayoutData(textProductIdLData);
// END << textProductId

lblOrderDate = new Label(compOrderStatus, SWT.NONE);
GridData lblOrderDateLData = new GridData();
lblOrderDateLData.horizontalAlignment = GridData.END;
lblOrderDate.setLayoutData(lblOrderDateLData);
lblOrderDate.setText("Order Date");

GridData textOrderDateLData = new GridData();
textOrderDateLData.grabExcessHorizontalSpace = true;
textOrderDateLData.horizontalAlignment = GridData.FILL;
textOrderDate = new Text(compOrderStatus, SWT.BORDER);
textOrderDate.setEnabled(false);
textOrderDate.setLayoutData(textOrderDateLData);

lblOrderTotal = new Label(compOrderStatus, SWT.NONE);
GridData lblOrderTotalLData = new GridData();
lblOrderTotalLData.horizontalAlignment = GridData.END;
lblOrderTotal.setLayoutData(lblOrderTotalLData);
lblOrderTotal.setText("Order Total");

GridData textOrderTotalLData = new GridData();
textOrderTotalLData.horizontalAlignment = GridData.FILL;
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textOrderTotalLData.grabExcessHorizontalSpace = true;
textOrderTotal = new Text(compOrderStatus, SWT.BORDER);
textOrderTotal.setEnabled(false);
textOrderTotal.setLayoutData(textOrderTotalLData);

lblOrderQuantity = new Label(compOrderStatus, SWT.NONE);
GridData lblOrderQuantityLData = new GridData();
lblOrderQuantityLData.horizontalAlignment = GridData.END;
lblOrderQuantity.setLayoutData(lblOrderQuantityLData);
lblOrderQuantity.setText("Order Quantity");

GridData textOrderQuantityLData = new GridData();
textOrderQuantityLData.horizontalAlignment = GridData.FILL;
textOrderQuantityLData.grabExcessHorizontalSpace = true;
textOrderQuantity = new Text(compOrderStatus, SWT.BORDER);
textOrderQuantity.setEnabled(false);
textOrderQuantity.setLayoutData(textOrderQuantityLData);
// START >> lblCurrency
lblCurrency = new Label(compOrderStatus, SWT.NONE);
GridData lblCurrencyLData = new GridData();
lblCurrencyLData.horizontalAlignment = GridData.END;
lblCurrency.setLayoutData(lblCurrencyLData);
lblCurrency.setText("Currency");
// END << lblCurrency
// START >> textCurrency
GridData textCurrencyLData = new GridData();
textCurrencyLData.horizontalAlignment = GridData.FILL;
textCurrencyLData.grabExcessHorizontalSpace = true;
textCurrency = new Text(compOrderStatus, SWT.BORDER);
textCurrency.setEnabled(false);
textCurrency.setLayoutData(textCurrencyLData);
// END << textCurrency
// START >> lblPrice
lblPrice = new Label(compOrderStatus, SWT.NONE);
GridData lblPriceLData = new GridData();
lblPriceLData.horizontalAlignment = GridData.END;
lblPrice.setLayoutData(lblPriceLData);
lblPrice.setText("Price");
// END << lblPrice
// START >> textPrice
GridData textPriceLData = new GridData();
textPriceLData.horizontalAlignment = GridData.FILL;
textPriceLData.grabExcessHorizontalSpace = true;
textPrice = new Text(compOrderStatus, SWT.BORDER);
textPrice.setEnabled(false);
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textPrice.setLayoutData(textPriceLData);
// END << textPrice

lblDeliveryDate = new Label(compOrderStatus, SWT.NONE);
GridData lblDeliveryDateLData = new GridData();
lblDeliveryDateLData.horizontalAlignment = GridData.END;
lblDeliveryDate.setLayoutData(lblDeliveryDateLData);
lblDeliveryDate.setText("Delivery Date");

GridData textDeliveryDateLData = new GridData();
textDeliveryDateLData.grabExcessHorizontalSpace = true;
textDeliveryDateLData.horizontalAlignment = GridData.FILL;
textDeliveryDate = new Text(compOrderStatus, SWT.BORDER);
textDeliveryDate.setEnabled(false);
textDeliveryDate.setLayoutData(textDeliveryDateLData);

lblDeliveryQuantity = new Label(compOrderStatus, SWT.NONE);
GridData lblDeliveryQuantityLData = new GridData();
lblDeliveryQuantityLData.horizontalAlignment = GridData.END;
lblDeliveryQuantity.setLayoutData(lblDeliveryQuantityLData);
lblDeliveryQuantity.setText("Delivery Quantity");

textDeliveryQuantity = new Text(compOrderStatus, SWT.BORDER);
GridData textDeliveryQuantityLData = new GridData();
textDeliveryQuantityLData.horizontalAlignment = GridData.FILL;
textDeliveryQuantityLData.grabExcessHorizontalSpace = true;
textDeliveryQuantity.setLayoutData(textDeliveryQuantityLData);
textDeliveryQuantity.setEnabled(false);
// START >> lblDeliveryId
lblDeliveryId = new Label(compOrderStatus, SWT.NONE);
GridData lblDeliveryIdLData = new GridData();
lblDeliveryIdLData.horizontalAlignment = GridData.END;
lblDeliveryId.setLayoutData(lblDeliveryIdLData);
lblDeliveryId.setText("Delivery ID");
// END << lblDeliveryId
// START >> textDeliveryId
GridData textDeliveryNumberLData = new GridData();
textDeliveryNumberLData.horizontalAlignment = GridData.FILL;
textDeliveryNumberLData.grabExcessHorizontalSpace = true;
textDeliveryId = new Text(compOrderStatus, SWT.BORDER);
textDeliveryId.setEnabled(false);
textDeliveryId.setLayoutData(textDeliveryNumberLData);
// END << textDeliveryId
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lblOrderIdSearch = new Label(compOrderFilter, SWT.NONE);
lblOrderIdSearch.setText("Enter the Order ID");

textOrderIdSearch = new Text(compOrderFilter, SWT.BORDER);

btnSearch = new Button(compOrderFilter, SWT.PUSH | SWT.CENTER);
btnSearch.setText("Search");
btnSearch.addSelectionListener(new SelectionAdapter() {

public void widgetSelected(SelectionEvent evt) {
refreshOrderStatus(textOrderIdSearch.getText());

}
});

}// end method

The helper method in Example 8-25 is used to update the UI with the order 
status results.

Example 8-25   Order status helper methods

/*
 * Refreshes the order status on the order status tab.
 */
private void refreshOrderStatus(String orderId) {

boolean bOrderIdValid = false;
Order order = null;
if (orderId != null && !("".equals(orderId))) {

order = sapMgr.getOrderStatus(orderId);
// If an order was found, set the flag to true
if (order != null)

bOrderIdValid = true;
}// end if-else

if (bOrderIdValid) {
// update data
textOrderId.setText("" + order.getOrderId());
textDescription.setText(order.getDescription());
textStatus.setText(order.getStatus());
textOrderDate.setText(order.getOrderDate());
textOrderQuantity.setText(order.getQuantity() + "");
textDeliveryDate.setText(order.getDeliveryDate() + "");
textProductId.setText(order.getProductId() + "");
textOrderTotal.setText(order.getTotal() + "");
textCurrency.setText(order.getCurrency() + "");
textPrice.setText(order.getPrice() + "");
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textDeliveryDate.setText(order.getDeliveryDate() + "");
textDeliveryQuantity.setText(order.getDeliveryQuantity() + 

"");
textDeliveryId.setText(order.getDeliveryId() + "");

} else {
// reset data to be empty
textOrderId.setText("");
textDescription.setText("");
textStatus.setText("");
textOrderDate.setText("");
textOrderQuantity.setText("");
textDeliveryDate.setText("");
textProductId.setText("");
textOrderTotal.setText("");
textCurrency.setText("");
textPrice.setText("");
textDeliveryDate.setText("");
textDeliveryQuantity.setText("");
textDeliveryId.setText("");
//set the error message with help text.
lblInventoryError.setText("Order ID " + orderId + " was not 

found. " +
"Please check the order number. For example, do you need 

to " +
"enter leading zeros. Order number 9783 may need to be 

entered" +
"as 0000009783.");

}// end if-else
tabFolderSAP.redraw();

}// end method

SapMgr changes
There is only one BAPI required to check the order status in SAP, as shown in 
Table 8-6. 

Table 8-6   Overview of the SAP BAPIs used in the order status example

BAPI Description Input Output

BAPI_SALESORD
ER_GETSTATUS

Retrieves the order 
status and details.

Order ID Order status.
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Update the getOrderStatus method to call this BAPI, as shown in Example 8-26.

Example 8-26   Order status changes to the SapMgr

public Order getOrderStatus(String orderId){
Order order = null;
JCO.Function functionGetOrderStatus = null;
JCO.Table tblStatusInfo = null;
try {

functionGetOrderStatus = 
this.createFunction(ORDER_BAPI_GET_ORDER_STATUS);

//set input parameters

functionGetOrderStatus.getImportParameterList().setValue(orderId, 
"SALESDOCUMENT");

//execute the function
sapConnection.execute(functionGetOrderStatus);

JCO.Structure returnStructure = 
functionGetOrderStatus.getExportParameterList().getStructure("RETURN");

checkForErrors(returnStructure);

tblStatusInfo = 
functionGetOrderStatus.getTableParameterList().getTable("STATUSINFO");

if (tblStatusInfo.getNumRows() > 0){
order = new Order();
Activator.log("Order Status", "The order was found"); 

}else if(tblStatusInfo.isEmpty()){
Activator.log("Order Status", "The order was not found"); 

}//end if

//loop through the results, but there should only be one, so 
stop at 1

for (int i = 0; i < tblStatusInfo.getNumRows() && i < 1; i++) 
{

tblStatusInfo.setRow(i);
order.setCurrency(tblStatusInfo.getString("CURRENCY"));
order.setOrderId(tblStatusInfo.getInt("DOC_NUMBER"));

order.setDeliveryDate(tblStatusInfo.getString("DELIV_DATE"));
order.setOrderDate(tblStatusInfo.getString("REQ_DATE"));
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order.setStatus(tblStatusInfo.getString("DLV_STATE"));
order.setPrice(tblStatusInfo.getDecimals("NET_PRICE"));

order.setDescription(tblStatusInfo.getString("SHORT_TEXT"));

order.setDeliveryQuantity(tblStatusInfo.getDecimals("DLV_QTY"));
order.setOrderDate(tblStatusInfo.getString("REQ_DATE"));
order.setQuantity(tblStatusInfo.getDecimals("REQ_QTY"));

//set delivery state based on logic. This should be 
customized to 

//meet your needs. Maybe use a different BAPI.
int iDeliveryQuantity = 

tblStatusInfo.getDecimals("DLV_QTY");
int iOrderQuantity = tblStatusInfo.getDecimals("REQ_QTY");
if(iDeliveryQuantity == 0){

order.setStatus("ORDERED");
}else if(iOrderQuantity>iDeliveryQuantity){

order.setStatus("INCOMPLETE");
}else{

order.setStatus("COMPLETED");
}//end if

}//end for
} catch (Exception ex) {

ex.printStackTrace();
Activator.logError("Order Status", ex.getMessage());

}//end try-catch

sapConnection.disconnect();

return order;
}//end method
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TestMgr changes
Example 8-27 shows the order status changes to the TestMgr object.

Example 8-27   Order status changes to the TestMgr

public Order getOrderStatus(String orderId) {
Order order = new Order();

order.setDeliveryDate("09.10.2006");
order.setDeliveryQuantity(86);
order.setDeliveryId(2345679);
order.setOrderDate("15.03.2006");
order.setOrderId(Integer.parseInt(orderId));
order.setQuantity(175);
order.setCurrency("USD");
order.setPrice(500);
order.setTotal(130000);
order.setDescription("PCs");
order.setStatus("delivered");
order.setUnits("PC");
order.setProductId("MC-17");

return order;
}//end method
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8.2.7  Inventory example

The inventory example pulls a list of products from SAP and displays them in a 
combo box. The user selects a product and then enters the desired quantity, as 
shown in Figure 8-29. 

Figure 8-29   Initial window for the Inventory tab
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The plug-in then queries the SAP system to see if that quantity can be fulfilled, as 
shown in Figure 8-30.

Figure 8-30   Positive results from the inventory search

If there is not enough inventory to meet the request, the back-end system 
supplies the estimated date at which enough inventory will be available and then 
calculates the estimated delivery date for the client, as shown in Figure 8-31 on 
page 373. Due to time constraints, the formula for calculating the estimated 
delivery date is a dummy formula and not an algorithm from the back-end 
system.
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Figure 8-31   Results when there is not enough in stock inventory

The first step in changing the user interface is creating the helper classes. We 
will create or update the classes shown in Example 8-7 on page 334.

Table 8-7   Overview of the Inventory classes to create or update

package Class Description

com.ibm.redbooks.st75.ui InvComboLabelProvider Provides the labels and 
images for the inventory 
combo.

com.ibm.redbooks.st75.ui InvComboContentProvider Provides the structure for 
the inventory combo.

com.ibm.redbooks.st75.ui InvTableLabelProvider Provides the labels and 
images for the inventory 
table.

com.ibm.redbooks.st75.ui InvTableContentProvider Provides the structure for 
the inventory table.

com.ibm.redbooks.st75.ui SapMiniApp The user interface.
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InvComboLabelProvider.java
This class (Example 8-28) provides the labels (that is, text that users see) for the 
inventory combo.

Example 8-28   InvComboLabelProvider

public class InvComboLabelProvider implements ILabelProvider {

/* (non-Javadoc)
 * @see 

org.eclipse.jface.viewers.ILabelProvider#getImage(java.lang.Object)
 */
public Image getImage(Object element) {

// TODO Auto-generated method stub
return null;

}

/* (non-Javadoc)
 * @see 

org.eclipse.jface.viewers.ILabelProvider#getText(java.lang.Object)
 */
public String getText(Object element) {

String sText = null;
if (element != null) {

Product product = (Product) element;
sText = product.getName();

}//end if
return sText;

}//end method

/* (non-Javadoc)
 * @see 

org.eclipse.jface.viewers.IBaseLabelProvider#addListener(org.eclipse.jf
ace.viewers.ILabelProviderListener)

 */
public void addListener(ILabelProviderListener listener) {

// TODO Auto-generated method stub

}

com.ibm.redbooks.st75.ui SapMgr Performs SAP integration.

com.ibm.redbooks.st75.ui TestMgr Provides test data.

package Class Description
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/* (non-Javadoc)
 * @see org.eclipse.jface.viewers.IBaseLabelProvider#dispose()
 */
public void dispose() {

// TODO Auto-generated method stub

}

/* (non-Javadoc)
 * @see 

org.eclipse.jface.viewers.IBaseLabelProvider#isLabelProperty(java.lang.
Object, java.lang.String)

 */
public boolean isLabelProperty(Object element, String property) {

// TODO Auto-generated method stub
return false;

}

/* (non-Javadoc)
 * @see 

org.eclipse.jface.viewers.IBaseLabelProvider#removeListener(org.eclipse
.jface.viewers.ILabelProviderListener)

 */
public void removeListener(ILabelProviderListener listener) {

// TODO Auto-generated method stub

}

}
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InvComboContentProvider.java
This class (Example 8-29) provides the content for the inventory combo. It was 
used to provide an easy way to access the seleced item.

Example 8-29   InvComboContentProvider

public class InvComboContentProvider implements 
IStructuredContentProvider {

/* (non-Javadoc)
 * @see 

org.eclipse.jface.viewers.IStructuredContentProvider#getElements(java.l
ang.Object)

 */
public Object[] getElements(Object inputElement) {

Object[] oa;
if (inputElement == null){

//if there are no elements, 
//return an empty array because null is not allowed
oa = new Object[0];

} else {//The input is an array so convert it
oa = (Object []) inputElement;

}//end if-else
return oa;

}//end method

/* (non-Javadoc)
 * @see org.eclipse.jface.viewers.IContentProvider#dispose()
 */
public void dispose() {

// TODO Auto-generated method stub

}

/* (non-Javadoc)
 * @see 

org.eclipse.jface.viewers.IContentProvider#inputChanged(org.eclipse.jfa
ce.viewers.Viewer, java.lang.Object, java.lang.Object)

 */
public void inputChanged(Viewer viewer, Object oldInput, Object 

newInput) {
// TODO Auto-generated method stub

}
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}

InvTableLabelProvider.java
This class (Example 8-30) provides the label (that is, the text the users see) for 
the inventory table. 

Example 8-30   InvTableLabelProvider

public class InvTableLabelProvider implements ITableLabelProvider {

public Image getColumnImage(Object element, int columnIndex) {
//No images
return null;

}

public String getColumnText(Object element, int columnIndex) {
String text = "";
Product product = null;
if (element != null) {

product = (Product) element;
}//end if
//check which column it is
if (columnIndex == Constants.INVENTORY_PRODUCT_ID_COLUMN) {

text = "" + product.getProductId();
} else if (columnIndex == Constants.INVENTORY_NAME_COLUMN){

text = product.getName();
} else if (columnIndex == Constants.INVENTORY_QUANTITY_COLUMN){

text = "" + product.getQuantity();
} else if (columnIndex == Constants.INVENTORY_PRICE_COLUMN){

text = "" + product.getPrice();
} else if (columnIndex == 

Constants.INVENTORY_AVAILABILITY_DATE_COLUMN){
text = product.getAvailabilityDate();

} else if (columnIndex == Constants.INVENTORY_CURRENCY_COLUMN){
text = product.getCurrency();

} else if (columnIndex == Constants.INVENTORY_UNITS_COLUMN){
text = product.getUnits();

}//end if-else
return text;

}

public void addListener(ILabelProviderListener listener) {
// TODO Auto-generated method stub
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}

public void dispose() {
// TODO Auto-generated method stub

}

public boolean isLabelProperty(Object element, String property) {
// TODO Auto-generated method stub
return false;

}

public void removeListener(ILabelProviderListener listener) {
// TODO Auto-generated method stub

}

}

InvTableContentProvider.java
This class (Example 8-31) provides the content for the inventory table.

Example 8-31   InvTableContentProvider

public class InvTableContentProvider implements 
IStructuredContentProvider {

public Object[] getElements(Object inputElement) {
Object[] oa;
if (inputElement == null){

//if there are no elements, 
//return an empty array because null is not allowed
oa = new Object[0];

} else {//The input is an array so convert it
oa = (Object []) inputElement;

}//end if-else
return oa;

}//end method

public void dispose() {
}//end method
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public void inputChanged(Viewer viewer, Object oldInput, Object 
newInput) {

}//end method

}

SapMiniApp changes
The code in Example 8-32 was added to the SapMiniApp to create this user 
interface.

Example 8-32   Inventory UI code in the SapMiniApp

private void createInventoryTab() {
tabItemInventory = new TabItem(tabFolderSAP, SWT.NONE);
tabItemInventory.setText("Inventory");
compInventory = new Composite(tabFolderSAP, SWT.NONE);
tabItemInventory.setControl(compInventory);
GridLayout compInventoryLayout = new GridLayout();
compInventoryLayout.numColumns = 4;
compInventoryLayout.marginRight = 5;
compInventory.setLayout(compInventoryLayout);

GridData cboPartLData = new GridData();
cboPartLData.widthHint = 100;
cboPartLData.grabExcessHorizontalSpace = true;
cboViewerPart = new ComboViewer(compInventory, SWT.NONE);
cboViewerPart.getControl().setLayoutData(cboPartLData);
cboViewerPart.setContentProvider(new InvComboContentProvider());
cboViewerPart.setLabelProvider(new InvComboLabelProvider());

lblQuantity = new Label(compInventory, SWT.NONE);
lblQuantity.setText("Quantity");
GridData lblQuantityLData = new GridData();
lblQuantityLData.widthHint = 45;
lblQuantityLData.horizontalAlignment = GridData.END;
lblQuantity.setAlignment(SWT.DOWN);
lblQuantity.setLayoutData(lblQuantityLData);

GridData textQuantityLData = new GridData();
textQuantityLData.widthHint = 30;
textQuantity = new Text(compInventory, SWT.BORDER);
textQuantity.setLayoutData(textQuantityLData);
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btnSearchInventory = new Button(compInventory, SWT.PUSH | 
SWT.CENTER);

btnSearchInventory.setText("Search");
btnSearchInventory.addSelectionListener(new SelectionAdapter() {

public void widgetSelected(SelectionEvent evt) {
//check that something has been selected
if(!cboViewerPart.getSelection().isEmpty()){

IStructuredSelection sel = (IStructuredSelection) 
(cboViewerPart.getSelection());

Product p = (Product) sel.getFirstElement();
Product product = sapMgr.checkProductStatus(p);
checkInventory(product);

}//end if
}

});
GridData btnSearchInventoryLData = new GridData();
btnSearchInventoryLData.heightHint = 25;
btnSearchInventoryLData.widthHint = 45;
btnSearchInventory.setLayoutData(btnSearchInventoryLData);

tblViewerInventory = new TableViewer(compInventory, SWT.BORDER);
GridData tblPartsLData = new GridData();
tblPartsLData.heightHint = 94;
tblPartsLData.horizontalSpan = 4;
tblPartsLData.grabExcessHorizontalSpace = true;
tblPartsLData.horizontalAlignment = GridData.FILL;
tblViewerInventory.getControl().setLayoutData(tblPartsLData);

lblInventoryError = new Label(compInventory, SWT.NONE);
GridData lblInventoryErrorLData = new GridData();
lblInventoryErrorLData.heightHint = 25;
lblInventoryErrorLData.horizontalSpan = 4;
lblInventoryErrorLData.grabExcessHorizontalSpace = true;
lblInventoryErrorLData.horizontalAlignment = GridData.FILL;
lblInventoryError.setLayoutData(lblInventoryErrorLData);

}// end method
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The helper methods in Example 8-33 areused to update the UI with the inventory 
availability results.

Example 8-33   Inventory UI helper methods

/*
 * Retrieves the products in the inventory from the back-end system. 
 */
private void initializeInventory() {

// get items from back-end
Product[] products = 

sapMgr.getInventory(Constants.INVENTORY_PLANT_ID);
String[] productNames = new String[products.length];
// fill hashmap and product names for the comboBox
for (int i = 0; i < products.length; i++) {

hashProducts.put(products[i].getProductId() + "", 
products[i]);

productNames[i] = products[i].getName();
}// end for

// store product names in the combo box
cboViewerPart.setInput(products);

createInventoryTable();
}// end method

private void createInventoryTable() {
// create columns
String [] colHeaders = {"ID", "Name", "Price", "Currency", 

"Quantity", "Units", "Availability Date"};
int[] colWidths = {30, 70, 50, 50, 50, 50, 70};
int[] colAlignments = {SWT.LEFT, SWT.LEFT, SWT.LEFT, SWT.LEFT, 

SWT.LEFT, SWT.LEFT, SWT.LEFT};
Table tbl = (Table) tblViewerInventory.getControl();
tbl.setHeaderVisible(true);
for (int i = 0; i < colHeaders.length; i++) {

TableColumn tc = new TableColumn(tbl, colAlignments[i]);
tc.setText(colHeaders[i]);
tc.setWidth(colWidths[i]);

}//end for
tblViewerInventory.setContentProvider(new 

InvTableContentProvider());
tblViewerInventory.setLabelProvider(new InvTableLabelProvider());

}// end method
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SapMgr changes
There are three BAPIs that we will use to collect the information from SAP, as 
shown in Table 8-8. 

Table 8-8   Overview of the SAP BAPIs used in the inventory example

The first step is to get a list of material IDs. Add the code in Example 8-34 to do 
this.

Example 8-34   Get a list of material IDs

public Product[] getInventory(){
Product[] products = null;
JCO.Function functionGetInventory = null;
JCO.Table tblMaterialSelection = null;
JCO.Table tblPlantSelection = null;
JCO.Table tblMaterials = null;

try {

functionGetInventory = 
this.createFunction(INV_BAPI_GET_MATERIAL_BY_PLANT);

//set input parameters

BAPI Description Input Output

BAPI_MATERIAL_
GETLIST

Retrieves a list of 
materials (that is, 
products) at the 
given plant (that is, 
factory).

plant ID A list of material 
IDs (product IDs).

BAPI_MATERIAL_
GET_DETAIL

Retrieves details 
for the material ID.

material ID Detailed material 
information (price, 
unit of measure, 
and so on).

BAPI_MATERIAL_
AVAILABILITY

Checks the 
availability of a 
given material at a 
given plant for a 
given quantity. If 
there is not enough 
stock, it estimates 
when there will be 
enough.

material ID, 
quantity, unit of 
measure, and plant 
ID

The availability of 
the material. If 
there is not enough 
stock, it will 
estimate when 
enough stock will 
be ready to meet 
this potential order.
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//set the maximum number of results you want to return
functionGetInventory.getImportParameterList().setValue(100, 

"MAXROWS");
//set the material parameter to return all materials with 

MATNR_LOW = * 
//this could be filtered to return only specific 

materials/products
tblMaterialSelection = 

functionGetInventory.getTableParameterList().getTable("MATNRSELECTION")
;

tblMaterialSelection.appendRow();
tblMaterialSelection.setValue("I", "SIGN");
tblMaterialSelection.setValue("CP", "OPTION");
tblMaterialSelection.setValue("*", "MATNR_LOW");

//enter the plant id to search for
tblPlantSelection = 

functionGetInventory.getTableParameterList().getTable("PLANTSELECTION")
;

tblPlantSelection.appendRow();
tblPlantSelection.setValue("I", "SIGN");
tblPlantSelection.setValue("CP", "OPTION");
tblPlantSelection.setValue(plantId, "PLANT_LOW");

sapConnection.execute(functionGetInventory);

tblMaterials = 
functionGetInventory.getTableParameterList().getTable("MATNRLIST");

products = new Product[tblMaterials.getFieldCount()];
for (int i = 0; i < tblMaterials.getFieldCount(); i++) {

tblMaterials.setRow(i);
products[i] = 

getProductInfo(tblMaterials.getString("MATERIAL"), plantId);
}//end for

} catch (Exception ex) {
ex.printStackTrace();
Activator.logError("Getting Inventory", ex.getMessage());

}//end try-catch

return products;
}//end method
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You now need to get information for each of the material IDs. Create the method 
shown in Example 8-35.

Example 8-35   Get detailed information for the material

private Product getProductInfo(String productId, int plantId){
Product product = null;
JCO.Function functionGetProductDetail = null;

try {

functionGetProductDetail = 
this.createFunction(INV_BAPI_GET_MATERIAL_DETAIL);

//set parameters

functionGetProductDetail.getImportParameterList().setValue(productId, 
"MATERIAL");

functionGetProductDetail.getImportParameterList().setValue( 
""+plantId, "PLANT");

sapConnection.execute(functionGetProductDetail);

JCO.Structure returnStructure = 
functionGetProductDetail.getExportParameterList().getStructure("RETURN"
);

checkForErrors(returnStructure);

JCO.Structure structureExportMaterial = 
functionGetProductDetail.getExportParameterList().getStructure("MATERIA
L_GENERAL_DATA");

product = new Product();
product.setProductId(productId);
product.setPlant(plantId+"");

product.setUnits(structureExportMaterial.getString("BASE_UOM"));

product.setName(structureExportMaterial.getString("MATL_DESC"));

JCO.Structure structureExportValuation= 
functionGetProductDetail.getExportParameterList().getStructure("MATERIA
LVALUATIONDATA");

for (int i = 0; i < structureExportValuation.getFieldCount(); 
i++) {

System.out.println("valuation = " + 
structureExportValuation.getField(i).getName());
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}

product.setCurrency(structureExportValuation.getString("CURRENCY"));

product.setPrice(structureExportValuation.getDecimals("STD_PRICE"));

} catch (Exception ex) {
ex.printStackTrace();
Activator.logError("Error retrieving info for product id = " + 

productId, ex.getMessage());
}//end try-catch

return product;
}//end method

The last functionality to implement is checking the availability. Create the method 
shown in Example 8-36.

Example 8-36   Check the availability

public Product checkProductStatus(Product product){
JCO.Function functionProductStatus = null;
try {

functionProductStatus = 
this.createFunction(INV_BAPI_GET_MATERIAL_BY_PLANT);

//set input parameters

functionProductStatus.getImportParameterList().setValue(product.getProd
uctId(), "MATERIAL");

functionProductStatus.getImportParameterList().setValue(product.getPlan
t(), "PLANT");

functionProductStatus.getImportParameterList().setValue(product.getUnit
s(), "UNIT");

sapConnection.execute(functionProductStatus);

JCO.Structure returnStructure = 
functionProductStatus.getExportParameterList().getStructure("RETURN");

product.setQuantity(returnStructure.getInt("AV_QTY_PLT"));
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product.setAvailabilityDate(returnStructure.getDate("ENDLEADTME").toStr
ing());

} catch (Exception ex) {
ex.printStackTrace();
Activator.logError("Getting Inventory", ex.getMessage());

}//end try-catch
return product;

}//end method

TestMgr changes
To test the inventory UI, you need to update the getInventory method to create a 
test inventory (that is, products) that will be returned by the TestMgr. An example 
is given in Example 8-37. Feel free to edit the test data to fit your needs.

Example 8-37   Inventory changes to TestMgr

public Product[] getInventory(){
Product [] products = new Product[5];

Product prod1 = new Product("2222", "Blue Widgets", "1001", 36, 
"USD", 7, "Widgets", "01/01/2009");

Product prod2 = new Product("2250", "Green Widgets", "1001", 36, 
"USD", 45, "Widgets", "02/14/2006");

Product prod3 = new Product("2290", "Electric Widgets", "1001", 
36, "USD", 3, "Widgets", "06/01/2007");

Product prod4 = new Product("1150", "Diesel Motor", "1001", 2000, 
"USD", 12, "Motors", "12/10/2006");

Product prod5 = new Product("1071", "Hybrid Motor", "1001", 2500, 
"USD", 4, "Motors", "01/15/2007");

products[0] = prod1;
products[1] = prod2;
products[2] = prod3;
products[3] = prod4;
products[4] = prod5;

return products;
}//end method

The user interface code you added should now compile correctly and you can 
test out the integration.
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8.3  SAP tips

This section contains a list of tips that we found useful when developing an SAP 
application.

1. Install an SAP GUI on your development machine. This is really helpful when 
testing your code versus what should come back from SAP. It is also very 
helpful in selecting test data and verifying input and output parametetrs for 
different BAPIs and RFCs.

2. Transaction SE37: In the SAP GUI, you can enter this transaction to check 
parameters and values for different BAPIs. 

3. Unexpected Errors: The SAP GUI performs some formatting for you 
automatically, which you will have to manually do when using the Java 
Connector. An example is the order status BAPI. 9783 works in the GUI, but 
0000009783 must be used in the Java Connector. You should also double 
check the parameter names as they are cut off sometimes in the GUI and you 
will need the full names for the Java Connector.

4. Use all CAPS for user names, passwords, parameters, types, and so on. The 
SAP GUI will convert this for you without you noticing, but the Java Connector 
does not. This is an easy mistake that is very difficult to discover.

8.4  Extending this plug-in

Ideas/extension points to take this further:

� Directory integration or synchronization between the Sametime directory and 
SAP.

� Add a lookup function to find Sametime names for SAP contacts and vice 
versa; useful for external partners.

� Store a mapping of the contacts and their links to SAP, save some core data 
in a file; similar to the recent buddies sample.

� Add an interface to a mapping services, such as Google maps, to show where 
the current order is or to chart the plants that house the parts.

� Extend the order status example to send the status as an e-mail or IM to the 
client or relevant employee within the company.

� Extend the order status to notify the client of certain events, such as failed 
delivery or delivery problem.
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Part 4 Advanced example: 
building a 
framework for 
structured content

In this part, we introduce an in-depth, advanced example of how to build a 
framework for structured content. In the case of this example, the content is 
specific to online learning. The details of how to build this plug-in are detailed 
within the following chapters.

Part 4
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Chapter 9. Introducing My Lotus 
Learning Education 
framework plug-in for 
Sametime Connect

A recent trend in the development of learning content is embedded learning. With 
embedded learning, education content is delivered directly within the context of 
an associated task, tool, or process. There is no separate education content 
delivery vehicle, such as a classroom session or training CD. 

This chapter presents an introduction of My Lotus Learning plug-in. My Lotus 
Learning plug-in was created as a means for providing and managing learning 
materials in the IBM Lotus Sametime 7.5 Connect client. 

The following topics are presented in this chapter:

� Overview of My Lotus Learning plug-in

� Design overview of My Lotus Learning plug-in

9
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Attention: All sample code used for this example can be downloaded from the 
IBM Redbooks FTP site. Please refer to Appendix A, “Additional material” on 
page 557 for detailed instructions on how to download and deploy the code 
sample: 

ftp://www.redbooks.ibm.com/redbooks/SG247346
392 Extending Sametime 7.5: Building Plug-ins for Sametime

ftp://www.redbooks.ibm.com/redbooks/SG247346


9.1  Overview of My Lotus Learning plug-in

At a recent meeting of Educational Centers for IBM Software (ECIS) partners, 
suggestions were made that IBM should pursue embedded learning delivery for 
software products. Several meeting participants, both from within IBM and the 
partner channel, mentioned the idea of using Sametime plug-ins in this context. 
My Lotus Learning plug-in is a proof-of-concept of embedded learning. It allows 
the user of Lotus Sametime Connect to view education content about the product 
using the plug-in facilities embedded within the Sametime product. 

My Lotus Learning Plug-in is actually composed of several Eclipse plug-ins. A 
User interface and controller functions are packaged in one mini-app plug-in, 
while the content definition is packaged in another plug-in that is an extension of 
My Lotus Learning plug-in. Multiple content plug-ins may exist in a user's 
Sametime installation and each is selectable for viewing in My Lotus Learning 
plug-in. An XML file within the content plug-in defines the structure of the 
content, including the available topics and the supporting content, or resources, 
for the topics. The content can be of any subject, so there is a great potential 
uses of the plug-in in displaying a variety of education content. Figure 9-1 
illustrates an overview of the My Lotus Learning plug-in. 

Figure 9-1   My Lotus Learning plug-in

 

Select a 
course or 
course topic 
to display

Right-click a 
topic for 
assistance
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As part of the content definition process, Sametime users can be identified as 
assistance providers for specific content topics. My Lotus Learning plug-in 
presents an interface that allows the user to display the assistance providers for 
a selected topic, view their Sametime connectivity status, and initiate 
communications with those users over the Sametime communication channels, 
such as chat, e-mail, or voice suite.

9.2  Thinking about this plug-in as a sample for 
structured content delivery

With this example, we introduce an in-depth, advanced example of how to build a 
framework for structured content. In the case of this example, the content is 
specific to online learning. As you read this, keep in mind how this example 
plug-in could be extended and used with other types of structured content. For 
example, the content could be education related, or it could serve as a structured 
list of forms for an organization. Once you understand how to build the plug-in 
and create the framework, your organization could ultimately use this to provide 
many different types of content. 

For additional ways in which this plug-in could be utilized, see 11.4, “Additional 
examples: using the Lotus Education plug-in for for other content delivery” on 
page 521.

9.2.1  Sametime specific value add

In the case of this plug-in, it could easily serve as a stand-alone application. So, 
what are the specific benefits to having this embedded within Sametime? In 
particular, this application has a “Live Assistance” feature that allows the user to 
ask an expert who is associated with each topic. This ability for real-time 
interaction with an expert, and that the expert is embedded within the context of a 
specific topic, which illustrates the unique value of Sametime and having this as a 
Sametime application. See “Getting live assistance” on page 398 for details on 
this powerful feature. 

9.2.2  Embedded learning with IBM Lotus Sametime 7.5

My Lotus Learning plug-in is used to manage learning materials inside your IBM 
Lotus Sametime 7.5 Connect client. 
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Navigating learning content
There are three ways to navigate and search for learning content:

� Course list

� Topic Filter list 

� Topics expanded list 

Figure 9-2 shows these navigation choices.

Figure 9-2   Searching and displaying content

Course list
The course list displays a list of courses that are installed in My Lotus Learning 
plug-in. Users click the list arrow to view and select a course title, as shown in 
Figure 9-3.

Figure 9-3   Selecting a course
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Filtered topics list 
It is possible to also display related learning content by topic. Use the Topic 
Filter to view and select a topic from the list of predefined topics. The result is 
that a list of related topics displays in the Topics area, as shown in Figure 9-4.

Figure 9-4   Using Topic Filters to display content

Expanded topics list
After you select a course title or Topic Filter, the course menu or list of topics 
displays in the Topics area. Click the “+” icon to expand the topics list and select 
a specific item to view. Figure 9-5 shows the expanded topic list.

Figure 9-5   Viewing expanded topics list

To display a learning resource, the user clicks the resource item in the expanded 
Topics list. My Lotus Learning plug-in connects, via an URL to the associated 
page and displays the content of the page, whether local or Web-based, in a new 
window. Figure 9-6 on page 397 shows the new content window after a user 
selects the resource from the Topics menu.
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Figure 9-6   Displaying content

Learning object icons
Learning content can be presented in many ways. For example, a task may be 
documented in a procedure table, a movie, or click-through demonstration. A 
task may also be documented in a reference card that you can download and 
print. 

Icons are used to help you identify the format of each learning item. Figure 9-7 
shows a sample menu, with the icons next to each item denoting the type of 
learning object.

Figure 9-7   Menu icons
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Table 9-1 lists and describes the icons that display next to the learning items in 
the Topics menu. 

Table 9-1   Learning object icons

Getting live assistance
Another feature of My Lotus Learning plug-in is the link between a content topic 
and a live person. Users right-click a content topic and click Assistance 
(Figure 9-8) to view a list of users, both online and offline, who have been 
assigned as assistance resources for the topic. 

Figure 9-8   Right-click a topic and select Assistance

 Icon Function

Knowledge resource that is information, knowledge, or concept.

Let me try interactive simulation or launchable tutorial.

Show me demonstration, animation, or simulation.

Procedure instructions or table.

Reference item which can be downloaded and printed.
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The result is that a window opens and displays the users who have been 
assigned as assistance providers for the topic, as shown in Figure 9-9. The 
online status of the user also displays. Select an assistance provider and their 
contact information displays.

Figure 9-9   Assistance providers

Users can also display the assistance providers from the learning content 
window. Figure 9-10 shows the Assistance tab in the learning content window. 

Figure 9-10   Getting assistance from within a learning resource

9.3  Design overview of My Lotus Learning plug-in

The design of My Lotus Learning plug-in was constructed using the 
model-view-controller pattern common in object-oriented programming.

The primary model components of the plug-in consist of a three-level class 
hierarchy that represents a course, and an external representation of that class 
hierarchy in an XML file. 
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The top level of the class hierarchy is the Course class, which represents a 
collection of related content that can be viewed with the plug-in. Related 
materials in the course are grouped in a topic, which are represented by the 
Topic class in the second level of the hierarchy. There is a one-to-many 
relationship between Class and Topic. Course content is represented by 
Resource class in the third-level of the hierarchy; there is also a one-to-many 
relationship between Topic and Resource. Additional classes are used to 
represent a topic classification category (Category), assignment of a category to 
a topic (Tag), and Sametime contact IDs (Contact) who can be contacted for 
assistance on a topic.

A Document Type Definition (DTD) is defined for the XML that describes a 
course. The course definition XML files are stored in separate plug-ins that 
implement an extension point defined by My Lotus Learning plug-in. There is one 
plug-in per course. At plug-in initialization time, the extension registry searches 
for the plug-ins implementing the extension, creating a dynamic list of courses. 
The course definition XML file is parsed and the class representation of the 
course is built the first time a course is selected from the course list. 

The view components of My Lotus Learning plug-in are implemented with SWT 
widgets and controls and their corresponding JFace viewers. The course 
selection and topic filtering controls are implemented as combo viewers, and the 
topic list is implemented with a tree viewer. Content provider and label provider 
classes provide and format the data from the model for viewing. The plug-in's 
primary actions open new windows outside of the physical display space 
bounded by the plug-in; these user interfaces use the same general design 
approach as the plug-in's own interface.
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The controller components of the plug-in are implemented with a combination of 
selection listeners, menus, and actions. 

� Selection listener: A selection listener on the course combo drives changes 
to the category (topic filer) and topic list. Similarly, a selection listener on the 
topic filter combo drives changes in the topic list. 

� Menus: Context menus for the topics and resources in the topic list tree are 
provided by a menu manager. When a topic or resource item in a context 
menu is selected, the run method of the corresponding Action class is 
invoked. 

� Actions: The actions of My Lotus Learning plug-in displays properties for a 
topic or resource, provides a list Sametime contact who can provide 
assistance for a topic, and displays the content associated with a resource in 
a browser. 

9.4  Creating the MyLearning plug-in project

The MyLearning MiniApp is developed within an Eclipse plug-in project. Before 
we can begin development, we need to create the plug-in project, specify 
dependencies on other plug-ins and libraries, define the application as a miniApp 
extension. In addition, we will do some basic housekeeping tasks, such as 
setting up a Java package structure and creating a folder to store the user 
images that will be used in the user interface.

1. Create an new Eclipse plug-in project with a name like 
com.ibm.wplc.education.mylearning. You can use the procedure in shown in 
4.1.1, “Creating a plug-in project and plug-in” on page 64 as a guide. 

In the Plug-in Content dialog box that is displayed during the project creation 
process, specify com.ibm.wplc.education.mylearning.MyLearningPlugin in 
the Activator field.

2. Click the Dependencies tab.

3. On the Dependencies page, in the Required Plug-ins section, click Add.

4. In the Plug-in Selection dialog box, select 
com.ibm.wplc.education.mylearning.content. 

5. Repeat step 3 and 4 to add the following plug-ins as dependencies:

– org.eclipse.ui

– org.eclipse.core.runtime

– com.ibm.collaboration.realtime.imhub

– com.ibm.collaboration.realtime.community
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– com.ibm.rcp.realtime.livenames

– com.ibm.collaboration.realtime.core

6. On the Dependencies page, in the Imported Packages section, click Add.

7. From the Package Selection dialog box, select 
com.ibm.collaboration.realtime.

8. Repeat steps 6 and 7 to add the 
com.ibm.collaboration.realtime.contacts.search package. The Dependencies 
page should look like Figure 9-11.

Figure 9-11   Defining dependencies

9. Click the Extensions tab.

10.Click the Add button and select the 
com.ibm.collaboration.realtime.imhub.miniApps plug-in from the 
Extension Point Selection dialog box.

11.Right-click the com.ibm.collaboration.realtime.imhub.miniApps icon and 
select New → miniApp from the context menu.

12.In the Extension Element Details form to the right of the page, enter the 
following values:

– id: com.ibm.wplc.education.learning.mylearningminiapp

– displayName: My Lotus Learning

– class: com.ibm.wplc.education.mylearning.MyLearningMiniApp

– category: shelf,messaging

– maxHeight: 400

– icon: images/learning_view.gif

The Extensions page should look like Figure 9-12 on page 403.
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Figure 9-12   Defining extensions

13.Save the project. You will see a warning icon next to the plugin.xml file in the 
project hierarchy. The warning is due to the fact that the images directory 
specified in the icon field of the miniApp extension definition has not yet been 
created.

Create ui, model, and catalog sub-packages
The code for the plug-in will be created in one of three sub-packages (ui, model, 
and catalog) of the package created at project creation time. To create these 
packages, use the following procedure:

1. Expand the \src folder in the project hierarchy.

2. Select New → Package from the context menu.

3. In the Java Package dialog box, in the Name field, enter 
com.ibm.wplc.educat.ion.mylearning.ui 

4. Click Finish.

5. Repeat steps 2 to 5, to add the two other packages. For the Name field in step 
3, enter:

com.ibm.wplc.education.mylearning.catalog 
com.ibm.wplc.education.mylearning.model

Move the activator class
Move the activator class, MyLearningPlugin.java, that you specified during 
project creation, to the ui package using the following procedure:

1. Right-click the MyLearning.java icon in the 
com.ibm.wplc.education.mylearning package.

2. Select Refactor → Move... from the context menu. 

3. In the Move dialog box, select com.ibm.wplc.education.mylearning.ui as 
the destination package.
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4. Click OK.

Create \images folder
The images that are used in the MyLearning plug-in are stored in an images 
folder located directly below the project folder. To create this folder, use the 
following procedure:

1. Right-click the com.ibm.wplc.education.mylearning project folder.

2. Select New → Folder from the context menu.

3. In the New Folder dialog box, in the Folder Name field, enter images.

4. Click Finish.

You are now ready to start development of the MyLearning miniApp plug-in.
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Chapter 10. Building the education 
framework plug-in

In this chapter, we examine how to build a My Lotus Learning plug-in, including 
the data model, the user interface, and the plug-in’s control logic.

The following topics are presented in this chapter:

� Plug-in data

� Plug-in user interface

� Plug-in controller

10

Attention: All sample code used for this example can be downloaded from the 
IBM Redbooks FTP site. Please refer to Appendix A, “Additional material” on 
page 557 for detailed instructions on how to download and deploy the code 
sample: 

ftp://www.redbooks.ibm.com/redbooks/SG247346
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10.1  Plug-in data 

In this section, we examine the data structure of the MyLearning plug-in. 

First, we examine the class diagram that represents the content displayed in the 
plug-in. Next, we proceed to implement the classes in the class diagram. Finally, 
we create an implementation of the ICatalog interface, which defines the 
methods used to create the list of courses available to the user of the plug-in to 
find a particular course for display by the plug-in.

10.1.1  Data model class diagram

The plug-in models a learning course and its associated content using a series of 
aggregated classes, as shown in Figure 10-1.

Figure 10-1   Plug-in class model

The top level class, Course, uses the classes Category, CourseDescriptor, and 
Topic. 

� Category represents a keyword that can be used to classify or categorize the 
content of the course for possible filtering in the user interface. The category 
is analogous to an index.
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� CourseDescriptor represents the name and unique identifier of the course. 

� Topic represents the major organizing structure of the course, somewhat 
analogous to a chapter in a book. 

Topic contains a further aggregation of classes, including Contact, Tag, and 
Resources. 

� The Contact class represents the contact ID of the person who can provide 
assistance on the topic and who can be contacted via the user interface with 
the communication facilities provided by Sametime connect, including e-mail, 
chat, and VoIP. 

� Tag represents the assignment of a keyword defined in Category. 

� Resource represents learning content. The url attribute of the class points to 
the actual content that is presented by the plug-in user interface.

10.1.2  Implementing the class model diagram

In this section, we will implement the class diagram into the corresponding Java 
classes. Each of the attributes in a class will have a public accessor and mutator 
method defined within the class. 

Creating the Resource and ResourceList classes
The first class to be added to the com.ibm.wplc.education.model package is the 
class named Resource. Resource has the instance variables shown in 
Table 10-1.

Table 10-1   Resource instance variables

Name Type Notes

author String Corporate or personal author of the resource

description String Short description of the resource

id String Unique identifier

label String Display name

level String Targeted level of expertise for the content, such as 
Basic or Advanced

topic Topic Reference to parent Topic

type String Type of learning resource, such as Reference or 
Procedure

url String URL of the resource content
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Create the Resource class
To create the Resource class in the com.ibm.wplc.education.model package, use 
the following procedure:

1. Select the com.ibm.wplc.education.model package.

2. Right-click and select New → Class from the context menu.

3. In the New Java Class dialog box, enter Resource in the Name field and click 
Finish.

4. Code the variable as shown in Table 10-1 on page 407 as private instance 
variables of the class. 

5. Create public accessor and mutator methods for each of the instance 
variable.

Right-click in the source editing pane and select Source → Generate Getters 
and Setters. A wizard opens to assist you in generating these methods.

6. Create an empty no-argument constructor.

7. Create a constructor that takes String arguments of id and label and sets the 
corresponding instance variables.

8. Optionally, you can create a toString method to provide more meaningful 
String representation of the class than the default method inherited from the 
Object class. 

For many of the model classes, such as Resource, it will be useful to provide a 
corresponding class that represents a list of instances of the class. For example, 
a Topic entity can contain multiple Resources, so it would be desirable to have a 
ResourceList class that could be used to represent the aggregated multiple 
Resources within the Topic class.

The java.util.ArrayList container class is a very flexible and useful list container, 
but unfortunately it is not type-sensitive since it holds references to Object. 
However, a type-sensitive list container that uses ArrayList could be created, as 
shown in Example 10-1 on page 409 of a class called ResourceList that can only 
contain references to the Resource class.

Note: There will be compilation errors in the source because the Topic 
class referenced by the topic attribute has not yet been created. When the 
Topic class is later defined, this error will not longer appear. You will see 
similar errors constructing all these classes, until all the classes in the 
package have been defined. 
408 Extending Sametime 7.5: Building Plug-ins for Sametime



Example 10-1   ResourceList class

package com.ibm.wplc.education.mylearning.model;

import java.util.ArrayList;
import java.util.Iterator;

/*
 * Type-sensitive array list of Resource
 */
public final class ResourceList {

private ArrayList list = new ArrayList();

public void add(Resource Resource) {
list.add(Resource);

}
public Resource get(int index) {

return (Resource) list.get(index);
}

public int size() {
return list.size();

}

public Resource[] toArray(Resource[] array) {
return (Resource[]) list.toArray(array);

}

public void clear() {
list.clear();

}

public Iterator iterator() {
return list.iterator();

}

public String toString() {
StringBuffer sb = new StringBuffer("[");
sb.append(this.getClass().getName());
sb.append(" size = ");
sb.append(size());
sb.append("]");
return sb.toString();

}
}
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For the remainder of the model classes in the 
com.ibm.wplc.education.mylearning.model package, you will use a procedure 
similar to that used for the Resource and ResourceList classes to create the 
remainder of the classes that are contained in the package.

Creating the Topic and TopicList classes
The Topic class has the instance variables listed in Table 10-2.

Table 10-2   Topic class instance variables

Much like the topic variable in the Resource class, the courseDescriptor variable 
serves as a “backwards pointer” to the course containing the topic. The 
CourseDescriptor class contains instance variables that represent the id and 
label attributes of the Course entity.

Like the Resource class, the Topic class has an empty non-argument constructor 
and a constructor that takes String arguments of id and label and sets the 
corresponding instance variables.

A TopicList class, similar to the ResourceList class, also needs to be created as 
shown in Example 10-2 on page 411. Refer to “Create the Resource class” on 
page 408 for instructions to create the TopicList class.

Name Type Notes

Id String Unique identifier

Label String Display name

description String Short description of the 
topic

tagList TagList List of Tag assigned to the 
topic

resourceList ResourceList List of Resource contained 
in the topic

contactList Contact List of Contact providing 
assistance on the topic

courseDescriptor CourseDescriptor Reference to the 
CourseDescriptor for the 
parent course
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Example 10-2   TopicList class

package com.ibm.wplc.education.mylearning.model;

import java.util.ArrayList;
import java.util.Iterator;

/*
 * Type-sensitive array list of Tag
 */
public final class TagList {

private ArrayList list = new ArrayList();

public void add(Tag Tag) {
list.add(Tag);

}
public Tag get(int index) {

return (Tag) list.get(index);
}

public int size() {
return list.size();

}

public Tag[] toArray(Tag[] array) {
return (Tag[]) list.toArray(array);

}

public void clear() {
list.clear();

}

public Iterator iterator() {
return list.iterator();

}
}

Creating the Tag and TagList classes
The Tag class has just one instance variable, as shown in Table 10-3:

Table 10-3   Tag class instance variables

Name Type Notes

key String The id of a Category 
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Tag has one constructor that takes a String argument and sets its only instance 
variable. 

A TagList class also needs to be created. Refer to “Create the Resource class” 
on page 408 for instructions to create the TagList class.

Creating the Contact and ContactList classes
Another simple data model class like the Tag class is the Contact class. Contact 
has one constructor that takes a String argument and sets it as the only instance 
variable, as shown in Table 10-4.

Table 10-4   Contact class instance variable

A ContactList class also needs to be created. Refer to “Create the Resource 
class” on page 408 for instructions to create the TopicList class.

Creating the CourseDescriptor and CourseDescriptor Classes
CourseDescriptor contains the instance variables shown in Table 10-5.

Table 10-5   CourseDescriptor class instance variables

In addition to being an aggregated component of the Course class, 
CourseDescriptor is also used as a component of the course catalog, as 
described in 10.1.3, “Create the Catalog class” on page 414.

The CourseDescription class overrides the equals method of the Object parent 
class (see Example 10-3 on page 413). The equals method of this class is used 
in the Catalog class to search for a particular CourseDescription in a 
CourseDescriptionList. CourseDescription instances are equal only if the id and 
label instance variables of the two instances are equal. 

Name Type Notes

e-mail String The Sametime Connect 
contact ID in the standard 
Internet e-mail format

Name Type Notes

id String Unique identifier

label String Display name
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Example 10-3   Overrided hashCode and equals method

public boolean equals(Object o) {
// equals if the id and label fields are the same

boolean b = false;
if (o == this) return true;
if (o != null && o instanceof CourseDescriptor) {

String thisId = getId();
String oId = ((CourseDescriptor)o).getId();
String thisLabel = getLabel();
String oLabel = ((CourseDescriptor)o).getLabel();
b = (thisId != null && oId != null && thisId.equals(oId) && 

thisLabel.equals(oLabel));
}
return b;

}

public int hashCode(){
int r = 71;
r = 57 * r + id.hashCode();
r = 57 * r + label.hashCode();
return r;

}

Notice that the hashCode method of the parent Object class is also overridden in 
the CourseDescriptor class. Java programming best practices recommend that a 
class's hashCode method be overridden when the equals method is overridden 
in order to provide the same hash code for equivalent classes.This standard 
method in the Object class does not provide this capability. 

A CourseDescriptorList class also needs to be created to store the list of 
available courses on a user's system. Refer to “Create the Resource class” on 
page 408 for instructions to create the TopicList class.

Note: A good resource for this topic is the Effective Java Programming 
Language Guide, by Bloch. 
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Creating the Category and CategoryList classes
The Category has two instance variables, as shown in Table 10-6.

Table 10-6   Category Class

The Category class has an empty non-argument constructor and a constructor 
that takes String arguments of id and label and sets the corresponding instance 
variables. 

A CategoryList class also needs to be created. Refer to “Create the Resource 
class” on page 408 for instructions to create the TopicList class.

Creating the Course class
The Course class represents the Course entity and has the instance variables 
shown in Table 10-7.

Table 10-7   Course class instance variables

The Course class has an overridden equals method and corresponding 
overridden hashCode method that returns true if the courseDescriptor instance 
variables for the comparing classes are equal. 

10.1.3  Create the Catalog class

The Catalog class implements the ICatalog interface, which defines the methods 
show in Example 10-4 on page 415.

Name Type Notes

id String Unique identifier

label String Display name

Name Type Notes

categoryList CategoryList List of Category for the 
course

topicList TopicList List of Topic for the course

defaultCategory Category The default category for 
the course

courseDescriptor CourseDescriptor The CourseDescriptor for 
the course
414 Extending Sametime 7.5: Building Plug-ins for Sametime



Example 10-4   ICatalog interface

package com.ibm.wplc.education.mylearning.catalog;

import com.ibm.wplc.education.mylearning.model.Course;
import com.ibm.wplc.education.mylearning.model.CourseDescriptor;
import com.ibm.wplc.education.mylearning.model.CourseDescriptorList;

public interface ICatalog {
public Course findCourse(CourseDescriptor c);
public CourseDescriptorList list();
public CourseDescriptor findDefaultCourseDescriptor();
}

In the completed My Lotus Learning plug-in, the Catalog class implements the 
interface's list method by creating a CourseDescriptorList that is built by locating 
course plug-ins in the Eclipse Workbench registry that will use the description 
extension and then reading attributes of the plug-ins's <extension> element to 
obtain the course's id and label. This resulting list serves as the “course catalog” 
for the MyLearning plug-in.

The findCourse method builds an instance of the Course class by parsing the 
course definition XML file for the course plug-in that is identified by the method's 
CourseDescriptor parameter. 

The findDefaultCourseDescriptor returns a CourseDescriptor whose label 
instance variable is displayed as the initial selection in the Course combo of the 
MyLearning plug-in user interface after initialization. The default 
CourseDescriptor is simply the first item in the CourseDescriptorList returned 
from list method.

For the first development iteration of the Catalog class, we will forego the course 
plug-in location and XML parsing of the Catalog class's final implementation of 
the ICatalog interface. Instead, we will use a simplified approach of creating a 
hard-coded, singe-item CourseDescriptorList and corresponding test Course. In 
11.1, “Refining the catalog” on page 487, we will re-implement the interface with 
the final version of Catalog as one of the last steps in the development process.
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The single test course has three categories and two topics (each with one 
contact, three tags, and two resources), as specified in Figure 10-2.

Figure 10-2   Test course

Create the Catalog class
To create the Catalog class, perform the following steps:

1. In the com.ibm.wplc.education.mylearning.catalog package, create the 
ICatalog interface, as in Example 10-4 on page 415.

2. Create the Catalog class to implement the ICatalog interface in the same 
package as the interface.

3. Create the private instance variables courseList of type CourseDescriptorList 
and course of type Course.

4. Create a no-argument constructor for the Catalog class that calls a private 
void setup() method, as shown in Example 10-5 on page 417.

Course id:C1   label:Test Course

Category id:AllTopics label:All Topics

Category id:TopicA label:Topic A

Category id:TopicB label:Topic B

Topic id:TA label:Topic A

Contact email-id:contactA@a.com

Tag id:AllTopics

Tag id:TopicA

Resource id:RA1  label:Resource A1 level:Basic type:Reference author:Authors

url:file://C|testhtml/RA1.html
Resource id:RA2  label:Resource A2 level:Basic type:Reference author:Authors

url:file://C|testhtml/RA2.html

Topic id:TB Topic B
Contact email-id:contactB@b.com
Tag id:AllTopics
Tag id:Topic B
Resource id:RB1  label:Resource B1 level:Basic type:Reference author:Authors

url:file://C|testhtml/RB1.html
Resource id:RB2  label:Resource B2 level:Basic type:Reference author:Authors

url:file://C|testhtml/RB2.html
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Example 10-5   Catalog class constructor

public Catalog() {
setup();

}

5. Code the setup method to implement the specification of the test course, 
presented 10.1.2, “Implementing the class model diagram” on page 407, by 
using classes you created in the previous steps of this chapter and the 
instance variable you created in step 3 of this procedure. The completed 
method is shown in Example 10-6.

Example 10-6   Setup method for the Catalog class

private void setup() {
Tag tagAll = new Tag("AllTopics");

Tag tagA = new Tag("TopicA");
TagList tagListA = new TagList();
tagListA.add(tagA);
tagListA.add(tagAll);

Contact contactA = new Contact("ContactA@a.com");
ContactList contactListA = new ContactList();
contactListA.add(contactA);

Resource resourceA1 = new Resource("RA1", "Resource A1");
resourceA1.setDescription("Resource A1");
resourceA1.setLevel("Basic"); 
resourceA1.setType("Reference"); 
resourceA1.setAuthor("Author");
resourceA1.setUrl("file:///C|/testhtml/RA1.htm");
Resource resourceA2 = new Resource("RA2", "Resource A2");
resourceA2.setDescription("Resource A2");
resourceA2.setLevel("Basic");  
resourceA2.setType("Reference");  
resourceA2.setAuthor("Author");
resourceA2.setUrl("file://C|/testhtml/RA2.htm");
ResourceList resourceListA = new ResourceList();
resourceListA.add(resourceA1);
resourceListA.add(resourceA2);

Topic topicA = new Topic("TA", "Topic A");
topicA.setDescription("Topic A");
topicA.setTagList(tagListA);
topicA.setResourceList(resourceListA);
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topicA.setContactList(contactListA);
resourceA1.setTopic(topicA);
resourceA2.setTopic(topicA);

//Setup topicB and resource B1 and resource B2 as in previous
//code for topicA and resource A1 and resource A2
//code not shown

TopicList topicList = new TopicList();
topicList.add(topicA);
topicList.add(topicB);
Category categoryAll = 

new Category("AllTopics", "All Topics");
Category categoryA = new Category("TopicA", "Topic A");
Category categoryB = new Category("TopicB", "Topic B");
CategoryList categoryList = new CategoryList();
categoryList.add(categoryAll);
categoryList.add(categoryA);
categoryList.add(categoryB);

CourseDescriptor courseDescriptor = 
new CourseDescriptor("C1", "Test Course");

course = new Course();
course.setCourseDescriptor(courseDescriptor);
course.setCategoryList(categoryList);
course.setDefaultCategory(categoryAll);
course.setTopicList(topicList);
topicA.setCourseDescriptor(courseDescriptor);
topicB.setCourseDescriptor(courseDescriptor);
courseList = new CourseDescriptorList();
courseList.add(courseDescriptor);

}

6. Code the list method to return instance variable courseList, as shown in 
Example 10-7.

Example 10-7   list method of Catalog class

public CourseDescriptorList list() {
return courseList;

}
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7. Code the findCourse method to return instance variable course, as shown in 
Example 10-8.

Example 10-8   findCourse method of Catalog course

public Course findCourse(final CourseDescriptor descriptor) {
return course;

}

8. Code the findDefaultCourseDescriptor method to return the first element in 
the CourseDescriptorList returned from the list method, as shown in 
Example 10-9.

Example 10-9   findDefaultCourseDescriptor method of Catalog class

public CourseDescriptor findDefaultCourseDescriptor() {
// Just make the first course the default
return list().get(0);

}

9. Create four small test HTML files that contain the test content for each 
resource and place them in the locations on your local file system specified by 
each resource URL.

A typical test HTML files is shown in Example 10-10.

Example 10-10   Typical HTML test

<html>
<body>
<h3>Resource RA1</h3>
<p>Test content for Resource RA1</p>
</body>
</html>

The test course definition is now complete. We will be using the definition test 
course to verify the plug-in actions implemented in 10.3.3, “Create actions” on 
page 446.
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10.2  Plug-in user interface

In this section, we examine the user interface of the MyLearning plug-in. We:

1. Create the MyLearningMiniApp class that extends the AbstractMiniApp class 
and create the methods that will be overridden to define the user interface. 

2. Create basic controls of the user interface, using SWT widget classes, such 
as Label, Combo, and Tree. 

3. Introduce the data from the MyLearning plug-in's course catalog into the user 
interface and use the Eclipse JFace classes to populate the contents of the 
user interface controls with the course data. 

4. Implement a filter mechanism into the user interface that allows users to 
select a subset of course topics for display.

10.2.1  Create the MyLearingMiniApp class

When the plug-in.xml file was created, the name of the miniApp class was 
specified in the class attribute of the <miniApp> element as 
com.wplc.education.mylearning.ui.MyLearningMiniApp. Use the following 
procedure to create the MyLearningMiniApp class and the associated methods 
that will be required to implement the user interface:

1. Select the com.ibm.wplc.education.ui package.

2. Right-click and select New → Class from the context menu.

3. In the New Java Class dialog box, enter Resource in the Name field. 

4. Browse the Superclass field for the AbstractMiniApp class.

5. Click Finish.

6. Create a constructor that will assign the location of the class instance to a 
static variable named myLearningInstance, as shown in Example 10-11.

Example 10-11   MyLearning MiniApp class constructor

private static MyLearningMiniApp myLearningInstance;

public MyLearningMiniApp() {
myLearningInstance = this;

}

7. Create a public no-argument method getInstance that will return the static 
variable myLearningInstance, as shown in Example 10-12 on page 421.
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Example 10-12   Method of MyLearning MiniApp class

public static MyLearningMiniApp getInstance() {
return myLearningInstance;

}

8. Create the createControl method. 

This is a public method that has one parameter of type Composite (in the 
org.eclipse.swt.widgets package, as are most of the user interface controls). 

The createControl method is a method of AbstractMiniApp that will be 
overridden to specify the user interface of the plug-in miniApp. 

Within the method, create a new composite and specify the layout type to be 
form layout. The form layout method allows for the user interface controls to 
be precisely located and sized to be specified as in terms of pixel units.

Example 10-13   createControl method of MyLearning MiniApp class

public Control createControl(final Composite parent) {
final Composite comp = new Composite(parent, SWT.BORDER);

comp.setLayout(new FormLayout());
}

9. Add the code shown in Example 10-14 to establish the image as a 
background.

We will be using the image mod_menu_background.gif as the background for 
the image.The image is contained in an images folder within the MyLearning 
plug-in. By specifying the constant SWT.INHERIT_DEFAULT in the 
setBackgroundMode method of the composite, we ensue that the background 
of other controls contained within the composite are inherited from this 
background image. 

Example 10-14   Setting the background to an image

comp.setBackgroundMode(SWT.INHERIT_DEFAULT);
final ImageDescriptor id = 
ImageDescriptor.createFromURL(FileLocator 
.find(MyLearningPlug-in.getDefault().getBundle(), 

new Path("images/mod_menu_background.gif"),
null));

Image bgImage = id.createImage();

comp.setBackgroundImage(bgImage);
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10.Create another overridden method, init, as shown in Example 10-15. This is a 
public method that has no parameters an empty method body, and throws 
Exception. No initialization of MyLearningMinApp is required beyond that 
performed in the createControl method, so this method will remain as an 
empty body method.

Example 10-15   init method

public void init() throws Exception {
}

10.2.2  Create basic user interface widgets

We can proceed with composing the createControl method to add the user 
interface controls to MyLearning plug-in.

1. Add a Label control to specify the instructions for using the plug-in user 
interface, as shown in Example 10-16. 

Example 10-16   Instructions label

final Label instructions = new Label(comp, SWT.LEFT | 
SWT.HORIZONTAL| SWT.WRAP);

//  Note: Following setText method should be entered on one line 
instructions.setText("Select a Course. 

Expand an entry on the Topics list to see the learning 
resources for the topic. Double-click on a resource to view
it." ); 

FormData data = new FormData();
data.top = new FormAttachment(0, 5);
data.left = new FormAttachment(0, 5);
data.right = new FormAttachment(100, -5);
instructions.setLayoutData(data);
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2. Add a Label control that will be a label (“Course:”) to the left of the course 
combo, as shown in Example 10-17. 

Example 10-17   Course label

final Label coursesLabel = new Label(comp, SWT.LEFT | 
SWT.HORIZONTAL);

coursesLabel.setText("Course:");
data = new FormData();
data.top = new FormAttachment(instructions, 5);
data.left = new FormAttachment(0, 5);
data.right = new FormAttachment(20, 0);
coursesLabel.setLayoutData(data);

3. Add the course drop-down, read-only Combo control to the right of the label 
you just created, as shown in Example 10-18.

Example 10-18   Course combo

final Combo courseCombo = new Combo(comp, SWT.DROP_DOWN | 
SWT.READ_ONLY);

data = new FormData();
data.top = new FormAttachment(instructions, 5);
data.left = new FormAttachment(coursesLabel, 5);
data.right = new FormAttachment(100, -5);
courseCombo.setLayoutData(data);

4. Add a Label control that will be a label (“Topic Filter”) to the left of the 
categories combo, as shown in Example 10-19.

Example 10-19   Topic Filter label

final Label categoriesLabel = 
new Label(comp, SWT.LEFT | SWT.HORIZONTAL);

categoriesLabel.setText("Topic Filter:"); 
data = new FormData();
data.top = new FormAttachment(courseCombo, 5);
data.left = new FormAttachment(0, 5);
data.right = new FormAttachment(20, 0);
categoriesLabel.setLayoutData(data);); 
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5. Add the categories drop-down, read-only Combo to the right of the “Topic 
Filter” label you just created, as shown in Example 10-20.

Example 10-20   Category combo

final Combo categoryCombo = new Combo(comp, SWT.DROP_DOWN
| SWT.READ_ONLY);

data = new FormData();
data.top = new FormAttachment(courseCombo, 5);
data.left = new FormAttachment(categoriesLabel, 5);
data.right = new FormAttachment(100, -5);
categoryCombo.setLayoutData(data);

6. Add a Label control that will be a label (“Topic:”) to the left of the topic tree, as 
shown in Example 10-21.

Example 10-21   Topics label

final Label topicsLabel = new Label(comp, SWT.LEFT | 
SWT.HORIZONTAL);

topicsLabel.setText("Topics);
data = new FormData();
data.top = new FormAttachment(categoryCombo, 5);
data.left = new FormAttachment(0, 5);
data.right = new FormAttachment(20, 0);
topicsLabel.setLayoutData(data);

7. The last control is a Tree control where the topic and resource tree is 
displayed. 

Create a Tree control, as shown in Example 10-22.

Example 10-22   Topic Tree

final Tree topicTree = new Tree(comp, SWT.BORDER | SWT.V_SCROLL
| SWT.SINGLE);

data = new FormData();
data.top = new FormAttachment(categoryCombo, 5);
data.left = new FormAttachment(topicsLabel, 5);
data.right = new FormAttachment(100, -5);
data.bottom = new FormAttachment(100, -10);
topicTree.setLayoutData(data);

You can now test the user interface. Use the Eclipse Workbench Run control to 
start the plug-in mini-app. The user interface should look like the screen capture 
in Figure 10-3 on page 425.
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Figure 10-3   My Learning user interface

10.2.3  Create JFace viewers

We have created a user interface for the MyLearning plug-in. All of the controls 
are in place, but none are populated with any data from the course catalog. In 
this section, we use JFace classes to enhance the Combo and Tree controls to 
be JFace types of ComboViewer and TreeViewer that can accept and display the 
course catalog data. 

For each of the viewers, we will specify a content provider class, a label provider 
class, and an input source. The task of the content provider is to convert the input 
source to an array of objects that are associated with the viewer. The task of the 
label provider is to convert each element associated with the viewer into a 
displayable format; both text and image formats can be displayed by the viewers. 

Sort providers and filters can further manipulate the viewer's element data by 
sorting it in a specified order or by selecting subsets of the element array to be 
displayed according to a specified search criteria. We will implement a sort filter 
in a single viewer. The topic of viewer filters will be covered in “Implementing the 
Topic Filter” on page 433.
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To create the JFace viewers, use the following procedure:

1. At the bottom of the createControls method, add the code (see 
Example 10-23) that will use the ICatalog interface’s methods to:

a. Create the course catalog (list)

b. Find the default course descriptor (findDefaultCourseDescriptor)

c. Find the default course using the default course descriptor (findCourse).

Example 10-23   Using the iCatalog interface

final ICatalog catalog = new Catalog();
final CourseDescriptorList courseList = catalog.list();
final CourseDescriptor defaultCourseDescriptor = catalog

.findDefaultCourseDescriptor();
final Course defaultCourse = catalog

.findCourse(defaultCourseDescriptor);.

2. Create a ComboViewer from the courseCombo (see Example 10-24). 

Specify a content provider class (CourseContentProvider) with the 
setContentProvider method, a label provider class (CourseLabelProvider) 
with the setProviderLabel method, and an input source (courseList) with the 
setInput method. Also, specify that the list in the combo viewer is to be sorted 
alphabetically by specifying the default ViewerSorter class as the combo 
viewer’s sorter. 

Example 10-24   Course combo viewer

final ComboViewer courseComboViewer = 
new ComboViewer(courseCombo);

courseComboViewer.setContentProvider(
new CourseContentProvider());

courseComboViewer.setLabelProvider(new CourseLabelProvider());
courseComboViewer.setInput(courseList);
courseComboViewer.setSorter(new ViewerSorter());

3. Create the CourseContentProvider content provider, which implements the 
IStructureContentProvider interface. 

Within the content provider class, the getElements method’s role is to take the 
input element object specified in the setInput method of the combo viewer 
and transform it to an Object array. Each element in the returned Object array 
represents an element in the course combo viewer list. Since the courseList 
input source is of type CourseList, we can use the toArray method to convert 
it to an Object array, as shown in Example 10-25 on page 427.
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Example 10-25   getElements method of CourseContentProvider class

public Object[] getElements(final Object inputElement) {
int arraySize =

 ((CourseDescriptorList)inputElement).size();
CourseDescriptor[] cd = new CourseDescriptor[arraySize];
return ((CourseDescriptorList) inputElement).toArray(cd);

}

4. Create the CourseLabelProvider label provider, which extends the 
LabelProvider class. 

The getText method’s role in the label provider is to transform its input 
parameter to a String for display in the combo viewer. The input parameter of 
the method is an element in the Object array returned by the getElement 
method of the content provider class. Since this element would be of type 
CourseDescriptor, we only need to use the getLabel method to return the text 
to be displayed, as shown in Example 10-26.

Example 10-26   getText method of CourseLabelProvider class

public String getText(final Object inputElement) {
return ((CourseDescriptor) inputElement).getLabel();

}

5. In the createControl method of the MyLearningMiniApp, specify the initial 
selection for the courseComboViewer as the variable 
defaultCourseDescriptor, as shown in Example 10-27. The viewer element 
represented by this variable is displayed in the course combo after the 
MyLearning program is initialized.

Example 10-27   Setting initial selection of course combo viewer

courseComboViewer.setSelection(new StructuredSelection(
defaultCourseDescriptor), true);

Note: The inputChange method in the class is only invoked when the input 
source changes. Because the input source (courseList) is never changed 
once it has been created, an empty-body implementation of the method is 
adequate.
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6. Create a ComboViewer from the categoryCombo, as shown in 
Example 10-28. 

This step is much like step 2. We are going to display the categories in the 
order maintained by the input source, so we do not need a sorter. The input 
source is provided by invoking the getCategoryList method on the 
defaultCourse variable.

Example 10-28   Category combo viewer

final ComboViewer categoryComboViewer = 
new ComboViewer(categoryCombo);

categoryComboViewer.setContentProvider(new 
CategoryContentProvider());

categoryComboViewer.setLabelProvider(
new CategoryLabelProvider());

categoryComboViewer.setInput(defaultCourse.getCategoryList());

7. Create the CategoryContetProvider content provider. 

This code is very similar to the code produced in step 3, except we are now 
handling a CategoryList as the input element instead of a 
CourseDescriptorList. The getElements method is shown in Example 10-29.

Example 10-29   getelements method of CategoryContextProvider class

public Object[] getElements(final Object inputElement) {
Category[] categoryArray = 

new Category[((CategoryList) inputElement).size()];
return ((CategoryList)inputElement).toArray(categoryArray);

8. Create the CategoryLabelProvider label provider. This code is very similar to 
the code produced in step 4. The getText method is shown in Example 10-30.

Example 10-30   getelements method of CategoryLabelProvider class

public String getText(final Object inputElement) {
return ((Category) inputElement).getLabel();

}

9. In the createControl method of the MyLearningMiniApp, specify the initial 
selection for the categoryComboViewer as the return value from the method 
defaultCourse.getDefaultCategory (see Example 10-31 on page 429). This 
value is displayed in the category combo (Topic Filter) after the MyLearning 
program is initialized.
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Example 10-31   Setting initial selection of Category combo view

categoryComboViewer.setSelection
(new StructuredSelection(defaultCourse

.getDefaultCategory()), true);

10.At the top of the class file, declare topicTreeViewer as a private instance 
variable of type TreeViewer, as shown in Example 10-32. 

Example 10-32   topicTreeViewer instance variable

private TreeViewer topicTreeViewer;

11.Create a TreeViewer from the topicTree, as shown in Example 10-33. This 
step follows the general pattern presented in step 2. The input source is 
provided by invoking the getTopicList method on the defaultCourse variable. A 
viewer sorter is not required.

Example 10-33   Topic tree viewer

topicTreeViewer = new TreeViewer(topicTree);
topicTreeViewer.setContentProvider(new TopicContentProvider());
topicTreeViewer.setLabelProvider(new TopicLabelProvider());
topicTreeViewer.setInput(defaultCourse.getTopicList());

12.Create the TopicContentProvider content provider, which implements the 
ITreeContentProvider interface. as shown in Example 10-34. The getElement 
method is very similar to the getElement method used in the combo content 
providers that implement the IStructureContentProvider interface.

Example 10-34   getElements method of TopicContentProvider class

public Object[] getElements(final Object inputElement) {
int arraySize = ((TopicList) inputElement).size();
Topic[] topicArray = new Topic[arraySize];
return ((TopicList) inputElement).toArray(topicArray);

}

Content provider classes that implement the ITreeContentProvider interface 
have three more methods, getParent, hasChildren, and getChildren, than the 
content provider classes that implement IStructuredContentProvider. These 
additional methods, as shown in Example 10-35 on page 430, reflect the 
hierarchical nature of the TreeViewer, as compared to the simple list structure 

Note: In step 14, a reference will be made to the topicTreeViewer variable 
inside the scope of an inner class, so it must be a class instance variable to 
have the proper visibility for the inner class. 
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inherent in the ComboViewer, and are used to compose the hierarchical 
display of a tree viewer. As you study these additional methods, remember 
from the class diagram (Figure 10-1 on page 406) that the Topic class is the 
parent of the Resource class.

Example 10-35   TreeContentProvider hierarchy navigation methods

public Object[] getChildren(final Object parentElement) {
if (parentElement instanceof Topic) {

ResourceList list = ((Topic) 
parentElement).getResourceList();

return (Resource[]) list.toArray(new 
Resource[list.size()]);

} else {
return new Object[] {};

}
}

public Object getParent(final Object element) {
if (element instanceof Resource) {

return ((Resource) element).getTopic();
} else {

return null;
}

}

public boolean hasChildren(final Object element) {
if (element instanceof Topic) {

if (((Topic) element).getResourceList().size() > 0) {
return true;

} else {
return false;

}
} else {

return false;
}

}

13.Create the TopicLabelProvider. 

The getElement method of the label provider is much like the previous version 
of the method, as shown in this section for the combo viewers. However, in 
the present case of the tree viewer, the input parameter of this method could 
be either the parent class (Topic) or the child class (Resource). 

To handle this case, we introduce a new interface called ILabel, shown in 
Example 10-36 on page 431.
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Example 10-36   ILabel interface

package com.ibm.wplc.education.mylearning.ui;

public interface ILabel {
String getLabel();

}

Since both Resource and Topic have been defined with getLabel methods 
that are in the ILabel interface, we can change both their class declarations to 
implement the interface, as shown in Example 10-37.

Example 10-37   Implementing ILabel in Resource and Topic

public class Resource implements ILabel 

public class Topic implements ILabel

After the above changes have been made to the Resource and Topic class 
declarations, the getElement method of the TopicLabelProvider can be coded, 
as shown in Example 10-38, to eliminate the need for any conditional code 
based on the type of the input element.

Example 10-38   getElement method of TopicLabelProvider

public String getText(final Object inputElement) {
// ILabel interface implemented by Resource and Topic
return ((ILabel) inputElement).getLabel();

}

The tree display of the topic tree viewer is designed to display an icon 
adjacent to each entry of a Resource to indicate the value of the type attribute 
in the class. For example, if the type variable has a value of “Reference”, an 
icon depicting a reference book is displayed. The getImage method is used to 
handle the display of images as shown in Example 10-39.

Example 10-39   getImage method

public Image getImage(final Object element) {
Image icon = null;
if (element instanceof Resource) {

final ImageDescriptor id = ImageDescriptor
.createFromURL(getIconUrl(((Resource) 

element).getType()));
icon = id.createImage();
setImage(icon);

}
return icon;
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}

The entire TopicLabelProvider class is available with the downloaded plug-in 
code, available from the Redbooks FTP site. There is an additional method 
(getIconURL) and class variable declarations in this class that are used in the 
getImage method. You should examine these to understand the getImage 
method. 

14.As a final step, we need to add a selection changed listener for the course 
combo viewer in the MyLearning MiniApp class. When a user selects a new 
course in the course combo viewer, the Course instance corresponding to the 
selection must be located, and the category combo viewer and topic tree 
viewer must be updated with elements from the selected course.

An argument-defined anonymous inner class will be defined to handle the 
course selection processing, as shown in Example 10-40.

Example 10-40   Course combo SelectionChangedListener (MyLearningMiniApp class)

courseComboViewer 
.addSelectionChangedListener(

new ISelectionChangedListener() {
IStructuredSelection selection;

public void selectionChanged(
final SelectionChangedEvent event) {
selection =(IStructuredSelection)

courseComboViewer
  .getSelection();

if (!selection.isEmpty()) {
final Course course = catalog

.findCourse((CourseDescriptor)
selection

.getFirstElement());
categoryComboViewer.setInput(course

.getCategoryList());
categoryComboViewer.setSelection(

new StructuredSelection(
course
.getDefaultCategory()), true);

categoryComboViewer.refresh();

Note: A dispose method must be coded to specifically free memory 
allocated to the image, unlike the case for text which does not require an 
explicit dispose method.
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topicTreeViewer.setInput(
course.getTopicList());

topicTreeViewer.refresh();
}

}
});

When a user selects a course from category combo viewer:

a. The selectionChanged method of the selection listener class in invoked. 
As shown in Example 10-40 on page 432, the method first finds the new 
Course based on the selection of the course in the course combo viewer. 

b. The input source of the category combo viewer is then set to the 
categories from the new course with the getCategoryList, and the default 
selection is set to the return value of the getDefaultCategory method. 

c. The refresh method of the categoryComboViewer makes sure the viewer 
has the latest data. 

d. The topic tree viewer input source is set to the return value of the 
getTopicList method of course and the topic tree viewer is refreshed.

Implementing the Topic Filter
When a user selects a category from the category combo viewer (labeled Topic 
Filter), the resulting action of the MyLearning plug-in is to display only those 
topics in the topic tree viewer that have the selected category associated with 
them. As you recall from the class diagram (Figure 10-1 on page 406), a 
Category is associated with the Topic instance by including a Tag instance 
variable in the Topic class. The key attribute of the Tag class contains the ID from 
the desired Category class instance.

In this section, you will implement the topic filtering mechanism. A new class, 
TopicFilter, is created to perform the filtering action. Additionally, code is added to 
the createControl method of the MyLearningMiniApp that detects the selection of 
a category from the category combo viewer and then invokes a method to add 
the filter to the topic tree viewer.

To implement the filtering mechanism, use the following procedure:

1. Create a class named TopicFilter in the 
com.ibm.wplc.education.mylearning.ui package. 

The class is an extension of the JFace ViewerFilter class. The select method 
of TopicFilter determines if a data element (as specified by the element input 
parameter of the method) is to be displayed. Since we are filtering the topic 
tree viewer, as specified in the viewer input parameter of the method, the 
element input parameter represents either an instance of the Topic class or 
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an instance of the Resource class. The select method is invoked for each 
element associated with the topic tree viewer. If the select method returns 
“true,” the element is displayed in the topic tree viewer.

From the code in Example 10-41, notice that the type of element is checked 
and that Resource instances are always selected to be displayed. Checking 
Resources is not necessary, since they do not have a Tag instance directly 
associated with them. For elements of type Topic, the list of Tag instances 
associated with the topic are searched and the key attribute of each Tag class 
in the list is compared to the categoryId. The categoryId variable is the filter’s 
search term and is set via a mutator method in the class and corresponds to 
the category selected by the user in the category combo viewer. If the 
categoryId and key attribute of any of the Tag in the list are equal, the method 
returns “true.”

Example 10-41   Select method of the TopicFilter class

public boolean select(final Viewer viewer, 
final Object parentElement,
final Object element) {

boolean found = false;
if (element instanceof Topic) {

final TagList categories = 
((Topic) element).getTagList();

Iterator iterator = categories.iterator();
while (iterator.hasNext()&& found == false) {

if (((Tag) iterator.next()).getKey().equals(
categoryId)) {

found = true;
}

}
} else {

found = true; // do not filter Resource object
}
return found;

}

2. Add code to the createControl method of the MyLearningMiniApp class that 
adds a selection changed listener for the course combo viewer. 

Place the new code directly after the setInput method statement for 
taskTreeViewer. The selection listener class, which is an argument-defined 
anonymous inner class of type ISelectionChangedListener, manages the 
TopicFilter class that was created in step 14 on page 432. The code to add 
the selection changed listener is listed in Example 10-42 on page 435.
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Example 10-42   Category combo viewer selection changed listener (MyLearningMiniApp class)

categoryComboViewer
.addSelectionChangedListener(

new ISelectionChangedListener() {
TopicFilter filter;
IStructuredSelection selection;

public void selectionChanged(
final SelectionChangedEvent event){

selection = (IStructuredSelection) 
categoryComboViewer.

getSelection();
// Filters task list according to category
// selections
if (!selection.isEmpty()) {

if (filter == null) {
filter = new TopicFilter();

} else {
topicTreeViewer.

removeFilter(filter);
}

filter.setCategoryId(((Category) 
selection
.getFirstElement()).getId());

topicTreeViewer.addFilter(filter);
}

}
});

When a user selects a course from the course combo viewer:

a. The selectionChanged method of the selection listener class in invoked. 
As shown in the code in Example 10-42, the method first extracts the 
selected element from the category combo viewer and then creates a new 
instance of TopicFilter if it does not exist, or removes the current filter from 
the topic tree viewer. 

b. The selected category (categoryId) is passed to the filter by the 
setCategoryId method. 

c. The filter is then added to the topicTreeViewer to be used to check if each 
element in the tree viewer should be displayed.
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3. You can now test the user interface. Use the Eclipse Workbench Run control 
to start the plug-in mini-app and note how the interface controls are populated 
with the data. Try selecting different categories in the combo viewer labeled 
Topic Filter and notice the difference in the topics displayed in the Topic tree 
viewer, as shown in Figure 10-4, Figure 10-5, and Figure 10-6 on page 437.

Figure 10-4   User interface with “All Topics” selected from Topic Filter 

Figure 10-5   User interface with “Topic B” selected
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Figure 10-6   Icons associated with the resources

10.3  Plug-in controller 

In this section, we examine the plug-in controller of the MyLearning plug-in. 
Within Eclipse-based applications like MyLearning, the control of processing is 
largely handled by context menus and actions. 

Actions are classes that can be listed as an item on a menu. When the item is 
selected in the menu, the run method of the action class is invoked, which 
performs the desired processing, usually by utilizing additional classes written to 
perform tasks specific to the action.

From a user viewpoint, context menus are available by right-clicking either a topic 
or resource element in the topic tree viewer. The menu and available actions, 
Assistance and Properties, for a topic element are shown in Figure 10-7.

Figure 10-7   Topic context menu
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For a resource element, the available actions in the context menu are Open, 
Assistance, and Properties, as shown in Figure 10-8.

Figure 10-8   Resource context menu

The Open action can also be selected by double-clicking a resource element in 
the topic tree viewer. 

For the MyLearning plug-in, each action opens a new window and displays a set 
of data in that window. 

� The Assistance action displays Sametime contacts who have been defined as 
a contact for assistance on a topic. 

� The Properties actions display information about the selected topic or 
resource element.

� The Open action opens a url associated with a resource and displays it 
content in a browser-like interface.

In this section, we will:

1. Create the Action classes that are used in the MyLearning plug-in. 

2. Place those action classes in a context menu that available by right-clicking 
elements in the topic tree viewer.

3. Create the classes are invoked by each action class's run method. 
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10.3.1  Define the actions

The actions are defined in classes that extend the JFace Actions class. The 
name of the action classes, by action, are presented in Table 10-8.

Table 10-8   Classes that extend the JFace Actions class

To define the actions available in the MyLearning plug-in, use the following 
procedure:

1. Create a new class named AssistAction that extends Action. 

Within the class, create a constructor that takes a TreeViewer as an 
argument. The constructor should:

– Copy its input parameter to a private instance variable.

– Use the setEnable method to enable the action.

– Use the setText method to set the text of the action in the menu to 
“Assistance.” 

This class, and all of the other classes related to action definition and 
implementation, are part of the com.ibm.wplc.education.mylearning.ui 
package.

Action Action class

Properties (Topic) DescribeTopicAction

Properties (Resource) DescribeResourceAction

Open DisplayAction

Assistance AssistAction
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Also, create a no-argument method called run that has private access and 
returns void. For now, the run method has an empty method body, as shown 
in Example 10-43, but it will be completed later in the procedure.

Example 10-43   AssistAction cpass

public class AssistAction extends Action {

private TreeViewer taskTreeViewer;

AssistAction(final TreeViewer taskTreeViewer) {
this.taskTreeViewer = taskTreeViewer;
setEnabled(true);
setText("Assistance"); 

}

public void run() { 
}

}

2. Repeat step 1 for the action class DisplayAction.

Example 10-44   DisplayAction class

public class DisplayAction extends Action {

private TreeViewer taskTreeViewer;

DisplayAction(final TreeViewer taskTreeViewer) {
this.taskTreeViewer = taskTreeViewer;
setEnabled(true);
setText("Open");  

}

public void run() { 
}

}

3. Repeat step 1 for the action class DescribeResourceAction, as shown in 
Example 10-45 on page 441.
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Example 10-45   DescribeResourceAction class 

public class DescribeResourceAction extends Action {

private TreeViewer treeViewer;

DescribeResourceAction(final TreeViewer treeViewer) {
this.treeViewer = treeViewer;
setEnabled(true);
setText("Properties"); 

}

public void run() { 
}

}

4. Repeat step 1 for the action class DescribeTopicAction, as shown in 
Example 10-46.

Example 10-46   DescribeTopicAction class

public class DescribeTopicAction extends Action {

private TreeViewer treeViewer;

DescribeTopicAction(final TreeViewer treeViewer) {
this.treeViewer = treeViewer;
setEnabled(true);
setText("Properties"); 

}

public void run() { 
}

}

5. Create a new method in the MyLearningMiniApp class named createActions, 
as shown in Example 10-47. The method has private access, is of type void, 
and has no arguments.

Example 10-47   createActions method declaration

private void createActions() {
}
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6. Place the call to createActions in the createControl method, just above the 
return statement, as shown in Example 10-48.

Example 10-48   createActions method invocations

createActions();

7. In the MyLearningMiniApp class, declare four private variables of type Action 
as instance variables. 

The variable names are:

– displayAction (representing the Open action)

– describeTopicAction (representing the Properties action for a topic)

– describeResourceAction (representing the Properties action for a 
resource)

– assistAction (representing the Assistance action)

Example 10-49 shows the instance variable declarations.

Example 10-49   Action instance variables

private Action displayAction, describeTopicAction, 
                  describeResourceAction, assistAction;

8. Within the createActions method, create new instances of the Action classes 
DisplayAction, DescribeTopicAction, DescribeResourceAction, and 
AssistAction, as shown in Example 10-50. 

Each class has a single argument, topicTreeViewer, passed to the 
constructor.

Example 10-50   Creating new Action classes

displayAction = new DisplayAction(topicTreeViewer);
describeTopicAction = new DescribeTopicAction(topicTreeViewer);
describeResourceAction = 
                  new DescribeResourceAction(topicTreeViewer);
assistAction = new AssistAction(topicTreeViewer);
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10.3.2  Create the context menu for the TreeViewer viewer 

In this section, we will create a context menu manager for the topic TreeViewer. 
The menu manager will display a list of available actions in a context menu when 
an element in the topic TreeViewer is right clicked. To create the menu manager, 
use the following procedures: 

1. Create a new method in the MyLearningMiniApp class named 
createMenuManager as shown in Example 10-51. The method has private 
access, is of type void, and has no arguments.

Example 10-51   createMenuManager method declaration

private void createMenuManager() {
}

2. Place the call to the createMenuManager method in the createControl 
method, just above the return statement, but after the createActions 
statement.

Example 10-52   createMenuManager method invocation

createMenuManager();

3. In the createMenuManager method, add the code shown in Example 10-53 to 
create a context menu to be used in the topic tree viewer.

Example 10-53   Setting up the menu manager

final MenuManager manager = new MenuManager();
final Menu menu = manager.createContextMenu(

topicTreeViewer.getControl());.getControl());
topicTreeViewer.getControl().setMenu(menu);

4. Context menus can be either static or dynamic. Since the set of actions that 
are available are different for the two different types of elements (topic and 
resource) in the topic tree viewer, we will need to create a dynamic menu that 
can determine the current element selection in the viewer and display the 
appropriate context menu. 
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To create a dynamic menu, the menu manager's setRemoveAllWhenShown 
method must be used with an argument of true and a menu listener must be 
added to the code, as shown in Example 10-54.

Example 10-54   Dynamic context menu construction

manager.setRemoveAllWhenShown(true);
manager.addMenuListener(new IMenuListener() {

public void menuAboutToShow(
final IMenuManager manager) {
final IStructuredSelection selection = 

(IStructuredSelection) 
topicTreeViewer

.getSelection();

if (selection.getFirstElement() instanceof
 Resource) {

manager.add(displayAction);
manager.add(new Separator());
manager.add(assistAction);
manager.add(new Separator());

manager.add(describeResourceAction);
} else if (selection.getFirstElement()instanceof 

Topic) {
manager.add(assistAction);
manager.add(new Separator());
manager.add(describeTopicAction);

}
}

});

From the code in Example 10-54, it can be seen that the selection listener 
class is an anonymous argument-defined inner class that implements 
IMenuListener. When the user right-clicks a topic TreeViewer element, the 
menuAboutToShow method is invoked. The menuAboutToShowMethod 
determines the type of the selected element and dynamically constructs the 
context menus using the menu manager add method. The Separator class 
draws a horizontal line between the action entries in the resulting context 
menu.
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5. The Open action is selectable by selecting Open from the topic TreeViewer 
context menu or by double-clicking a resource element. 

To add the double-click selection capability, a double-click listener is added to 
the topic tree viewer (see Example 10-55). The double-click selection listener 
class is an anonymous argument-defined inner class that implements 
IDoubleClickListener. When an element of the topic TreeViewer is 
double-clicked, the doubleClick method is invoked. If the selected element is 
of type Resource, the run method of the DisplayAction action is invoked. 

Example 10-55   Topic TreeViewer double-click selection listener

//  Listen for double clicks on resource in task tree
topicTreeViewer.addDoubleClickListener(new IDoubleClickListener() 

{
public void doubleClick(final DoubleClickEvent event) {

if (((IStructuredSelection) event.getSelection())
.getFirstElement() instanceof Resource) {

displayAction.run();
}

}
});

6. The MyLearning plug-in is now ready to be tested to confirm that the context 
menus are properly displayed. Right-clicking a topic element in the topic 
TreeViewer should display the context menu shown in Figure 10-9.

Figure 10-9   Topic context menu
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Right-clicking a resource element in the topic TreeViewer should display the 
context menu shown in Figure 10-10.

Figure 10-10   Resource context menu

10.3.3  Create actions

In the previous sections, we created the menus and “stub” action classes. In this 
section, we will put code in place to perform the actual processing required by 
each action.

The classes and development steps for implementing each of the actions in the 
MyLearning plug-in are similar. The actions generally have:

� A class that creates a new window in which to display the action's data. These 
classes extend the JFace Windows class. Each class contains a 
createContents method, which is where the user interface composite is 
defined. The Open and Assistance actions define the composite in separate 
classes and these separate classes are then used in the createContents 
method.

� Classes that serve as content and label providers for the JFace viewers in the 
user interface composite (except for the Open action).

� Supporting classes that provide data structures or processing functions 
required by the action. 

Note: Nothing will happen when you select one of the actions because the run 
method of all the action classes is currently implemented as an empty body. 
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Table 10-9 shows the class names for each of the above types of classes by 
action. All of these classes are part of the com.ibm.wplc.education.mylearning.ui 
package.

Table 10-9   Supporting action classes

For each action, the run method of the associated action class uses the following 
pattern of processing:

1. Determines the selected topic or resource element in the topic tree viewer.

2. Obtains parameters to be passed to window creation class constructor, 
usually from methods of the selected element's Topic or Resource class.

3. Constructs a new instance of the applicable window creation class. 

4. Opens the window.

The following sections will describe the classes used in each of the actions. 
Many of the classes have familiar code patterns and artifacts that were explained 
earlier in the chapter, so we will focus on examining new aspects of the classes.

Actions Window 
creation

Composite 
definition

Content and label 
providers

Supporting 
classes

Properti
es 
(Topic)

DescriptionWin
dow

DescriptionWin
dow

DescriptionConten
tProvider

DescriptionLabelPr
ovider

DescriptionTab
le

DescriptionTab
leRow

Properti
es 
(Resour
ce)

DescriptionWin
dow

DescriptionWin
dow

DescriptionConten
tProvider

DescriptionLabelPr
ovider

DescriptionTab
le

DescriptionTab
leRow

Assistan
ce

AssistWindow AssistComposi
te

AssistContentProvi
der

AssistLabelProvide
r

PeopleList
PersonHelper

Open DIsplayWindow AssistComposi
te

BrowserComp
osite

AssistContentProvi
der

AssistLabelProvide
r

None
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Topic Properties Action
The Properties action for a Topic presents a window with a table of name and 
value pairs for the attributes of selected topic, as shown in Figure 10-11.

Figure 10-11   Topic Properties

The only attribute shown for a topic is its description.

To create the Properties action for a topic, use the following procedure:

1. Create the DescriptionWindow class and add the code for the class, as shown 
in Example 10-56.

Example 10-56   DescriptionWindow class

/**
 * 
 */
package com.ibm.wplc.education.mylearning.ui;

import org.eclipse.jface.viewers.ColumnWeightData;
import org.eclipse.jface.viewers.TableLayout;
import org.eclipse.jface.viewers.TableViewer;
import org.eclipse.jface.window.Window;
import org.eclipse.swt.SWT;
import org.eclipse.swt.layout.FillLayout;
import org.eclipse.swt.widgets.Composite;
import org.eclipse.swt.widgets.Control;
import org.eclipse.swt.widgets.Shell;
import org.eclipse.swt.widgets.Table;
import org.eclipse.swt.widgets.TableColumn;
/*
 * Displays window for properties action 
 */
final class DescriptionWindow extends Window {

private DescriptionTable description;

private static final int WIDTH = 300;
private static final int HEIGHT = 200;
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private String label;

DescriptionWindow(final DescriptionTable desc, final String label) {
super((Shell) null);
setLabel(label);
setDescription(desc);

}

public Control createContents(final Composite parent) {
final Shell shell = parent.getShell();
shell.setLayout(new FillLayout());
shell.setSize(WIDTH, HEIGHT);
shell.setText(getLabel());

final Composite comp = new Composite(parent, SWT.NONE);
comp.setLayout(new FillLayout());
final Table table = new Table(comp, SWT.MULTI | SWT.READ_ONLY);
final TableLayout layout = new TableLayout();
table.setLayout(layout);
table.setLinesVisible(true);
table.setHeaderVisible(true);

layout.addColumnData(new ColumnWeightData(5, 50, false));
final TableColumn colLeft = new TableColumn(table, SWT.NONE);
colLeft.setAlignment(SWT.LEFT);
colLeft.setText("Name"); 

layout.addColumnData(new ColumnWeightData(5, 200, true));
final TableColumn colRight = new TableColumn(table, SWT.NONE);
colRight.setAlignment(SWT.LEFT);
colRight.setText("Value"); 

final TableViewer descTable = new TableViewer(table);
descTable.setContentProvider(new DescriptionContentProvider());
descTable.setLabelProvider(new DescriptionLabelProvider());
descTable.setInput(getDescription());

return comp;
}

private DescriptionTable getDescription() {
return description;

}
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private void setDescription(DescriptionTable desc) {
this.description = desc;

}

private String getLabel() {
return label;

}

private void setLabel(String label) {
this.label = label;

}

}

The first parameter of the class constructor is a DescriptionTable, which is a 
class that contains a table of attributes. The first column of the table contains 
the name of the attribute and the second column of the table contains the 
value of the attribute. The second parameter is the label of the topic, which is 
used as the window's title text.

The createContents method creates a Table control. The ColumnWeightData 
class permits the relative widths of the columns to be defined in the table 
layout. Columns are created with the TableColumn class and incorporated 
into the table layout. Methods setText and setAlignment in the TableColumn 
class allow for specification and alignment of the text in the column headers.

A TableViewer is then created from the Table control. The input source is the 
DescriptionTable that was obtained as the first argument of the 
DescriptionWindow's constructor. The table viewer's content provider and 
label provider are covered in the next steps of the procedure.

2. Create the DescriptionContentProvider class and add the code to the class, 
as shown in Example 10-57.

Example 10-57   DescriptionContentProvider class

/**
 * 
 */
package com.ibm.wplc.education.mylearning.ui;

import org.eclipse.jface.viewers.IStructuredContentProvider;
import org.eclipse.jface.viewers.Viewer;

/*
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 * Content provider for description table viewer
 */

final class DescriptionContentProvider implements 
IStructuredContentProvider {

public void dispose() {
}

public Object[] getElements(final Object inputElement) {
return ((DescriptionTable) inputElement).getTableRow();

}

public void inputChanged(final Viewer viewer, final Object 
oldElement, final Object newElement) {

}
}

This content provider is much like others we have looked at this chapter. The 
getElements method uses the getTablesRow method of DescriptionTable to 
return an array of DescriptionTableRow.

3. Create the DescriptionLabelProvider class and add the code to the class, as 
shown in Example 10-58.

Example 10-58   DescriptionLabelProvider class

/**
 * 
 */
package com.ibm.wplc.education.mylearning.ui;

import org.eclipse.jface.viewers.ITableLabelProvider;

import org.eclipse.jface.viewers.LabelProvider;
import org.eclipse.swt.graphics.Image;

/*
 * Label provider for description table viewer
 */

final class DescriptionLabelProvider extends LabelProvider implements
ITableLabelProvider {

public Image getColumnImage(final Object element, final int col) {
return null;

}
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public String getColumnText(final Object element, final int col) {
String text = "";
if (col == 0) {

text = ((DescriptionTableRow) element).getName();
} else if (col == 1) {

String s = ((DescriptionTableRow) element).getValue();
// Values defined as #IMPLIED in the DTD may be null, so 

convert to blank
text = (s == null) ? " " : s;

}
return text;

}
}

This variant of this label provider is slightly different than the ones we have 
seen before. Since the input element is a table, the getColumnText method 
contains a column parameter (col), which the method uses to determine 
whether it should use the getName or getValue method of 
DescriptionTableRow class.

4. Create the DescriptionTable class and add the code to the class, as shown in 
Example 10-59. 

This class represents a table as an array of DescriptionTableRow.

Example 10-59   DescriptionTable class

/**
 * 
 */
package com.ibm.wplc.education.mylearning.ui;

import org.eclipse.jface.viewers.IStructuredContentProvider;
import org.eclipse.jface.viewers.Viewer;

/*
 * Content provider for description table viewer
 */

final class DescriptionContentProvider implements 
IStructuredContentProvider {

public void dispose() {
}

public Object[] getElements(final Object inputElement) {
return ((DescriptionTable) inputElement).getTableRow();
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}

public void inputChanged(final Viewer viewer, final Object 
oldElement, final Object newElement) {

}
}

5. Create the DescriptionTableRow class and the code to the class, as shown in 
Example 10-60.

Example 10-60   DescriptionTableRow class

/**
 * 
 */
package com.ibm.wplc.education.mylearning.ui;

import org.eclipse.jface.viewers.ITableLabelProvider;

import org.eclipse.jface.viewers.LabelProvider;
import org.eclipse.swt.graphics.Image;

/*
 * Label provider for description table viewer
 */

final class DescriptionLabelProvider extends LabelProvider implements
ITableLabelProvider {

public Image getColumnImage(final Object element, final int col) {
return null;

}

public String getColumnText(final Object element, final int col) {
String text = "";
if (col == 0) {

text = ((DescriptionTableRow) element).getName();
} else if (col == 1) {

String s = ((DescriptionTableRow) element).getValue();
// Values defined as #IMPLIED in the DTD may be null, so 

convert to blank
text = (s == null) ? " " : s;

}
return text;

}
}
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This class represents a (name, value) pair as a row with methods to return the 
name (getName) or value (getValue) of the pair.

6. Complete the run method of the DescriptionTopicAction class, as shown in 
Example 10-61.

Example 10-61   Run method of the DescriptionTopicAction class

package com.ibm.wplc.education.mylearning.ui;

import org.eclipse.jface.action.Action;
import org.eclipse.jface.viewers.IStructuredSelection;
import org.eclipse.jface.viewers.TreeViewer;

import com.ibm.wplc.education.mylearning.model.Topic;

/*
 * Action to display properties table of a Topic
 */

public class DescribeTopicAction extends Action {

private TreeViewer treeViewer;

DescribeTopicAction(final TreeViewer treeViewer) {
this.treeViewer = treeViewer;
setEnabled(true);
setText("Properties");

}

public void run() { 
final IStructuredSelection selection = (IStructuredSelection) 

treeViewer
.getSelection();

if (!selection.isEmpty()) {
final Topic task = (Topic) selection.getFirstElement();
final DescriptionWindow window = new DescriptionWindow(

new DescriptionTable(
new DescriptionTableRow[] { new 

DescriptionTableRow(("Description"), task.getDescription()) }), 
task.getLabel());

window.open();
}

}
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}

The run method obtains the selected topic and creates a new instance of the 
DescriptionWindow class. 

The first parameter of the DescriptionWindow constructor is a new instance of 
DescriptionTable, with one new instance of DescriptionTableRow. The 
constructor of DescriptionTableRow sets the name component of the row as a 
String literal “Description” and sets the value component of the row as the 
return value from the getDescription method of the selected Topic element. 

The second parameter of the DescriptionWindow constructor is obtained from 
the getLabel method of the selected Topic element.

After the DescriptionWindow is created, it is opened with the open method.

7. Test the new action. The Properties window (shown for Topic B) should look 
like Figure 10-12.

Figure 10-12   Topic B Properties window

Resource Properties action
The Properties action for a Resource presents a window with a table containing 
name and value pairs for the attributes of selected resource, as shown in 
Figure 10-13.

Figure 10-13   Resource Properties window
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The Resource Properties actions uses most of the same components as the 
Topic Properties action. Only the DescriptionResourceAction class is unique to 
the Resource Properties action. To create the Properties action for a resource, 
use the following procedure:

1. Complete the run method of the DescriptionResourceAction class, as shown 
in Example 10-62.

Example 10-62   Run method of DescriptionResourceAction class

public void run() { 
final IStructuredSelection selection = (IStructuredSelection) 

treeViewer
.getSelection();

if (!selection.isEmpty()) {
final Resource resource = (Resource) 

selection.getFirstElement();
final DescriptionWindow window = new DescriptionWindow(

new DescriptionTable(
new DescriptionTableRow[] {

new DescriptionTableRow("Description",   
resource.getDescription()),

new DescriptionTableRow("Level",    
resource.getLevel()),

new DescriptionTableRow("Type",   
resource.getType()),

new DescriptionTableRow("Author",  
//$NON-NLS-1$

resource.getAuthor()) }),
resource.getLabel());

window.open();

}
}

The run method obtains the selected resource and creates a new instance of 
the DescriptionWindow class. 

The first parameter of the DescriptionWindow constructor is a new instance of 
DescriptionTable consisting of multiple DescriptionTableRow in an array. For 
each element in the DescriptionTableRow array, the constructor of 
DescriptionTableRow sets the name component of the row as a String literal 
and sets the value component of the row as the return value from a 
corresponding accessor method of the selected Resource element.

The second parameter of the constructor is obtained from the getLabel 
method of the selected Topic element.
456 Extending Sametime 7.5: Building Plug-ins for Sametime



After the DescriptionWindow is created, it is opened with the open method.

2. Test the new action. The Properties window for a resource should look like the 
Figure 10-14. 

Figure 10-14   Topic B Properties window test

Assistance action
The Assistance action presents a window that contains a list of people who are 
identified as assistance providers for a particular topic. The action is available 
both from the resource and topic context menus. The action is also available from 
a resource. In this instance, the assistance providers are taken from the 
resource's parent topic.

When a user is selected from the assistance provider list, their business card is 
displayed, as shown in Figure 10-15. 

Figure 10-15   Assistance provider business card

Notice that the Sametime status icon displays next to the assistance providers 
contact ID. This status indicator represents the person's current Sametime 
status, not just the status that was available when the Assistance action was first 
selected. Changes to a person's Sametime status are immediately reflected in 
the status icon.

Right-clicking a selected contact displays a Sametime context menu with 
available actions, such as start chat, send announcement, and compose e-mail 
targeted to the selected contact.
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To create the Assistance action use the following procedure:

1. Create an interface called IAssist, as shown in Example 10-63.

Example 10-63   IAssist interface

package com.ibm.wplc.education.mylearning.ui;

import com.ibm.wplc.education.mylearning.model.Topic;

public interface IAssist {
public Topic getTopic();

}

2. Change the class declaration of the Resource class so that it implements the 
IAssist interface, as shown in Example 10-64.

The Resource class already has a getTopic method defined, so no additional 
changes are required for the class to meet the interface contract.

Example 10-64   IAssist implemented by Resource

public class Resource implements ILabel, IAssist {

3. Change the class declaration of the Topic class so that it implements the 
IAssist interface. Add a getTopic method to the Topic class so that it conforms 
to the interface contract class, as shown in Example 10-65.

Example 10-65   IAssist implemented by Topic

public class Topic  implements ILabel, IAssist {

public Topic getTopic() {
return this;

}

With the IAssist interface implemented by Resource and Topic, we can obtain 
the topic associated with a selected element in the topic TreeViewer with the 
interface's getTopic method, regardless of whether the element has a base 
type of Resource or Topic.

4. Create a PeopleList class to represent a list that is type-aware of 
com.ibm.collaboration.realtime.people.Person, which is the class used to 
represent a Sametime contact. Model the list after a class such as 
CategoryList. Example 10-66 on page 459 shows the complete PeopleList 
class.
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Example 10-66   PeopleList class

package com.ibm.wplc.education.mylearning.ui;
/*
 * Type-sensitive array list of IPerson
 */

import java.util.ArrayList;
import java.util.Iterator;

import com.ibm.collaboration.realtime.people.Person;

public class PeopleList {

private ArrayList list = new ArrayList();

public void add(Person people) {
list.add(people);

}
public Person get(int index) {

return (Person) list.get(index);
}

public int size() {
return list.size();

}

public Person[] toArray(Person[] array) {
return (Person[]) list.toArray(array);

}

public void clear() {
list.clear();

}

public Iterator iterator() {
return list.iterator();

}
}
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5. Create the AssistWindow class and add the code for the class, as shown in 
Example 10-67.

Example 10-67   AssistWindow class

/**
 * 
 */
package com.ibm.wplc.education.mylearning.ui;

import org.eclipse.jface.window.Window;
import org.eclipse.swt.SWT;
import org.eclipse.swt.graphics.Color;
import org.eclipse.swt.graphics.RGB;
import org.eclipse.swt.layout.FillLayout;
import org.eclipse.swt.widgets.Composite;
import org.eclipse.swt.widgets.Control;
import org.eclipse.swt.widgets.Shell;

/*
 * Displays the Assistance window 
 */

final class AssistWindow extends Window {

private final static int WIDTH = 580;

private final static int HEIGHT = 240;

private String label;

private String topic;

private String course;

private PeopleList people;

AssistWindow(final IAssist assist, final PeopleList people) {
super((Shell) null);
setLabel(assist.getTopic().getLabel());
setPeople(people);
setCourse(assist.getTopic().getCourseDescriptor().getLabel());
setTopic(assist.getTopic().getLabel());

}
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public Control createContents(final Composite parent) {

final Shell shell = parent.getShell();
shell.setLayout(new FillLayout());
shell.setText(getLabel());
shell.setSize(WIDTH, HEIGHT);

final Composite comp = new Composite(parent, SWT.NONE);
comp.setLayout(new FillLayout());

// Set background to Lotus Yellow
comp.setBackgroundMode(SWT.INHERIT_DEFAULT);

    Color bgColor = new Color(comp.getDisplay(), new RGB(255, 204, 
0));

    comp.setBackground(bgColor);
    bgColor.dispose();

// Assistance form
new AssistComposite(comp, SWT.NONE, getPeople(), getCourse(),

getTopic());
// bgImage.dispose();

return comp;
}

private String getLabel() {
return label;

}

private void setLabel(final String label) {
this.label = label;

}

private PeopleList getPeople() {
return people;

}

private void setPeople(final PeopleList people) {
this.people = people;

}

private String getCourse() {
return course;

}

private void setCourse(final String course) {
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this.course = course;
}

private String getTopic() {
return topic;

}

private void setTopic(final String topic) {
this.topic = topic;

}
}

The constructor's first argument is of type IAssist and represents the selected 
Topic or Resource in the topic TreeViewer, and the second argument is of 
type PeopleList and represents the contact IDs for the selected element.

The createContents class creates a new instance of AssistComposite which 
is where the user interface controls are defined, as explained in step 6.

6. Create the AssistComposite class. 

The class constructor takes the following arguments:

– The parent composite

– The composite style flag (SWT.NONE)

– A PeopleList of those who can provide assistance

– The course name

– The topic name

The constructor sets instance variables from the constructor arguments and 
calls a private method createLayout, which contains the definitions of the user 
interface.

The code in the first part of the createLayout method sets a background and 
creates several Label and Text widgets to display instructions, the course 
name, and the topic. The remainder of the code is more interesting and deals 
primarily with managing the Sametime contact list and the business card.

The class hierarchy of the MyBusinessCard class includes the SWT Control 
class, so it can be created and laid out like any other control, as shown in 
Example 10-68.

Example 10-68   Creating a MyBusinessCard instance

// Setup business card
final MyBusinessCard card = new MyBusinessCard(this,

MyBusinessCard.DIRECTORY_INFO | MyBusinessCard.IMAGE
| MyBusinessCard.LIVENAME);
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data = new FormData();
data.top = new FormAttachment(topicText, 10);
data.left = new FormAttachment(assistTable, 10);
data.right = new FormAttachment(100, -10);
card.setLayoutData(data);

The TableViewer shown in Example 10-69 displays the list of assistance 
contact names. The input source is the PeopleList that was an argument to 
the AssistComposite class constructor. The viewer's content provider is 
AssistContentProvider and the label provider is AssistLabelProvider; both are 
explained later in this procedure.

Example 10-69   TableViewer

// Setup table of names that can provide assistance
final TableViewer assistTableViewer = new TableViewer(assistTable);
assistTableViewer.setContentProvider(new AssistContentProvider());
assistTableViewer.setLabelProvider(new AssistLabelProvider());
assistTableViewer.setInput(getPeople());

To obtain data about a contact person that can be placed in their business 
card, the Sametime directory is used. To use the directory, we first need to 
obtain a reference to the Sametime directory service, as shown in 
Example 10-70. This sequence of code starts with a reference to a static 
method getCommunity in class PersonHelper. The PersonHelper class 
contains a set of Sametime-related utility methods and will be shown later in 
this procedure.

Example 10-70   Obtaining a Directoryservice instance

// Get directory service to use to obtain image url for a selected
// user
final Community community = PersonHelper.getCommunity();
final DirectoryServiceFactory factory = (DirectoryServiceFactory) 
community

.getService(DirectoryServiceFactory.SERVICE_TYPE);
final RtcSession rtcSession = community.getRtcSession();
final DirectoryService directoryService = factory

.getDirectoryService(rtcSession);
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The next section of code, shown in Example 10-71 defines a named 
(LookupHandler) inner class that is used as a user information lookup 
handler. When this class is installed as a lookup event handler, the 
handleUserInfoLookupEvent method is executed whenever there is a request 
to look up user information. The code in the handleUserInfoLookupEvent 
method finds a contact's directory information and obtains the URL to the 
person's image, which it then sets into the business card so the image can be 
retrieved and displayed.

Example 10-71   LookupHandler class

// Lookup handler class for directory services user lookups
class LookupHandler implements UserLookupListener {

public void handleUserInfoLookupEvent(
final UserInfoLookupEvent event) {

if (event.getType() == UserInfoLookupEvent.USERINFO_SUCCEEDED) 
{

final ContactInfo contact = event.getUserInfo();
final DirectoryInfo dirInfo = contact

.getDirectoryInfo();
if (dirInfo != null) {

String imagePath = (String) dirInfo
.get(DirectoryInfo.IMAGE_PATH);

if (imagePath != null) {
// point to picture url for business card
card.setImageUrl(imagePath);

}
}

}
}

}

In the next segment of code, shown in Example 10-72 on page 465, we set a 
selection changed event handler on the assistance table viewer. As in 
previous instances of setting event handlers on JFace viewers, the handler is 
an argument-defined anonymous inner class that has the same general 
execution pattern as other selections changed event handlers we have 
examined.

When a selection is made in the assistance table, the selectionChanged 
method in the handler runs. 

a. First, the selected element (type Person) is extracted. We now get to use 
the directory service reference we obtained earlier to invoke its 
addUserInfoLookupListener method to add a user lookup listener. The 
handler for the listener is the LookupHandler class previously defined as a 
named inner class. 
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b. Next, the directory service queryUserAttributes method is issued with a 
request to obtain the person's image path. The invocation of the 
queryUserAttributes method causes the handlerUserInfoLookupEvent 
method in LookupHandler to run, as described above. The directory 
service user lookup listener is then removed and the selected person from 
the assist table viewer is set into the business card.

Example 10-72   Assistance section changed listener

assistTableViewer
.addSelectionChangedListener(new ISelectionChangedListener() {

IStructuredSelection selection;
public void selectionChanged(

final SelectionChangedEvent event) {
selection = (IStructuredSelection) assistTableViewer

.getSelection();
if (!selection.isEmpty()) {

final Person person = (Person) selection
.getFirstElement();

//  Lookup image path for selected user and
// set on card (done by lookup handler class).
final LookupHandler lookupHandler = new LookupHandler();
directoryService

.addUserInfoLookupListener(lookupHandler);
directoryService

.queryUserAttributes(
person.getContactId(),
new String[] { DirectoryInfo.IMAGE_PATH });

directoryService
.removeUserInfoLookupListener(lookupHandler);

// Setup business card for current person
card.setPerson(person);
card.setShowExtraInfo(false);

}
}

});
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The final code segment (Example 10-73) sets the initial selection of the assist 
table viewer to the first person in the list and sets up the Sametime LiveName 
context menu with the PersonHelper.getContextMenu method. The context 
menu allows a variety of Sametime actions, such as starting a chat, sending 
an announcement, or composing an e-mail for the person selected in the 
assist table viewer.

Example 10-73   Setting the initial selection for Assistance table

// Set default assistance provider user (first in table)
assistTableViewer.setSelection(new StructuredSelection(getPeople()

.get(0)), true);

// Setup Live Name context menu (same as used in Sametime
PersonHelper.getContextMenu(assistTable, assistTableViewer);

7. Create the AssistContentProvider class and add the code shown in 
Example 10-74 to the class.

Example 10-74   AssistContentProvider class

/**
 * 
 */
package com.ibm.wplc.education.mylearning.ui;
/*
 * Content provider for Topics tree list viewer
 */

import java.beans.PropertyChangeEvent;
import java.beans.PropertyChangeListener;
import java.util.Iterator;

import org.eclipse.jface.viewers.IStructuredContentProvider;
import org.eclipse.jface.viewers.StructuredViewer;
import org.eclipse.jface.viewers.Viewer;
import org.eclipse.swt.widgets.Control;

import com.ibm.collaboration.realtime.people.Person;

final class AssistContentProvider implements 
IStructuredContentProvider,

PropertyChangeListener {

private StructuredViewer viewer;
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public void dispose() {
}

public Object[] getElements(final Object inputElement) {
int arraySize = ((PeopleList) inputElement).size();
Person[] personArray = new Person[arraySize];
return  ((PeopleList) inputElement).toArray(personArray);

}

public void inputChanged(final Viewer viewer, final Object 
oldElement,

final Object newElement) {
// Add or remove property listensers for each person PeopleList
this.viewer = (StructuredViewer) viewer;
if (oldElement != newElement) {

if (oldElement != null) {
Iterator it = ((PeopleList) oldElement).iterator();
while (it.hasNext()) {

Person person = (Person) it.next();
if (person != null) {

person.removePropertyChangeListener(this);
}

}
}
if (newElement != null) {

Iterator it = ((PeopleList) newElement).iterator();
while (it.hasNext()) {

Person person = (Person) it.next();
if (person != null) {

person.addPropertyChangeListener(this);
}

}
}

}
}

public void propertyChange(final PropertyChangeEvent event) {
// Refresh view when any person property changes
Control ctrl = viewer.getControl();
if ((ctrl != null) && !ctrl.isDisposed()) {

ctrl.getDisplay().asyncExec(new Runnable() {
public void run() {

viewer.refresh();
}

});
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}
}

}

This content handler is different from the ones we have examined so far. All of 
the previous content handlers assumed the data input source was static, but 
this handler is designed to handle changes that are made to the data source. 
The mostly likely change to the viewer's elements (type Person) is a change 
in Sametime status. 

In all other content providers, the inputChanged method had an empty 
method body, but in this one, the implementation is fully coded to handle input 
source changes through the use of property change listeners. To provide the 
property change listener capability, this content provider implements the 
PropertyChangeListener interface.

The inputChanged method is first run when the setInput method of the viewer 
is run. At that time, oldElement is null, so the code iterates through 
newElement (the PeopleList data source) to get each Person instance in the 
list and add a property change listener to each person with the 
addPropertyChangeListener method of the Person class. The this argument 
in the addPropertyChangeListener specifies that the existing instance of the 
AssistContentProvider serves as the handler class for the property change 
listener. 

When a property change event fires (such as a change in a person's 
Sametime status), the propertyChange method runs, invoking the refresh 
method of the viewer. This causes the data input source to be reread. 

When the method is about to be disposed, newElement is null, so the code 
iterates through oldElement (the PeopleList data source) to get each Person 
instance in the list and removes the property change listener from each 
person with the removePropertyChangeListener method of the Person class.

8. Create the AssistLabelProvider class and add the code shown in 
Example 10-75 to the class.

Example 10-75   AssistLabelProvider class

/**
 * 
 */
package com.ibm.wplc.education.mylearning.ui;

import java.net.URL;
import java.util.HashMap;
import java.util.Map;
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import org.eclipse.core.runtime.FileLocator;
import org.eclipse.core.runtime.Path;
import org.eclipse.jface.resource.ImageDescriptor;
import org.eclipse.jface.viewers.ILabelProvider;
import org.eclipse.jface.viewers.LabelProvider;
import org.eclipse.swt.graphics.Image;

import com.ibm.collaboration.realtime.people.Person;

/*
 * Label provider for Assistance table
 */

final class AssistLabelProvider extends LabelProvider implements 
ILabelProvider{

Image image;

public static final Map STATUS_ICON_PATH_TABLE;

static {
// Map status to icon path
STATUS_ICON_PATH_TABLE = new HashMap(12);

STATUS_ICON_PATH_TABLE.put(new Integer(Person.STATUS_DND), new 
Path(

"images/ST_Awns_DND.png"));
STATUS_ICON_PATH_TABLE.put(new Integer(Person.STATUS_DND_MOBILE),

new Path("images/ST_Awns_DND.png"));
STATUS_ICON_PATH_TABLE.put(new Integer(Person.STATUS_IN_MEETING),

new Path("images/ST_Awns_InAMtng.png"));
STATUS_ICON_PATH_TABLE.put(new 

Integer(Person.STATUS_IN_MEETING_MOBILE),
new Path("images/ST_Awns_InAMtng.png"));

STATUS_ICON_PATH_TABLE.put(new Integer(Person.STATUS_INVALID),
new Path("images/ST_Awns_Offline.png"));

STATUS_ICON_PATH_TABLE.put(new Integer(Person.STATUS_NOT_USING),
new Path("images/ST_Awns_Offline.png"));

STATUS_ICON_PATH_TABLE.put(new Integer(Person.STATUS_OFFLINE),
new Path("images/ST_Awns_Offline.png"));

STATUS_ICON_PATH_TABLE.put(new Integer(Person.STATUS_ONLINE),
new Path("images/ST_Awns_Active.png"));

STATUS_ICON_PATH_TABLE.put(new Integer(Person.STATUS_OVER_LIMIT),
new Path("images/ST_Awns_Offline.png"));
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STATUS_ICON_PATH_TABLE.put(new Integer(Person.STATUS_UNKNOWN),
new Path("images/ST_Awns_Offline.png"));

STATUS_ICON_PATH_TABLE.put(new Integer(Person.STATUS_AWAY), new 
Path(

"images/ST_Awns_Away.png"));
STATUS_ICON_PATH_TABLE.put(new 

Integer(Person.STATUS_AWAY_MOBILE),
new Path("images/ST_Awns_Away.png"));

};

public Image getImage(final Object element) {

Image icon = null;
final ImageDescriptor id = ImageDescriptor

.createFromURL(getIconUrl(((Person) element).getStatus()));
icon = id.createImage();
setImage(icon);
return icon;

}

public String getText(final Object element) {
return ((Person) element).getDisplayName();

}

public void dispose() {
super.dispose();
if (getImage() != null) {

getImage().dispose();
}

}

private URL getIconUrl(final int statusCode) {
URL url = null;
final Integer key = new Integer(statusCode);
if (STATUS_ICON_PATH_TABLE.containsKey(key)) {

url = 
FileLocator.find(MyLearningPlug-in.getDefault().getBundle(),

(Path) STATUS_ICON_PATH_TABLE.get(key), null);
} else {

url = 
FileLocator.find(MyLearningPlug-in.getDefault().getBundle(), new Path(

"images/ST_Awns_Offline.png"), null);
}
return url;

}
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private Image getImage() {
return image;

}

private void setImage(Image image) {
this.image = image;

}
}

This label provider is much like others we have examined in the chapter. The 
provider handles both text and images. Text for display is extracted from the 
Person element with the getDisplayName method. Images are selected 
according to the value of the getStatus method.

9. Create the PersonHelper class and add the code to the class shown in 
Example 10-76.

Example 10-76   PersonHelper class

package com.ibm.wplc.education.mylearning.ui;

/*
 * Methods that use the Sametime Community, Person, and LiveNames APIs
 */

import java.util.Iterator;

import org.eclipse.core.runtime.IStatus;
import org.eclipse.core.runtime.Status;
import org.eclipse.jface.viewers.ISelectionProvider;
import org.eclipse.swt.widgets.Control;

import com.ibm.collaboration.realtime.im.community.Community;
import com.ibm.collaboration.realtime.im.community.CommunityService;
import com.ibm.collaboration.realtime.people.PeopleService;
import com.ibm.collaboration.realtime.people.Person;
import com.ibm.collaboration.realtime.servicehub.ServiceException;
import com.ibm.collaboration.realtime.servicehub.ServiceHub;
import com.ibm.rcp.realtime.livenames.LiveNameContextMenu;
import com.ibm.rcp.realtime.livenames.LiveNameService;
import com.ibm.wplc.education.mylearning.model.Contact;
import com.ibm.wplc.education.mylearning.model.ContactList;

public class PersonHelper {
 Chapter 10. Building the education framework plug-in 471



static Community getCommunity() {
Community community = null;
try {

final CommunityService communityMgr = (CommunityService) 
ServiceHub

.getService(CommunityService.SERVICE_TYPE);
community = communityMgr.getDefaultCommunity();

} catch (final ServiceException e) {
StackTraceElement[] st = e.getStackTrace();
String className = st[0].getClassName();
final String message = "ServiceException detected in 

getCommunity() in class "
+ className;

final Status status = new Status(IStatus.ERROR, 
MyLearningPlug-in

.getDefault().getBundle().getSymbolicName(), 
IStatus.ERROR,

message, e);
MyLearningPlug-in.getDefault().getLog().log(status);

}
return community;

}

static void getContextMenu(final Control control,
final ISelectionProvider provider) {

try {
final LiveNameService svc = (LiveNameService) ServiceHub

.getService(LiveNameService.SERVICE_TYPE);
final LiveNameContextMenu liveNamesMenu = svc

.createLiveNameContextMenu();
liveNamesMenu.registerContextMenu(control, provider,

MyLearningMiniApp.getInstance().getSite());
} catch (final Exception e) {

StackTraceElement[] st = e.getStackTrace();
String className = st[0].getClassName();
final String message = "ServiceException detected in 

getContextMenu() in class "
+ className;

final Status status = new Status(IStatus.ERROR, 
MyLearningPlug-in

.getDefault().getBundle().getSymbolicName(), 
IStatus.ERROR,

message, e);
MyLearningPlug-in.getDefault().getLog().log(status);

}

472 Extending Sametime 7.5: Building Plug-ins for Sametime



}

static PeopleList getDisplayPeople(final IAssist topic) {
final PeopleList pList = new PeopleList();
final ContactList idList = topic.getTopic().getContactList();
final Iterator iterator = idList.iterator();
while (iterator.hasNext()) {

final Person p = getPerson(((Contact) 
iterator.next()).getEmail());

pList.add(p);
}
return pList;

}

private static PeopleService getPeopleService() {
PeopleService peopleService = null;
try {

peopleService = (PeopleService) ServiceHub
.getService(PeopleService.SERVICE_TYPE);

} catch (final ServiceException e) {
StackTraceElement[] st = e.getStackTrace();
String className = st[0].getClassName();
final String message = "ServiceException detected in 

getPeopleService() in class " + className; //$NON-NLS-1$
final Status status = (new Status(IStatus.ERROR, 

MyLearningPlug-in
.getDefault().getBundle().getSymbolicName(), 

IStatus.ERROR,
message, e));

MyLearningPlug-in.getDefault().getLog().log(status);
}
return peopleService;

}

private static Person getPerson(final String id) {
Person p = null;
final Community community = getCommunity();
if (null != community) {

p = getPeopleService().getPerson(id, community.getId());
}
return p;

}

}
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This class is a collection of static utility methods primarily dealing with 
Sametime services. The primary purposes of this class are to hide the details 
of Sametime services from the referencing classes, such as AssistComposite, 
and to consolidate all Sametime specific classes in one location. The class 
has three default-access static methods:

– getCommunity returns the Sametime community service and is used by 
AssistComposite.

– getContextMenu returns the Sametime context menu for a given Control 
and ISelectionProvider and is used by AssistComposite. 

– getDisplayPeople returns a PeopleList for a given IAssist and is used by 
AssistAction.

10.Complete the run method of the AssistAction class, as shown in 
Example 10-77.

Example 10-77   AssistAction class

package com.ibm.wplc.education.mylearning.ui;

import org.eclipse.jface.action.Action;
import org.eclipse.jface.viewers.IStructuredSelection;
import org.eclipse.jface.viewers.TreeViewer;

/*
 * Action to display list of help providers for a topic
 */

public class AssistAction extends Action {

private TreeViewer taskTreeViewer;

AssistAction(final TreeViewer taskTreeViewer) {
this.taskTreeViewer = taskTreeViewer;
setEnabled(true);
setText("Assistance"); 

}

public void run() { 

Note: Several methods throw the ServiceException exception. The Status 
class serves as a container for error and exception details. Messages 
constructed with status are then written to the plug-in's log.
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final IStructuredSelection selection = (IStructuredSelection) 
taskTreeViewer

.getSelection();
if (!selection.isEmpty()) {

final IAssist assist = (IAssist) selection.getFirstElement();
final AssistWindow window = new AssistWindow(assist,

PersonHelper.getDisplayPeople(assist));
window.open();

}
}

}

The run method obtains the selected IAssist element and creates a new 
instance of the AssistWindow class. The first parameter of the 
DescriptionWindow constructor is the selected element and the second 
parameter is the PeopleList for the selected element obtained by method 
PersonGelp.getDisplayPeople. After the new instance of AssistWindow is 
created, it is opened.
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Open action
The Open action displays the content identified by the url attribute of a selected 
resource.

The output is presented in a two tabbed display, as shown in Figure 10-16. The 
first tab, labeled Browser, displays the actual content. The second tab, labeled 
Assistance, displays the same information as the Assistance action for the 
resource. 

Figure 10-16   Learning content display

To complete the Open action, use the following procedure:

1. Create the DisplayWindow class and add the code for the class shown in 
Example 10-78 on page 477.
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Example 10-78   DisplayWindow class

/**
 * 
 */
package com.ibm.wplc.education.mylearning.ui;

import org.eclipse.jface.window.Window;
import org.eclipse.swt.SWT;
import org.eclipse.swt.custom.CTabFolder;
import org.eclipse.swt.custom.CTabItem;
import org.eclipse.swt.graphics.Color;
import org.eclipse.swt.graphics.RGB;
import org.eclipse.swt.layout.FillLayout;
import org.eclipse.swt.widgets.Composite;
import org.eclipse.swt.widgets.Control;
import org.eclipse.swt.widgets.Shell;

import com.ibm.wplc.education.mylearning.model.Resource;

final class DisplayWindow extends Window {

private final static int HEIGHT = 600;

private final static int WIDTH = 600;

private String url, label, course, topic;

private PeopleList people;

DisplayWindow(final Resource resource,
final PeopleList people) {

super((Shell) null);
setUrl(resource.getUrl());
setLabel(resource.getLabel());
setPeople(people);
setCourse(resource.getTopic().getCourseDescriptor().getLabel());
setTopic(resource.getTopic().getLabel());

}

public Control createContents(final Composite parent) {

final Shell shell = parent.getShell();
shell.setLayout(new FillLayout());
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shell.setText(getLabel());
shell.setSize(WIDTH, HEIGHT);

final Composite comp = new Composite(parent, SWT.NONE);
comp.setLayout(new FillLayout());

// Set background to Lotus Yellow
comp.setBackgroundMode(SWT.INHERIT_DEFAULT);

    Color bgColor = new Color(comp.getDisplay(), new RGB(255, 204, 
0));

    comp.setBackground(bgColor);
    bgColor.dispose();

// Setup tab folders (with curved tabs)
final CTabFolder tabFolder = new CTabFolder(comp, SWT.NONE);
tabFolder.setSimple(false);

// Setup browser tab
final CTabItem browserTab = new CTabItem(tabFolder, SWT.BORDER);
browserTab.setText("Browser"); //$NON-NLS-1$
final Composite browserComp = new Composite(tabFolder, SWT.NONE);
browserComp.setLayout(new FillLayout());

// Browser Form
new BrowserComposite(browserComp, SWT.NONE, getUrl());
browserTab.setControl(browserComp);

// Assistance tab
final CTabItem collabTab = new CTabItem(tabFolder, SWT.BORDER);
collabTab.setText("Assistance"); //$NON-NLS-1$
final Composite collabComp = new Composite(tabFolder, 

SWT.BORDER);
collabComp.setLayout(new FillLayout());

// Assistance form
new AssistComposite(collabComp, SWT.NONE, getPeople(), 

getCourse(), getTopic());
collabTab.setControl(collabComp);

return comp;
}

private String getCourse() {
return course;

}
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private void setCourse(String course) {
this.course = course;

}

private String getLabel() {
return label;

}

private void setLabel(String label) {
this.label = label;

}

private PeopleList getPeople() {
return people;

}

private void setPeople(PeopleList people) {
this.people = people;

}

private String getTopic() {
return topic;

}

private void setTopic(String topic) {
this.topic = topic;

}

private String getUrl() {
return url;

}

private void setUrl(String url) {
this.url = url;

}
}

The first parameter of the class constructor is the selected resource element, 
and the second parameter is PeopleList from the parent topic of the selected 
element.

In the createControl method, a CTabFolder instance is created to form a 
composite tabFolder; this is the instance that creates the tabbed folder 
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metaphor. Specifying false to the setSimple method for the tab folder results 
in a set of curved tabs being displayed. 

The first tab is created by creating a new instance CTabItem associated with 
tabFolder and the tab's text (Browser) is specified through the setText 
method. 

A new child composite, called browserComp, is created from tabFolder. A new 
instance of the BrowserComposite is then created that uses browserComp as 
its parent composite. The setControl method of browserTab specifies that 
browserComp is to be the composite displayed in the interface when the 
Browser tab is selected. 

A similar process is used to create the second tab (Assistance), which uses 
the AssistComposite, as detailed in the previous paragraph.

2. Create the BrowserComposite class and add the code for the class, as shown 
in Example 10-79.

Example 10-79   BrowserComposite class

package com.ibm.wplc.education.mylearning.ui;

import java.net.MalformedURLException;
import java.net.URL;

import org.eclipse.swt.SWT;
import org.eclipse.swt.browser.Browser;
import org.eclipse.swt.graphics.Color;
import org.eclipse.swt.graphics.RGB;
import org.eclipse.swt.layout.FormAttachment;
import org.eclipse.swt.layout.FormData;
import org.eclipse.swt.layout.FormLayout;
import org.eclipse.swt.widgets.Composite;

final class BrowserComposite extends Composite {

private String url;

BrowserComposite(final Composite comp, final int style, final String 
url) {

super(comp, style);
setUrl(url);
createLayout();

}

private void createLayout() {
this.setLayout(new FormLayout());
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this.setBackgroundMode(SWT.INHERIT_DEFAULT);
final Color bgColor = new Color(this.getDisplay(), new RGB(255, 

204, 0));
this.setBackground(bgColor);

// Setup Browser
final Browser browser = new Browser(this, SWT.NONE);
FormData data = new FormData();
data.top = new FormAttachment(0, 5);
data.left = new FormAttachment(0, 5);
data.bottom = new FormAttachment(100, -5);
data.right = new FormAttachment(100, -5);
browser.setLayoutData(data);

try {
new URL(getUrl());
browser.setUrl(getUrl());

} catch (final MalformedURLException e) {
// Assume URL is really HTML text
browser.setText(getUrl());

}

}

private String getUrl() {
return url;

}

private void setUrl(final String url) {
this.url = url;

}

}

The class constructor takes the following arguments:

– The parent composite

– The composite style flag (SWT.NONE)

– The URL of the content

The constructor sets instance variables from the constructor arguments and 
calls a private method, createLayout, which contains the definitions of the 
user interface.

The createLayout method sets up a background color, then creates a new 
instance of a Browser composite. The URL is passed as a constructor 
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argument to a new URL class instance to test if it is properly formed. If a 
MalformedURLException is thrown, it is assumed that the URL is actually an 
HTML String and the browser's setText method is used to display the HTML. 
In Chapter 11, “Refining and implementing the education framework plug-in 
for Sametime Connect” on page 485, we will see how an HTML string can be 
used to display an error message in the browser. If the url is valid, the 
browser's setURL method is called and the content at the url location is 
displayed in the browser.

3. Complete the run method of the DisplayAction class, as shown in 
Example 10-80.

Example 10-80   Run method of the DisplayAction class

public void run() { 
final IStructuredSelection selection = (IStructuredSelection) taskTreeViewer

.getSelection();
if (!selection.isEmpty()) {

final IAssist assist = (IAssist) selection.getFirstElement();
final AssistWindow window = new AssistWindow(assist,

PersonHelper.getDisplayPeople(assist));
window.open();

}
}

The run method obtains the selected IAssist element and creates a new 
instance of the DisplayWindow class. The first parameter of the 
DisplayWindow constructor is the selected element. The second parameter is 
the PeopleList for the selected element, obtained by method 
PersonGelp.getDisplayPeople. After the new instance of AssistWindow is 
created, it is opened.

4. Test the Open action by selecting Open from a resource context menu or 
double-click a resource item. The resulting display should look like 
Figure 10-17 on page 483.
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Figure 10-17   Testing the Open action
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Chapter 11. Refining and implementing 
the education framework 
plug-in for Sametime 
Connect

At this point, we have a working MyLearning plug-in with one notable exception: 
the course catalog. When we started developing the plug-in, we created a 
rudimentary implementation of a course catalog in the Catalog class by 
hand-coding a single-element CourseDescriptorList and the corresponding 
Course. 

The following topics are presented in this chapter:

� Refining the catalog

� Including Content in a Course Plug-in

� Creating a course plug-in

� Additional examples: using the Lotus Education plug-in for for other content 
delivery
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Attention: All sample code used for this example can be downloaded from the 
IBM Redbooks FTP site. Please refer to Appendix A, “Additional material” on 
page 557 for detailed instructions on how to download and deploy the code 
sample: 

ftp://www.redbooks.ibm.com/redbooks/SG247346
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11.1  Refining the catalog

We are now ready to upgrade the Catalog class so that it can build the course 
catalog by searching the plug-in registry for plug-ins that extend the description 
extension of the MyLearning plug-in. 

The data for each entry in the course catalog will be obtained by reading the 
plug-in's identifier and name, which will correspond to a course's identifier and 
label, respectively. When a user requests a course to be displayed in the 
MyLearning plug-in, methods in the Catalog class will read and parse a course 
definition XML file and store the representation of the course (the Course and its 
aggregated classes) in a list so it can be referenced again without parsing the 
definition file again.

In this section, we:

� Examine the course definition XML file and its accompanying DTD. 

� Show how to create the description extension point and examine how the 
Catalog class builds a course catalog by searching for plug-ins that use the 
description extension. 

� Examine how the Catalog class parses the XML file and builds the internal 
representation of a course. 

� Take a brief look at the SAX parser used to parse the course definition XML 
and several associated helper classes.

11.1.1  Course definition XML

From the class diagram (Figure 9-1 on page 393), we can derive a DTD that can 
be used to validate the course definition XML. The DTD is shown in 
Example 11-1.

Example 11-1   DTD

<!DOCTYPE course [
<!ELEMENT course (categories, topics)>
<!ELEMENT categories (category+)>
<!ELEMENT category EMPTY>
<!ELEMENT topics (topic+)>
<!ELEMENT topic (tag+,contact*,resource+)>
<!ELEMENT tag EMPTY>
<!ELEMENT contact EMPTY>
<!ELEMENT resource EMPTY>
<!ATTLIST categories

  default  REF #REQUIRED>
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<!ATTLIST category
  id ID #REQUIRED
  label CDATA #REQUIRED>

<!ATTLIST topic
  id ID #REQUIRED
  label CDATA #REQUIRED
  description CDATA #REQUIRED>

<!ATTLIST tag
  key IDREF #REQUIRED>

<!ATTLIST contact
  email-id CDATA #REQUIRED>

<!ATTLIST resource
  id ID #REQUIRED
  label CDATA #REQUIRED
  description CDATA #REQUIRED
  url  CDATA #REQUIRED
  type CDATA #IMPLIED
  level CDATA #IMPLIED
  author CDATA #IMPLIED>  

]>

By applying the rules of the DTD to the Course structure that we created earlier 
in the setup method of the Catalog class, the course definition XML file is 
produced, as shown in Example 11-2.

Example 11-2   Course definition XML

<course>
<categories default="AllTopics">

<category id="AllTopics label="All Topics"/>
<category id="TopicA" label="Topic A"/>
<category id="TopicB" label="Topic B"/>

<categories>
<topics>

<topic id="TA" label="Topic A"
description="Topic A">
<tag key="AllTopics"/>
<tag key="TopicA"/>
<contact email="contactA@a.com"/>
<resource id="RA1" label="Resource A1"

   description="Resource A1"
   level="Basic" type="Reference"

           author="Author"
   url="file:///C|/testhtml/RA1.html"/>

<resource id="RA2" label="Resource A"
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   description="Resource A2"
   level="Basic" type="Reference"

           author="Author"
   url="file:///C|/testhtml/RA2.html"/>

</topic>
<topic id="TB" label="Topic B"

description="Topic B">
<tag key="AllTopics"/>
<tag key="TopicB"/>
<contact email="contactB@b.com"/>
<resource id="RB1" label="Resource B1"

   description="Resource B1"
   level="Basic" type="Reference"

           author="Author"
   url="file:///C|/testhtml/RB1.html"/>

<resource id="RB2" label="Resource B"
   description="Resource B2"
   level="Basic" type="Reference"

           author="Author"
   url="file:///C|/testhtml/RB2.html"/>

</topic>
</topics>

</course>

11.1.2  Creating the Description Extension Point

The XML schema that describes the extension point can now be generated. The 
schema should be implemented so that:

� The id attribute of the extension element is required. This attribute represents 
the course ID.

� The name attribute of the extension element is required. This attribute will 
represents the course label.

� A new element named description is added.

� The description element has an attribute named file that is required. This 
attribute represents the name of the course definition XML file.

� The description element has an attribute name validate that is required. This 
attribute is a flag that indicates if DTD validation should be performed during 
parsing of the XML course description file.

� The description element is sequenced after the extension element.

� All the attributes are of type string.
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Create the description extension point
To create the description extension point for the MyLearning plug-in, use the 
following procedure:

1. Double-click the plug-in.xml icon for the MyLearning plug-in.

2. Click the Extension Points tab.

3. Click the Add button.

4. In the Extension Point Properties dialog box:

a. In the Extension Point ID field, enter description.

b. In the Extension Point Name field, enter Course Description.

The Extension Point Schema field is automatically generated from the value 
entered in the Extension Point ID field. See Figure 11-1.

Figure 11-1   Extension Point Properties dialog

5. Click Finish.

6. The Course Description forms appears. Click the Definition tab.

7. Click the plus sign icon to the left of the extension icon to see the attributes of 
the element, as shown in Figure 11-2 on page 491.
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Figure 11-2   Extension Point Elements

8. Click the id attribute. 

The Attribute Details form appears to the right of element tree, as shown in 
Figure 11-3.

9. In the Use field, select required.

Figure 11-3   id Attribute Details

10.Click the name icon in the element tree.

11.In the Attribute Detail form, select required for the Use field. 

12.Click the New Element button. 
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The Element Details form appears to the right of the element tree.

13.In the Element Details form, in the Name field enter description, and then 
press Enter. The form should look like Figure 11-4.

Figure 11-4   Element Details form

14.Click the New Attribute button. 

The Attribute Details form appears to the right of the element tree.

15.In the Attribute Details form,

a. In the Name field, enter file 

b. In the Use field, select required.

16.Click the New Attribute button again.

17.In the Attribute Details form, 

a. In the Name field, enter validate 

b. In the Use field, select required.

18.Right-click the extension icon in the element tree and select New → 
Compositor → sequence.

19.Right-click the Sequence icon and select New → Reference → description 
from the context menu.

20.The Course Description page should look like Figure 11-5 on page 493.
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Figure 11-5   Course Description

21.Save the descripton.xsd schema file.

11.1.3  Creating the course catalog 

In this section, we will replace the setup and list methods of the first 
implementation of the Catalog class, by using the following procedure:

1. Create the CourseExtension class in the 
com.wplc.education.mylearning.catalog package. All of the classes that are 
created or modified in this section are members of this catalog package. Add 
the code shown in Example 11-3.

Example 11-3   CourseExtension class

package com.ibm.wplc.education.mylearning.catalog;

import com.ibm.wplc.education.mylearning.model.Course;

/* Describes a course and the related plug-in 
 * configuration elements for a description extension of the 
 * HowDoI plug-in. Also stores status regarding parsing of the 
 * courses XML configration file in parsed  and valid fields.
 */

public class CourseExtension extends Course {
private String namespace;

private boolean validate;
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private String xmlFile;

private boolean parsed;

public boolean isParsed() {
return parsed;

}

public void setParsed(boolean parsed) {
this.parsed = parsed;

}

public String getXmlFile() {
return xmlFile;

}

public void setXmlFile(String xmlFile) {
this.xmlFile = xmlFile;

}

public String getNamespace() {
return namespace;

}

public void setNamespace(String namespace) {
this.namespace = namespace;

}

public boolean isValidate() {
return validate;

}

public void setValidate(boolean validate) {
this.validate = validate;

}

}

As its name implies the CourseExtension class extends the Course class. 
CourseExtension is used to store the representation of Course derived from 
parsing the course definition XML. Additional instance variables in this class 
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are used primarily to store information related to the course plug-in and the 
parsing process. 

2. Create the CourseExtensionList class and add the code shown in 
Example 11-4.

Example 11-4   CourseExtensionList class

package com.ibm.wplc.education.mylearning.catalog;

import java.util.ArrayList;
import java.util.Iterator;
/*
 * A type-dependent array list for CourseExtensions
 */

public class CourseExtensionList {

private ArrayList list = new ArrayList();

public void add(CourseExtension CourseExtension) {
list.add(CourseExtension);

}
public CourseExtension get(int index) {

return (CourseExtension) list.get(index);
}

public int size() {
return list.size();

}

public CourseExtension[] toArray(CourseExtension[] array) {
return (CourseExtension[]) list.toArray(array);

}

public void clear() {
list.clear();

}

public Iterator iterator() {
return list.iterator();

}

public void remove(int index) {
 list.remove(index);

}
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public String toString() {
StringBuffer sb = new StringBuffer("[");
sb.append(this.getClass().getName());
sb.append(" size = ");
sb.append(size());
sb.append("]");
return sb.toString();

}
}

This class is a type-aware list class for the CourseExtension class and is 
similar to may other classes of this type that we have already examined in this 
chapter.

3. Replace the setup method in the Catalog class with the code shown in 
Example 11-5.

Example 11-5   New constructor and setup method for Catalog class

private static final String EXTENSION_POINT_ID = "description";

private final CourseExtensionList list = new CourseExtensionList();

public Catalog() {
setup();

}

private void setup() {
/*
 * Read plug-in extension information to setup class extension 

descriptor
 * list
 */
final IExtensionRegistry registry = Platform.getExtensionRegistry();
final IExtensionPoint extensionPoint = registry.getExtensionPoint(

MyLearningPlug-in.PLUG-IN_ID, EXTENSION_POINT_ID);
final IExtension[] e = extensionPoint.getExtensions();
for (int i = 0; i < e.length; i++) {

final CourseExtension cx = new CourseExtension();
cx.setNamespace(e[i].getContributor().getName());
// Course id and label
cx.setCourseDescriptor(new CourseDescriptor(e[i]

.getSimpleIdentifier(), e[i].getLabel()));
// Only one config element defined for extension
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final IConfigurationElement config = e[i]
.getConfigurationElements()[0];

// Path to XML config file for course
cx.setXmlFile(config.getAttribute(FILE_ATTR));
// Flag to indicate if validating parser should be used
cx.setValidate(isTrue(config.getAttribute(VALIDATE_ATTR)));
list.add(cx);

}
}

Note that setup is the only method called from the class constructor. The 
setup method obtains a reference to the extension registry and locates the 
description extension point for the MyLearning plug-in. The getExtensions 
method returns an array of IExtension, which represents the course plug-ins.

The setup method loops through that array and, for each extension, data 
contained in the extension is copied to a new instance of a CourseExtension 
class. At the end of each loop iteration, the CourseExtension instance is 
added to the CourseExtensionList list instance variable.

Data that is stored from the plug-in into the CourseExtension instance 
include:

– The extension namespace.

– The CourseDescriptor, which is constructed from the extension's identifier 
and name.

– The file path to the course description XML file, as defined in the file 
attribute of the extension definition's description element. 

– The validate flag, as defined in the validate attribute of the extension 
definition's description element.
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4. Replace the list method in the Catalog class with the code shown in 
Example 11-6.

Example 11-6   New list method for Catalog class

public CourseDescriptorList list() {
/*
 * Provide a course descriptor list of all courses (dervied from 

course
 * extension list)
 */
final CourseDescriptorList descriptorList = new 

CourseDescriptorList();
final Iterator it = list.iterator();
while (it.hasNext()) {

descriptorList.add(((Course) it.next()).getCourseDescriptor());
}
if (descriptorList.size() == 0) {

// If there are no courses add a "marker" course descriptor
descriptorList.add(CatalogHelper.getNoCourseDescriptor());

}
return descriptorList;

}

Given that we have already constructed a CourseExtensionList of all the 
available courses in the setup method, the list method only needs to iterate 
through that list to extract each CourseDescriptor, and build a new 
CourseDescriptorList. If no courses are found, a special “marker” course 
descriptor is placed in the list.The marker course is produces by a method in the 
CatalogHelper class, which will be covered in step 4 on page 503. 

11.1.4  Building a course from the XML definition

In this section, we upgrade the findCourse method in the Catalog class to parse 
the course definition XML and build the corresponding Course object that is 
returned by the method.

1. Replace the findCourse method in the Catalog class with the code shown in 
Example 11-7 on page 499.
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Example 11-7   New findCourse method in the Catalog class

public Course findCourse(final CourseDescriptor descriptor) {
/*
 * Find a course based on the course descriptor. The course may 

already
 * have been parsed and stored in a course extension, or the course 

XML
 * config file may need to be parsed to get a course object.
 */
Course course = null;
if (descriptor != null) {

final Iterator it = list.iterator();
while (it.hasNext()) {

final CourseExtension cx = (CourseExtension) it.next();
if (descriptor.equals(cx.getCourseDescriptor())) {

if (cx.isParsed()) {
// The XML config file has already been parsed

course = cx;
} else {

// Parse the XML config file to get the course
course = translateCourseFromXml(cx);

}
break;

}
}

}
// If course not found, return "marker" course
return (course == null) ? CatalogHelper.getNoCourse() : course;

}

Recall that the list variable created by the setup method is a 
CourseExtensionList of all the courses that have been found as extensions to 
the MyLearning plug-in's description extension. After completion of the setup 
method, the CourseExtension elements in the list contain basic information 
about the course and the plug-in, but the representation of the course as an 
instance of the Course class (the supertype of CourseExtension) has not yet 
been built.

To find a course in the list, the findCourse method loops through the list and 
compares the CourseDescriptor passed in the method's input argument to the 
CourseDescriptor associated with the CourseExtension elements contained 
in list. If a match is found, the isParsed method of the matching 
CourseExtension element is checked. If isParsed returns “true,” this means 
the course definition file has already been parsed, and the CourseExtension 
element is assigned to a Course variable and returned. If isParsed returns 
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“false,” the private static method translateCourseFromXML is called and 
passed the CourseExtension element as its argument.

2. Create the translateCourseFromXML method with the code shown in 
Example 11-8.

Example 11-8   translateCourseFromXML method of the Catalog class

private static Course translateCourseFromXml(final CourseExtension cx) 
{

/*
 * Get the course from XML config file. Post parsing processing is
 * required to set the course descriptor from the course extension 

and
 * fix up backward pointers in objects not set by parse handler.
 * Synchronize the derived Course and the CourseExtension object so 

the
 * config file does not need to be re-parsed when it is referenced
 * again.
 */
Course course = null;
cx.setParsed(true);
try {

final InputStream s = getInputStream(cx.getNamespace(), 
cx.getXmlFile());

course = parseCourse(s, cx.isValidate());
try {

s.close();
} catch (final IOException ie) {

final String message = "IOException detected closing parse 
input stream"; 

final Status status = (new Status(IStatus.ERROR, 
MyLearningPlug-in

.getDefault().getBundle().getSymbolicName(),
IStatus.ERROR, message, ie));

MyLearningPlug-in.getDefault().getLog().log(status);
}

} catch (final SAXException se) {
final String message = "SAXException detected parsing course id "

+ cx.getCourseDescriptor().getId() + " (" 
+ cx.getCourseDescriptor().getLabel() + ") "; 

final Status status = (new Status(IStatus.ERROR, 
MyLearningPlug-in

.getDefault().getBundle().getSymbolicName(), IStatus.ERROR,
message, se));

MyLearningPlug-in.getDefault().getLog().log(status);
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} catch (final IOException ie) {
final String message = "IOException detected in parse input 

stream"; 
final Status status = new Status(IStatus.ERROR, 

MyLearningPlug-in.getDefault()
.getBundle().getSymbolicName(), IStatus.ERROR, message, 

ie);
MyLearningPlug-in.getDefault().getLog().log(status);

} catch (final DefinitionException de) {
final String message = "Error detected parsing course with id " 

+ cx.getCourseDescriptor().getId() + " (" 
+ cx.getCourseDescriptor().getLabel() + ")"; 

final Status status = new Status(IStatus.ERROR, 
MyLearningPlug-in.getDefault()

.getBundle().getSymbolicName(), IStatus.ERROR, message, 
de);

MyLearningPlug-in.getDefault().getLog().log(status);
}
// If any errors (course == null) set course to course 
// definition error "marker" course
course = (course == null) ? CatalogHelper

.getCourseDefinitionErrorCourse() : course;
// Course extension has course descriptor from plug-in extension 

data
course.setCourseDescriptor(cx.getCourseDescriptor());
// Set "backward pointers"
course = establishCourseBackwardPointers(course);
// Synchronize the course extension and course
copyCourse(cx, course);
return course;

}

Parsing the XML course definition file
The translateCourseFromXML method starts by setting the isParsed method 
of the CourseExtension argument to true, to indicate that this course has 
been parsed. The XML file's input stream is obtained with the private static 
getInputStream method, using the namespace and XML file path that were 
copied into the CourseExtension during the setup method. 

The private static parseCourse method is used to set up the parser handler 
that will parse course XML file. The validate flag passed to parseCourse is 
supplied by the CourseExtension isValidate method instructs the parser on 
whether or not to perform DTD validation during the parsing process. This is 
another data element that copied to the CourseExtension object from the 
extension configuration data. The parseCourse method throws a 
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DefinitonException if it detects that any parsing errors were encountered by 
the parser handler. If a DefinitionException, SAXException, or IOException 
are detected, Status containers are created with the appropriate error 
messages and exception information and written to the plug-in's log.

If the parseCourse method returns the Course as null, indicating an error, a 
special marker course is created to indicate that there were course definition 
parsing errors. Additional processing is performed on the Course object by 
the private static establishBackwardCoursePointers method. This ensures 
that references from each Resource to its parent Topic, and from each Topic 
to its parent CourseDescriptor, are property established. Finally, the resulting 
Course instance that represents the structure of the course is copied to the 
CourseExtension that is the method's input argument.

3. Create the parseCourse method in the Catalog class using the code in 
Example 11-9.

Example 11-9   ParseCourse method in Catalog class

private static Course parseCourse(final InputStream s,
final boolean validate) throws DefinitionException, IOException,
SAXException {

Course course = null;
// Parse the course definition XML file
if (s != null) {

// See CourseHandler for the SAX parsing details
final CourseHandler handler = new CourseHandler();
final XMLReader reader = XMLReaderFactory.createXMLReader();
reader.setContentHandler(handler);
reader.setErrorHandler(handler);
reader.setFeature(VALIDATING_FEATURE, validate);
reader.parse(new InputSource(s));
if (handler.getErrors() == 0) {

course = handler.getCourse();
} else {

throw new DefinitionException(handler.getErrorMessage());
}

}
return course;

}

This method follows a standard pattern for setting up a SAX parsing handler. 
The actual parsing is being done by the class handler, CourseHandler. At the 
completion of parsing, the method checks if there were any errors by issuing 
the handler's getErrors method. If no errors are detected, the Course object 
generated from parsing the XML definition file is obtained with the handler's 
getCourse method. If there are errors, a DefintionException is created, using 
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the handler getErrorMessage method as the argument to its constructor, and 
a DefintionException is thrown.

4. Create the CatalogHelper class. 

The CatalogHelper class creates special instances of a Course that are used 
to report error conditions associated with the definition of a course. These 
objects are used as an alternative to an error reporting dialog box.

These special courses, used to report error conditions, contain a single topic 
and a single resource, both titled with the nature of the error, either “Course 
Definition Error” or “No Courses Available”. Additional error message details 
are composed as HTML text string and set as the URL attribute of the 
resource so that the error message is displayed in the browser when the 
resource is double-clicked. This class also produces a CourseDescriptor with 
an ID and label that indicate no courses are available to display.

The source for the CatalogHelper class is shown in Example 11-10.

Example 11-10   CatalogHelper class

package com.ibm.wplc.education.mylearning.catalog;
/*
 *  Helper methods for the Catalog class. Return various
 *  instances of Course or CourseDescriptor if there are
 *  no courses available for the plug-in to display or if there
 *  are course definition errors in the XML definition file.
 */

import com.ibm.wplc.education.mylearning.model.Category;
import com.ibm.wplc.education.mylearning.model.CategoryList;
import com.ibm.wplc.education.mylearning.model.ContactList;
import com.ibm.wplc.education.mylearning.model.Course;
import com.ibm.wplc.education.mylearning.model.CourseDescriptor;
import com.ibm.wplc.education.mylearning.model.Resource;
import com.ibm.wplc.education.mylearning.model.ResourceList;
import com.ibm.wplc.education.mylearning.model.Tag;
import com.ibm.wplc.education.mylearning.model.TagList;
import com.ibm.wplc.education.mylearning.model.Topic;
import com.ibm.wplc.education.mylearning.model.TopicList;

public class CatalogHelper {

private static final String NO_COURSES_ID = "NoCoursesAvailable";

private static final String COURSE_DEFINITION_ERROR_ID = 
"CourseDefinitionError"; 
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private static Course noCourse;

private static Course courseDefinitionErrorCourse;

private CatalogHelper() {
}

static Course getNoCourse() {
if (noCourse == null) {

StringBuffer sb = new StringBuffer("<html>"); //$NON-NLS-1$
sb.append("<h1>No Courses Available</h1>"); 
sb.append("<p>No plug-ins were found for the 'description' 

extension point of the com.wplc.education.mylearning plug-in.</p>"); 
sb.append("</html>"); //$NON-NLS-1$
noCourse = getMinimalCourse(NO_COURSES_ID, "No Courses 

Available",
sb.toString());

}
return noCourse;

}

static CourseDescriptor getNoCourseDescriptor() {
return new CourseDescriptor(NO_COURSES_ID, "No Courses 

Available"); 
}

 static Course getCourseDefinitionErrorCourse() {
if (courseDefinitionErrorCourse == null) {

StringBuffer sb = new StringBuffer("<html>"); 
sb.append("<h1>Course Definition Error</h1>"); 
sb.append("<p>An error was encountered parsing the course 

definition file. Check the log for details.</p>"); 
sb.append("<p>The log is located on Windows at C:\\Documents 

and Settings\\[user]\\Application Data\\Sametime\\.metadata\\.log"); 
sb.append("</html>"); 
courseDefinitionErrorCourse = 

getMinimalCourse(COURSE_DEFINITION_ERROR_ID,
"Course Definition Error", sb.toString()); 

}
return courseDefinitionErrorCourse;

}

private static Course getMinimalCourse(String id, String label,
String htmlMessage) {

Tag tag = new Tag(id);
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TagList tagList = new TagList();
tagList.add(tag);
ContactList contactList = new ContactList();
Resource resource = new Resource(id, label);
resource.setDescription(label);
resource.setLevel("Basic"); 
resource.setType("Reference"); 
resource.setUrl(htmlMessage);
ResourceList resourceList = new ResourceList();
resourceList.add(resource);
Topic topic = new Topic(id, label);
topic.setDescription(label);
topic.setTagList(tagList);
topic.setResourceList(resourceList);
topic.setContactList(contactList);
TopicList topicList = new TopicList();
topicList.add(topic);
Category category = new Category(id, label);
CategoryList categoryList = new CategoryList();
categoryList.add(category);
CourseDescriptor courseDescriptor = new CourseDescriptor(id, 

label);
Course course = new Course();
course.setCourseDescriptor(courseDescriptor);
course.setCategoryList(categoryList);
course.setDefaultCategory(category);
course.setTopicList(topicList);
return course;

}

}

11.1.5  SAX parser and helper classes

The course definition XML is parsed with a SAX parser handler implemented in 
the CourseHandler class. CourseHandler extends the SAX helper 
DefaultHandler class and overrides two of its methods, startElement and 
endElement. 

The SAX parser process is event-driven in nature. As the XML stream is parsed, 
the startElement method is executed as the start of an element is encountered. 
In a similar fashion, the endElement method is processed when the end of an 
element is processed. In either case, the startElement or endElement method 
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examines the name of the element and then calls another handler method to 
process a particular element. 

Typical processing in an element-specific handler method is to create new 
instances of classes associated with the element to be processed and to set the 
instance variable of these classes with the element attributes, which are passed 
to the element-specific handlers.

The startElement method is shown in Example 11-11.

Example 11-11   startElement method in CourseHandler class

public void startElement(final String uri, final String localName,
final String qName, final Attributes attrs) throws SAXException {
if (TOPIC.equals(qName)) {

handleTopicElement(attrs);
} else if (TOPICS.equals(qName)) {

handleTopicsElement(attrs);
} else if (RESOURCE.equals(qName)) {

handleResourceElement(attrs);
} else if (TAG.equals(qName)) {

handleTagElement(attrs);
} else if (CONTACT.equals(qName)) {

handleContactElement(attrs);
} else if (CATEGORIES.equals(qName)) {

handleCategoriesElement(attrs);
} else if (CATEGORY.equals(qName)) {

handleCategoryElement(attrs);
}

}

Example 11-12 shows a typical element-specific method, handleTopicElement, 
that is called from startElement.

Example 11-12   handleTopicElement method of CourseHandler class

private void handleTopicElement(final Attributes attrs) {
setTopic(new Topic());
setResourceList(new ResourceList());
setContactList(new ContactList());
setTagList(new TagList());
getTopic().setId(attrs.getValue(ID));
getTopic().setLabel(attrs.getValue(LABEL));
getTopic().setDescription(attrs.getValue(DESCRIPTION));

}
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Example 11-13 shows the endElement method.

Example 11-13   endElement method of CourseHandler class

public void endElement(final String uri, final String localName,
final String qName) throws SAXException {

if (TOPIC.equals(qName)) {
handleEndTopicElement();

} else if (CATEGORIES.equals(qName)) {
handleEndCategoriesElement();

} else if (COURSE.equals(qName)) {
handleEndCourseElement();

}
}

Example 11-14 shows a typical element-specific method, 
handleEndTopicElement, that is called from endElement.

Example 11-14   handeEndTopicElement method of CourseHander class

private void handleEndTopicElement() {
getTopic().setContactList(getContactList());
getTopic().setTagList(getTagList());
getTopic().setResourceList(getResourceList());
getTopicList().add(getTopic());

}

The CourseHandlerErrorHelper is a class that provides a method to format error 
messages that may be found during the parsing of the XML definition.

The source list for CourseHandlerErrorHelper is presented in Example 11-15.

Example 11-15   CourseHandlerErrorHelper class

package com.ibm.wplc.education.mylearning.catalog;

import java.util.Iterator;

import org.xml.sax.SAXParseException;

/*
 * Helper class to process error messages for CourseHandler 
 * SAX parser handler class.
 */

public class CourseHandlerErrorHelper {
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CourseHandlerErrorHelper() {
}

private static String formatExceptionMessage(Exception e) {
String s = null;
if (e instanceof SAXParseException) {

s = "Error at line " + ((SAXParseException) e).getLineNumber() 
+ " column " + ((SAXParseException) e).getColumnNumber() 
+ " " + e.getMessage();

} else {
s = e.getMessage();

}
return s;

}

private static StringBuffer formatErrorReportSection(final 
ExceptionList list,

final String header) {
final StringBuffer sb = new StringBuffer(header);
sb.append(": "); 
sb.append(list.size());
sb.append(" "); 
final Iterator i = list.iterator();
while (i.hasNext()) {

sb.append(" "); 
sb.append(formatExceptionMessage((Exception) i.next()));
sb.append(" "); 

}
return sb;

}

static String getErrorMessage(ExceptionList errorList, ExceptionList 
warningList,

ExceptionList fatalList) {
final StringBuffer sb = new StringBuffer("Parsing error report"); 
sb.append(" "); 
sb.append(formatErrorReportSection(errorList, "Errors:")); 
sb.append(formatErrorReportSection(warningList,"Warnings:")); 
sb.append(formatErrorReportSection(fatalList, "Fatal:")); 
return sb.toString();

}

public String toString() {
StringBuffer sb = new StringBuffer("["); 
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sb.append(this.getClass().getName());
sb.append("']"); //$NON-NLS-1$
return sb.toString();

}

}

A DefinitionException is thrown by the parseCourse method in Catalog if errors 
are encountered. The source for this exception, shown in Example 11-16, follows 
standard Java practice for defining exception extensions.

Example 11-16   DefinitionException class

package com.ibm.wplc.education.mylearning.catalog;

/*
 * Exception for storing errors regarding SAX parsing of 
 * the course definition XML file.
 */

public class DefinitionException extends Exception {

private static final long serialVersionUID = 45612389011L;

public DefinitionException(String message ) {
super(message);

}

public DefinitionException(String message, Exception exception) {
super(message, exception);

}

}
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A class that implements Exception type-aware ArrayList processing is also used 
by the parsing classes and its source, as shown in Example 11-17.

Example 11-17   ExceptionList class

package com.ibm.wplc.education.mylearning.catalog;

import java.util.ArrayList;
import java.util.Iterator;

public final class ExceptionList {
private ArrayList list = new ArrayList();

public void add(Exception Exception) {
list.add(Exception);

}
public Exception get(int index) {

return (Exception) list.get(index);
}

public int size() {
return list.size();

}

public Exception[] toArray(Exception[] array) {
return (Exception[]) list.toArray(array);

}

public void clear() {
list.clear();

}
public Iterator iterator() {

return list.iterator();
}

}

11.2  Including Content in a Course Plug-in

The MyLearning Plug-in has the capability to access content that is stored in a 
course plug-in. In order for a course to contain content, it must implement the 
content extension point of the MyLearning plug-in. The content is referenced 
through a special URL. The URL has the format shown in Example 11-18.
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Example 11-18   Pattern for referencing plug-in resident content

http://com.ibm.wplc.education.mylearning/[id]/[path] 

In Example 11-18, id is the value of the id attribute of the extension element for 
the content extension of a plug-in. Path is the path name of the file relative to the 
plug-in root. 

For example, if the HTML file RA1.html were imported into the project folder of a 
plug-in identified by an id of demo in its content extension definition, then the 
URL would be as shown in Example 11-19.

Example 11-19   Reference to plug-in-resident content

http://com.ibm.wplc.education.mylearning/demo/RA1.html

Code in the BrowerComposite class recognizes this special URL pattern and 
maps it into a URL with a file:// device using classes available in the Eclipse 
Workbench.

In this section, we outline the specification for the content extension point 
schema and examine the code in the BrowserComposite class that analyzes and 
maps the URL for content stored in a course plug-in.

11.2.1  Creating the content extension point 

The XML schema for the extension point can now be defined. The requirements 
of the schema are:

� The id attribute of the extension point is required and of type string.

� The name attribute of the extension point is required.

Create the content extension point
To define the extension point, use the following procedure:

1. Double-click the plug-in.xml icon for the MyLearning plug-in.

2. Click the Extension Points tab.

3. Click the Add button.

4. In the Extension Point Properties dialog box: 

a. In the Extension Point ID field, enter content.

b. In the Extension Point Name field, enter Resource Content. 

c. The Extension Point Schema field is automatically generated from the 
value entered in the Extension Point ID field.
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5. Click Finish.

The Course Description forms appears. 

6. Click the Definition tab.

7. Click the plus sign icon to the left of the extension icon to see the attributes of 
the element, as shown in Figure 11-6.

Figure 11-6   Extension Point Elements

8. Click the id attribute. 

The Attribute Details form appears to the right of the element tree.

9. In the Attribute Detail form, in the Use field, select required, as shown in 
Figure 11-7 on page 513.
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Figure 11-7   Extension Point Elements: Attribute Details

10.Click the name icon in the element tree.

11.In the Attribute Detail form, in the Use field, select required. 

12.Save the context.xsd schema file.

11.2.2  Enhancing the BrowserComposite class

Use the following procedure to modify the BrowserComposite class to accept 
URL for content stored in course plug-ins:

1. Find and select the code in the createLayout method shown in 
Example 11-20. 

Example 11-20   URL parsing in BrowserComposite class

try {
new URL(getUrl());
browser.setUrl(getUrl());

     } catch (final MalformedURLException e) {
// Assume URL is really HTML text
browser.setText(getUrl());

     }
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2. Replace the selected code with the code shown in Example 11-21.

Example 11-21   New URL parsing in BrowserComposite class

private static final String EXTENSION_POINT_ID = "content"; 

private static final String PLUG-IN_HOST = 
"com.ibm.wplc.education.mylearning"; 

private static final String FILE_SEPARATOR = "/";

try {
final URL u = new URL(getUrl());
if (PLUG-IN_HOST.equals(u.getHost())) {

final URL url = getResolvedUrl(u.getFile());
if (u == null) {

browser.setText("<htm><h1><p>Null URL 
returned</p></h1></html>");

} else {
browser.setUrl(url.toString());

}
} else {

browser.setUrl(getUrl());
}

     } catch (final MalformedURLException e) {
// Assume URL is really HTML text
browser.setText(getUrl());

     }

The revised code coverts the String URL passed in the constructor to a 
type of URL and then extracts the host portion of the name. If the host 
portion of the name matches the special host name defined in 
PLUG-IN_HOST, then the file portion of the URL is passed as an 
argument to the getResolvedURL method, which returns the URL resolved 
to a file:// device URL. The resolved URL is then displayed in the browser 
with the setURL method.

If the resolved URL is null, an HTML String error message is displayed in 
the browser with the setText method.

The getResolvedURL method, shown in Example 11-22 on page 515, 
parses the file portion of the URL to determine the path of the content 
relative to the plug-in root.
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Example 11-22   getResolvedURL method

private static URL getResolvedUrl(final String filename) {
URL u = null;
String plug-inId = null;
StringBuffer file = null;
final StringTokenizer st = new StringTokenizer(filename, 

FILE_SEPARATOR);
if (st.hasMoreTokens()) {

plug-inId = st.nextToken();
file = new StringBuffer();
while (st.hasMoreTokens()) {

file.append(st.nextToken());
file.append(FILE_SEPARATOR);

}
if (file.length() > 1) {

file.deleteCharAt(file.length() - 1);
u = resolveURLFromFile(getNameSpace(plug-inId), 

file.toString());
}

}
return u;

}

The method resolveURLFromFile, shown in Example 11-23, determines 
the resolved URL. It uses the name space of the plug-in and the path of 
the content relative to the plug-in root, by using static methods from both 
the Plug-in and FileLocator classes. Essentially, this method finds the 
location of the content in the file system and returns a URL with a file:// 
device reflecting that location.

Example 11-23   resolveURLFromFile method

private static URL resolveURLFromFile(final String namespace,
final String filename) {

URL u = null;
if (namespace != null) {

final Bundle bundle = Platform.getBundle(namespace);
final IPath path = new Path(filename);
try {

final URL bundleUrl = FileLocator.find(bundle, path, null);
u = FileLocator.resolve(bundleUrl);

} catch (final IOException e) {
// s == null used to indicate error
// log
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final String message = "Unable to get input stream for"+ " '" 
+ filename + "'"; 

final Status status = new Status(IStatus.ERROR, 
MyLearningPlug-in

.getDefault().getBundle().getSymbolicName(),
IStatus.ERROR, message, e);

MyLearningPlug-in.getDefault().getLog().log(status);
}

}
return u;

}

The getNamespace method, shown in Example 11-24, returns the 
namespace of the plug-in whose id was contained in the original URL. This 
method uses code very similar to the code in the setup method of the Catalog 
class to locate the configuration information for the plug-in with the specified 
id that extends the content extension point.

Example 11-24   getNamespace method in Browser

private static String getNameSpace(final String plug-inId) {
String s = null;
final IExtensionRegistry registry = Platform.getExtensionRegistry();
final IExtensionPoint extensionPoint = registry.getExtensionPoint(

MyLearningPlug-in.PLUG-IN_ID, EXTENSION_POINT_ID);
final IExtension[] e = extensionPoint.getExtensions();
if (e != null) {

for (int i = 0; i < e.length; i++) {
if (plug-inId.equals(e[i].getSimpleIdentifier())) {

s = e[i].getContributor().getName();
break;

}
}

}
return s;

}

The listing for the new version of the BrowserComposite is included in the 
downloadable code available from the FTP site for the IBM Redbook.

At this point, the plug-in is complete. You can now start to create and include 
content.
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11.3  Creating a course plug-in

Now that the MyLearning plug-in is complete, we can start adding courses and 
content in course plug-ins. We will create an Eclipse plug-in project, configure the 
plug-in to use the content and description extension, create the course definition 
XML file, and add some content to the plug-in. 

To create a course plug-in project and configure the content and description 
extensions, use the following procedure:

1. Create an new Eclipse plug-in project with a name such a 
com.ibm.wplc.education.content.redbook_demo. 

The project does not require a Java project, so you should:

a. In the Plug-in Project dialog box, deselect Create a Java project.

b. In the Templates dialog box, deselect Create a plug-in using one of 
these templates.

2. Click the Dependencies tab.

3. Click the Add button

4. In the Plug-in Selection dialog box, select 
com.ibm.wplc.education.mylearning.content.

5. Click the Extensions tab.

6. Click the Add button.

7. In the Extension Point Selection dialog box, select the 
com.ibm.wplc.education.content plug-in.

8. In the Extension Details form to the right of the page:

a. In the ID field, enter redbook_demo 

b. In the Name field, enter Demo Content. 

9. Click the Add button.

10.In the Extension Point Selection dialog box, select the 
com.ibm.wplc.education.mylearning.description plug-in.

Note: The value of the ID field is the simple identifier of a plug-in where 
content is stored. In this case, the value of ID points to the same plug-in 
that is storing the course definition XML file, but it could be any plug-in 
extending the MyLearning plug-ins content extension point.
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11.In the Extension Details form to the right of the page:

a. In the ID field, enter demo_course.

b. In the Name field, enter Demo Course.

12.Right-click the com.ibm.wplc.education.mylearning.description icon and 
select New → description from the context menu.

13.In the Extension Element Details form to the right of the page:

a. In the file field, enter course.xml. 

b. In the validate field, enter yes. 

14.Save the project. 

Create course definition file
Follow these instructions to create the course definition file:

1. Right-click the project folder and select New → File from the context menu.

2. In the New File dialog box, in the File name field, confirm that the project 
folder is selected as the parent folder. Enter course.xml.

3. The file opens in the editing pane. Enter the text shown in Example 11-25 into 
the file.

Example 11-25   course.xml course definition XML file

<!DOCTYPE course [
<!ELEMENT course (categories, topics)>
<!ELEMENT categories (category+)>
<!ELEMENT category EMPTY>
<!ELEMENT topics (topic+)>
<!ELEMENT topic (tag+,contact*,resource+)>
<!ELEMENT tag EMPTY>
<!ELEMENT contact EMPTY>
<!ELEMENT resource EMPTY>
<!ATTLIST categories

  defaultIDREF#REQUIRED>
<!ATTLIST category

  id ID #REQUIRED
  labelCDATA#REQUIRED>

<!ATTLIST topic
  id ID #REQUIRED
  labelCDATA#REQUIRED
  descriptionCDATA#REQUIRED>

<!ATTLIST tag
  key IDREF#REQUIRED>

<!ATTLIST contact
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  email-idCDATA#REQUIRED>
<!ATTLIST resource

  id ID #REQUIRED
  labelCDATA#REQUIRED
  descriptionCDATA#REQUIRED
  url CDATA#REQUIRED
  typeCDATA#IMPLIED
  levelCDATA#IMPLIED
  authorCDATA#IMPLIED>  

]>

<course>
<categories default="AllTopics">

<category id="AllTopics" label="All Topics"/>
<category id="TopicA" label="Topic A"/>
<category id="TopicB" label="Topic B"/>

</categories>
<topics>

<topic id="TA" label="Topic A"
description="Topic A">
<tag key="AllTopics"/>
<tag key="TopicA"/>
<contact email-id="contactA@a.com"/>
<resource id="RA1" label="Resource A1"

   description="Resource A1"
   level="Basic" type="Reference"

           author="Author"
   

url="http://com.ibm.wplc.education.mylearning/redbook_demo/RA1.htm"/>
<resource id="RA2" label="Resource A2"

   description="Resource A2"
   level="Basic" type="Reference"

           author="Author"
   url="file:///C|/testhtml/RA2.htm"/>

</topic>
<topic id="TB" label="Topic B"

description="Topic B">
<tag key="AllTopics"/>
<tag key="TopicB"/>
<contact email-id="contactB@b.com"/>
<resource id="RB1" label="Resource B1"

   description="Resource B1"
   level="Basic" type="Reference"

           author="Author"
   url="file:///C|/testhtml/RB1.htm"/>
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<resource id="RB2" label="Resource B2"
   description="Resource B2"
   level="Basic" type="Reference"

           author="Author"
   url="file:///C|/testhtml/RB2.htm"/>

</topic>
</topics>

</course>

4.Save the course.xml file.

Moving content to a course plug-in
From the course definition file listing above, you can see that the URL for 
Resource RA1 is defined to reside in the plug-in. To move that HTML file from the 
current location in C:\testhtml in the file system to the plug-in, use the following 
procedure:

1. Right-click the project folder and select Import.

2. In the Select dialog box, click File System, and then click Next.

3. In the File System dialog box, use Browse... to select the C:\testhtml 
directory.

4. Mark the check box adjacent to the RA1.htm file.

5. Click Finish. 

Your project structure should look like Figure 11-8.

Figure 11-8   Project structure

Test the course plug-in
You can now test the MyLearning plug-in to ensure that the course plug-in has 
been detected.

1. Double-click the plug-in.xml file in the 
com.ibm.wplc.education.content.redbook_demo plug-in project.

Note: Before you deploy the course plug-in, you should check that the course 
definition XML and any content files are included in the build.
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2. Click the Build tab

3. Mark the check boxes next to the course.xml and RA1.htm files, as shown in 
Figure 11-9.

Figure 11-9   Binary and source builds window

4. Save the plug-in.xml file.

Testing and verifying the plug-in
At this point, you can open the plug-in and view the content you created.

11.4  Additional examples: using the Lotus Education 
plug-in for for other content delivery

It is not difficult to imagine using this plug-in framework to deliver other types of 
content. 

Human resource example
For example, an organization may populate the environment with links to human 
resources information, procedures, and forms used by employees. Live 
assistance can support users who may need further help. Figure 11-10 on 
page 522 shows how the plug-in could be used to provide resources and support 
from an organization’s human resource department.
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Figure 11-10   Human Resources example

ISO certification example
Another example would be an organization that uses the environment to manage 
their ISO certification documentation. ISO certification requires:

� Employees have access to up-to-date controlled documentation. These 
include:

– Quality statement 

– Work instructions

– Policies

– Procedures

– Controlled forms

– Controlled records

� Processes be assigned to owners or teams of owners

The Lotus Education plug-in supports both these requirements. Controlled 
documents and forms can be maintained in a central server location where they 
can be updated as needed. 

Process, policy, and work instruction owners can be assigned to documents 
using the Assistance feature of this plug-in. Users can directly contact these 
owners as needed.

Help and support example
Some organizations are moving to a self-serve model for first-line user support. 
Using this strategy, users are encouraged and enabled to first help themselves in 
solving a problem. In many instances, users can resolve their own problems if 
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they are provided the appropriate tools and resources. If a user cannot resolve 
their problem, they are directed to a trained support person who can help.

The structure of this plug in supports this strategy as well. Users can search 
online resources for information, tools, and tips to first try to resolve a problem. 
The filtered topics list can be used to direct users according to feature, function, 
product, task and so on. If a user cannot solve his problem, he can use the 
Assistance feature to directly contact an available support person who has been 
assigned to that topic area. 

Figure 11-11 shows the plug-in populated with troubleshooting information for a 
variety of applications. Users search for their problem and display information, 
instruction, or demonstrations about how to resolve their issue. If the user is still 
having problems, he can right-click a topic for assistance.

Figure 11-11   Help and support example
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Chapter 12. Deploying plug-ins for 
Sametime 7.5

This chapter presents how to deploy IBM Lotus Sametime Connect client 
plug-ins, including how to manually install plug-ins, and how to set up 
administrative provisioning to automatically distribute plug-ins for a distributed 
environment. 

The following topics are presented in this chapter:

� Deploying Custom Plug-ins to IBM Lotus Sametime Connect Users

� Deploying Plug-ins Automatically

� Deploying Plug-ins Manually Through Sametime Connect

� Configuring Plug-ins

� Setting Automatic Plug-in Update Preferences

� Installing Plug-Ins Through the Preferences.ini File

� Disabling Manual Plug-in Installs Through the Sametime Connect Client

12
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12.1  Deploying custom plug-ins to IBM Lotus Sametime 
Connect users

When you have finished developing and testing your custom plug-in for Lotus 
Sametime Connect 7.5, you will need to make your plug-in available to your 
target users. To do so, you have a couple of options:

� Auto provision plug-ins: Work with the Sametime administrator to 
automatically provision your plug-in to all Lotus Sametime Connect users in a 
particular community. When using this option, your plug-in is automatically 
downloaded to the client when the user launches Lotus Sametime Connect. 
The user is notified of the update and can have the client restart automatically 
to load the new plug-in. The user does not need to take any other action.

� Manually install plug-ins: Post your plug-in on an Eclipse update site and 
instruct users to install the plug-in using the Lotus Sametime Connect 
Manage Updates User Interface. Note that Sametime administrators can 
disable the ability for users to install plug-ins in this way, in which case you will 
need to use the first option.

This chapter will show how to set up each option.

For more information about using an Eclipse update sites to distribute plug-ins, 
see the How To Keep Up To Date article at this site:

http://www.eclipse.org/articles/Article-Update/keeping-up-to-date.html

12.2  Deploying plug-ins automatically

To deploy plug-ins automatically, complete the following tasks. Each task is 
described in detail in the following pages.

Task 1: Prepare your plug-in for deployment.

Task 2: Create a Feature.

Task 3: Create an Eclipse Deployment Web site.

Task 4: Configure the Sametime Server. 

12.2.1  Task 1: Prepare your plug-in for deployment

The following steps prepare the plug-in for deployment: 

1. Open Eclipse. Be sure to use the same work space where you created your 
plug-ins. Figure 12-1 on page 527 shows the Eclipse interface.
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Figure 12-1   Open workspace displaying your plug-in

2. Expand your plug-in in the Package Explorer perspective.

3. Double-click the Build.Properties file. 
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The Build Configuration Editor page displays in your center view, as shown in 
Figure 12-2.

Figure 12-2   Build Configuration Editor

4. Select the portions of the plug-in you need or wish to include in the build. For 
the purposes of this example, all are chosen; however, this may or may not be 
necessary in your scenario.

Figure 12-3   Select what will be included in the Binary and Source Builds

5. Click File → Save.
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12.2.2  Task 2: Create a feature

A Feature contains a manifest that provides basic information about the feature 
and its contents, including plug-ins and fragments. A feature is deployed and 
delivered in the form of a JAR file.

Now that your plug-in is ready to be deployed, it will need to be packaged in a 
manner that will be recognized by Eclipse Update Manager. Eclipse Update 
Manager is an Eclipse tool that manages versions and deployment of plug-ins 
and fragments. 

Next, you need to create a Feature for your plug-in(s).

1. Make sure your plug-in is open in the Workspace you created.

2. Select File → New → Project. This will launch the New Project Wizard.

Note: For the purposes of this example, we are deploying one plug-in only; 
however, you may have several closely coupled or similarly themed plug-ins 
you want to deploy in a single packaged feature. A feature will provide a 
structure for your similarly themed plug-ins as well as a place for branding 
elements, such as About pages and Images.
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3. Select Feature Project wizard, and then click Next, as shown in Figure 12-4.

Figure 12-4   Select the New Feature Wizard

4. On the New Properties page for the New Feature wizard, complete the 
properties as follows, and as shown in Figure 12-5 on page 531:

– The Project Name should be the same as the plug-in you want to deploy 
with the term .feature appended, as shown in Example 12-1.

Example 12-1   Project Name

com.riverbend.sametime.branding.feature

– The Feature ID should be left as the default after you create a feature 
name. 

– If your plug-in utilizes a custom installer, provide that information in the 
Install Handler Library field.

Note: As you give the Feature Project a name, you will notice that other 
properties, such as Feature ID and Feature Provider, become populated 
with information based on your feature name. You can leave them as the 
default or change them to something you will recognize more easily.
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Figure 12-5   Feature Properties Dialog in the New Feature Wizard

5. Click Next.
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6. On the Referenced Pug-ins and Fragments page, shown in Figure 12-6, 
select the plug-in you are making ready for deployment from the list, and then 
click Finish.

Figure 12-6   Select your plug-in from the Plug-ins and Fragments page of the wizard

The wizard now creates your feature package and opens the feature on the 
Overview tab of the feature.xml file (see Figure 12-7 on page 533). You can 
always come back to this view (known as the feature manifest editor) by double 
clicking the feature.xml file.
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Figure 12-7   Overview tab of the Feature.xml file in the Feature editor

7. There are many options in this view. Change the following fields if necessary:

a. In the Branding Plug-in field, click the Browse... field.

b. Select the plug-in you wish to deploy and click OK, as shown in 
Figure 12-8.

Figure 12-8   Select plug-in dialog
 Chapter 12. Deploying plug-ins for Sametime 7.5 533



c. In the Update Site URL field, enter the Eclipse Update Site URL. 

d. In the Update Site Name field, enter the site name. 

This information is used to specify the site that will be used to load your 
feature using Eclipse Update Manager. When Update Manager looks for 
updates, it will look for sites defined in your update site URL. If you have 
not created an Eclipse update site yet (this is shown in 12.2.3, “Task 3: 
Create an Eclipse deployment Web site” on page 536), you can change 
this setting later.

e. In the Supported Environments section, enter OS, platform, and language 
specifications, if these are required by your plug-in. For our example, this 
is not necessary.

8. Click the Information tab.

The Feature Information, Copyright, License and Sites to Visit tabs are 
displayed. Feature information is displayed to the user by the update manager 
when the feature is selected. 

9. For each of these tabs, you can either enter a URL, if sites already exist, or 
you can enter the information in the Text area for each (see Figure 12-9).

Figure 12-9   Information tab in the Feature editor

10.In the Optional URL field, enter a URL and name for any other relevant 
Update sites you have.
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11.Click the Plug-in tab.

12.Confirm that your plug-in is listed in the Plug-ins and Fragments window. If it 
is not, click Add... and select the plug-in you wish to include, and then click 
OK. Figure 12-10 shows the Plug-ins and Fragments window.

Figure 12-10   The Plug-ins tab of the Feature editor should show your plug-in(s)

13.Click the Version button.

14.Select Synchronize Versions on Build (recommended), as shown in 
Figure 12-11 on page 536, and then click Finish. This will synchronize your 
feature version and plug-in version.
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Figure 12-11   Version Synchronization Dialog

15.Your feature and plug-in are now ready to deploy.

12.2.3  Task 3: Create an Eclipse deployment Web site

Whether you want to deploy Sametime plug-ins automatically or prefer to let your 
user base manually choose and install plug-ins, you will need an Eclipse 
Deployment Web site. This section describes how to create an Eclipse 
Deployment Web site using Eclipse V3.2.

1. Open Eclipse. Be sure to open the workspace where you created your plug-in 
and feature (see Figure 12-12).

Figure 12-12   Verify your Feature shows in Package Explorer

2. Select File → New → Project.
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3. Select Update Site Project, as shown in Figure 12-13, and then click Next to 
launch the wizard.

Figure 12-13   Select the Update Site wizard

4. The New Update Site wizard has only one page, as shown in Figure 12-14 on 
page 538. 

a. Enter a Project name. You should enter the plug-in name and append a 
another word to denote that this is an update site project. In our example, 
we use com.riverbend.sametime.branding.update.

b. Select Use the default location.

c. Check the Generate a Web page listing all available resources within 
the site.

d. Leave the Web resource location as the default web.

5. Click Finish.
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Figure 12-14   Update Site Wizard properties page

The wizard creates your update site within your Eclipse workspace.

6. Double-click the index.htm file located in the Package Explorer tab, as shown 
in Figure 12-15.

Figure 12-15   Select the index.html file in your update site
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This will display the look of the Web site in the editor frame (center frame). 
Note that there are no plug-ins currently listed in this site. You will need to add 
them.

Figure 12-16   The wizard created site has no plug-ins by default

7. To add your feature(s), double-click the site.xml file located in the Package 
Explorer frame.

Figure 12-17   Select the site.xml file in your update site

8. This will open your site manifest editor in the editor frame (center frame), as 
shown in Figure 12-18 on page 540. 

To add your new feature, click Add Feature. If you are adding more than one 
feature/plug-in or plan to in the future, you may choose to organize them by 
category. 
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Figure 12-18   New category and Add Feature buttons in Update site manifest editor

9. Click New Category to categorize your plug-ins.

10.If adding a new category, click New Category, as shown in Figure 12-19.

Figure 12-19   Clicking New Category displays properties for the New Category
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11.In the Category Properties pane, enter a Name and Label for the new 
category, as well as a description.

12.Highlight the newly named category in the site category list (left).

13.Click Add Feature to add feature(s) to this category, as shown in 
Figure 12-20.

Figure 12-20   Click Add Feature to set your feature/plug-in within the update site

14.Select the feature you are including in this category, as shown in Figure 12-21 
on page 542. You can select more than one by holding down the Ctrl key. 
When finished selecting, click OK.
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Figure 12-21   Select your feature.

15.Click the Build All button, as shown in Figure 12-22. 

This adds the /Features and /Plug-ins directories to the Site project and 
populates them with JAR files containing your feature and plug-in files.

Figure 12-22   Building the Update Site locally
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This will now build your update site locally. You will see a progress bar, as 
shown in Figure 12-23.

Figure 12-23   Progress Bar for Site Build

16.Once completed, click the site.xml tab to switch to the Update Site Map 
dialog for the site.xml page of the editor, as shown in Figure 12-24.

Figure 12-24   Site.xml tab of the Manifest editor

Your XML code should look like Example 12-2.

Example 12-2   XML code for the River Bend update site

?xml version="1.0" encoding="UTF-8"?>
<site>
   <feature 
url="features/com.riverbend.sametime.branding.feature_1.0.0.jar" 
id="com.riverbend.sametime.branding.feature" version="1.0.0">
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      <category name="Corporate Branding"/>
   </feature>
   <category-def name="Corporate Branding" label="Corporate Branding">
      <description>
         River Bend Branding of the Sametime Connect Client
      </description>
   </category-def>

That is it. You have now created an Eclipse Update site locally.

17.Copy the site map and jar files within the update project to your Web server 
(see Figure 12-25). These files are found under the project root directory. In 
our example, this is com.riverbend.sametime.branding.update.

Figure 12-25   Files and folders that need to be transferred to the web server

The files and folders in this directory include:

� features folder

� plug-ins folder

� web folder 

� .project

� index.html 

� site.xml 
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18.After you have the directory copied, open the site in a browser 
(http://fullyqualifiedname/folder/index.html). It should look like Figure 12-26.

Figure 12-26   Verify your Web server 

12.2.4  Task 4: Configure the Sametime server

The URL that was created for your update site will now need to be added to the 
Lotus Sametime server. Adding this will enable the deployment of the plug-in to 
all users who have this community as the primary community.

To configure the Sametime server to automatically push down plug-ins, do the 
following.

1. Open stconfig.nsf on the Sametime server.

2. Edit the Community Client Document.

3. Add the URL to the Eclipse Deployment Web site, as shown in Figure 12-27 
on page 546.

Note: This is known as adding a “server attribute” to the Sametime server.
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Figure 12-27   Community Client Document in stconfig.nsf on Sametime Server

4. Restart your Sametime server.

The next time a user logs into the Sametime Connect client, the plug-in is 
downloaded and the user is prompted to restart the Sametime client.

12.3  Deploying plug-ins manually through Sametime 
Connect 

An user can install Sametime Connect plug-ins manually by doing the following 
from the Sametime Connect Client:

1. Select File → Manage Updates → Download Plugins....

2. Click Search for New Features to Install, as shown in Figure 12-28 on 
page 547.

Note: This can be disabled by an administrator. This is discussed in 12.8, 
“Disabling manual plug-in installs through the Connect Client” on page 552.
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Figure 12-28   Manual plug-in Install (Feature Installs)

3. Click Next.

4. Click New Remote Site. 

5. Enter the Name and URL for that site, as shown in Figure 12-29. This is the 
Eclipse Deployment Web Site that was discussed in 12.2.3, “Task 3: Create 
an Eclipse deployment Web site” on page 536.

Figure 12-29   New Update Site
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6. Click OK. Figure 12-30 should appear.

Figure 12-30   Update Site

7. Select Ignore features not applicable to this environment. 

8. Click Finish. Figure 12-31 on page 549 should appear.
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Figure 12-31   Updates

9. Select the plug-ins to install. 

10.Select to Show the latest version of a feature only. 

11.Select whether to install each plug-in only once by choosing to filter features. 

12.Click Next. 

13.Select whether you accept the licensing agreement for each plug-in you are 
installing, and then click OK. 

14.Select a feature to install. 

15.Click Change location to select a different location to which to install it or 
leave the default. 

16.Click Finish. 

The plug-in will now be installed and the user will be prompted to restart.
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12.4  Deploying a plug-in through copying files

It is possible to manually deploy plug-ins by copying files to specific directories by 
doing the following:

1. Export the plug-in JAR file from Eclipse.

2. Copy the exported plug-in JAR file to the <sametime-root>/eclipse/plug-in 
directory, where <sametime-root> is the directory in which the Sametime 
client is installed.

3. If the Connect Client is currently running, restart it to detect the plug-in.

The Eclipse plug-in should then become part of the Sametime client.

12.5  Configuring plug-ins

You can view and change the configuration settings for any plug-ins you have 
installed, if your system administrator makes this functionality available to you.

To configure your plug-ins, do the following

1. Click File → Manage updates → Configure. 

2. In the navigator, click the name of the plug-in configuration you want to view 
or change. 

3. Optional: Click the plus sign (+) beside the plug-in name to select the 
installation location or specific plug-ins whose configuration you want to view 
or change. 

4. Click the task you want to perform. 

5. Click the X to close the Product Configuration window. 

Important: Deploying plug-ins in by copying files will not allow users to 
configure the plug-in through the Sametime Connect interface. The plug-in will 
not appear in the File → Manage updates → Configure dialog box. The 
ability to deploy plug-ins in this manner may be prohibited in future releases of 
Lotus Sametime.
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12.6  Setting automatic plug-in update preferences

Your system administrator determines whether plug-ins are available to you and 
whether new plug-in updates are automatically installed to your IBM Lotus 
Sametime Connect client. If automatic updates are available to you, you can 
specify an update schedule and download options. To enable this, do the 
following:

1. Select File → Preferences and click the plus (+) sign beside Install/Update in 
the navigator. Then click Automatic Updates. 

2. Select Automatically find new updates and notify me to automatically 
install updates to plug-ins. 

3. Select how often you want to look for updates and down load options for new 
updates, as shown in Figure 12-32.

Figure 12-32   Sametime 7.5 Connect Automatic Updates preferences

4. Click Apply. 
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5. Click OK.

12.7  Installing plug-ins through the preferences.ini file

Sametime plug-ins can also be installed through the preferences.ini. The file is 
located at C:\Program Files\IBM\Sametime Connect 
7.5\plugins\com.ibm.collaboration.realtime.update_1.0.0\preferences.ini file. 

The actual file location is dependent on where Sametime is installed.

The Eclipse Update Site URL would need to be added to the 
adminUpdatePolicyURL= line in the preferences.ini.

The order of events follow:

1. The Sametime client starts.

2. The Sametime client searches for the existence of the server property, which 
is the Eclipse Update Site URL, in the Community Client Document, in 
stconfig.nsf.

3. If the key is not found, the client searches the preferences.ini for the 
adminUpdatePolicyURL value. If it is there, the client will handle it as though it 
came from the server attributes.

12.8  Disabling manual plug-in installs through the 
Connect Client

An administrator can disable the ability for users to manually download plug-ins. 
The user will see that they cannot use the File → Manage Updates menu 
options because they will be grayed out. 

Follow these instructions to disable this ability:

1. On the server machine, open the \Lotus\Domino\sametime.ini file.

2. Under the [config] section, add the following line:

DisableConnectPluginUpdates=1

3. Restart the server and reconnect with the client.

The user options will be greyed out, as shown in Figure 12-33 on page 553.

Note: IBM is reviewing the ability to use polices to deploy plug-ins in a future 
release of Sametime.
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Figure 12-33   Disabled plug-in
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Appendix A. Additional material

This IBM Redbook refers to additional material that can be downloaded from the 
Internet as described below. 

Locating the Web material
The Web material associated with this redbook is available in softcopy on the 
Internet from the IBM Redbooks Web server. Point your Web browser to:

ftp://www.redbooks.ibm.com/redbooks/SG247346

Alternatively, you can go to the IBM Redbooks Web site at:

ibm.com/redbooks

Select the Additional materials and open the directory that corresponds with 
the redbook form number, SG247346.

A
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Using the Web material
The additional Web material that accompanies this IBM Redbook includes the 
following files:

Table 12-1   File name and description

Details of how to use the Web material
Create a subdirectory (folder) on your workstation, and unzip the contents of the 
Web material zip file into this folder.

� Extension Points.zip 

File name Description

Code Samples.zip All of the code samples used within the 
book. Within this .zip file, the following files 
are contained:

Extension Points.zip Code used for the example in Chapter 4, 
“Extension points” on page 61

Branding.zip Code used for the example in Chapter 5, 
“Introduction to building a plug-in: 
modifying the UI” on page 161

Calendar Lookup.zip Code used for the example in Chapter 6, 
“Leveraging Web services and building a 
calendar lookup plug-in for Sametime 
Connect” on page 215

com.ibm.redbook.sametime.statistics.zip Code used for the example in Chapter 7, 
“Advanced plug-in example: The 
Sametime Server Statistics Plug-in” on 
page 249

com.ibm.redbooks.st75.sap_1.0.0.zip Code used for the example in Chapter 8, 
“Advanced plug-in example: SAP 
integration” on page 297

com.ibm.wplc.education.mylearning.zip Code used for the examples in Chapter 9, 
“Introducing My Lotus Learning Education 
framework plug-in for Sametime Connect” 
on page 391, Chapter 10, “Building the 
education framework plug-in” on 
page 405, Chapter 11, “Refining and 
implementing the education framework 
plug-in for Sametime Connect” on 
page 485
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This .zip file contains three plug-ins with their associated source code.

Import them into your Eclipse workspace by unzipping the three .jar files to 
your hard-drive, then select File → Import → Plug-in Development → 
Plug-ins and Fragments.

Make sure you specify Projects with source folders in the Import As section 
of the wizard.

The plug-in com.ibm.redbooks.extensionpoints_1.0.0.jar covers the extension 
points detailed in 4.3, “Adding to the contact list window” on page 69, 4.4, 
“Adding to the chat window” on page 100, 4.6, “Adding a preference page” on 
page 143, and 4.7, “Adding a mini application” on page 151.

The plug-in com.ibm.riverbend.enway_1.0.0.jar covers the extension points 
detailed in 4.5, “Adding to the nway chat (multi person chat) window” on 
page 120.

The plug-in com.ibm.redbooks.messagelistener_1.0.0.jar covers the 
extension point detailed in 4.8, “Message Event Notification extension point” 
on page 154

� Branding.zip

This .zip file contains one plug-in and associated source code.

Import it into your Eclipse workspace by unzipping the .jar file to your 
hard-drive, then select File → Import → Plug-in Development → Plug-ins 
and Fragments.

Make sure you specify Projects with source folders in the Import As section 
of the wizard.

The plug-in com.riverbend.chat.branding_1.0.1.jar covers the Branding 
options detailed in Chapter 5, “Introduction to building a plug-in: modifying the 
UI” on page 161. 

� Calendar Plug-in Sample.zip

This .zip file contains the source code used in the Calendar Lookup plug-in, 
and a Domino database containing the Calendar Lookup Web service.

This code is provided for illustration only; you will need to create your own 
plug-in project and generate your own Web service client jar file from your 
deployed version of the Domino Web service.

The Domino database must be deployed on a Domino 7 server, as it uses the 
new Web service design element.

� Sametime Admin Statistics Sample

The Java source code for the Sametime Server Statistics application are 
contained in archive file com.ibm.redbook.sametime.statistics.zip. When the 
archive is expanded, the resulting structure consists of a single top-level 
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directory, com.ibm.redbook.sametime.statistics, which contains two 
sub-directories:

\plugin The plugin directory contains files associated with the 
Sametime Server Statistics plug-in. 

\servlet The servlet directory contains files associated with the 
stlogserv servlet.

The plugin and servlet sub-directories both contain bin and src directories. 
The plugin directory contains an additional xml directory.

The structure of the expanded com.ibm.redbook.sametime.statistics.zip 
archive file is shown below:

com.ibm.redbook.sametime.statistics

plugin

   bin(compiled and exported Sametime plug-in)

   src

      com

         ibm

            redbook

               sametime

                  statistics(Java source files)

   xml(plugin.xml)

servlet

   bin(compiled stlogserv servlet)

   src(Java source files)

� MyLearning.zip

The Java source code and images for the My Lotus Learning plug-in are 
contained in archive file com.ibm.wplc.education.mylearning.zip. When the 
archive is expanded, the resulting structure consists of a single top-level 
directory, com.ibm.wplc.education.mylearning, which contains two 
sub-directories:

\src The src directory contains further sub-directories that 
correspond to the three packages used to organize the 
plug-in’s code: 

com.ibm.wplc.education.mylearning.catalog

com.ibm.wplc.education.mylearning.model

com.ibm.wplc.education.mylearning.ui. 
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\image The image directory contains various GIF and PNG 
image files that are used for icons and graphic labels 
within the plug-in’s user interface.

The structure of the expanded com.ibm.wplc.education.mylearning.zip 
archive file is shown below:

com.ibm.wplc.education.mylearning 

src

   com

      ibm

         wplc

            education

               mylearning

                  catalog   (Java source files)

                  model (Java source files)

                  ui  (Java source files)

image(Image files)

The course definition XML file, course.xml, for the test course used with My 
Lotus Learning plugin, is also available for download.
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Glossary

API. Application Programming Interface.

ATF. Ajax Tools Framework.

CDT. C/C++ Development Tools.

CLASS file. A compiled Java source file. 

Compilation unit. A Java source file. 

Eclipse Platform. Eclipse Platform is the name for 
the core frameworks and services upon which 
plug-in extensions are created. It provides the run 
time in which plug-ins are loaded and run. The 
Platform's direct consumers are tool builders, or 
ISVs, since they add the value to the Eclipse 
Platform that makes it useful to people. 
The Eclipse Platform is divided up into Core and UI. 
Anything classified as "UI" needs a window system, 
while things classified as "Core" can run "headless". 
The UI portion of the Eclipse Platform is known as 
the Workbench. The core portion of the Eclipse 
Platform is simply called the Platform Core, or Core. 

Eclipse SDK. The Eclipse SDK includes the 
Eclipse Platform, Java development tools, and 
Plug-in Development Environment, including source 
and both user and programmer documentation.

Eclipse. An open platform for rich client 
development. Although Eclipse is a Java-based 
platform, it can be used to build tools for other 
programming languages.

EMF. Eclipse Modeling Framework.

Extension Points. The specification that declares 
how extensions can add to the functionality of a 
plug-in. Several plug-ins can contribute to an 
extension point by defining extensions in the 
plug-in's extension manifest file, plugin.xml.
© Copyright IBM Corp. 2007. All rights reserved.
Extension. A mechanism that expands the 
functionality of a plug-in by connecting to an 
extension point. An extension is also referred to as a 
"contribution" to another plug-in.

GEF. Graphical Editing Framework.

IBM WebSphere Everyplace Deployment. The 
platform used by Lotus Sametime Connect and IBM 
managed client products. WebSphere Everyplace 
Deployment includes the Eclipse Rich Client 
Platform (RCP) and Java Runtime Environment 
(JRE), as well as additional services used by 
managed client products. The WebSphere 
Everyplace Deployment platform is available as a 
separate product, so that third parties can build their 
own WebSphere Everyplace Deployment 
applications.

IDE. Integrated Development Environment. The 
IBM Rational Application Developer IDE and Eclipse 
IDEs are examples of IDEs.

ISV. Independent Software Vendor.

J2SE. Java 2 Platform, Standard Edition. This is 
the standard JRE for desktop applications.

J9 JCL Desktop. A custom run time environment 
that provides a wide set of features from the Java 2 
Platform API core libraries. J9 JCL Desktop is the 
runtime environment used by Lotus Sametime 
Connect 7.5 on Windows and Linux platforms.

JDT. Java Development Tools.

JFace. JFace is the mid-level UI framework useful 
for building complex UI pieces, such as property 
viewers. JFace works in conjunction with SWT.

JRE Java Runtime Environment. This is the 
technology that allows Java applications to run. 
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OSGi. The OSGi Service Platform is a standard 
that defines, among other things, how Eclipse 
plug-ins are packaged.

Packages. A group of types that contain Java 
compilation units and CLASS files. 

PDE. The plug-in development environment.

Perspective. An Eclipse Development Term that 
indicates a view into your Eclipse development 
environment workbench. More specifically, the 
Eclipse development environment (and Eclipse 
applications) runs inside an environment called a 
workbench. The workbench is a collection of 
toolbars, menus, and one or more perspectives. 
Essentially, you can think of the workbench as the 
Eclipse IDE. When starting a new project, you can 
create a specific profile for a development project, 
known as a workspace.

Plug-in registry. A registry of declared plug-ins, 
extension points, and extensions managed by the 
Eclipse Runtime Platform.

Plug-in. An Eclipse platform feature component. A 
plug-in is the basic building block of an Eclipse 
application.

RCP. Rich Client Platform.

RTC. Real-time Collaboration, which describes 
synchronous technologies such as instant 
messaging, presence awareness, Web conferences, 
telephony, and so on.

SIP. Session Initiation Protocol, a standard 
protocol for managing interactive sessions between 
users. SIP is used for instant messaging, presence, 
telephony, and a number of other applications

Source folder. A folder that contains Java 
packages. 

SWT. Standard Widget Toolkit is a small, fast 
widget toolkit with a portable API and a native 
implementation. So far, SWT has been ported to 
Windows, Linux (GTK and Motif window systems), 
AIX® (Motif), Solaris™ (GTK), HP-UX (Motif), QNX 
(Photon), and Mac OS X (Carbon).

Type. A type inside a compilation unit or CLASS 
file. 

Workbench. Eclipse development environment. A 
workbench is a collection of toolbars, menus, and 
one or more perspectives.

Workspace. A workspace is the general umbrella 
for managing resources in the Eclipse Platform. 
Note that workspaces and resources are an optional 
part of the Platform; some configurations of the 
Platform will not have a workspace.
The Workbench is a high-level UI framework for 
building products with sophisticated UIs built from 
pluggable components. The Workbench is built atop 
JFace, SWT, and the Platform Core.
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Related publications

The publications listed in this section are considered particularly suitable for a 
more detailed discussion of the topics covered in this IBM Redbook.

IBM Redbooks
For information about ordering these publications, see “How to get IBM 
Redbooks” on page 566. Note that some of the documents referenced here may 
be available in softcopy only. 

� Lotus Instant Messaging/Web Conferencing (Sametime): Building Sametime 
Enabled Applications, SG24-7037

Other publications
These publications are also relevant as further information sources:

� D'Anjou, Jim, et al, The Java Developer's Guide to Eclipse, Second Edition, 
Covers Eclipse 3.0, Pearson Education, 2004, ISBN 0321305027

� Bloch, Joshua, Effective Java Programming Language Guide, 
Addison-Wesley, 2001, ISBN 0201310058

� Carlson, David. Eclipse Distilled (The Eclipse Series), Pearson Education, 
2005, ISBN 0321288157

� Burnette, Ed. Eclipse IDE Pocket Guide, O'Reilly Media, Incorporated, 2005, 
ISBN 0596100655

Online resources
These Web sites are also relevant as further information sources:

� Chris Aniszczyk’s Recommended Eclipse Reading List

http://www-128.ibm.com/developerworks/library/os-ecl-read/index.html

� IBM WebSphere EveryplaceDeployment

http://www.ibm.com/software/pervasive/ws_everyplace_deployment
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� Sametime Home page on IBM developerWorks

http://www-128.ibm.com/developerworks/lotus/products/instantmessagin
g/

Eclipse
� Eclipse Organization Community home page

http://www.eclipse.org

� Eclipse Workbench User’s Guide basic tutorial

http://help.eclipse.org/help32/index.jsp

� Eclipse project resources

http://www.ibm.com/developerworks/opensource/top-projects/eclipse.ht
ml

� Eclipse documentation, including help, tutorial and guides

http://www.eclipse.org/documentation/

Java
� The Java Tutorial

http://java.sun.com/docs/books/tutorial/

� Java technology

http://www.ibm.com/developerworks/java

How to get IBM Redbooks
You can search for, view, or download IBM Redbooks, IBM Redpapers, Hints and 
Tips, draft publications and Additional materials, as well as order hardcopy 
Redbooks or CD-ROMs, at this Web site: 

ibm.com/redbooks
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Help from IBM
IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
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